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Getting Started in Nexsure 

Logging in to Nexsure 

1. Enter your Login Name. 

2. Enter your Password. 

3. Click Login. 

Note: When you are finished with your session in Nexsure click the Logout link in the Utility 
menu or you will remain logged in for four hours. After four hours of inactivity the session will be 
automatically logged off. 

 

Password 

Changing Your Password 

Ask your Nexsure administrator if there are any password requirements such as a minimum character 
limit or case sensitivity.  These rules are set in the Setup > Security Administration screens in Nexsure. 

1. On the Login screen, click the Change Password link. 

2. Enter your login name. 
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3. Enter your existing password. 

4. Enter a new password.   

5. Re-enter the new password in the Confirm new password field. 

6. Click Change Password. 

Note: While using Nexsure, you are responsible for maintaining the confidentiality of your account 
and password and for restricting access to your computer. You also agree to accept responsibility 
for all activities that occur under your account or password. 

To Retrieve a Password 

1. Enter your User Name. 

2. Click the Forgot your password? link. 

3. A new password will be sent to the email address you have on file.  

4. Return to the Nexsure login screen and enter your User Name and the new password and click 
Login. 

5. Once you have logged back into Nexsure, you can enter a new custom password. 

• On the Primary menu, click Organization. 

• Click the employees tab. 

• Select your employee name by clicking on the Details  icon next to your name. 

• Click the Security tab. 

• In the Enter a new password field, enter a new password. 

• In the Confirm new password filed, enter the same password again. 

• Click the Update link.  Your password is changed. 

To Request New User Registration 

1. Click the New User Registration request link. The new user web form appears. 

2. Enter the information. The fields with the red asterisks are required fields.   

3. Click Submit. The information will be sent to the XDTI sales department and you will be contacted 
in regards to adding a new user. 
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Menu Navigation in Nexsure 

 
To navigate through Nexsure it is important to learn the basic menus. The menus include: 

• Utility menu - Includes HOME, HELP, SETUP, LOGOUT 

• Primary menu - Includes SEARCH, ORGANIZATION, REPORTS, Bookmarks 

• Home menu - The Home menu is a dynamic (or changing) menu.  Upon initial login to 
Nexsure the Home menu is displayed.  When a client has been selected on the Search 
screen, the Home menu will change to the Client menu.  The menu remains in the same 
position, but the menu selections will be different. Includes ACTIONS, OPPORTUNITIES, 
MARKETING, BINDER LOG, EDITS, AUDITS, EXPIRATIONS, ENDORSEMENTS, 
CANCELLATIONS, CLAIMS, INTERFACE, DELIVERY 

• Client menu - Includes CLIENT PROFILE, OPPORTUNITIES, MARKETING, POLICIES, 
CLAIMS, SERVICING, ATTACHMENTS, ACTIONS, TRANSACTIONS, DELIVERY, T-LOG 

• Organization menu - Includes ORGANIZATION PROFILE, ALL EMPLOYEES, ALL 
LOCATIONS 

• Report menu - Includes Reports, Global Activity, Ad-Hoc 

• Carrier menu - Includes Carrier Profile, Attachments 

• Retail Agent menu - Includes Retail Agent Profile, Actions, Opportunities, Marketing, 
Policies, Attachments 

Note: Items on the menus can be removed by an administrator for security purposes. For 
example, administrators may want to restrict access to the accounting or reports items for 
customer service employees. 

Search Overview 

The search screen allows you to search for and add an entity, as well as import downloaded records. The 
following entities can be searched for and added: 

• Additional Interest 

• Carrier 

• Client 

• Financial Entity 

• Premium Finance Company 

• Retail Agent 
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• Tax Authority 

• Vendor 

 
• Before adding an entity you are required to search for the entity to make sure it has not already 

been entered into Nexsure.  Each entity type has the same following characteristics and criteria:  

• When the Search menu is selected, the history search results is displayed for any entities you 
have accessed in the past with the most recent entities displaying first. 

• From the Search Type drop-down list, select Begins with to search items that begin with 
specific characters, or Contains to search items that contain specific characters anywhere in 
the selected field. 

• Prior to adding a new entity a search is required to avoid entering duplicate accounts. 

• When the Search menu is selected, the History Search Results are displayed for any entities 
you have accessed in the past with the most recent entities displaying first. 

To search for an entity 

1. On the Primary menu, click SEARCH. 

2. From the Entity drop-down list, select the entity type and enter the search criteria. 

3. From the Search Type drop-down list, select Begins with to search items that begin with specific 
characters, or Contains to search items that contain specific characters anywhere in the selected 
field.  You must enter at least 2 characters in the search criteria fields to return results. 

Tip: Entering "%%" in a search field will return ALL results existing for that particular branch, entity 
type and stage. 

4. Click Search to begin the search, or click Clear to clear the search criteria. 

Note: Once you leave the Search screen, upon the next return the last searched for entity will be 
displayed. Once you log out of the current Nexsure session the Search screen will revert back to 
the default entity (Client). 
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Importing a Record 

The [Import Record] link allows you to import IVANS or FSC downloads from either the Interface 
screen or a designated source directory. 

Bookmarks 

Bookmarks are a convenient way to mark your position in Nexsure. For example, if you need to access a 
different screen in Nexsure (such as the help system) adding a bookmark will allow you to return to the 
same screen without losing the data you have entered. 

To insert a bookmark 

Note: Before adding a bookmark, click the Save Changes link to make sure your data has been saved. 

1. On the Primary menu, click Add. To view the bookmark, click Expand, the bookmark screen will 
drop-down. 

 

2. To return to your bookmarked screen, click the flag  icon. 

• Hide: Hides or collapses the bookmark screen. 

To remove a bookmark 

1. On the Primary menu, if the bookmark window is closed, click Expand. 

2. Select the bookmark to be deleted using the selection boxes on the left. 

3. On the Primary menu, click Remove Selected. 
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Utility Menu 
The Utility menu is the menu located in the upper right corner. 

 
The Utility menu contains the following options: 

• HOME: The default selection after login. This option is used to reveal the Home menu. 

• HELP: This option is used to view the Nexsure help system. 

• SETUP: The Setup Console can be accessed by clicking on this option. 

• LOGOUT: Use this option to logout of Nexsure. Using this option frees up a registered user license 
and lets others in the organization know that you are not available.   

Note: Closing Internet Explorer does not log you out of Nexsure. You must click the LOGOUT option to 
logout of Nexsure. 

Home Menu 

The Home menu is the default menu that appears after logging in to Nexsure. It can also be accessed by 
selecting the HOME option from the Utility menu. The Home menu and the Client menu utilize the same 
space. The appropriate menu will appear based upon your navigation within Nexsure.  

 
The Home menu contains the following options: 

• ACTIONS 

• OPPORTUNITIES 

• MARKETING 

• BINDER LOG 

• EDITS 

• AUDITS 
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• EXPIRATIONS 

• ENDORSEMENTS 

• CANCELLATIONS 

• CLAIMS 

• INTERFACE 

• DELIVERY 

Actions 

Actions are used as follow-up reminders.  There are three levels of actions that can be created: 

Personal actions - This action is created from the Home > Actions screen by clicking the [Add New 
Action] link.  An action created here would be a personal action or a reminder to follow up on a potential 
client that has had no card file created yet. 

Client actions - This action is created from the actions link on the Client menu.  An action created here 
would contain general information pertaining to a client. 

Policy actions - This action is created from the actions tab at the policy level.  An action created here 
would pertain to a client's policy. 

The Actions screen is where users should look to see what items should be taken care of for a particular 
day.  To print out custom actions reports, see action reports. 

For more information on creating actions, see Creating Actions. 

  

 
  

• Select Branch: The drop-down list at the top of the screen allows a specific branch to be selected. 
 Use the Navigation link (Showing Page 1 of ...) next to the Select Branch drop-down box to 
navigate to different screens.   

• Search Filter: Click [Show] to display the search filter.  This will allow a search for an action 
meeting particular criteria.  The more information entered into the fields, the more specific the 
result will be.  The results may also be sorted. Click on the Sort By drop-down box and select a 
sort prior to initiating the search.   

•  MS Outlook: The MS Outlook icon is used to open Microsoft Outlook® to synchronize actions 
with your Outlook calendar or tasks.  See Creating Actions. 
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•  Export: Click [Export] to generate a Microsoft Excel® spreadsheet from the actions being 
displayed on the screen. Exporting to Excel can help to manage large amounts of records that can 
be returned on the home screen by using Excel's search, sort and print capabilities. 

• The blue Details  icon will display the client card file screen. Right clicking on the Details  
icon displays the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New line of business topic.   

• Add certificate - Selecting this option will display the add new certificate screen as described 
in the Servicing > Creating New Certificates topic.   

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic.   

• Add new opportunity - Selecting this option will display the Home > Opportunities screen 
as described in the Adding a New Opportunity topic.   

• The white Details  icon will display the selected action allowing the Due Date, Status, Priority 
or User to be modified, or an additional Memo to be added.  Right clicking on the Details  icon 
displays the following navigation options: 

• Open - Select Open to display the card file.  If it's a personal action Open will not be available.   

• Mark as Closed - Selecting this option will automatically close the action without opening it.   

• Add New Action - Select Add New Action to add a new action for the client.  Any topic, type, 
policy, certificate, assignment, status, priority, due date, due time or memo may be added.     

• Client Name: If the action is created for a particular client, the clients name will be displayed is the 
primary named insured. The red flag icon under the client name on the actions summary screen 
indicates a high level of priority. 

• Action Topic - Action Type: Topics are unique and allow grouping of like items together.  For 
instance, the renewal topic would be used on every action during the renewal process, which 
would then make it easier to determine where you are in the renewal process.  Type is the actual 
description of the action such as call the underwriter. Type is found directly under the topic beside 
the action icon.  (See action setup for more details).  [ ] [ ] Icons displayed in the actions column 
to the left of the Type will tell the user what type of action they are looking at.  The icons are 
selected when the actions are created in setup. 

• Policy Info: If an action is added at policy level the policy number, line of business and effective 
date will be displayed. 

• Status: The action status will either be Open or Closed which is identified by the user while 
creating or modifying it. The status may be changed as necessary. 

• Due Date/Due Time: This is the date that this action is due to be completed.  If more than one 
action is due on the same day, a due time can be assigned to address each action in chronological 
order.  Next to the due date is a color-coded countdown number of the days remaining or past the 
due date of that specific action.  The legend is as follows: 

• Green - indicates more than five days before the due date. 

• Orange - five days or less before the due date. 

• Red - number of days past the due date. 

• Assigned to: The user assigned the responsibility to address the action.   

• Created By: User who created the action.   
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• Date/Time Created: Date and time action created.   

• Last Updated By: User who last updated the action.  

• Date/Time Last Updated: Date and time action was last updated. Clicking on the name in this 
column is the only way to see the date and time the action was updated.   

• Memo: Clicking in the memo portion of the action, which is the last line in the summary of each 
action, will display all notes, users, dates and times this action has been posted to. 

  

Related Topics 

Creating Actions 

Setup > Actions 

Creating Actions 

There are three levels of actions that can be created: 

• Personal actions – This action is created from the home actions screen by clicking the [Add 
New Action] link.  An action created here would be a personal action or a reminder to follow up 
on maybe a potential client that has had no card file created yet. 

• Client actions – This action is created from the Actions link in the client menu. An action created 
here would contain general information pertaining to a client. 

• Policy level actions – This action is created from the actions tab at the policy level.  An action 
created here would pertain to a client’s policy.   

Logging into Nexsure defaults to the HOME > actions screen.  This will display a daily list of actions, or 
tasks, which need to be followed up on.  The actions will remain on the HOME > actions screen until the 
due date is extend or the action is closed.  

Personal Actions 

1. On the Utility menu, click HOME. The Actions screen will be displayed. 

2. Click the [Add New] link. The Nexsure Action pop-up window is displayed.   
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Note: When adding actions from the Home menu, the Name: field will be blank since it is not 
associated with a client or a policy.  Once saved, the client name field will show as a personal 
action. 

3. Select a Topic for the action. Topics are unique and allow grouping of like items together, such as 
the renewals or endorsements. 

4. Select a Type for the action. Types (sub-actions) are not unique and may be reused for any topic.   

Tip: Topics and Types are added in Setup. 

5. When adding actions from the Home menu, the Policy and Certificate fields are be grayed out 
and cannot be assigned.    

6. Select the Status. The status defaults to Open. When the action is completed, the status is 
changed to Closed and the action will no longer display on the Home actions screen.  

7. Select the Priority (Normal or High). A High priority creates a red flag  icon that will be 
displayed to the left of the action. 
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8. Due Date: This field is automatically populated with a date, which has been associated with the 
topic in setup. The due date can be changed by clicking the calendar icon and selecting a new due 
date or typing in the date using the correct format 

9. Due Time: By default the time an action is due is 12:01 AM.  If multiple actions are due on the 
same day, they can be assigned different times so they can be addressed in chronological order. 

10. Time Zone: In the drop-down list, select the time zone associated with the due time for the action. 

Note: Actions do not appear on the Home > actions screen until their due date. 

11. The action being created will default to the current user.  The action can be assigned to another 
user by selecting the Others option button and enter at least two characters in both the first and 
last name search fields.  Click the Search button.  If a match is found the name will display in the 
Assign box next to Others.  Select the Others option to assign the action to this user.  If no match 
was found, click the Requery button to run a new search.   

12. MS Outlook: Selecting this option will mark this action for MS Outlook synchronization. If the 
action is an appointment, it will be added to the Outlook calendar.  Other action types will be added 
as a task in Outlook.  Once the MS Outlook option is selected, an Outlook reminder can be set up 
by selecting the Reminder option and selecting a time interval.  Once the action is saved, click the 
Outlook   icon on the Home > Actions screen. Nexsure will open Outlook.  In Outlook, on the 
File menu, select Synchronize with Nexsure actions.  The users Outlook calendar and/or Outlook 
tasks will be updated.  To change how an action is added to the calendar or taskpad, see Setup > 
Actions. 

13. In the memo field, type the action message.  Previous memos will display in the previous memo 
box, these cannot be edited or deleted. 

14. Click Close to close the action without saving.  Clicking Add will add this action and leave the pop-
up window open to allow the addition of a new action.  Clicking Save will save this action and close 
the pop-up window. 

Client Actions 

To associate an action with a specific client 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. Click the Action link on the Client menu. 

4. If no records are found, click the [Add New Action] link. 

5. Complete the action as described in Personal Actions starting from step 3. 

Note: The client’s name will appear in the Name field.  Policies and certificates for the client will be 
available in the drop-down boxes.  Select the policy and/or certificate to be associated to this 
action if applicable. 
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Policy Level Actions 

To associate an action with a specific client 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. Click the POLICIES link on the Client menu. 

4. Click the Details  icon of the appropriate policy. 

5. Click the actions tab. 

6. If no records are found, click the [Add New Action] link. 

7. Complete the action as described in personal actions starting from step 3. 

Note: The client’s name will appear in the Name field and the policy number will appear in the 
Policy field.   Certificates for the client will be available in the drop-down box.  Select the certificate 
to be associated to this action if applicable. 

  

Related Topics 

About Actions 

Setting up Actions 

Opportunities 

The Opportunities screen displays prospective sales data.  A separate opportunity should be set up for 
each line of business or policy package.  It is up to each organization to define the use of opportunities to 
best fit their need.   

You can access the opportunities screen from the Home menu, or by clicking the opportunities tab at the 
client level.  When accessed from the Home menu, opportunities for the entire branch will be displayed. 
 The search filter may be used to refine the data that is displayed.  Click [Show] and enter a minimum of 
two characters in the appropriate criteria fields.  Click [Hide] on the search filter to hide. 

At the home level, clicking the details icon next to the opportunity brings you to the client level.  When 
accessed from the client level, only the opportunities for that client will be displayed.   
  

Accessing the opportunity screen from the Home menu 

1. On the Utility menu, click HOME. 

2. Click OPPORTUNITIES. 

Note: Use the Select Branch drop-down box to display opportunities for a different branch. 
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Accessing the opportunity screen from the client details 

1. Click SEARCH on the Primary menu and conduct a search for a specified client. 

2. Click the Details icon next to the specified client.   

3. Select the opportunities tab. This view will show only those opportunities specific to the selected 
client. 

Related Topics 

Adding a New Opportunity 

Customizing Opportunities for a Branch 

  

Adding a New Opportunity 

1. On the Primary menu, click SEARCH and conduct a search for the client you wish to add an 
opportunity to. 

2. Click the Details  icon next to the specified client.  Or add a new prospect/client. 

3. Click Opportunities. 

4. Click [Add New].  The New Opportunity dialog box will appear. 

5. In the State drop-down box, select the state in which the policy will be held. 

6. From the Type drop-down list, select the type of coverage. 

7. Select the line of business from the list box.  You can select multiple lines of business by holding 
down the control key to create a package policy. 

8. Click Save.  The opportunity will appear in the list of opportunities for that client.   

9. Click the Details  icon for the new opportunity.  The client profile opens to the qualification tab: 
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• X/BOR Date – Enter the prospects policy expiration or broker of record date.  This field is 
mandatory.  Enter a date manually, or click the calendar icon and select a date. 

• Program – Select the program, if any, that this opportunity is being qualified for.  Programs 
are tied to branches.  If a program that should be available to your agency is not listed in the 
drop-down list, contact your system coordinator to have it added. 

• Buying Mode – Select the appropriate buying mode from the list provided.  The buying mode 
is an indication of the prospect’s buying attitude. 

Using the drop-down lists, select the appropriate answer for each of the questions listed in 
the opportunity criteria.  

Opportunity Status 

• Total – The total will automatically calculate the answers selected in the opportunity criteria 
section.   

• System Grade – Automatically calculates based on the total score and the answer 
requirements for the specified questions.   

• User Grade – The user grade is selected as deemed appropriate for each opportunity based 
upon user knowledge of the account and factors that may not be considered in the criteria 
questions. 
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• Commission – Enter the commission amount estimated for each opportunity added. 

• Contacts Information – Enter the contacts associated with this opportunity and assign their 
role in the buying process.  Click [Add New] to associate the client contacts with the 
opportunity. 

 
Note: The contact names must have already been added to the account at the client level. 
Roles on this screen differ from those on the client contact details screen. 

10. Click Save Changes to save the information you have entered on the screen. 

Related Topics 

Home Menu > Opportunities 

Customizing Opportunities for a Branch 

Marketing 

This screen serves as a way to keep track of policies identified with a policy mode of marketing. It is not 
necessary to create actions in order to track these policies as Nexsure keeps track of them for you. 
 Policies displaying on the marketing screen located on the home page include both new or renewal 
policies being re-marketed. After the policy has renewed or moved to history, it will no longer appear on 
the marketing screen.   

 
The search filter selections may be used to search and filter for specific submissions. The more fields 
data is entered into, the more specific the results will be.   

Screen Column definitions: 

• Branch: The branch will default according to user setup but other branches may be selected 
depending on user security.  The policies displayed will only be policies that belong to the selected 
branch or branches assigned to the logged in user by default.  To select a different branch, use the 
drop-down list. 

• Clicking the blue Details  icon beside the entity name will display the Client Profile screen.  
Right clicking on the Details  icon will display the following navigation options: 

• Open - Selecting Open will open the card file for that client. 
    

• Add new marketing policy - Select this option to add a new marketing policy.  This 
procedure is detailed in the Servicing > Marketing > New line of business topic.   

• The  Details icon will display the underwriting screen for that policy.  Right clicking on the  
icon will display the following navigation options: 
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• Open - Displays the Underwriting screen to add a new marketing application as described in 
the Policy Underwriting topic.   

• Print - Displays a PDF of the entire policy for printing. 
    

• Create policy edit - Displays the Servicing > Edits screen as explained in the Servicing > 
Edits topic.   

• Create endorsement - Displays the Servicing > Endorsements screen, as described in the 
Servicing > Endorsement topic.   

• Renew policy - Displays the policy underwriting screen. 
    

• Re-market policy - Displays the Servicing > re-marketing screen. 
    

• Create cancellation - Displays the Servicing > Cancellation screen.  
    

• Create claim - Displays the Servicing > Claims screen. 
    

• Create audit - Displays the Servicing > Audits screen as described in the Posting an Audit 
topic.   

• Create binder - Displays the Servicing > Binders screen as described in the Servicing > 
Binders topic.   

• Client Name: The clients name from the primary named insured on the Named Insureds screen.   

• Assign: Producer and account manager information.  Populated from the assignment screen. 

• Policy Type: Nexsure identifies policy types on the underwriting screen, which display here when 
a binder is created and the policy has not yet been In forced.  (Policy types are identified as either 
monoline or package policies.)   

• Line of Business: Line of business is identified by the user on the underwriting screen and 
displays here when the binder is created and the policy is not placed In Force. 

• Status: Both the user and Nexsure identify policy status on the underwriting screen.  The Status 
identifies if the policy is "In force, cancelled, an endorsement is pending, etc.”   

• Updated By: Displays the user who updated the binder last.  The user is identified at login. 

• Premium: Premium will be populated from the Premium field on the policy info screen.   

• Policy Term: Populated from the effective and expiration date fields on the underwriting screen.   

• Billing Carrier: This is the company who the agency owes money to or who will pay the agency 
for direct bill policies.  The user on the underwriting screen identifies the company.   

• Issuing Carrier: This is the company who actually writes the policy, the name on the top of the 
written policy.  The user on the underwriting screen identifies the company. 

Related Topics 

Policy Info Tab 

Assignments Tab 

Working With Forms 

Importing and Exporting to Policies 
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Editing the Policy 

Working with Schedules 

Populating Coverage and Premium Fields 

Creating a Package Policy and Add Supplemental Forms 

Coverage Templates 

Application templates can be created to save application population time. Templates can be created on 
any client account at the marketing/underwriting level. On state-specific forms, only templates for the 
same state as the target application may be used. 

To create a coverage template 

1. Add the desired line of business to marketing and complete the application. 

2. Click the  beside the line of business and the  beside the form number to activate the 
[Template] link. 

 
3. Click the [Template] link. 
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4. Select Add New and click Next. 

5. Enter a name to identify the template. Naming the template makes it easier to pick out of a list 
later. 

  

6. Click Next. 
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7. The sections listed are the same sections found in the tree on the navigation tab. Select the 
sections to be used to create the template and click Next. 

  

8. The drop-down box contains each section selected on the previous screen. Selecting the section 
displays the fields for each section.  
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9. Select the needed fields. When all sections have been completed, click Finish. 

10. Click OK to confirm the template. 

Using the Template 

To use a coverage template 

1. Add the line of business to marketing for the prospect or client.  

2. Click the plus beside the line of business and then beside the form number. 

 

3. Click the [Template] link. 

4. Select the option button beside the template to use. You must select a template for the Populate 
button to become available. 
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5. Click Populate. When populated, a message notifies you that the application was successfully 
populated from the template.  

6. Click Cancel to close the template screen. 

Creating a Package Policy and Adding Supplemental Forms 

Package policies are created by simply adding another line of business.   

  

To change a monoline policy to a package policy 

1. On the Primary menu, click SEARCH to search for the appropriate the client or prospect. 

2. Click on the Details  icon next to the client or prospect name to display the card file. 

3. On the Client menu, click MARKETING.  The marketing summary screen is displayed. 

4. Click the Details  icon next to the marketing policy to display the underwriting screen. 

5. In the navigation toolbar, click the Add Applications link and select another line of business.  If 
the application helper is not needed, click in the box beside the helper to remove the checkmark.   

6. Select Next to add the application.  Notice that the policy type now displays Package instead of 
monoline. 
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Supplemental Forms 

Sometimes forms require a Supplemental form as well. 

To add a supplement 

1. Click the Add Supplement link in the navigation toolbar and select the Line of business from the 
drop-down box. 

2. Select the supplement from the Available Supplements list.  When a supplement is highlighted in 
the list, a description of the supplement is displayed under the Available Supplements box. 

3. Click Next, the supplement will be added to the policy.  Notice that the supplement is now 
displayed under the selected line of business.   

Related Topics 

Underwriting 

Working with Forms 

Populating Coverage and Premium Fields 

Marketing a New Application 

To Market a new application 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon next to the appropriate client. 

3. On the Client menu, click the MARKETING option. 

4. Click the Details  icon next to the appropriate marketing policy. 

5. On the underwriting tab, below the policy header, click the [Add Application] link.  The New 
Application dialog displays. 
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6. Complete the following fields: 

Form Standard: Select the appropriate form type from the drop-down box. Sample choices: 

• All 

• ACORD 

• Carrier Specific 

State: Select the appropriate state the policy is being written in from the drop-down box containing 
all the states. Only the corresponding applications will be available for that state. 

Type: Select the line of business from the drop-down box which contains the following (This 
feature will filter the forms):  

• All 

• Personal 

• Commercial 

• Benefits 

• Bonds 

Line of Business: Select the application from the Line of Business drop-down box. The drop-
down box will only contain applicable choices according to criteria selected in the previous fields.  

The Application Helper: Is activated by selecting the check box beside Pre-fill applications to 
help reduce key strokes. The check box is selected by default.  
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Cancel: Closes the dialog box without saving.   

Next: To continue to the next step in the flow, adding a new blank form or copying an existing form 
to the new form. 

Note: If the Application Helper check box remains checked when the Next button is selected and 
a matching policy exists, the following is displayed: “Nexsure has determined that the following 
forms have possible matches to fully or partially pre-fill the current application you are completing.” 
Select the form Nexsure should use for this process and click Accept to copy the selected form to 
the new form. If no policies are found or the check box was not selected the Application Helper is 
skipped. 

The Application Helper screen will contain the form name under a drop-down box that will contain 
a listing of all possible application matches to copy to the new form being added. The company 
and policy number are included in the list. Select the application to be copied and click one of the 
following buttons: 

Cancel: To close without saving the changes 

Back: To return to the New Application window 

Accept: To copy the form to the new form 

  

Related Topics 

Working With Forms 

Importing and Exporting XML to Policies 

You can import XML data into Nexsure to easily transfer lists of data (such as schedules of autos or 
drivers) that would otherwise have to be entered manually.  This is most useful in transferring information 
from one Nexsure system to another.   

To import record data XML 

This procedure is done when filling out policy forms.  If the Import/Export option is available for a form 
item, it will appear in the upper right corner of the record summary dialog box.  For more information on 
filling out policy forms, see Working with Forms.   

1. From the record summary screen, click Import. 

2. Browse to the XML data file. 

3. Click the Import link. 
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4. Select the items to import and click the Import button: 

 
Note: If an error occurs during the import process, a notification will appear on the attachments 
window: 

 
To export record data XML 

1. From the record summary screen, click Export.  The XML Export Data dialog box appears. 

2. Right click on the plus or minus sign to the left of the XML and click Save Target As. 

3. Name the file and save it to a specified directory. 

4. Click Save. 

Related Topics: 

Policy Underwriting 
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Working With Forms 

  

Policy Underwriting 

1. After performing a client search and selecting a client, click on the marketing tab.  If no marketing 
policies exist, a dialog box will display explaining that no marketing policies exist and asking if you 
would like to see if any marketing history exists.  

2. Click OK to check for marketing history or click Cancel to add new marketing policy. 

3. Complete the heading information and click on the Save Changes link below the header. 

4. To add a new policy to marketing when other marketing policies exist, click on the servicing tab 
and follow directions under Servicing > Marketing. 

•  To view or modify existing marketing policies, click on the Details  icon.   

 
  

5. Complete each of the following fields appropriately for the marketing policy:  

6. Branch: The Branch is selected on the assignment screen and is displayed here automatically 
when a policy is added. 

7. Policy Type: Identified automatically on this screen using the following criteria:  

• If only one Line of Business is added, the policy type will be identified as Monoline.   

• If more than one Line of Business is added, the policy type will be identified as a 
Package.  

Note: adding supplements is not considered a Line of Business and will not change the 
policy type to Package.  

8. Issuing Company: Use the drop-down box that will contain all the companies added and identified 
as issuing companies. Unassigned may be used if an issuing company is not yet known.   

9. Billing Company: Use the drop-down box that will contain all the companies added and identified 
as billing companies.  Unassigned may be used if a billing company is not yet known.   

10. Policy Number: The policy number will default to Unassigned upon adding the policy since policy 
numbers are not generally assigned at the marketing stage.  
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11. Policy Term: The current date + 1 year is the default.  Effective and expiration times default to 
12:01 A.M.  Click the calendar icon   to select a different date and time: 
 

• The From date defaults to the 
effective date of the policy.  To 
select a different From date, select 
the month and year from the drop-
down boxes and click on the day in 
the calendar. 

• The To date defaults to the policy 
expiration date.  To select a different 
date, select the month and year from 
the drop-down boxes and click on 
the day in the calendar. 

• Select a Duration.  Notice the To 
date will change based on your 
selection. 

• Annual - one year from beginning 
date. 

• Semi-Annual - six months from 
beginning date. 

• Quarterly - three months from 
beginning date. 

• Once you have the proper dates 
entered, click Apply. 

• Other - Select this option for any 
policy that falls outside the default 
policy durations such as special 
event coverage. 

• Select the Other option. 

• Select the From date. 

• In the text boxes at the bottom 
of the calendar, enter in the 
number of days, months, or 
years for the coverage (i.e. two 
days). 

• Click the "!" button. 

• Click Apply. 
 
  

Time 

Click the time tab to change the time zone or 
effective time in hours and minutes. 
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12. The From date defaults to the current date (if it's a new policy) or to the effective date of an 
existing policy.  To select a different From date, select the month and year from the drop-down 
boxes and click on the day in the calendar. 

The To date defaults to one year past the current date (for a new policy) or the policy expiration 
date of an existing policy.  To select a different date, select the month and year from the drop-
down boxes and click on the day in the calendar. 

13. Select a Duration.  Notice the To date will change based on your selection. 

Annual - one year from beginning date. 

Semi-Annual - six months from beginning date. 

Quarterly - three months from beginning date. 

Once you have the proper dates entered, click Apply. 

Other - Select this option for any policy that falls outside the default policy durations such as 
special event coverage. 

14. Select the Other option. 

15. Select the From date. 

16. In the text boxes at the bottom of the calendar, enter in the number of days, months, or years for 
the coverage.  

17. Click the "!" button. 

18. Click Apply. 

19. Click OK. 

20. On the policy header, click the Save Changes link. 
  

Time 

1. Click the time tab to change the time zone or effective time in hours and minutes. 

 
   

2. Coverage Term: Once a policy is bound and a binder is created, the coverage term of the policy 
will change.  The coverage term effective and expiration dates will be the effective and expiration 
dates of the binder.  Once an endorsement is processed, the coverage term effective dated 
becomes the effective date of the last endorsement with the expiration date remaining the same as 
the policy.  If a policy is pending cancellation or canceled, the coverage term expiration date will be 
the cancellation effective date. Click the calendar icon  to select a different date and time. 
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3. Stage: Identifies the stage the policy is currently in. Nexsure defines Stage automatically, such as: 
marketing or policy stage.   

4. Mode: Populated from the policy mode on the Policy Summary screen. The Mode identifies what 
the policy is, such as New, Renewal, Rewritten, etc. 

5. Status: Both the user and Nexsure identify the policy status. The Status identifies if the policy is in 
force, canceled, an endorsement is pending, etc. 

6. In Force: Clicking this link will move the policy from Marketing to Policies making the policy a 
current In Force policy status. Applications should always be added prior to making a policy In 
Force. Once a policy is In Force, it cannot be edited without either endorsing or clicking Edit on the 
Servicing menu. 

7. Import: The import link will import the client’s data into the file from outside programs such as 
rating vendors.  

8. History: Click on this link to move the marketing policy to history when the marketing policy is no 
longer active or needed.   

9. Add Supplements: This link will add supplements necessary for a particular line of business. 

10. Add Applications: This link will allow the addition of the application.   
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11. Form Standard: Select the appropriate form type from the drop-down box. Sample choices: 

• All 

• ACORD 

• Carrier Specific 

12. State: Select the appropriate state the policy is being written in from the drop-down box containing 
all the states. Only the corresponding applications will be available for that state. 

13. Type: Select the line of business from the drop-down box which contains the following (This 
feature will filter the forms):  

• All 

• Personal 

• Commercial 

• Benefits 

• Bonds 

14. Line of Business: Select the application from the Line of Business drop-down box. The drop-
down box will only contain applicable choices according to criteria selected in the previous fields.  

15. The Application Helper: Activated by selecting the check box beside Pre-fill applications to 
help reduce key strokes.  The check box is selected by default.  

16. Cancel: Closes the dialog box without saving.   

17. Next: To continue to the next step in the flow, adding a new blank form or copying an existing form 
to the new form. 

Note: If The Application Helper check box remains checked when the Next button is selected 
and a matching policy exists, the following is displayed: “Nexsure has determined that the 
following forms have possible matches to fully or partially pre-fill the current application 
you are completing.” Select the form Nexsure should use for this process and click Accept to 
copy the selected form to the new form. If no policies are found or the check box was not selected 
The Application Helper is skipped. 

18. The Application Helper screen will contain the form name under a drop-down box that will contain 
a listing of all possible application matches to copy to the new form being added. The Company 
and policy number are included in the list. Select the application to be copied and click one of the 
following buttons: 

19. Cancel to close without saving the changes. 

20. Back to return to the New Application window. 

21. Accept to copy the form to the new form. 

Tip: Once the application has been added, you can access Help information on the selected form 
by clicking on the name of the form.  A PDF file will launch with information specific to each form: 
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Navigation: This tab found on the right side of the screen will contain all lines of business added 
for this policy in a tree format.  Base Requirements is the first item in the tree when a line of 
business is dependent on other forms such as the ACORD 125 that is required for most 
commercial applications.  The dependent form will automatically be added to the Base 
Requirements.  To complete the application, click on the [+] beside the application to expand the 
tree view of the various applications. The application is broken down into sections and any section 
can be selected for completion. The navigation bar can be used within the sections as well 
[Summary, Add New Record, Previous and Next].  For more information see Working With Forms.   

1. The navigation bar has the following options available:  

• List – This link will allow a screen display of every field on the application and the data 
entered.   

• Print – This link will allow a print preview of the application in Adobe. The form will 
display Adobe functionality so the form may be printed if desired.   

Tip: Right-clicking on the Print link will display the following short cuts: Print App, 
Endorse, Renew, Re-market, Cancel, Claim, Audit, eServices and Certificate. 

• History – Click this link when you are completely through with the marketing policy, 
which will move the policy to history. Select a status from the drop-down box and enter 
any applicable notes. The status choices are not available for additions or edits.   

• In Force – Is only used on New business. If the policy already exists in the current policy 
list, use the Renew option on the servicing page. Once a policy has been placed in force 
it can only be edited by creating an Edit or Endorsement from Servicing. In the pop-up 
window, the following choices may be made:  

• In force – This selection is made when policies are being entered into Nexsure from 
your present data if you did not receive a data conversion.  

• Bound – This selection is made when the policy has been bound and the status 
should reflect this.  

• Create Binder – This selection is made when issuance of a binder is necessary. 
Creating a binder will create an entry on the Binder Log found on the Home menu. 

The instruction tab located next to the navigation tab contains instructions or tips 
that may help complete the current screen.   

• To add supplemental forms, click on [Add Supplements], select the line of business 
application and then select the appropriate supplement.  See Creating a Package Policy 
and Add Supplemental Forms. 

Related Topics 

Policy Info Tab 

Assignments Tab 

Working With Forms 

Importing and Exporting to Policies 

Editing the Policy 
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Working with Schedules 

Populating Coverage and Premium Fields 

Creating a Package Policy and Add Supplemental Forms 

Populating Coverage and Premium Fields on a Form 

To Populate Coverage and Premium Fields on Forms: 

1. On the Primary menu, click SEARCH. 

2. Enter at least two characters in the name field and click Search. 

3. Click the Details  icon next to the client or prospect name to display the card file.  

4. On the Client menu, click MARKETING. The marketing summary screen is displayed.  

5. Click the Details  icon next to the marketing policy to display the underwriting screen. 

6. To populate a premium field on the Commercial ACORD General Liability application, from the 
Navigation tab on the right, click on the "+" beside General Liability and the "+" beside the 
ACORD form, and then on the Billing link. 

7. Enter the premium amount without commas. 

Note: The field is formatted automatically after moving to the next field to provide formatting for 
dollars and cents while limits are formatted for whole numbers. 

8. To enter a coverage limit, click on Coverage/limits. 

9. From the navigation tab, click Limits.  

10. Enter the limit without formatting; the field automatically formats after moving to the next field. Text 
may also be entered into these type fields as necessary. For example entering the word “included” 
in the “Products and Completed Operations Aggregate Limit:” field is accepted after moving to the 
next field. 

Related Topics 

Working With Forms 

Remarketing a Policy 

Policies may be remarketed at any time, although prior to renewal is standard.  Remarketing a policy at 
renewal allows the Agency the flexibility of obtaining various quotes from carriers for their clients. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 
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3. On the Client menu, click SERVICING. 

 

4. Select Marketing > Existing line of business and click [Next].   

5. Select the policy to remarket. To search for specific policies, including policies previously sent to 
history, click [Show] to view the search filter screen.  If multiple policies are being selected, the 
policies will be grouped as if they are a package policy.  This feature allows applications to be 
bundled so they can all be sent to the carrier at one time.  The policy mode always reflects New.  If 
a marketing version of the policy is selected as the renewal the in force mode will reflect Renew. 

• In the Include History drop-down list, select Yes. 

 
  

Note: Use Servicing > Renew when issuing the re-marketed policy in order to display the correct 
mode.  (See “Placing a Remarketed Renewal in force” section of help for assistance). 

6. Select the lines of business that will make up the renewal policy and click [Next]. 

Note: When a policy is selected the system automatically copies the existing applications so the 
user will not need to re-key application information. 
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7. The marketing underwriting screen is displayed.  Select the Issuing and Billing Carrier, edit the 
policy term dates if needed and click the Save Changes link in the navigation toolbar under the 
header.  Review the application for accuracy and make any necessary modifications.  (See the 
Working with Forms section of help for assistance in navigating the forms). 

8. To remarket to another carrier repeat steps 1-7.  This process is necessary to capture statistical 
data and separate application information for each carrier.  

Tip: Use the Home > Marketing page to compare quotes or to determine if each carrier’s quote 
has been received. 

Sending a Marketing Policy to History 

Agencies may define reasons (setup in Actions) for marketing policies sent to history.  

To send a marketing policy to history 

1. On the Home > Client menu, click MARKETING. 

2. Select the marketing policy to send to history by clicking the Details  icon. 

 

3. Click the History link. 

 
• Status - Select the status from the drop-down list. 

• Reason - Select the reason from the drop-down list. Reasons are agency-defined and can be 
setup in Actions (see "To define reasons" below). 

• Notes - Enter a detailed description for the marketing submission. 
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4. Click Save. The policy will be available to view on the history tab. Note that the policy header is 
gray denoting that it is in history. 

 
  

To define reasons 

1. On the Utility menu, click SETUP. The actions setup appears by default. Before adding a new 
action type, search to see if the action already exists to avoid duplicates. 

2. Select the types tab and click Add New. 

 

3. Enter a reason in the Type field and click Save. 

4. Select the actions tab and click Add New. 
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5. In the Topic drop-down, select Marketing. 

6. In the Type drop-down, select the reason which was just created. 

7. Click Finish. 

  

Related Topics 

Sending an Expired Policy to History 

  

Working With Forms 

Nexsure works with standard insurance forms such as ACORD forms, allowing you to populate the fields 
through the Nexsure interface.   

Populating form fields is done on the Underwriting screen.  When the form has been completed you can 
view the form in Adobe® Acrobat® and then send the form to a printer for hard copy and/or save the 
Adobe® PDF file.   
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Using Nexsure to complete a form 

1. Once you have added the application, the form you chose will appear in the navigation panel under 
Underwriting. 

2. Selecting the form, in this example ACORD 125, will display a list of fields to be completed for the 
form. 

3. Select an item in the navigation panel, and the form fields will appear to the left. See example 
below: 
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Tip: When adding multiple records, such as drivers or accidents to a policy, you must select the 
item in the navigation panel each time you enter the record. For example, after adding a driver to a 
personal auto policy, Nexsure will advance to the next item on the form - Accidents Violations. To 
add another driver to the policy, you must select drivers in the Navigation panel again. Note that 
the name of each specific record being worked on is at the top of the fields labeled "Current 
Record": 

 

4. After completing each screen, click Next or click Prev to go back to the previous page.  Or you can 
skip to any section of the form by clicking on an item in the navigation panel. 

5. When all screens are completed, click Save Changes. 

Record Summaries 

In instances where there are multiple records to a single policy, such as multiple drivers, you can manage 
those records on the Summary screen. 

The Summary screen allows you to Sort your records by First, Middle or Last Name, Relationship to 
Applicant or Date of Birth.   

  

To Sort Records 

1. On the Summary screen, click Sort. 

2. Choose the item to sort by and select Ascending or Descending from the drop-down list.   

3. Click Sort. The items will be sorted accordingly in the summary. 

To Search Records 

You can also search your records by First, Middle or Last Name, Relationship to Applicant or Date of 
Birth. 

1. On the Summary screen, click Search. 

2. Choose the item to search by and enter the search criteria. 

3. Click Search. Any items found will appear in the summary.  

Working with Schedules 

To add scheduled items to a form 

1. On the Primary menu, click SEARCH. 
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2. Search for the client or prospect. 

3. Click the Details  icon next to the client or prospect name to display the card file.  

4. On the Client menu, click MARKETING.  The marketing summary screen is displayed. 

5. Click the Details  icon next to the marketing policy to display the underwriting screen. 

6. To populate the Vehicle schedule on the Commercial ACORD auto application from the 
navigation tab, click on the "+" beside Commercial Auto and the "+" beside the ACORD form, 
and then on the Vehicles link. 

7. Click the Add Record link on the navigation toolbar to add a vehicle. 

8. Enter all the vehicle information navigating through all the vehicle screens.   

9. Selecting Summary on the navigation toolbar saves the current screen and displays to the vehicle 
summary. 

10. To add more vehicles, continue by selecting the Add Record link from the navigation toolbar.  

Renumbering Schedules 

When the policy is in a pliable state (marketing, pending endorsement, edit of future policy) renumbering 
can be performed within the schedule itself. Items which can be renumbered include: vehicles, drivers, 
locations and additional interests. 

To renumber a schedule 

1. Select the client. 

2. On the Client menu, click POLICIES. 

3. Select the policy with the schedule by clicking the Details  icon. 

4. In the navigation panel, select the Vehicles (in this example) section of the form to display the 
schedule. 
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5. Click the Renumber link. 

 

6. Select the records in the schedule and click the up or down arrows on the right of the dialog box to 
change the order of the items.  When the records are in the correct order, click Renumber. 

Entering a Fleet 

Some commercial businesses will purchase a fleet of the same type vehicle.  In order to save time, enter 
one vehicle and use the Copy tool to add the remaining fleet. 

1. Click the Vehicles link on the Navigation tab to display the vehicle summary. 

2. Click the Details  icon beside the auto. 

3. On the Navigation toolbar, select the Copy link to display the Copy Record screen. 

4. Enter in the number of vehicles remaining in the fleet. 
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5. Select Copy to add the specified number of vehicles to the schedule.  The vehicles have been 
added to the schedule. 

6. To edit the VIN number of each vehicle, click on the Details  icon beside the vehicle and edit 
the VIN number. 

7. Click the Summary link in the Navigation toolbar to save the change and display the summary.  

8. Repeat the process until all vehicles have been updated. 

Related Topics 

Working with Forms 

Binder Log 

Any policies with an open binder will display on the binder log.  When the policy is placed in force or the 
binder is closed, the policy is removed from the log. 

 
Screen Column definitions: 

• Branch: The default branch will be displayed according to user setup but other branches may be 
selected depending on user security.  Only the policies associated with the selected branch and 
the logged in user will be displayed.  To select a different branch, use the drop-down list to select 
the appropriate branch.   

• View: Agency Issued Binders - Displays policies with open binders issued against them. 
Bound/Future - No Open Binder  Displays policies with a status of Bound or Future that do not 
have open agency issued binders against them. The latter view can also be thought of as the 
carrier issued binders view. The binder log view may be managed using the coverage term 
effective and expiration dates (which are the binder effective and expiration dates) with the ability 
to extend the binder dates when the carrier does by changing the coverage term dates with the 
active calendar icon in the policy header. (See Extending a Binder) Once the policy is received, 
follow the normal work-flow to place the policy in force - which would indicate that the carrier binder 
is closed and thus removing the policy from the Home > Binder Log. 

Note: To set a particular view as the default view, click the [Show] link to open the Search and 
Sort Filters screen and select the Save Filter Settings check box. 

• Clicking the Details  icon beside the entity name will display the client profile screen.  Right 
clicking on the  icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New Line of Business topic.   
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• Add certificate - Selecting this option will display the add new certificate screen as described 
in the Servicing > Creating New Certificates topic.   

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic.   

• Add new opportunity - Selecting this option will display the Home > Opportunities screen 
as described in the Adding a New Opportunity topic.   

• Clicking the Details  icon will display the Binder Details screen for that policy.  Right clicking on 
the Details  icon will display the following navigation options: 

• Open - Displays the Underwriting screen to add a new marketing application as described in 
the Policy Underwriting topic.   

• Print - Displays a PDF of the entire policy for printing. 

• Create policy edit - Displays the Servicing > Edits screen as explained in the Servicing > 
Edits topic.   

• Create endorsement - Displays the Servicing > Endorsements screen, as described in the 
Servicing > Endorsement topic.   

• Renew policy - Displays the policy underwriting screen. 

• Re-market policy - Displays the Servicing > re-marketing screen. 

• Create cancellation - Displays the Servicing > Cancellation screen. 

• Create claim - Displays the Servicing > Claims screen. 

• Create audit - Displays the Servicing > Audits screen as described in the Posting an Audit 
topic.   

• Assign: Producer and account manager information.  Populated from the assignment screen. 

• Client Name: The clients name from the primary named insured on the named insureds screen.  

• Policy Number: Nexsure identifies Policy types on the underwriting screen, which display here 
when a Binder is created and the policy is not placed In force.   

• Policy Type /Line of Business: Policy types are identified as either Monoline or Package policies. 
Line of Business is identified by the user on the underwriting screen and displays here when the 
binder is created and the policy is not placed In Force. 

• Status: Both the user and Nexsure identify Policy Status on the underwriting screen.  The Status 
identifies if the policy is "In force, canceled, an endorsement is pending, etc.”  

• Updated By: Displays the user who updated the binder last.  The user is identified at login. 

• Annualized $/Billed Premium: Premium amounts are populated from the policy info screen.  The 
bill type (agency or direct) will be displayed to the right of the premium as an A or D respectively. 

• Coverage Eff Date/Coverage Exp. Date:  Populated from the effective and expiration date fields 
on the underwriting screen.  

• Billing Carrier: This is the company who the agency owes money to or who will pay the agency 
for direct bill policies.  The user on the underwriting screen identifies the company. 

• Issuing Carrier: This is the company who actually writes the policy, the name on the top of the 
written policy.  The user on the underwriting screen identifies the company.   
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Related Topics 

Creating a binder 

Extending a binder 

Putting a Bound Policy In Force 

Binder Extension Default 

When you click the Extend icon on the binder details screen, the binder is automatically extended by 90 
days.   

To change the default extension 

1. On the Utility menu, click SETUP. 

2. In the Setup Console, click lookup management. 

 

3. In the Category drop-down list, select Policy. 

4. In the Types box, select Binder Term. 

5. In the Description field, enter the number of days you want the binder to automatically extend to 
(you don't need to type the word 'days'). 

6. Click [Update]. 

  

Related Topics 

Binder Log 

Creating a Binder 

Extending a Binder 

Putting a Bound Policy In Force 
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Creating a Binder 

Once you have completed a marketing application, you can In Force a policy or create a binder.  Binders 
can also be added to existing policies from the Servicing screen. 

To create a binder 

1. Complete the marketing policy. 

2. Click Save Changes. 

3. Click In force. 

 

4. Select Bound, and select  Click here to create binder. 

5. Click Save.  The binder details will be displayed. 

 
Note: The binder also appears on the right in a tree view. Click the [Close] link to close the 
binder. If a binder is closed, an [Open] link will be displayed. Click [Open] to reopen the binder. 

• Now you can Print, Deliver or Abort the binder. 
• Print - Click Print, if there are multiple binders, you will be prompted to select the binder(s) 

you wish to print.  The binder will open as an Adobe® Acrobat® file in Nexsure.  Click the Print 
 icon to send the binder to a printer. 

  

Related Topics 

Binder Log 
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Extending a Binder 

Putting a Bound Policy In Force 

Delivering a Binder 

Once you have created a binder you can deliver it via fax or email. 
  

To deliver a binder 

1. From the Client menu, click POLICIES. 

2. Select the binders tab. 

3. Click the Details  icon for the binder you wish to deliver. 

4. Click the delivery tab.  If there is no pending delivery you will be prompted to "Click here to add 
new". 

5. Select the transport method of your delivery, the email or fax tab. 

6. Enter the delivery information on the left. 

7. On the right, in the binders group, click [Add New]. 

 

8. Select the binder(s) to deliver and click Attach. 

9. The attachment will appear on the delivery tab, click [Send]. 
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Related Topics 

Binder Log 

Creating a Binder 

Extending a Binder 

Putting a Bound Policy In Force 

  

Extending a Binder 

Expired binders will appear on the Home > Binder Log screen.  Notice that the date in the Coverage 
Term column is red denoting that the binder has expired. 



Nexsure User's Guide    Utility Menu 

XDimensional Technologies, Inc.   47

 
  

1. Click the Details  icon for the binder you want to extend. If the status of the policy has not been 
changed to Expired, you will be prompted to change. The binder details screen appears. 

 

2. Click the Extend  icon.  The Nexsure default is 30 days.  You can change the default in Setup. 

  

Related Topics 

Binder Log 

Creating a Binder 

Putting a Bound Policy In Force 

Putting a Bound Policy In Force 

To Change a Bound Status to In Force 

1. Select the client with the open binder. 

2. From the Home menu, click BINDER LOG. 

3. Click the Details  icon beside the binder. The binders/details screen appears. 
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4. On the right side of the binder details screen click [Close].  

5. Click the Save Changes link. The policy is now In Force. 

Note: A bound policy may also be placed in force by selecting the policy from the Policy Summary 
screen and selecting In Force. Once a policy is In Force it can only be edited from the Servicing 
screen. 

  

  

Related Topics 

Editing an In Force Policy 

Binder Log 

Creating a Binder 

Extending a Binder 

Edits 

Any client with a pending edit to their policy will display on the Home > Edits screen until the edit is 
closed.  For information on editing a policy see Servicing > Edits. 

 
Screen Column definitions: 

• The default Branch will be displayed according to user setup, but other branches may be selected 
depending on user security.  Only the policies associated with the selected branch and the logged 
in user will be displayed.  To select a different branch, use the drop-down list to select the 
appropriate branch.  
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• Clicking the blue Details   screen. Client profile icon beside the entity name will display the 
Right clicking on the  icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New Line of Business topic.   

• Add certificate - Selecting this option will display the add new certificate screen as described 
in the Servicing > Creating New Certificates topic.   

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic.   

• Add new opportunity - Selecting this option will display the Home > Opportunities screen 
as described in the Adding a New Opportunity topic.   

• Clicking the white Details  icon will display the underwriting screen for that policy.  Right 
clicking on the  icon will display the following navigation options: 

• Open - Displays the underwriting screen to add a new marketing application as described in 
the Policy Underwriting topic.   

• Print - Displays a PDF of the entire policy for printing.   

• Post edit - Selecting this option will display the underwriting screen.  You can then post or 
abort the edit by clicking the Post or Abort Edit links.   

• Abort edit - Selecting this option will display the underwriting screen.  You will be prompted to 
confirm the Abort command.   

• Client Name: The clients name from the primary named insured on the named insureds screen.   

• Assign: Producer and account manager information.  Populated from the assignment screen. 

• Policy Type: Nexsure identifies policy types on the underwriting screen, which display here when 
an edit is not posted. (Policy types are identified as either Monoline or Package policies.) 

• Line of Business: Line of business is identified by the user on the underwriting screen and 
displays here when the edit is pending.  

• Status: Both the user and Nexsure identify Policy Status on the underwriting screen. The status 
identifies if the policy is “In force, canceled, an endorsement is pending, etc.” 

• Updated By: Displays the user who updated the binder last.  The user is identified at login. 

• Annualized $/Billed Premium: Premium amounts are populated from the policy info screen.  The 
bill type (agency or direct) will be displayed to the right of the premium as an A or D respectively. 

• Policy Term: Populated from the effective and expiration date fields on the underwriting screen.  

• Billing Carrier: This is the company who the agency owes money to or who will pay the agency 
for direct bill policies. The user on the underwriting screen identifies the company. 

• Issuing Carrier: This is the company who actually writes the policy, the name on the top of the 
written policy. The user on the underwriting screen identifies the company. 

Audits 

Any existing audits will appear on the Home > Audits menu.  For information on posting a new audit, see 
Posting an Audit.  
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• The default Branch will be displayed according to user setup but other branches may be selected 

depending on user security.  Only the policies associated with the selected branch and the logged 
in user will be displayed.  To select a different branch, use the drop-down list to select the 
appropriate branch.   

• Clicking the blue Details   screen. Client profile icon beside the entity name will display the 
Right clicking on the  icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen 
for a new policy as described in the Servicing > Marketing > New Line of Business 
topic.   

• Add certificate - Selecting this option will display the add new certificate screen as 
described in the Servicing > Creating New Certificates topic.   

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic.   

• Add new opportunity - Selecting this option will display the Home > Opportunities 
screen as described in the Adding a New Opportunity topic.   

• Clicking the white Details  icon will display the underwriting screen for that policy.  Right 
clicking on the Details  icon will display the following navigation options: 

• Open - Displays the Underwriting screen to add a new marketing application as described 
in the Policy Underwriting topic.   

• Print - Displays a PDF of the entire policy for printing. 

• Post audit - Selecting this option will display the underwriting screen.  You can then Post 
or Abort the audit by clicking the Post or Abort Audit links.   

• Abort audit - Selecting this option will display the underwriting screen.  You will be 
prompted to confirm the Abort command.   

• Assign: Producer and account manager information.  Populated from the assignment screen. 
  

• Client Name: The clients name from the primary named insured on the named insureds 
screen.   

• Policy Type: Nexsure identifies policy types on the underwriting screen, which display here 
when a binder is created and the policy is not placed In force.  (Policy types are identified as 
either Monoline or Package policies.)   

• Line of Business: Line of business is identified by the user on the underwriting screen and 
displays here when the binder is created and the policy is not placed In force. 

• Status: Both the user and Nexsure identify Policy Status on the underwriting screen.  The 
Status identifies if the policy is "In force, canceled, an endorsement is pending, etc.”  

• Updated By: Displays the user who updated the binder last.  The user is identified at login.   
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• Annualized $/Billed Premium: Premium amounts are populated from the policy info screen. 
 The bill type (agency or direct) will be displayed to the right of the premium as an A or D 
respectively. 

• Policy Term: Populated from the effective and expiration date fields on the underwriting 
screen.  

• Billing Carrier: This is the company who the agency owes money to or who will pay the 
agency for direct bill policies.  The user on the underwriting screen identifies the company. 

• Issuing Carrier: This is the company who actually writes the policy, the name on the top of 
the written policy.  The user on the underwriting screen identifies the company.   

  

Related Topics 

Posting an Audit 

Expirations 

Any policies that are nearing their expiration date will display on the expirations screen.  Once the policy 
has been renewed, Nexsure removes the policy from the expirations screen automatically.  For 
information on renewing expired policies, see Servicing > Renewals. 

A policy is expired when the expiration date is past the current date.  When a policy expires in Nexsure, 
the expiration date is displayed with a red font and a red Details  icon. The status of an expired policy 
is changed to Expired when the red Details  icon is clicked and the OK button is selected in the 
Expired status pop-up window. 

The Search Filter selections may be used to search and filter for specific expirations. The more fields 
data is entered into, the more specific the results will be. If a particular sort is desired, select a sort order 
from the Sort drop-down box prior to initiating the search.   

 
Use the navigation buttons (Showing Page 1 of ...) to display the different screens. 

Screen Column definitions: 

• The default Branch will be displayed according to user setup but other branches may be selected 
depending on user security.  Only the policies associated with the selected branch and the logged 
in user will be displayed.  To select a different branch, use the drop-down list to select the 
appropriate branch.   

• Select a different branch by clicking on the arrow of the drop-down box and clicking the appropriate 
branch.   

•  Export: Click [Export] to generate an Microsoft Excel® spreadsheet from the expirations 
being displayed on the screen. Exporting to Excel can help to manage large amounts of records 
that can be returned on the Home screen by using Excel's search, sort and print capabilities. 
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• Clicking the blue Details   icon beside the entity name will display the client profile screen. 
Right clicking on the Details  icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New Line of Business topic. 

• Add certificate - Selecting this option will display the add new certificate screen as described 
in the Servicing > Creating New Certificates topic. 

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic. 

• Add new opportunity - Selecting this option will display the Home > Opportunities screen as 
described in the Adding a New Opportunity topic. 

• Clicking the white Details  icon will display the Underwriting screen for that policy.  Right 
clicking on the Details  icon will display the following navigation options: 

• Open - Displays claims details screen. 

• Print - Displays a PDF of the entire policy for printing. 

• Push to history - Selecting this option will send the expired policy to history.  Select Lapsed, 
Renewed, or Non-Renewed from the Status drop-down list.  You can add a description in the 
Action Memo field, then click Save.  The policy is sent to the policies > history tab. 

• Assign: Producer and account manager information.  Populated from the assignment screen. 

• Client Name: The clients name from the primary named insured on the named insureds screen 
displays once regardless of the number of expiring policies. 

• Policy Type: Nexsure identifies Policy types on the underwriting screen, which display here 
when the expiration date approaches. (Policy types are identified as either Monoline and Package 
policies.) 

• Line of Business: Line of business comes from the underwriting screen and displays here when 
a policy nears its expiration date. Adding multiple lines of businesses to one policy will create a 
policy type of Package.  Only the policy type displays on the Home > Marketing screen when the 
Policy Type is Package. 

• Status: Nexsure identifies the Policy Status on the underwriting screen.  The Status identifies if 
the policy is In force, canceled, an edit is pending, etc.  

• Mode: Identifies whether the policy is a New, Renewal, or Renew Co. Renewal Co is a renewal to 
the agency with a new carrier.   

• Updated By: Displays the date and user who updated the policy last.  The user is identified at 
login. 

• Annualized $/Billed Premium: Premium amounts are populated from the policy info screen.  The 
bill type (agency or direct) will be displayed to the right of the premium as an A or D respectively. 

• Policy Term: Populated from the effective and expiration date fields on the underwriting screen. 
 The expiration dates are color-coded to show the proximity to the expiration date: 

• Red – Expired.  

• Orange - Expires in 30 days or less. 

• Green - Expires in 90 days or less (at 30 days color changes to orange). 

• Black - Policy is greater than 90 days from expiration. 
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• Billing Carrier: This is identified as who payments are sent to or received from by the branch. The 
user on the underwriting screen identifies this field. 

• Issuing Carrier: This is identified as the carrier who actually issues the policy, the name on the top 
of the written policy.  The user on the underwriting screen identifies this field. 

   

Endorsements 

Any policies awaiting endorsements will appear on the Home > Endorsements screen.  Once a policy 
has been endorsed it will be removed from this screen automatically.  For information on making an 
endorsement, see Servicing > Endorsements. 

 
Screen Column definitions: 

• The default Branch will be displayed according to user setup but other branches may be selected 
depending on user security.  Only the policies associated with the selected branch and the logged 
in user will be displayed.  To select a different branch, use the drop-down list to select the 
appropriate branch.   

• Select a different branch by clicking on the arrow of the drop-down box and clicking the appropriate 
branch.   

• Clicking the blue Details  icon beside the entity name will display the client profile screen. 
Right clicking on the  icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New line of business topic. 

• Add certificate - Selecting this option will display the Add New Certificate screen as 
described in the Servicing > Creating New Certificates topic. 

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic. 

• Add new opportunity - Selecting this option will display the Home > Opportunities screen 
as described in the Adding a New Opportunity topic. 

• Clicking the white Details   icon will display the underwriting screen for that policy.  Right 
clicking on the Details  icon will display the following navigation options: 

• Open - Displays the audits details screen. 

• Print - Displays a PDF of the entire policy for printing. 

• Post endorsement - Selecting this option will display the underwriting screen.  Before the 
endorsement is posted, enter a description in the Action Memo field and click Save. 

• Abort endorsement - Selecting this option will display the underwriting screen.  You will be 
prompted to confirm the Abort command. 
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• Add binder - Displays the Servicing > Binders screen as described in the Servicing > 
Binders topic. 

• Assign: Producer and account manager information.  Populated from the assignment screen. 

• Client Name: The clients name from the primary named insured on the named insureds screen 
displays once regardless of the number of expiring policies.  

• Policy Type: Nexsure identifies policy types on the underwriting screen, which display here when 
the expiration date approaches. (Policy types are identified as either Monoline and Package 
policies.) 

• Line of Business: Line of business comes from the underwriting screen and displays here when 
a policy nears its expiration date. Adding multiple lines of businesses to one policy will create a 
policy type of Package.  Only the policy type displays on the Home > Marketing screen when the 
Policy Type is Package. 

• Status: Nexsure identifies the Policy Status on the underwriting screen.  The Status identifies if 
the policy is In force, cancelled, an edit is pending, etc.  

• Updated By: Displays the user who updated the policy last.  The user is identified at login. 

• Annualized $/Billed Premium: Premium amounts are populated from the policy info screen.  The 
bill type (agency or direct) will be displayed to the right of the premium as an A or D respectively. 

• Coverage Eff Date/Coverage Exp. Date  Populated from the effective and expiration date fields 
on the underwriting screen.  

• Billing Carrier: This is identified as who payments are sent to or received from by the branch. The 
user on the underwriting screen identifies this field. 

• Issuing Carrier: This is identified as the carrier who actually issues the policy, the name on the top 
of the written policy.  The user on the underwriting screen identifies this field. 

  

Related Topics 

Creating an endorsement 

Claims 

Open claims will display on the Home menu until the claim is closed. For information on generating a new 
claim, see Servicing > Claims. 

 
Screen Column definitions: 

• The default Branch will be displayed according to user setup but other branches may be selected 
depending on user security.  Only the policies associated with the selected branch and the logged 
in user will be displayed. To select a different branch, use the drop-down list to select the 
appropriate branch.   
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•  Export: Click [Export] to generate an Microsoft Excel® spreadsheet from the claims being 
displayed on the screen. Exporting to Excel can help to manage large amounts of records that can 
be returned on the Home screen by using Excel's search, sort and print capabilities. 

• Clicking the blue Details  icon beside the entity name will display the client profile screen. 
Right clicking on the Details   icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New line of business topic.   

• Add certificate - Selecting this option will display the Add New Certificate screen as 
described in the Servicing > Creating New Certificates topic.   

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic.   

• Add new opportunity - Selecting this option will display the Home > Opportunities screen 
as described in the Adding a New Opportunity topic.   

• Clicking the white Details  icon will display the underwriting screen for that policy.  Right 
clicking on the Details   icon will display the following navigation options: 

• Open - Displays claims details screen.   

• Print - Displays a PDF of the entire policy for printing.   

• Display claim 
 
Selecting this option displays the claim information on the client > claims tab. 

• Post claim - Selecting this option will display the underwriting screen.  You can then post or 
abort the claim by clicking the Post or Abort Claim links.   

• Abort claim - Selecting this option will display the underwriting screen.  You will be prompted 
to confirm the Abort command.   

• Assign: Producer and account manager information.  Populated from the assignment screen. 

• Client Name: The clients name from the primary named insured on the named insureds screen.  

• Line of Business: Line of business is identified by the user on the underwriting screen and 
displays here when the claim is created. 

• Date of Loss: Identifies the day the loss occurred. 

• Claim Status: Is reflects as either Open or Closed, which is assigned on the policy info screen 
under the claim detail.  

• Mode: Identifies whether the policy is a New, Renewal, or Renew Co. Renew Co is a renewal to 
the agency with a new carrier  .   

• Taken By: Displays the user who entered the claim information. The user is identified at login. 

• Updated By: Displays the user who last updated the claim information. The user is identified at 
login. 

• Paid Amount: Is the amount paid out for the claim.  This amount is entered on the policy info 
screen under the claim detail. 

• Res. Amount: Is the reserve amount for the claim.  This amount is entered on the policy info 
screen under the claim detail.   
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• Policy Term: Populated from the effective and expiration date fields on the underwriting screen.  

• Issuing Carrier: This is the company who actually writes the policy, the name on the top of the 
written policy. The user on the underwriting screen identifies the company. 

• Adjuster: The adjuster name is entered on the Policy Info screen under the claim detail.   

Cancellations 

Any policy with a Pending Cancellation status will display on the cancellations screen.  The search and 
filter screen may be used to search for specific pending or previously canceled policies.  To post or 
reinstate a cancellation, see Servicing > Cancellations. 

 
Screen column definitions: 

• The default Branch will be displayed according to user setup but other branches may be selected 
depending on user security.  Only the policies associated with the selected branch and the logged 
in user will be displayed.  To select a different branch, use the drop-down list to select the 
appropriate branch.   

• Clicking the blue Details   icon beside the entity name will display the client profile screen. 
 Right clicking on the Details  icon will display the following navigation options: 

• Market new line of business - Selecting this option will display the underwriting screen for a 
new policy as described in the Servicing > Marketing > New line of business topic. 

• Add certificate - Selecting this option will display the Add New Certificate screen as 
described in the Servicing > Creating New Certificates topic. 

• Add verification - Selecting this option will display the Servicing > Verification screen as 
described in the Servicing > Verification topic. 

• Add new opportunity - Selecting this option will display the Home > Opportunities screen 
as described in the Adding a New Opportunity topic. 

• Clicking the white Details   icon will display the underwriting screen for that policy.  Right 
clicking on the Details  icon will display the following navigation options: 

• Open - Displays claims details screen. 

• Print - Displays a PDF of the entire policy for printing. 

• Push to history - Selecting this option will send the canceled policy to history.  Select 
Canceled by Agent, Carrier, or Insured from the Status drop-down list.  You can add a 
description in the Action Memo field, then click Save.  The policy is sent to the policies > 
history tab. 

• Assign: Producer and account manager information.  Populated from the assignment screen. 
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• Client Name/Policy Number: The policy number and the clients name from the primary named 
insured on the named insureds screen displays once regardless of the number of expiring 
policies. 

• Policy Type: Nexsure identifies policy types on the underwriting screen, which display here when 
the expiration date approaches.  (Policy types are identified as either Monoline and Package 
policies.) 

• Line of Business: Line of business comes from the underwriting screen and displays here when 
a policy nears its expiration date.  Adding multiple lines of businesses to one policy will create a 
policy type of Package. Only the policy type displays on the Home > Marketing screen when the 
Policy Type is Package. 

• Status: Nexsure identifies the Policy Status on the underwriting screen.  The Status identifies if 
the policy is In force, cancelled, an edit is pending, etc.  

• Updated By/Last Updated: Displays the date and user who updated the policy last . The user is 
identified at login.   

• Annualized $/Billed Premium: Premium amounts are populated from the policy info screen.  The 
bill type (agency or direct) will be displayed to the right of the premium as an A or D respectively. 

• Coverage Eff Date/Coverage Exp. Date  Populated from the effective and expiration date fields 
on the underwriting screen.  

• Billing Carrier: This is identified as who payments are sent to or received from by the branch. The 
user on the underwriting screen identifies this field. 

• Issuing Carrier: This is identified as the carrier who actually issues the policy, the name on the top 
of the written policy. The user on the underwriting screen identifies this field. 

Multiple Claim Payments 

To add multiple claim payments 

1. Search for and select the client. 

2. On the Client menu, click Claims. The underwriting tab will appear. 

3. Click the claims tab. 

4. Select the policy by clicking the Details  icon. 

5. Click the claim payments tab. 

6. Click Add New Payment. 
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• Payment type: Select from drop-down list. These items can be added through lookup 

management. 

 
7. On the Utility menu, click Setup. 

8. In the Setup Console, click Lookup Management. 

9. In the Category drop-down box, select Policy. 

10. In the Types box, select Claim Payment Types. 

11. In the Select Item box, select the Add New item. 

12. Enter a name in the description field and click the [Add New] link. 

 
• Draft date: defaults to Date of Loss.  

• Draft#: Enter the check number. 

• Payment amount: Enter the amount being paid on this payment. 

• Payee: The entity receiving the payment on behalf of the claimant. 

• Description: Optional. 
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• Claimant: Enter the name of the claimant. 

• Reduce reserves? When selected, the Reserved Amount on the claim details screen will be 
reduced by the payment amount entered. 

13. Click Save. 

  

Related Topics 

Claims > Home Menu 

Servicing Claims 

  

Interface 

The Interface screen displays a record of all carrier downloads with a Pending status.  Pending 
downloads are displayed in blue, completed transactions display in black.  To search for specific 
downloads, use the search filter screen by clicking the [Show] link.  This is also where quotes and 
IVANS information is imported into Nexsure. 

Note: To receive IVANS downloads, you must first have a valid IVANS account.  2-way rating integration 
requires a rating application to be installed on the user's machine. 

 
  

• Details - The Details   icon will open the interface details screen.  It displays each download for 
that particular carrier. 

• Interface ID - The interface ID is a number assigned by Nexsure to make it easier to track specific 
downloads.  Numbers are generated in the order received.  

• Carrier Sequence ID - This ID is assigned by the carrier and is pulled from the AL3 file. 

• Carrier - Carrier name. 

• File Name - This name is generated by Nexsure and is used by support to query the database if 
need be. 

• File Type - The different file types are Daily Download, FSC Quote and Initial Load. 

• Import Date/Completed Date - The date the download was received and the date the transaction 
was completed. 

• Exceptions - The import status of a download.   

http://www.ivans.com/
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• Processing Client - Waiting to be processed. 

• Processing Policy - Waiting for data import. 

• Aborted - An error occurred while processing the import, and processing has been aborted by the 
branch.  This might occur, for example, if the policy did not belong to that agency.  Selecting the 
Aborted import status and running a search displays all policies that ere rejected by the agency. 
 Choosing to reject a policy will queue the policy for re-processing.  This process looks for the 
policy again, so if you added the policy, the change would then be attached. 

• Queued for Re-Processing - Import has been set to be re-processed. 

• LOB Exception - Line of business not currently supported for import. 

• Carrier Exception - Carrier could not be determined. Make sure carrier is listed with correct NAIC 
code, and click Accept to re-process. 

• Branch Exception - Branch could not be determined. Make sure branch code is listed under the 
carrier's commission tab in Nexsure.  Click Accept to re-process. 

• Application Exception - Application does not exist.  

• Client Exception - Client could not be found. Click here to search existing clients, or click Accept 
to create a new client. 

• Policy Exception - Endorsement could not determine policy to endorse. Select policy to endorse. 

• Policy Exception - Reinstatement could not determine policy to re-instate. Select a cancelled 
policy to re-instate. 

• Policy Exception - Cancellation could not determine policy to cancel. Select a policy to cancel. 

• Import Completed - The import file has been successfully imported into Nexsure. 

• Endorsement Date Exception - Policy to endorse could not be determined due to effective date 
of endorsement being outside policy term. 

• Reinstatement Date Exception - Policy to reinstate could not be determined due to effective date 
of reinstatement being outside policy term. 

• Cancellation Date Exception - Policy to cancel could not be determined due to effective date of 
cancellation being outside policy term. 

• Transactions - The transactions number is the amount of policies or individual files sent from the 
carrier. 

• Status - While a download has exceptions that haven't been addressed it remains in a Pending 
status.  When all exceptions are resolved, the status changes to Complete.  Pending downloads 
are displayed in a blue font, completed downloads are black. 

 

Note: Policies with a status of New can no longer download and add to a client that already has a 
policy. 

• Remove - Clicking the Remove   icon will delete the download. 

Advanced Search Tab 

The advanced search tab shows all transactions for all carriers regardless of status. 
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Processing Downloads 

Once downloads have been completed they must be processed. 

To process downloads 

1. Click the Details  icon for the download you want to process. 

 
2. Before you can accept or reject a download you must select the check box for each download you 

wish to process.  Use the Select All or Deselect All links to select or deselect all downloads at 
once.  Select All/Deselect All will only select the boxes of the downloads on the page being 
displayed. 

Note: If you have multiple pages of downloads, check boxes you have selected will stay selected 
as you click through the pages. However, if you leave the downloads screen, they will not remain 
saved unless you click the Save link. Selected downloads will all be processed together, for 
example, if ten downloads are selected and you click Accept, all selected downloads will be 
accepted.  If you save your selections and leave the interface screen, upon return make sure you 
review your current selections before you process them all together. 

3. Click Accept or Reject to process the downloads you selected. 

  

 IVANS Downloads 

 Importing FSC Quotes 

AL1 and AL3 Support 

ACORD Level 1 and 3 data can be imported into Nexsure via the Home > Interface screen. 

AL3 data can be accepted into Nexsure as a new business, renewal, policy change, reinstatement or 
cancellation.  AL1 data is imported as a memo and is limited to the Interface screen.  AL1 data can be 
viewed and printed.  New memos have an import status of New Memo once they have been viewed they 
change to Memo. 
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To view/print a memo 

1. On the Home menu, click INTERFACE. All downloads for the current day appear.   

Tip: To filter specifically for Memo or New Memo, click the [Show] link and select either option in 
the Import Status drop-down list. 

2. Select the AL1 (memo) you wish to view/print and click the Details  icon. 

3. The data will appear in a separate window. 

4. To print the memo, click your browsers Print button or from the File menu, click Print. 
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Carrier Commission Downloads 

The commission statements come in as a group under the carrier name. The commission statement is 
worked as a group.  At this time, only The Hartford is supported for commission downloads. 

To process carrier commission downloads 

1. Prior to working with the Daily Download statements, process all the policy downloads. 

2. On the Home menu, click INTERFACE. The File types are Commission Downloads. 
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3. If exceptions exist, take the following steps: (Exceptions are Carrier, Branch, Client or Policy) 

• Click on the red exception link (1) to display the item(s) 

• The exception is displayed. Click the exception link to select the policy for a policy exception 
to display a list of policies. Select a policy from history or the in-force list. 

 

 
• After selecting the policy, click the Select link. The invoice is processing. 

 
  

4. After all exceptions are processed, the Create Reconciliation link is active. Click the Create 
Reconciliation link to: 

• Create the invoice. 

• Post the invoice. 

• Create reconciliation worksheet ready for posting. 

5. After clicking Create Reconciliation link the Ready to Create Reconciliation message is displayed. 

6. Click OK to proceed or Cancel to abort. 

7. The reconciliation confirmation is displayed with the Reconciliation ID. Make note of the ID in order 
to complete the reconciliation. Click Cancel. The Interface screen is displayed. 
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8. To complete reconciliation, on the Primary menu, click Organization, select the territories tab and 
then click the territory details   icon. 

9. Select the accounting tab.  

10. Click on the transactions tab and then the reconciliation tab. 

11. If the reconciliation worksheet is not displayed use the [Show] link to search for the specific 
Reconciliation. 

12. Click the Details    icon to display the worksheet.  

13. Modify header and transactions as necessary. 

14. If the producer commissions need to be adjusted, click the Item ID link to display the invoice detail.  

15. Scroll down to the other commission and click the Details   icon to edit.  

16. Click the Post Adjustment link on the navigation toolbar and acknowledge the post. 

Note: If Post Adjustment is not selected any adjustments are aborted. (Clicking on the “X” will 
abort the adjustment) 

17. Click the Reconciliation ### link on the navigation toolbar to go back to the reconciliation. 

18. The adjusted amount posts with the same ID with an A beside the number for easy reference. 
Please note that once an adjustment is posted it cannot be edited.  

19. Click the Post link on the reconciliation navigation toolbar to complete. 

20. Process receive payment and deposit. 
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Delivery 

Using Nexsure's Delivery screen, you can deliver policy information via fax or email.   

Delivery Summary Screen 

The delivery summary screen can be accessed from the Home menu, or the Client menu.  From the 
Home menu, a summary for all deliveries will appear.  At the client level, only deliveries for the specified 
client will be displayed. 

 
  

• The Details  column displays an icon to determine the status of a delivery: 

 

Note: To re-send a failed delivery, from the summary view, click the Details  icon for the 
failed delivery, then click the Re-Send link. 

• The paper clip  column displays the number of attachments associated with the delivery. 

Sending a Delivery 

To deliver policy information 
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1. On the Client menu, click Delivery.  The delivery summary screen appears.  If this is the first 
delivery you will be prompted to add a new delivery.  If you have made previous deliveries they will 
appear in the summary.   

2. Click [Add New]. 

3. Select a delivery method, email or fax. 

4. Enter the delivery information in the address fields, or use the address book . 

 
 

  

• Title: -The Title field is not displayed to the recipient and is intended to be used as an internal 
note or to aid in a search.  The Regarding field is displayed to the recipient and populates the 
Subject area of an email. 

• From E-Mail Address / Fax number: Your email address or fax number (for reply purposes 
only).   

Note: While you don't need a valid email address or a fax machine, you must populate the 
From email field.  The policy information will be sent via Nexsure and a third party tool. 

• From: Enter your name.   

• To E-Mail Address/Fax Number: Enter the email or fax number you are sending to.  

Tip: To send an email of fax to multiple recipients, add a semi-colon between the multiple 
email address or fax numbers. 

• To: The person's name you are sending to.   

• CC: (email only) Any person's email you would also like this information sent to. 

• BCC: (email only)  Any person's name you would like to send the information to without the 
others CC'd seeing the names in this field. 

• Regarding: The delivery subject, as would be shown on the cover page. 

• Message: Enter a message, if needed, to accompany the attachments.  You can add a 
signature file to your deliveries on the employee > identity screen. 

 
 
Signature files can display your name, company name, phone number etc. 
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a. On the Primary menu, click Organization. 

b. Click the Employees tab. 

c. Select the employee name to append the signature file to and click the Details  icon. 

d. Click the identity tab. 

e. Click the Add Salutation link. 

Note: Though you can have more than one salutation (or signature) file, the first one will 
appear in your delivery message body. 

f. Enter a Name for the signature file (i.e. Delivery) 

g. In the Text field, enter your information. 

h. Click Save, then click Update on the employee/identity tab. 

  

5. Attach a policy, claim, cancellation, certificate, verification, binder or other (such as a digital 
picture).   

  

 
6. Choose a type of attachment and click Add. 

7. Select the policy, certificate, image or other item and click Next.  Follow any remaining prompts. 

8. Once any attachments are added, click Send.  

Note:  If the initial fax could not be delivered, there are two ways to proceed: 
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A PDF file of the document will be automatically generated.  That file may then be printed and 
manually faxed. 
 
-Or- 
 
Click the Details  icon for the failed delivery, then click the Re-Send link. 

9. After the delivery has been sent, the view tab will appear on the delivery screen.  To view the 
attachment, click the details icon for the attachment, click the viewer tab, and click the magnifying 
glass icon to view the document attachment or digital image in the viewer.  Once a delivery has 
been made it cannot be deleted. 

  

 
  

Related Topics 

Attachments 

Attaching Outlook Messages 

Delivery Address Book 

The address book can be used to search and select email or fax recipients.  By default the address book 
will display the current user's delivery history. The address book allows a search of the following entities: 

• Additional Interest Location 

• Carrier Location 

• Contacts 

• Delivery History 

• Organization Location 

• Policy Assignments 
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• Retail Agent Locations 

 

Adding an address to a delivery 

1. Select an Entity from the drop-down list.  Respective search options will be displayed for each 
entity: 

• Additional Interest Location - Company/City 

• Carrier Location – Company is the contact’s company or the location’s company/Display 
Name the person's first and last name or location name. This populates the Send To name.  

• Contacts - Display Name/Company/Entity is the contact’s entity type. Such as client, carrier, 
organization, branch or additional interest.   

• Delivery History - Display Name/email/Sender. 

• Organization Location - Display Name/City/State. 

• Policy Assignments - Client Name/Policy No/LOB. 

• Retail Agent Locations - Company/Display Name/State. 

2. Enter search criteria in the available option boxes and click the Search link. 

Tip: Entering %% in a field will return all entries. 

3. Click on the desired entity (to select multiple recipients on the same search screen, press the 
CTRL key and click each name). 

4. Select the From, To, CC or BCC delivery option. 

5. Click the Select link.  Notice that once you click Select, the information appears in the respective 
fields on the email tab.   
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6. Click Close. The selected entities have been added to the fax or email. 

  

Related Topics 

Delivery 

Annualized Premium 

Nexsure utilizes a simple formula that takes a mid-term premium (debit or credit), calculates the 
annualized value based on policy term compared to effective date of the mid-term premium, and adds it 
to the existing annualized values. 

Example 

A commercial auto policy with a term of 1/1/2005 to 1/1/2006 and an original premium of $10,000 will be 
used. 

  

Next, an endorsement to the policy is made to add an additional vehicle effective 1/24/2005 with pro-rata 
additional premium of $1,200.00.  That is the cost of adding a vehicle from 1/24/2005 to 1/1/2006 or a 
total of 342 days. 

  

Nexsure then uses the following formula to determine the annualized amount of $1200: 

  

$1,200 x 365 days / 342 days = $###.##  

  

1200 multiplied by 365 = 438,000 divided by 342 = $1,280.70 so the annualized premium is $1,280.70. 
 That premium is now added to the original annualized premium of $10,000.  This is displayed  in policy 
info as: 

  

Annualized $: $11,280.70 

Billed Premium: $11,200.00 

  

Setup Console 

The Setup Console is accessible via the SETUP option on the Utility menu. Use the Setup screens to 
perform the following functions: 

  

• Actions 

• Color Schemes 

• Lookup Management 

• Opportunities 
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• Branches 

• Buying Modes 

• Contact Roles 

• Grades 

• Labels 

• Print Blank Forms 

• Programs 

• Document Templates 

• Security Administration 

   

Actions 

To add or modify the defaults for actions 

1. On the Utility menu, click SETUP. 

2. From the Setup Console, click Actions. 

3. By default the Actions are displayed by topic.  Use the tabs at the top of the page to view other 
pages.  Click the   types tab to display the list of Types.  Click the topics tab to display the default 
view of Topics.  

4. Click [Add New] to add a new Action to setup.  The New Actions pop-up screen is displayed. 

5. Select a Topic. Topics are unique and allow grouping like items together such as the renewal 
topic.  This topic would be used on every action during the renewal process, which would then 
make it easier to determine where you are in the renewal process.  

• If a desired Topic does not exist, click Add to add a new one.  The Add New Topic pop-up 
screen is displayed. 

• Enter the new Topic and enter a description in the Description area.  Click the Next button 
to complete the addition of the new Topic.  The New Actions pop-up screen is displayed. 
To cancel the addition of the New Topic, click the Back button.   

6. Types are not unique and may be reused for any topic, so be careful when adding to make sure 
the type is not being repeated.  

• To add a new Type, Select the Type tab and click the Add New link. The Add New Type 
pop-up screen is displayed.  

• Enter a name for the new Type.  Select an icon from the drop-down list.  The icon will 
appear on the Home > Actions screen with the action that is associated with it. 

Note:  The icon also determines how the action interacts with MS Outlook.  Assigning a type to a 
appointment or phone call icon will synchronize the action with your Outlook calendar.  Assigning 
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any other icon to the type will synchronize the action with the Outlook taskpad. See Creating 
Actions. 

 
• Enter a description in the Description area. Click the Next button to complete the addition 

of the new Type.  The New Actions pop-up screen is displayed.  To cancel the addition of 
the New Type, click the Back button. 

7. From the Days Due drop-down list select the number of days to default the Due date from the 
current date when the Action is created by the user. 

8. From the Priority drop-down list select Normal or High.  If the Action’s priority is considered High 
a red flag icon will display on the action in the summary view.  If Normal no icon will be displayed. 
 The user may change the Priority as needed when the Action is created.  

9. The Action status may be set with a default of either Open or Closed.  When adding a new 
Action the status would generally default to Open since Actions are meant to remind the user to 
do something.  The user may change the status as necessary when the Action is added or 
modified.   

10. The Description entered in setup is strictly to identify the Action in setup.   

To remove action topics 

1. On the Utility menu, click SETUP. 

2. From the Setup Console, click Actions. 
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3. By default the Actions are displayed by Topic.  Use the navigation link at the top of the page to 
view other pages.  Click the [View Types] link to display the list of Types.  Click the [View Topics] 
link to display the default view of Topics.  

4. Click the Remove  icon next to the topic you want to remove. 

Note: Topics used for Annotations will not have an active Remove  icon. 

 
  

Related Topics 

About Actions 

Creating Actions 

Color Schemes 

You can change the Nexsure color scheme or add your company logo to the Nexsure login page. 
 Customizing your interface will allow Nexsure to more closely match your company's look and feel. 

To Change the Color Scheme 
 

1. On the Utility menu, click Setup. 

2. In the Setup Console, select Color Schemes. 

3. In the Color Schemes drop-down list, select a color scheme.  Selecting a scheme will present a 
preview in the color scheme Preview window. 

4. When you have chosen a scheme, click Change Scheme. 

To Add a Custom Logo Graphic 
 

1. On the Utility menu, click Setup. 

2. In the Setup Console, select Color Schemes. 

3. Beside Apply Image, select Use New. 
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4. Beside New Logo File: click Browse.  Select your logo file in .gif format. 

Note: The graphic dimensions must be no bigger than 135 x 58 pixels and a file size no larger than 
10 Kb.  To resize a graphic that is too large, use a graphics program such as Microsoft Paint (MS 
Paint is typically found by clicking Start > Programs > Accessories) or Microsoft Photo Editor. 

5. Click Change Scheme. 

Adding a Default Message 

You can add a message that will appear to all users when they login.  For example: "Welcome to Sample 
Insurance Agency, Please login." 

1. On the Utility menu, click Setup. 

2. In the Setup Console, select Color Schemes. 

3. In the Default message to all users box, enter a message. 

4. Click Change Schemes. 

Lookup Management 

The Lookup Management screens are where the agency has the most control over what is displayed in 
certain drop-down boxes.  Lookup Management consists of three sections: 

• Categories 

• Types 

• Items 

Categories are main areas of Nexsure (Additional Interests, Carriers etc.)  Types are groupings within 
Categories.  Items are the actual drop-down list options.  Items that appear in light gray are system 
generated items and while they cannot be changed or deleted, the agency is not required to use them.   

  

Listing of Types within each Category and the system generated Items within each Type 

 
 

Category  Types  System Generated Items  

Additional Interest Interest Types Corporation 

Default 

Individual 

Partnership 
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Category  Types  System Generated Items  

Carrier Location Types (Carrier) Corporate Headquarters 

Home Office 

Satellite Office 

Client Business Types Corporation 

Default 

Individual 

Partnership 

  Code Classes Internet Access 

  Code Designation (No System Generated Items) 

  Client Relationship Types Corporate/Subsidiary 

Franchiser/Franchisee 

Partner/Partner 

PEO/Client Company 

  How Relates (No System Generated Items) 

  Location Types (Client) Corporate Headquarters 

General Office 

  Referred By Default Past Client 

Financial Entity Location Types  Branch Office 

Corporate Office 

Document Integration Category Proposal 

Miscellaneous Attachment File Types (No System Generated Items) 

  Delivery Types Email 

Fax 

FTP 
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Category  Types  System Generated Items  

  Phone Types After Hours 

Automated 

Back Line 

Building Security 

Business Phone 

Fax Number 

Main Fax 

Phone 

Receptionist 

Technical Support 

Toll Free 

Organization Location Types (Organization) Corporate Office 

General Office 

Home Office 

People Contact Roles Daughter 

Husband 

Son 

Wife 

  Marital Status Married 

Single 

  People Availability Status Offline 

Online (Available) 

Online (Unavailable) 

  Name Prefixes Dr. 

Miss 

Mr.  

Mrs. 

Ms. 
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Category  Types  System Generated Items  

  Titles Account Manager 

Default 

File Clerk 

Producer 

Premium Finance 
Company 

Location Types Corporate Headquarters 

Home Office 

Satellite Office 

Retail Agent Location Types Corporate Headquarters 

Home Office 

Satellite Office 

Tax Authority Location Types Corporate Headquarters 

Home Office 

Satellite Office 

Vendor Location Types Accounting Office 

Corporate Headquarters 

Home Office 

Satellite Office 

Retail Office 

Service Center 

  

  

Related Topics 

Adding Lookup Management Items 

Editing Lookup Management Items 

Deleting Lookup Management Items 

Adding Lookup Management Items 

1. On the Utility menu, click SETUP. 

2. On the Setup Console, click Lookup Management. A summary list of existing categories and 
types will appear. 
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3. From the drop-down list, select a Category. The Types available for the Category will be 
displayed. 

4. Select the Type for the Category.   

5. Select [Add New] in the item list. 

 

6. Enter the item label.  This is what will appear in the drop-down list. 

7. Click [Add New] to add the New Item to the drop-down list. 

  

Related Topics 

Lookup Management 

Editing Lookup Management Items 

Deleting Lookup Management Items 

  

Deleting Lookup Management Items 

Note: Items in gray cannot be deleted. 

1. On the Utility menu, click SETUP. 

2. On the Setup Console, click Lookup Management.  A summary list of existing categories and 
types will appear. 

3. From the drop-down list, select a Category.  The Types available for the Category will be 
displayed. 

4. Select the Type for the item you wish to delete. 

5. Select the Item you wish to delete. 
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6. Click [Delete] to delete the Item from the drop-down list. 

  

Related Topics 

Lookup Management 

Adding Lookup Management Items 

Editing Lookup Management Items 

Editing Lookup Management Items 

Note: Items in gray cannot be modified. 

1. On the Utility menu, click SETUP. 

2. On the Setup Console, click Lookup Management. A summary list of existing Categories and 
Types will appear. 

3. From the drop-down list, select a Category. The Types available for the Category will be 
displayed. 

4. Select the Type for the Category. 

5. Select the Item to be modified in the Item list. 

6. Modify the item label.  This is what will appear in the drop-down list. 

7. Click [Update] to complete the modification. 

  

Related Topics 

Lookup Management 

Adding Lookup Management Items 

Deleting Lookup Management Items 

  

Opportunities 

Opportunities in the Setup Console contains several options. These options allow you to create sales 
profiling questions and answers. The options are listed below: 

• Branches   

• Buying Modes 

• Contact Roles 

• Grades 
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• Labels 

Customizing Opportunities for a Branch 

The Setup > Opportunities > Branches screen is for adding and managing customer qualifying 
questions that will be used on the opportunities screen.  Each branch can use the same group of 
questions or (Template) or use their own unique set of questions and answers.  After you create the 
qualifying questions and answers, you can assign a numerical value for each answer which will calculate 
a grade for prospective clients.   

To setup qualification questions for a branch 

Selecting the branches link displays a list of branches previously setup on the right side of the screen. 

Note: If no templates exist, click on the link to add a new branch template. "No record(s) found. Please go 
to here to add new data." 

1. On the Utility menu, click SETUP. 

2. On the Setup Console, click opportunities. 

3. Click branches. 

4. Click the Details  icon beside the branch you wish to setup questions for. The templates tab for 
that branch will open. 

5. On the Templates screen you can: 

Add a question 

1. Click [Add New] 

2. From the Question drop-down list, select a question. 

3. From the Answer drop-down list, select an answer. 

4. In the Value field, assign a value based on the importance of the answer.  For example, 1 
being highest. 

5. At the bottom of the dialog box, click Add. 

6. Continue to add values to the remainder of the available answers. 

7. When completed click Save.  The new question will be available for that branch next time the 
opportunities screen is accessed. 

Create a new question 

1. Click [Add New] 

2. Beside the Question drop-down list, click Add. 
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3. From the Answer drop-down list, select an answer. 

4. In the Value field, assign a value based on the importance of the answer.  For example, 5 
being highest. 

5. At the bottom of the dialog box, click Add. 

6. Continue to add values to the remainder of the available answers. 

7. When completed click Save.  The new question will be available for that Branch next time the 
Opportunities screen is accessed. 

Edit the value of an existing answer 

1. On the templates tab, only one question and it's corresponding answers will appear per page. 
 Select the answer you wish to change the value for and click the Details icon beside the 
answer. 

2. In the Value field, enter or edit the value of the answer. 

Change the order of questions and answers as they will appear on the Opportunities screen 
 

1. On the templates tab, Click [Order]. 

2. All the questions will appear with a corresponding drop-down box to input the desired order. 

3. Select an order place for each question. 

4. Click Next.  The answers for each question will appear. 

5. You can change the order of the answers for each question, or you can keep them as they 
were. 

6. Click Save then click Close. 

Delete a question 

1. On the templates tab, only one question and it's corresponding answers will appear per 
page.  Select the question you wish to delete and click the Remove  icon. 

Buying Modes 

The Setup > Opportunities > Buying Mode screen is where you can add or modify Buying Modes The 
Buying Mode is the Client/Suspect/Prospect's buying attitude.  For example: Overconfident.   that will 
display on the client opportunities screen in the Buying Mode drop-down list. 

To Add a New Buying Mode 

1. Click [Add New] 
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2. Enter a Buying Mode.  For example: Very Interested. 

3. Enter a brief description of the Buying Mode. 

4. Click Save. 

To modify an existing buying mode 

1. Select the Buying Mode you wish to modify. 

2. Click the Details  icon beside the Buying Mode. 

3. Modify the Buying Mode. 

4. Click Save. 

Contact Roles 

The Setup > Opportunities > Contact Roles is where Suspect/Prospect's role as Contact is defined. 
The contact roles added here will display on the client opportunities screen.  The contact roles are limited 
to four entries.  If no contact roles exist, you will be prompted to add new data. 

To add a new contact role 

1. Click [Add New]. 

2. Enter the Contact Role.  For example: Economic Buyer 

3. Selecting Active will make that Contact Role available in the Contact Role drop-down list.  If you 
select Inactive the Contact Role will not be available for selection in the drop-down list. 

4. Enter a brief description for the Contact Role (optional). 

5. Click Save. 

To modify a contact role 

1. Click the Details  icon beside the Contact Role you wish to modify. 

2. Modify the Contact Role 

3. Click Save. 

To Change the Order of Contact Roles 

1. Click [Order] 

2. Each Contact Role will have a drop-down list.  Select an order number for each Contact Role. 

3. Click Save. 
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Grades 

The grades screen displays the system ranking results.  This includes the minimum number of points 
needed in order for the opportunity to be ranked in a particular grade.  The system default rank may also 
be set on this screen.  The grades added on this screen will be displayed on the opportunities screen 
based on the total points. 

To add a new grade 

1. On the Utility menu, click SETUP. 

2. On the Setup Console, click the + sign next to opportunities to expand the options. 

3. Click on grades. 

4. Click [Add New].  

5. Enter a grade in the field.  For example: Gold 

6. Select Active to activate the grade in the ranking system. 

7. Enter the minimum number of points needed for this grade. 

8. Select the Default option if this grade should be the system default grade. 

9. Enter a brief description that describes the answer. 

10. Click Add to save the grade and continue adding another entry. 

11. When completed, click Save. 

Labels 

The labels screen lets you name the different groups on the client opportunities screen.  For example, 
Qualifying Information or Contact Information.  The default names for the four groups are: Qualifying 
Information, Opportunity Criteria, Opportunity Status and Contacts. 

  

To assign or modify a label name 

1. On the Utility menu, click SETUP. 

2. On the Setup Console, click opportunities. 

3. Click labels. 

4. Click [Add New] 

5. Enter a Label Name.  
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6. Enter a description for the label (optional). 

7. Click Save. 

To modify an existing label name, click the Details   icon next to the Label Name.  

Printing Blank Forms 

You can print standard insurance forms, such as ACORD forms, from the Setup > Print Blank Forms 
screen. 

To print a blank form 

1. On the Utility menu, click SETUP. 

2. Click Print Blank Forms 

3. Select the Form Standard, State, Type and Line of Business and click List.  All available forms 
matching your criteria will be displayed in the window below. 

Note: In order to view/print the ACORD 125 Commercial Application, Form Standard must be set 
to All. 

4. Click the View  icon.  The form will open in a new window. 

5. Click the Print  icon. 

Note: To view and print forms you must have a PDF viewer installed such as Adobe® Reader®. 
Click here to download Adobe® Reader®. 

Programs 

Programs are used to identify whether an opportunity is used for program business. Programs are located 
on the OPPORTUNITIES > qualification tab. The drop-down boxes for these programs are populated by 
each organization and then associated with each branch in the organization as needed. 

Utilizing Programs 

Programs are utilized at the Client > OPPORTUNITIES level. One method of accessing an existing 
opportunity is from the HOME > OPPORTUNITIES screen.  

1. Click the HOME link located on the Utility menu. 

2. Click the OPPORTUNITIES link. 

http://www.adobe.com/products/acrobat/readstep2.html
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3. Click the Details  icon to display the qualification tab. 

 

4. Any active program associated with the branch is available for selection from the Program drop-
down box. 

Note: After an opportunity has been added, details may be accessed from either the HOME > 
OPPORTUNITIES or Client > OPPORTUNITIES menus. 

  

Related Topics 

Adding New Programs 

Associating Programs with Branches 

Editing an Existing Program 

Setting Program Status to Inactive 

Removing Associated Branches 
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Removing Programs 

Adding New Programs 

To add a new program 

1. Click the SETUP link located on the Utility menu. 

2. Click the Programs link to display the current programs. 

3. Click the [Add New] link. 

 

4. Enter the description or name of the program in the Description field. 

5. Leave the Status drop-down box set to Active. 

6. Click the [Save] link to add the new program or [Cancel] to abort. 

 

Related Topics 

Programs 
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Associating Programs with Branches 

Editing an Existing Program 

Setting Program Status to Inactive 

Removing Associated Branches 

Removing Programs 

Associating Programs with Branches 

To associate programs with branches 

1. Click the Details  icon of a newly added program to associate it with branches. 

 

2. Click the [Add New] link to choose a branch to associate with the new program. 

 
The effective and expiration dates are used to identify the program timeframe. If there is no 
timeframe, leave the Effective Date and Expiration Date fields blank and the program will be 
available until its status is set to inactive.  

 

3. Click the [Save] link to store the newly associated branch or [Cancel] to abort. 

Once the record is stored, the Program Details summary screen is displayed, showing the 
Branch Name of the branch or branches associated to the program. 
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Related Topics 

Programs 

Adding New Programs 

Editing an Existing Program 

Setting Program Status to Inactive 

Removing Associated Branches 

Removing Programs 

Editing an Existing Program 

To edit an existing program 

1. On the Program Summary screen, click the Details  icon to display the Program Details > 
Associated Branches screen. 

 

2. Click the [Edit] link. 
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Note: Modifying the program name will modify all programs currently in use at the Client > 
OPPORTUNITIES level. 

3. In the Edit Program pop-up window, change the program name in the Description field. 

4. Click the [Save] link to save changes or [Cancel] to return to the Program Details screen. 

 

5. Click the [Add New] link to associate other branches to the program. 

 
  

Related Topics 

Programs 
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Adding New Programs 

Associating Programs with Branches 

Setting Program Status to Inactive 

Removing Associated Branches 

Removing Programs 

Setting Program Status to Inactive 

If a program is no longer valid, it may be identified as inactive so it is no longer an available selection on 
the Client > OPPORTUNITIES detail screen.  

1. Click the Details  icon of the selected program. 

 

2. Click the Details  icon on the selected associated branch. 

 

3. On the Branch Details pop-up window, select Inactive from the Status drop-down box. 

4. Click the [Save] link to store the change or [Cancel] to abort. 
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Note: Programs must be set to inactive by the branch in order to disable use at the Client > 
OPPORTUNITIES level. 

After saving the newly modified status, the Program Details screen is displayed. The red font 
indicates that a program's status has been set to Inactive. 

 
If the entire program is no longer valid for all branches, make sure to set all branches’ status to 
Inactive individually.  

5. Click the [Edit] link on the Program Details screen. 

6. Select the Inactive option from the Status drop-down box. 

7. Click the [Save] link to store the change or [Cancel] to abort. 
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Once saved, the program displays on the Program Details screen with a red font indicating it is an 
inactive program. 

 
  

Related Topics 

Programs 

Adding New Programs 

Associating Programs with Branches 

Editing an Existing Program 

Removing Associated Branches 

Removing Programs 

  

Removing Associated Branches 

In order to remove a program (the program must not have been used), all associated branches must first 
be removed from the Program Details screen.  

1. Click the Remove  icon on the Program Details screen. Repeat for all associated branches. 
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The program may now be removed. 

  

Related Topics 

Programs 

Adding New Programs 

Associating Programs with Branches 

Editing an Existing Program 

Setting Program Status to Inactive 

Removing Programs 

Removing Programs 

If a program was added but never used and all associated branches have been removed, the entire 
program can be removed from the Program Summary screen.  

1. Click the Remove  icon on the Program Summary screen. 
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2. Click OK to confirm removal. 

 
Note: If the program has been used, it cannot be removed. It can only be disabled by setting its 
status to Inactive. 

Related Topics 

Programs 

Adding New Programs 

Associating Programs with Branches 

Editing an Existing Program 

Setting Program Status to Inactive 

Removing Associated Branches 

Creating Document Templates 

Document templates in Nexsure allow data from the Nexsure database to be integrated into an MS Word 
or Excel file.  Before a template can be appended as an attachment, it must be created in Setup. Nexsure 
will add components to Word or Excel to aid in the template creation.  Use of this feature requires MS 
Office 2000 or XP. 

To create a Document Template 

1. On the Utility menu, click SETUP. (If the setup link is not available on the Utility menu, contact the 
Nexsure point person within the agency for assistance). 

2. In the Setup Console, click Document Templates. 
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3. Click [Add New]. 

 

4. Enter the following information for the template: 

• Template Name - Enter a brief name of the type of document that is being added so it can be 
easily recognized from the client/policy level.  

• Description - The description should describe what the document is to be used for. After the 
document has been created, the template name and description may be modified if 
necessary. 

• Document Type - Select Microsoft Word or Excel. 

• Category - This drop-down can be modified in Lookup Management to fit the organizations 
needs.  

• Client Stage - Select a client stage: 

• Suspect - Card file only 

• Prospect - Has Marketing policy only (no in force policy) 

• Client - Has an in-force policy. 

5. To make the document specific to a line of business, click Add New. 



Nexsure User's Guide    Utility Menu 

XDimensional Technologies, Inc.   97

  

6. Enter the following information pertaining to the Line(s) of Business: 

Stage - There are three policy stages: 

• Opportunities - No form data included 

• Marketing - Only form data from marketing included 

• Policies - Only form data from policies included 

Mode - There are three policy modes including an option for all: 

New - Select if the document is exclusively used for newly written policies and have a policy mode 
of New. 

Renew - Select if the document is exclusively used for renewal policies and have a policy mode of 
Renew. 

Re-New-Co - Select if the document is exclusively used for policies that are a renewal to the 
agency but new to the carrier and have a policy mode of Re-New-Co. 

Many documents will be for all modes but there will be exceptions such as new business letters. A 
mode of new would only be selected 

Business Type - This relates to the group that the form can be found in. There are five types: 

• Benefits 

• Bonds 

• Commercial Lines 

• Financial Services 

• Personal Lines 
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Use these to help filter through the line of business list. 

Line of Business - After selecting the specific type select the line of businesses that the document 
will be used on by holding down the control key and clicking with the right mouse button. The line of 
business must be added in order to use the document on that line of business at client/policy level. 

Tip: CTRL + Click will allow multiple lines of business to be selected. 

Required Check Box - Use this check box only if it is required to have the selected line of 
businesses in order to access the letter at client/policy level. 

Note: Adding lines of business will allow fields that are pertinent to the LOB available for selection 
when creating the template. 

7. Click OK, Word or Excel will open, it may take several seconds to open. 

8. Nexsure will add the Office Integration Toolbar to the Word or Excel menus. 

 

9. Click Nexsure Fields to display the XML Tree window.  The XML Tree contains the data fields as 
they appear in the policy form: 

 
Tip: For easier manipulation between the Word document and Nexsure field window, resize them 
so they are side by side. 

Note: The Validate Document button can be used to validate the structure of custom fields such 
as HideBegin and HideEnd. Use to help locate problems related to custom fields. 

• Position the cursor where the field will need to be in the document. 

10. In the XML Tree window click the + in front of each section to expand the available Nexsure fields. 
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11. In the Word Document window: 

a. On the Insert menu, click date and time. 

b. Select the format. 

c. Check the Update automatically check box.  This will automatically update the date on 
documents created using this template. 

d. Click OK. 

e. Click at the end of the date field and enter down one or two spaces. 

12. In the Nexsure Fields window: 

a. From the Client contact section, click and drag the First Name and drop it into the word 
document.  The Nexsure Field Properties pop-up box will display: 

  

b. Merge Field/Repeat Index - When generating a schedule the repeat index will allow a specific 
number of items to generate.  For example, if the number 10 is entered only the first 10 
vehicles on a policy will be generated.  Setting the Repeat Index value to zero will allow ALL 
vehicles on the policy to generate to the document. 

c. Field Mask - Select a decimal format (if applicable) to display numeric values.  Leaving Select 
Mask in the drop-down applies no formatting. 

d. Match Field on Form - Select this option if the field populates a specific form type.  For 
example: to merge a field from a state-specific form, this option must be selected. If Match 
Field on Form is not selected, any state-specific fields will not be merged. 

e. Match Field on LOB - Select this option if the field will only populate a specific line of 
business. 

f. Hide Page 
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The Hide Page is used to hide entire pages if the line of business is not present, such as in a 
proposal. It can also be used around tables to hide data that does not exist. More about Hide 
Page, Drop as Conditional HideBegin field and Add HideEnd field automatically... 
 
When using the Hide Page feature it is easiest to view the document in Normal mode (On Word's 
View menu, select Normal). This view will display all the page breaks so they may be included 
above or below the HideBegin/HideEnd fields. 

HideBegin is the starting position where the page is to be hidden if the condition is met. Place the 
cursor where the HideBegin is to be placed.  

It is important to select a field that will identify the section to be omitted from the document.  

Tip: If the line of business does not exist, consider choosing the Policy ID field. This field is unique 
and therefore, if it does not exist the page will be suppressed as desired. Find the Policy ID field 
after selecting the line of business in the XML tree. 

Drag the field toward the document to display the Nexsure Field Properties. Select Drop as 
Conditional Hide Page field. Notice that the Find the Policy ID field after selecting the line of 
business in the XML tree check box is checked. Leaving this box checked automatically places the 
HideEnd field immediately after the HideBegin. This HideEnd field will need to be moved to the end 
of the page that will be omitted if the Policy ID in this case is not found. 

In this scenario, if the field has no data the desired effect is to omit the page, so leave the Delete 
page if the value is field blank. 

 
The HideBegin and HideEnd is dropped into the document. Notice that the HideBegin was placed 
above the Section Break (Next Page). Doing this will suppress any empty pages. 
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Note: If the HideEnd box was not checked in the Nexsure Field Properties window, place the 
cursor where the HideEnd should be placed and click the HideEnd button on the toolbar to add. 

Select the HideEnd field and cut (use the scissors on the toolbar) and paste (click the clipboard on 
the toolbar) the HideEnd field at the end of where the page should be hidden.  
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Note: For every HideBegin there must be a corresponding HideEnd. If not when the document is 
merged these HideEnd fields will print on the merged document. Use the printed merge fields to 
help troubleshoot where missing fields may be. 

If it is necessary to have more than one HideBegin before the HideEnd is added, they can be 
'nested'. However, the HideBegin may not be embedded in (IF) conditional statements. If more 
than one condition should be met to determine if the page or section should populate, add as many 
HideBegin fields as needed. It works like a compare string, making sure the condition is met before 
populating the section. Make sure to add a HideEnd for each HideBegin after all conditions are 
added: 

<<HideBegin>> 

Section information entered here 

<<HideBegin>> 

Section information entered here 

<<HideBegin>> 

Section information entered here 

<<HideEnd>> 

<<HideEnd>> 
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<<HideEnd>> 

Tip: If the items in the Nexsure Field Properties box are irrelevant to the field being inserted in the 
template click OK without entering any data to bypass the dialog box. 

g. Click OK. 
 

13. In the Word Document window, click at the end of the first name, press the space bar. 

14. In the Nexsure Fields window, click and drag last name and click OK. 

15. In the Word Document window, click at the end of the last name, hit the Enter key to tab down. 

16. In the Nexsure Fields window, click and drag mail address 1 and click OK. 

17. In the Word Document window, click at the end of the mailing address, hit Enter key to tab down. 

18. In the Nexsure Fields window, click and drag mail city and click OK. 

19. In the Word Document window, click at the end of city, put in a comma, press the space bar. 

20. In the Nexsure Fields window, click and drag mail state and click OK. 

21. In the Word Document window, click at the end of the state and hit space bar. 

22. In the Nexsure Fields window, click and drag mail zip code field and click OK. 

23. In the Word Document window: 

a. Click at the end of the zip code, hit enter key to tab down two or three spaces. 

b. Type “Dear”, hit space bar 

c. In the Nexsure Fields window, click and drag First Name field. 

d. Click OK 

24. In the Word Document window: 

a. Click at the end of the first name, put in a comma, hit the Enter key to tab down two or three 
spaces. 

b. Type out message.  IE: “Here is the vehicle schedule you requested.  Let me know if you have 
any questions.” 

c. Hit the Enter key to tab down two or three spaces. 

25. While still in the Word Document window, to create a table: 

a. On the Table menu, point to Insert and click Table. 
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b. Number of columns: 6 

c. Number of rows: 2  (the number of rows will automatically increase to accommodate all items) 

d. Click OK 

e. Click in the top row of the first column type “Year”, tab to next row type “Make”, and continue 
across the top row until each column has a heading. 

 
Year Make Model Vin Compl Collision 

            

Tip: The word document may be customized by changing font size, using bold or italics, 
centering rows, etc., as seen in the screen shot above.   

 
Note: If an item is dragged over from the Nexsure Fields window and dropped into an 
inappropriate spot, highlight it and drag it to the correct spot or it can be deleted by hitting the 
delete key. 

f. Place the cursor in the 2nd row under year. 

26. In the Nexsure Fields window: 

a. Click on + in front of ACORD 1271 CA (or applicable form). 

b. Click on + in front of vehicles. 

c. Click on + in front of record. 

d. Click and drag Year field. 

e. Using the Nexsure fields property pop-up select: 

f. Repeat Index = set to zero to pull all records, no more, no less. 

g. Field Mask = Select Mask 

h. Table Name = 1 for 1st table 
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i. Click OK. 

27. In the Word Document window: 

a. Click at the end of Year and tab to move cursor over to second row under Make column. 

b. Repeat steps 27 and 28 for Make, Model and Year. 

c. Move the cursor to the second row under the comp column. 

28. In the Nexsure Fields window: 

a. Click and drag Comprehensive Deductible field. 

b. Using the Nexsure fields property pop-up select: 

c. Repeat Index = set to zero to pull all records, no more, no less. 

d. Field Mask = $#,##0 

e. Table Name = 1 for 1st table 

f. Click OK. 

29. In the Word Document window: 

a. Click at the end of comp deductible and tab to move curser over to second row under collision 
column. 

b. Repeat steps 29 & 30 for collision deductible. 

30. In the Word Document window: 

a. Click under the table 

b. Enter down 1 or 2 lines 

c. Type “Thank you,” 

d. Enter down 1 or 2 lines 

31. In the Nexsure Fields window, under the Client Assignment, click and drag the first name field and 
click OK. 

32. In the Word Document window, click at the end of the first name, press the space bar. 

33. In the Nexsure Fields window: 

a. Under the Client Assignment, click and drag last name field. 

b. Click OK 

c. When the document has been completed: 

d. In MS Word, on the File menu, click Nexsure Save As. 
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e. Draft: Selecting Draft allows edits to be made to the template by anyone having access to 
Setup, Document Templates. 

f. Complete: Selecting Complete only the author of the template, or an administrator, can make 
changes to the template. 

g. Click OK.  

The document template will be saved, closed and added to the system.  Once the template is in Nexsure, 
it can be added as a client or a policy attachment. 

Tip: Save as draft so that it may be modified later.  An Agency logo may be added to the top of the page. 

 
Note: When deleting a Nexsure field in Excel, the label must be deleted as well as the comment 
associated with it.  Simply deleting the label of the cell will not delete the comment. The comment may be 
deleted by deleting the entire row, or right clicking the cell and selecting Delete Comment. The same care 
must be taken when moving the field to another cell in a spreadsheet. To move a Nexsure field, right-click 
the field and select Cut, then paste it to another cell. 

Related Topics 

Attachments 
Using Document Templates 

Using Document Templates 

Document templates in Nexsure allow you to create and append custom MS Word or Excel templates to 
policy attachments (MS Office 2000, XP and 2003 only). Once a template has been created in Setup, it 
can be used to create new documents at the client or policy level.  

To create a document template 

1. Access the appropriate client or policy level attachment option. 

2. Click the [Add New] link. 

3. Select the Create Document with Template option. 

4. Enter the attachment name. 

5. Enter the document description. 
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6. Click Next. The Nexsure Office Integration pop-up window will be displayed. 

 

7. Enter at least two characters in the template name or description fields, if known. 

8. Choose document type, category & business type from drop-down box. 

• If the Template name, description, document type, category and business type are not known 
leave the fields blank and click Search. All available templates will be displayed in the 
Available Templates box. 

9. Click on the appropriate template. 

10. Click Next. 

11. The Policy Section will be displayed. Select the criteria to default into the document from the drop-
down boxes: 

• Named Insured 

• Contact 

• Location 

• Assignment 

• Line of Business 
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12. Click OK. 

13. The document will be opened in MS Word or Excel (whichever was specified) and will integrate 
with client and policy information. 

14. After the integration process is complete, this is now a normal word document. Make any 
necessary changes/additions to the document as needed. 

15. When the document has been completed: 

• From the Word File menu, click Nexsure Save As. 

 
• Draft: Selecting Draft allows edits to be made to the template by anyone having access to 

Setup, Document Templates. 

• Complete: Selecting Complete only the author of the template, or an administrator, can make 
changes to the template. 

16. Click OK. The Attachment summary view is displayed. 
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17. Click the attachments Details   icon to open the attachment for viewing. 

  

To Close the Attachment after Viewing 

1. On the Word File menu, click Nexsure Save As. 

• Draft: Selecting Draft allows edits to be made to the template by anyone having access to 
Setup, Document Templates. 

• Complete: Selecting Complete only the author of the template, or an administrator, can make 
changes to the template. 

2. Click OK. 

3. Click the Word   icon to update the attachment name or the document description. Click OK to 
save the change or Cancel to close the pop-up window. 

4. The [Show] filter may be used to refine a search. 

  

Related Topics 

Creating Document Templates 

Commercial Proposal Fields Map (.pdf file - will launch Adobe Reader) 

Security Administration 

User login security can be administered at an organization level, as well as on an employee level basis. 
 Some security options are: 

• Enable special password requirements. 

• Create specific log in and log out times by user. 

• Add expiration date and time to login accounts. 

• Lock down login screen contact link. 

• Lock down mandatory general ledger use by user. 

• Period Security - Enable specific individual’s rights to post to locked month. 

• Email notification upon login. 
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Organization-Wide Login Security 

To set organization-wide login security settings 

To setup org-wide security, you must have administrator rights. 

1. On the Utility menu, click SETUP. 

2. In the Setup Console, click Security Administration. 

 

3. Use the drop-down lists to set the security level. 

Note: When effective date column is blank, the rule takes effect immediately. When expiration date 
column is blank, the rule remains in effect indefinitely. 

4. Click Save to keep the security settings. 

Tip: Click the Access Log tab to view a time stamped list of all login activity in your organization. 

Employee-Specific Login Security 

In addition to the organization's security defaults, individual employees can have specific security settings 
that supersede the organization defaults. To modify employee login security settings, you must have 
administrative rights. 

To set employee security 

1. On the Primary menu, click ORGANIZATION. 

2. Select the employees tab. 
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3. Click the Details  icon for the employee you wish to modify the security settings for. 

4. Select the security tab.  

5. Select the login security settings and click Update. 

Region Employees Security 

To add security 

1. User Information is optional.  Clicking "Click here to make this contact a user" will create the 
security tab beside the contact detail tab.  Setup information provides information on adding and 
modifying security templates.  The security screen allows the users Login Information to be 
completed.  Once security has been assigned to a contact, this link can no longer be seen unless 
security is removed. 

2. To assign or edit the contacts security, select the security tab.  Complete or edit the following 
fields: 

• Login ID: Enter an User login ID no more than 18 characters long using an alphanumeric 
value. 

• Password: Enter a user password no more than 18 characters long using an alphanumeric 
value. 

• Confirm Password: This field is required for the password to be reentered correctly. 

• Time Zone: In the drop-down list, select the user's local time zone. 

• Cancel: Click Cancel to abort the record. 

• Save: Click Save to create User Accounts 

• Update: Click Update to update modifications to the record. 

• User Accounts: The user account listing contains the following: 

• Details : The Details  icon will display in this column.  Clicking on the icon will 
display the User Rights Information which may be edited. 

• Entity Name: All entity name(s) the user has been assigned rights will display in 
this column.  

• Entity Type: The entity type is defined as the contacts type in Nexsure, such as 
Client, Employee, Retail Agent, Underwriter, outside finance company or 
additional interest. 

• Rights: Rights are assigned by clicking the Details  icon on the Details column 
to access the User Rights Information pop-up screen. The rights as identified in 
Setup under User Rights Templates will display in this column. 

• Status: Status is assigned on the User Rights Templates pop-up screen. 

• Date Created: Is the date security was saved.  

• Remove: Deletes the security record for the contact.  The security tab will no 
longer be displayed but the link to add security will again display at the bottom of 
the Contacts screen (“Click here to make this contact a user.”). 
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3. Click on the Details  icon to display the User Rights Information pop-up screen.  Complete the 
following fields as appropriate for contact security: 

• Entity Type: Even though a drop-down list is shown, only the appropriate entity type as 
defined by the area in which the contact is being added in Nexsure will display; such as 
Client, Employee, Retail Agent, Underwriter, outside finance company or additional 
interest.  Example: If a Client contact, then the entity type available would be Client. 

• Entity Name: Even though a drop-down box is shown, only the entity that rights are being 
assigned for will be available.   

• Status: Status will be a drop-down list and will contain 2 choices: Active and Inactive. If 
Inactive is selected the contact login is disabled and an “ ” icon will be displayed on 
Contacts summary screen.  If Active is selected the contact login is enabled and an “ ” 
icon will be displayed on the Contacts summary screen. (See Contacts Summary for 
placement details) 

• Rights: Select the appropriate User Rights template from a drop-down box that is 
populated in Setup under User Rights Templates.  

  

Related Topics 

About Regions 

Adding Region Contacts 

Territories 

Branches 

User Rights Templates 

User Rights Templates are used to assign security to the following entities: 

• Organization 

• Carrier 

• Retail Agent 

• Client 

• Additional Interest 

• Premium Finance Co. 

• Tax Authority 

• Vendor 

• Financial Entity 

To add a user template 

1. On the Utility menu, click SETUP. 

2. From the Setup Console, click Security Administration and select the user rights tab. 
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3. Click Add.  Each new template added is automatically stored with the Date Created, Last 
Modified and Modified By which can be seen when an installed template is selected from the 
templates screen. 

4. On the Template screen, enter the following fields: 

• Enter the Template Name in the space provided. 

• Enter a description in the Description field. 

5. To assign security rights for a specific area, select a Core Component from the Security 
Wizard. Selecting View, Add, Modify, Delete or import will grant security access for those 
particular items. 

6. Click Save to save the added Template or Close to cancel without saving.   

To edit a template 

1. Click Edit and select Core Components. 

2. Click Save to save the added Template or Close to cancel.   

Note: When a template is modified all users associated with the template should be synchronized 
to update their security with the modifications.  See below. 

Synchronizing Users Security 

1. Select the user assigned tab.  On the user assigned screen, a list of assigned users is 
displayed.  

2. Click the Synchronize all User(s) button to sync users’ security. 

3. You will be prompted to synchronize all users’ rights. Click OK. 
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If modifications have been made to a template and the users security have not been synchronized, 
a red “ ” will display in the In Sync column.  Once the user(s) security has been synchronized the 
In Sync column will display a green check mark “ ”. 
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Primary Menu 
The Primary menu is the menu located in the upper left of the screen. 

 
The Primary menu contains the following options: 

• SEARCH: The search screen allows you to search for and add an entity, as well as import 
downloaded records. 

• ORGANIZATION: Includes Organization Profile, All Employees, All Locations. 

• REPORTS: Includes Reports, Global Activity, Ad-Hoc. 

  

Additional Interest 

Adding new additional interests is done on the search screen.  Before you can add a new additional 
interest, you must conduct a Search to avoid duplicate entries.   

To add an additional interest 

1. On the Primary menu, click SEARCH. 

2. In the Entity drop-down list select Additional Interest. 

3. Click the Search Button. 

4. Click [Add New Record]. The card file screen is displayed: 

Note: The Add New Record link will not be displayed unless an actual search has been run. 

• Interest Type: Select the Interest Type, such as Finance Company or Certificate Holder. 
 Additional Interest Types can be added to the drop-down list in Setup under Lookup 
Management. 

• Interest Name: Enter the Additional Interest name as you would identify and correspond 
with them.   

• Primary Location: The primary location is automatically assigned to the first location 
added.  The primary location may be reassigned only after other locations have been 
added.   
 
 

• Address: Enter the primary address for this entity.  

• City: Enter the city for the primary address entered in the previous field. 
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• State/Province: Select the state (or Province) for the primary address entered in 
the previous fields. 

• Zip/Postal Code: Enter the zip code for the primary address entered in the 
previous fields. 

• Phone: Enter the phone number without formatting.  Formatting will be applied 
after the screen has been saved. 

• Toll Free: Enter the toll free number without formatting. 

• Fax: Enter the fax number without formatting. 

Note: Once the additional interest has been entered, the Location Types drop-
down box is available on the additional interest locations tab. Additional interest 
Location Types can be added to Nexsure via the Lookup Management screen.  

 
1. On the Utility menu, click Setup. 

2. On the Setup Console, click Lookup Management.  A summary list of 
existing Categories and Types will appear. 

3. From the Category drop-down list, select Additional Interest.  The 
Types available for the Category will be displayed. 

4. Select the Type for the Category (Location Types (Addl Interest).   

5. Select [Add New] in the item list. 

 
6. Enter the Item Label.  This is what will appear in the drop-down list. 

7. Click [Add New] to add the New Item to the drop-down list. 

  

• Primary Contact: Only one contact may be added per entity at the time of initial entry. 
 Additional contacts may be added after the new Additional Interest is saved. 

• Prefix: Use the drop-down box that contains items added by the agency in Setup 
under Lookup Management. 

• First Name: Enter the first name of the contact for this entity. 

• Middle Initial (MI): This field is one character long. Enter the middle initial of the 
contact. 

• Last Name: Enter the last name of the contact. 
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• Suffix: Use the drop-down box that contains items added by the agency in Setup 
under Lookup Management. 

• Title: Use the drop-down box that contains items added by the agency in Setup 
under Lookup Management. The title is used to identify the contacts occupation. 

• Phone: Enter the phone numbers without formatting. Formatting will be applied 
after the screen has been saved. Use the drop-down box to identify the type of 
phone number. Extension numbers may be entered up to six characters. A brief 
description may be entered for each number added. Phone number identities 
initially are as follows: 

• Home phone 

• Cell phone 

• International phone 

• Office phone 

• Pager 

• Personal Fax 

Note: to add additional numbers, see Contacts. 

• E-mail: The E-mail address for the contact is optional, however if the format is 
entered incorrectly an error will be returned to warn of the improper format. The 
field can contain up to 30 characters with alphanumeric data. 

5. Click Save to save the data or click Clear to clear any data entered. Once the additional interest 
has been added, it can be viewed and edited by clicking on it's Details  icon. 

 
  

Additional Interest 

Additional interest entities are designated as entities that have a legal interest in a policy.  These entities 
may include financial institutions, private individuals, mortgage companies, certificate holders, etc. 
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 Additional Interests are created from the search screen and used in the policy, Invoicing Bill To and 
accounting screens of Nexsure. 

To setup an additional interest 

1. You must search for a record before entering a new additional Interest.  On the Primary menu, 
click SEARCH. 

2. From the Entity drop-down list, select Additional Interest, enter search criteria and click Search. 

3. If the institution you wish to add is not already in the system, click [Add New Record]. 

4. On the card file tab, fill in all location and contact information. 

5. Click Save. 

Adding Carriers 

Adding new carriers is done on the search screen. Carriers can be added as traditional carriers or as 
intermediaries (internal or external).  Before you can add a new carrier, you must conduct a search to 
avoid duplicate entries.   

To add a carrier 

1. On the Primary menu, click SEARCH.   

2. In the Entity drop-down list select Carrier. 

3. In the Carrier Category drop-down list, select All, Traditional or Intermediary. 

4. In the Carrier field, enter the name of the carrier (or at least two characters of the name) you wish 
to add and click Search. 

Note: Intermediaries are denoted in the search results by an additional icon  

5. If no record exists, click [Add New Record].  The card file screen is displayed: 

Note: The [Add New Record] link will not display unless an actual search has been run. 

• Carrier Name: Enter the insurance carrier name as you would identify and correspond with 
them.  The first carrier name is automatically designated as the parent company.  This may 
be reassigned only after other names have been added. 

• NAICS Code: Enter the carrier’s NAICS code as provided by the carrier. 

• Carrier Category: Select Traditional or Intermediary. 

• Carrier Types: Select the appropriate check box(es) for the carrier, Issuing, Billing or 
Internal. Note that if Intermediary is selected, the Issuing option is not available. 

• Contract Year: Enter the year the contract with this carrier began (optional). 

• Website: Enter the carrier's web site (optional). 

• AM Best Rating: This field can be used to track the carrier's AM Best or financial rating. 
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• Primary Location: The primary location is automatically assigned to the first location 
added.  The primary location may be reassigned only after other locations have been 
added. 

• Location Type: Use the drop-down box to identify the type of location.  This list may be 
populated in Setup under Lookup Management.  

• Is the above the mailing address for this location?: This option defaults to Yes, if it is 
not, select No and an additional set of address fields will be displayed to enter the mailing 
address. 

• Primary Contact 
 

• Prefix: Use the drop-down box that contains items added by the agency 
in Setup under Lookup Management. 

• First Name: Enter the first name of the contact for this entity. 

• Middle Initial (MI): This field is one character long. Enter the middle 
initial of the contact. 

• Last Name: Enter the last name of the contact. 

• Suffix: Use the drop-down box that contains items added by the agency 
in Setup under Lookup Management. 

• Title: Use the drop-down box that contains items added by the agency in 
Setup under Lookup Management. The title is used to identify the 
contacts occupation. 

• Phone: Enter the phone numbers without formatting. Formatting will be 
applied after the screen has been saved. Use the drop-down box to 
identify the type of phone number. Extension numbers may be entered 
up to six characters. A brief description may be entered for each number 
added. Phone number identities initially are as follows: 

• Home phone 

• Cell phone 

• International phone 

• Office phone 

• Pager 

• Personal Fax 

Note: To add additional numbers, see Contacts. 

• E-mail: The E-mail address for the contact is optional, however if the 
format is entered incorrectly an error will be returned to warn of the 
improper format. The field can contain up to 30 characters with 
alphanumeric data. 

  

6. Click Save to save the data or click Clear to clear any data entered.  The carrier profile will be 
displayed. 
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Understanding Carrier Commission Defaults 

At the policy underwriting level, the policy info tab is completed to set up the invoicing template. When 
the estimated premium amount is added to the policy info tab, Nexsure determines the commissions to 
set as default based on the carrier commission defaults added at the carrier level.  

When adding carrier commission defaults, it is important to understand the order in which Nexsure 
determines which commission to populate to the invoice template. Nexsure may use up to five different 
levels when determining what commission to use. These levels are: Specific Commission Match, Line 
of Business Default (LOB), Department Default, Carrier Default and Organization Default. The 
process of setting commission defaults requires selection of a branch so a branch match is always 
assumed. The order of determination begins by first attempting to match the line of business, specific 
department, carrier and organization. Use the chart below to understand how the commission defaults are 
determined by Nexsure. 

Carrier Commission Default Order 

Specific Commission Match: Nexsure searches for the perfect carrier commission match. This means 
that the branch, carrier, line of business and department must be an exact match to default to the policy 
info screen. If not, Nexsure looks for a line of business default. 

Line of Business (LOB) Default: Only one line of business default may be added for each carrier, each 
line of business for each department and branch. If Nexsure does not find a specific match, it looks for a 
line of business default and uses it. If not, Nexsure looks for a department default. 

Department Default: Only one department default may be added for each department for each branch 
the department is assigned to. If Nexsure does not find a specific commission or line of business default, 
it looks for a department default and uses it if it exists. If not, Nexsure looks for a carrier default. 

Carrier Default: Only one carrier default may be added per carrier for each branch. The subsidiaries 
added to the parent carrier are considered one carrier when it comes to assigning the carrier default. If 
Nexsure does not find a specific match, LOB or department default, it looks for a carrier default and uses 
it if it exists. If not, Nexsure looks for an organization default. 

Organization Default: There is only one organization default per organization. If Nexsure does not find a 
specific match, LOB, department or carrier default, it looks for an organization default and uses it if it 
exists. If one does not exist, no commission will default. 

Adding/Editing Carrier Commissions 

To add or edit carrier commissions 
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1. On the Primary menu, click SEARCH. 

2. Select Carrier in the Entity drop-down box.  

3. Enter a few letters of the Carrier’s name in the Carrier field and click the Search button. 

4. If the carrier does not exist, click the [Add New Record] link. 

5. If the carrier exists, click the Details  icon for the carrier. 

6. Click the commissions tab and update the existing commission by clicking the Details  icon. 

7. Edit the commission details or click [Add New]. 

 

8. Complete the Commission Detail: 

• Select the Branch Name from the drop-down box to identify which branch the commission is 
being setup for.  Proceed to Setting up Defaults.   

• Select the Department Name from the drop-down box to identify which department the 
commission is being setup for. Proceed to Setting up Defaults. 

• Select a Carrier from the drop-down box to identify which carrier the commission is being 
setup for.  Proceed to Setting up Defaults. 

• Select a Line of Business from the drop-down box to identify which line of business the 
commission is being setup for.  Proceed to Setting up Defaults. 

• Enter the required Branch Code. This field is typically identified as the code number 
assigned to the agency by the carrier. The code is also known as the Producer Code. 

9. Set the defaults by clicking the check  box beside each default type which are used as follows: 

• Organization Default: One organization default may be selected as the overall default for 
the entire Nexsure site.   
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Note: There can only be one organization default for an agent’s Nexsure site.  The 
organization default selected should be what best matches the commission that is received 
by the agency most of the time. 

• Department Default: One department default may be selected for each department within a 
branch. For example, two departments may be set up; Commercial Lines and Personal Lines. 
Each department may have a default in this case. If another commission line is added for the 
Commercial Lines department, then the first department default will be overwritten. 

• Carrier Default: One carrier may be selected as the commission default per carrier within a 
branch by selecting the check box beside Carrier Default.  A Carrier Default may be setup for 
each branch. 

Note: There can only be one carrier default per carrier per branch.  The carrier default should 
be selected to best match what commission is received most of the time from that carrier. 

• Line of Business Default: One line of business default may be added for each carrier (Each 
parent with subsidiaries = one carrier), each line of business for each department and each 
branch.  

Note: There can be only one line of business default per line of business, per branch.  A line 
of business default should be set up for each line of business that has a commission 
percentage outside of the carrier default. If a default exists and another default is selected, it 
will overwrite the existing default and become the current default. 

10. Rate Type is what that commission will be calculated from.   

• % Of Premium is defined as a percentage of the premium entered in the Premium field on 
the policy info screen by line of business. 

• Flat Amount is defined as a flat dollar amount entered in the Rate field. 
 

11. Enter the commission rate for New, Renew and Rewritten. Notice the red * asterisks beside each 
rate field, this indicates that something must be entered, even if it is zero. The record will not be 
saved if any required fields are not populated. 

 
12. Enter an amount into the Min. and Max. fields. These fields are used to identify the minimum and 

maximum commissions that would be seen on invoices. These fields are optional and are used for 
reference only. 

 
13. The Eff. Date field automatically populates and identifies the date the commission being added 

becomes effective. Change the Eff. Date field as needed. If this date is outside the policy term 
effective date, the commission will not populate the policy info screen. 
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14. Enter a date into the Exp. Date field. The Exp. Date field is not populated by default. Entering an 
expiration date indicates the date the commission will no longer be valid. Leaving the expiration 
date field blank allows the commission rate to not expire. If this date is outside the Policy Term 
expiration date, the commission will not default to the Policy Info screen. 

Note: If an expiration date is entered that commission will not pull to policies written with an 
effective date after that date.  A new commission, with the new rate and effective date, may be 
added.  The effective date of the policy will determine which commission will be pulled to the 
invoice. 

15. Enter a Quota amount as needed. The Quota amount is for reference only and is optional. Quota 
is the amount of either commission or premium amounts the branch expects to meet for the Eff. 
and Exp. Dates entered. 

16. Click on the Status drop-down box and select Active which is populated by default or Inactive (if 
the commission default is no longer needed). 

17. To finalize the new commission default, click the [Update] link to save changes or click the 
[Cancel] link to abort. 

  

How the System Determines the Proper Carrier Commission 

The system will first try to match line of business, department, carrier and organization default in that 
order. If the match is not exact, the system will search for a default line of business within the branch. If 
no line of business exists within the branch, the system will then search for the department default. If no 
department default exists, the system will then search for the carrier default. Finally, if there is no carrier 
default within the branch, the system will then search for the organization default. If there is no 
organization default the message "No valid default commissions exist" displays and the user will need to 
enter the commission manually.   

  

Related Topics 

Commissions Summary 

  

Adding/Editing Carrier Contacts 

1. On the Contacts summary screen, click [Add New]. This feature allows the current contact 
database to be utilized so that duplicate contact records may be avoided. 

• Beside Apply Contact: select the appropriate option – Search Contact is used to search 
existing contacts and to add as a contact to this entity, or select New Contact to add a 
brand new contact. 
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• Search For Existing Contact Record: Is available when Search Contact is selected. 
 Enter the last name of the contact as the search criteria.  Enter a minimum of two 
characters in order to have valid search criteria.  No wild card searches to search all are 
available.  The Search button will initiate the search and return all matches in a pop-up 
window display.  

• The results will display in alphabetical order by last name. If no results are found the 
message, "No contacts found for xxxxxx” is displayed instead. 

• Select the No Match button if there are no matching contacts. 

• Select the Use Selection button – after highlighting a contact from the list.  If no contact is 
highlighted when the User Selection button is selected the following message is displayed: 
Please select a value for required field.  The selected contact detail is automatically 
populated into the current contact detail screen with exception of Title.   

2. If the New Contact option is selected the contact detail screen is displayed ready for completion. 
  

Field Descriptions: 

• Prefix: Use the drop-down box that contains items added by the agency in Setup under 
Lookup Management.   

• First: Enter the first name of the primary contact for this entity.  The primary contact is 
identified as the person you would call or correspond with most of the time.   

• Middle Initial (MI): This field is one character long. Enter the middle initial of the primary 
contact.   

• Last: Enter the last name of the primary contact. 

• Suffix: Use the drop-down box that contains items added by the agency in Setup under 
Lookup Management. 

• Goes By: Enter the name the contact prefers to be addressed by.  This field may be used in 
letters or email to the entity.   

• Title: Use the drop-down box that contains items added by the agency in Setup under 
Lookup Management. The title is used to identify the contacts occupation.  

• Is this the Primary Contact for this account?: There can only be one primary contact and 
cannot be deleted.  The primary contact can be changed. 

• Personal Numbers: Enter the phone numbers without formatting.  Formatting will be 
applied after the screen has been saved.  Use the drop-down box to identify the type of 
phone number.  Extension numbers may be entered up to six characters.  A brief description 
may be entered for each number added.  Phone number identities are as follows: 

• Home phone 

• Cell phone 

• International phone 

• Office phone 

• Pager 

• Personal Fax 

• To add additional phone numbers: 
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• Click on the [Add New] link to the right of group heading 

• Use the drop-down box to select the identity of the phone number being 
added. 

• Enter the phone numbers without formatting. Formatting will be applied after 
the screen has been saved.  

• The extension numbers may be entered up to six numeric characters. 

• Enter a brief description for the phone number if desired. 

• Click Save to save the phone number just added. 

• Click Close to cancel the addition of the new number. 

• The number of Personal Phone numbers that can be added to each contact 
is not limited. Click [Add New] link to add a new phone number. 

• Click on the Details  icon beside the number to edit. 

• Click on the Delete  icon beside the number to delete. 

• Email: The email address for the contact is optional, however if the format is entered 
incorrectly an error will be returned to warn of the improper format. The screen cannot be 
saved until the format is corrected. The field can contain up to 30 characters with 
alphanumeric data. There are two email addresses to accommodate both work and 
personal as necessary. 

• Locations: Use the drop-down box to select the address where contacts are located.   

• Contact notes: Can be used for any notation about this contact. The notes can only be 
viewed from the contact details screen. 

• Save: The Save button will save new contact information. 

• Cancel: The Cancel link will cancel any modifications or adding a new contact. 

• Delete: The Delete link will delete the contact. The primary contact cannot be deleted but 
can be changed. The delete button will not be present if the contact is set to primary. 

• Update: The Update link will update any modifications to the contact record. 

Contacts Summary 

The Contacts tab displays all contacts added for this entity.  Unlimited contacts may be added for each 
entity but only one can be designated as the primary contact.  The primary assignment will be identified 
as a check box in the Primary column.  The primary may be reassigned but deletion of a primary contact 
is not allowed. 

• The Name link displays a pop-up window with the contact phone numbers, goes by, email address 
and notes.  A document may be created by clicking on the [Create Document] link and a text 
message sent by clicking on the cell phone link if one is present. 

• The E-mail link opens your email client to send an email to the contact. 

• The Details  icon is used to edit the contact. 

• The Remove  icon is used to delete the contact. 
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• Add New: link in the upper right hand corner of the Contacts summary screen within the tabs 
border.  The link will display a blank Contacts Detail screen to add a new contact.  See Carrier 
Contacts Detail for more information. 

  

Related Topics 

To add or edit carrier contacts 

Locations Detail 

1. Clicking on the [Add New] link on the Locations summary screen will display the Locations 
Detail screen. To edit a location see Carrier Locations Summary. 

2. Complete the Locations Detail using the following information: 

• Location Type is used to identify the location. Select the appropriate type from the drop-
down box. 

• Physical Address: The physical address for this location. 

• Mailing Address: The mailing address for this location if different from the physical 
address. 

• Location Phones: Enter the phone numbers without formatting. Formatting will be applied 
after the Locations screen has been saved. Use the drop-down box to identify the type of 
phone number. Extension numbers may be entered up to 6 characters. Phone number 
identities are as follows:  

• After Hours 

• Automated 

• Backline 

• Building Security 

• Business Phone 

• Fax Number 

• Main Fax 

• Phone 

• Receptionist 

• Technical Support   

• Toll Free 

Adding additional phone numbers: 

• Click on the [Add New] link to the right of group heading after 
accessing the location record to edit. 

• Use the drop-down box to select the identity of the phone number being 
added. 

• Enter the phone numbers without formatting.  Formatting will be applied 
after the screen has been saved.  

• The extension numbers may be entered up to 6 numeric characters. 
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• Click on Save to add the new phone number. 

• Click on Close to abort the addition of the new number. 

• As many phone numbers as needed may be added.  

• Click on the Details  icon beside the number to edit.  

• Click on the Delete  icon beside the number to delete. 

• Cancel – The [Cancel] link will abort any modifications or adding a new location. 

• Save – The [Save] link will save new location information. 

• Delete – The [Delete] link will delete the Location.  The primary location cannot be deleted 
but can be changed. The delete link will not be present if the location is set to primary. 

• Update – The [Update] link will update any modifications to the location record. 

  

Locations Summary 

The locations tab displays all locations added for this entity. Unlimited locations may be added for each 
entity but only one can be designated as the primary location. The primary assignment will be identified 
as a check box in the Primary column. The primary may be reassigned but deletion of the primary is not 
allowed. 

• Click on the Address link to connect to expedia.com for a map. 

• Click on the Details  icon to edit or delete the location. 

• Click on the Remove  icon to delete the location. 

  

Related Topics 

Adding/Editing Carrier Locations 

Carrier Names Detail 

1. Clicking on the [Add New] link on the Carrier Names summary screen will display the Carrier 
Names Detail screen.  To edit a carrier name see Carrier Summary Names. 
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2. Complete the Carrier Names Detail using the following information: 

• Carrier Name - Enter to identify the carrier. 

• Carrier Type - Identifies if the carrier is the issuing, billing or both. The issuing check box 
identifies the carrier writing the policy. The billing check box identifies the carrier who will 
either pay the branch or bill the branch.  

• Carrier DB Rule - This option is available if "Override by Carrier" is selected in the Posting 
Rules. "Post Direct Bill Commission to General Ledger" will be selected (by default) if Direct 
Bill Invoice General Ledger Posting is set to "Post to the General Ledger" in the posting 
rules. If the default is changed, all previous invoices will retain their posting rule at the time 
they were posted. Reversals will use the original invoice posting rule. 

If this option is not selected, direct bill invoice activity will not be available for reconciliation, 
receive payment or disbursement. No aspect of the invoice will post to the general ledger. 

• Website: Enter the carriers web site address. 

• Contract Year: Entering the contact year is optional. 

• AM Best Rating: Entered by the branch. 

• NAIC Code: Entered by the branch. 

• Carrier Email: The email address for the carrier is optional, however if the format is entered 
incorrectly an error will be returned to warn of the improper format. The screen cannot be 
saved until the format is correct. The field can contain up to 30 characters with 
alphanumeric data. 

• Notes: Enter any appropriate notes. 

• Cancel – The [Cancel] link will abort any modifications or adding a new Location. 

• Save – The [Save] link will save new location information. 

• Location (s): Click the [Add New] link to select or add the address for this carrier. There 
is no limit to the number of addresses that may be added.  

• Existing addresses may be added by selecting Use Existing. Select an 
existing address from the drop-down box which is populated from locations 
added to the carrier. A new location may also be added here, by selecting 
the [Add New] option.  Complete information should be populated by 
accessing the carrier location tab and click on the Details   icon to edit. 
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• Locations may be removed or edited by the following: 

• Click on the Details  icon to edit. 

• Click on the Remove  icon to delete.  This icon does not display on 
the primary location. 

Commissions Summary 

The commissions summary tab displays all commissions added for the parent carrier. Unlimited 
commissions may be added for each. A default may be set for each carrier added to the parent for each 
of the following: 

• Line of Business 

• Department 

• Carrier 

• Organization 

Each default is marked with a checked box in the appropriate column when the defaults are set. If a 
commission assignment is added other than the default, that commission will default on the client invoice 
if the line of business, department, carrier and organization match. 

The icons displayed on the summary screen are as follows: 

• Click on the Details  icon to edit. 

• Click on the Remove  icon to delete. 

  

Related Topics 

To add or edit new commissions 

Carrier Names Summary 

1. The Carrier Names tab displays all carriers added for this parent carrier.  Unlimited carriers may 
be added for each but only one can be designated as the parent carrier.  The parent assignment 
will be identified as a check box in the Parent column.  The parent may be reassigned but it cannot 
be deleted. 

• Click on the Details  icon to edit. 

• Click on the Remove  icon to delete. 

2. [Add New]: Select the link found in the upper right hand corner of the summary screen within the 
tabs border to display a blank data input Carrier Names Detail screen to add a new carrier. (For 
more information see Carrier Locations Detail.) 

Adding Suspects, Prospects and Clients 

Adding new suspects, prospects and clients is done on the Search screen. Before you can add a new 
client, you must conduct a Search to avoid duplicate entries.   

To add a client 
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1. On the Primary menu, click SEARCH. 

2. In the Entity drop-down list select Client. 

3. Enter the First Name and Last Name in the appropriate fields. 

4. Click the Search Button.   

5. Click [Add New Record]. The Add New Client screen is displayed: 

Note: The [Add New Record] link will not display unless an actual search has been run. 

6. On the client tab, enter the client information. 
 

• Client Name: Enter the client name as you would identify and correspond with them. 
The client name entered here will automatically be identified as the Primary (First 
Named Insured) in the Named Insured list located at client level. 

• Primary Account Address data: 

• Location Name: Enter a name that will easily identify the location among a 
list of many. 

• Address: Enter the primary address for this insured. The primary address 
is the location you will send correspondence or invoices to. 

• City: Enter the city for the primary address entered in the previous field. 

• State: Select the state for the primary address entered in the previous 
fields. 

• Zip: Enter the zip code for the primary address entered in the previous 
fields. 

• Phone: Enter the phone number without formatting. Formatting will be 
applied after the client screen has been saved. (Note: to add additional 
numbers, see Locations.) 

• Fax: Enter the fax number without formatting. Formatting will be applied 
after the client screen has been saved. (Note: to add additional numbers, 
see Locations.) 

• Account Assignment: 

• Branch: From the drop-down box select the branch to assign for this new 
entity. Branches are added to the organization by the administrator. 

• Primary Producer: From the drop-down box select the producer to assign 
the producer for this new entity. Producers are added to the organizations 
by the administrator. 

• Account Manager: From the drop-down box select the account manager 
to assign for this new entity. Producers are added to the organizations by 
the administrator. 

• Go Directly to Profile Page: By default the box is checked, un-check if completion 
of the profile screen is not needed. The profile screen contains questions about the 
client, prospect or suspect that may be useful to determine if the account is a fit for 
the entity. 
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• Primary Contact data: (Multiple contacts may be added, for additional information 
see Contacts) 

• Client Type: Use the drop-down box to identify if this account should be 
identified as a Personal or Commercial Client Type.  

• Prefix: Use the drop-down box that contains items that are added by the 
agency in Setup under Lookup Management. 

• First Name: Enter the first name of the primary contact for this entity. The 
primary contact is identified as the person you would call or correspond 
with most of the time. 

• Middle Initial: This field is one character long. Enter the middle initial of 
the primary contact. 

• Last Name: Enter the last name of the primary contact. 

• Suffix: Use the drop-down box that contains items that are added by the 
agency in Setup under Lookup Management. 

• Title: Use the drop-down box that contains items that are added by the 
agency in Setup under Lookup Management. The title is used to identify 
the contacts occupation. 

• Contact Role: Use the drop-down box that contains items that are added 
by the agency in Setup under Lookup Management. The role is used to 
identify the contacts role with the Branch on behalf of the named insured. 

• Phone: Enter the phone numbers without formatting. Formatting will be 
applied after the Client screen has been saved. Use the drop-down box to 
identify the type of phone number. Extension numbers may be entered up 
to 6 characters. Phone number identities are as follows: 

• 2nd Phone Line 

• Business Phone  

• Car Phone 

• Home Phone 

• International 

• Pager 

• Personal Fax 

• Underwriting. 

Note: To add additional numbers, see Contacts. 

• Email: The email address for the contact is optional, however if the format 
is entered incorrectly an error will be returned to warn of the improper 
format. The field can contain up to 30 characters with alphanumeric data. 

7. Click Save.   

Financial Entity 

Financial entities are banks used by the organization. Financial entities are created from the search 
screen and used in the accounting screens of Nexsure. 
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To setup a financial entity 

1. You must search for a record before entering a new one. On the Primary menu, click SEARCH. 

2. From the Entity drop-down list, select Financial Entity, enter search criteria and click Search. 

3. If the entity you wish to add is not already in the system, click [Add New Record]. 

4. On the card file tab, fill in all location and contact information. 

5. Click Save.  

Premium Finance Company Setup 

Premium finance companies are outside entities used by the organization to finance policies.  Premium 
finance companies are created from the search screen and are used as an alternate Bill To in the 
invoicing and accounting screens of Nexsure. 

To setup a premium finance company 

1. You must search for a record before entering a new one. On the Primary menu, click SEARCH. 

2. From the Entity drop-down list, select Premium Finance Company. 

3. Enter search criteria and click Search. 

4. If the premium finance company you wish to add is not already in the system, click [Add New 
Record]. 

5. On the card file tab, fill in all location and contact information. 

6. Click Save. 

Adding Retail Agents 

Retail agents are outside producers that broker business through another agency because they do not 
have a market.  Once they have been added to the system, retail agents can view actions, opportunities, 
marketing, policies and attachments as they pertain to the individual retail agent. Before you can add a 
new retail agent, you must conduct a search to avoid duplicate entries. 

To add a retail agent 

1. On the Primary menu, click SEARCH. 

2. In the Entities drop-down box, select Retail Agent.  Any previously accessed retail agents will be 
displayed automatically. 

3. Enter the name of the retail agent in the Name field or enter "%%" to display all existing retail 
agents. 

4. Click Search. 
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5. If the retail agent is in the system, click the Details  icon for the appropriate retail agent. If the 
retail agent does not appear, click [Add New Record]. 

6. Enter the card file information: 

• Agency Name 

• Primary Location 

• Primary Contact Name 

• Phone Numbers 

7. Click Save. 

 
  

Related Topics 

Retail Agent Profile 

Retail Agent Contracts 

Retail Agent Commissions 

Retail Agent Commissions 

Important: Please note that retail agent billing is a future enhancement to Nexsure. While retail agent 
commissions can be set up, please note that retail agent billing is not yet available. Commission 
selections may change with the future addition of retail agent billing. 

Retail Agent Contracts 

The retail agent contracts tab stores the agent's contract information, errors and omissions coverage and 
license information. 

To enter contract details  
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1. On the Primary menu, Click Search. 

2. Click the Entity drop-down box and select the Retail Agent. 

3. Click the Details  icon of the retail agent. 

4. Click the contracts tab. 

5. Enter the contract information.  When complete, click Save Contract.  Click Copy to create a 
duplicate of the same contract. To update the contract at a later point, select the contract on the 
contracts tab by clicking the Details  icon, make the changes and click Save Contract. 

 
  

Contract Information 

• Contract Number 

• Contract Name 

• Effective/Expiration Dates 

• Contract Name 

• Description 

  

Errors & Omissions Coverage 

• Carrier Name 

• Policy Number 

• Limit of Liability 

• Effective/Expiration Dates 

  

License Information 

The Contract Details must be saved (Click Save Contract) before adding license information.  

• State/Province 

• License Number 

• License Type 

• Effective/Expiration Date 

Tip: If you have administrator rights, custom license types can be added via Lookup Management. 
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1. On the Utility menu, click Setup. 

2. In the Setup Console, click Lookup Management. 

3. In the Category drop-down list, select Retail Agent. 

4. In the Types box, select License Types. 

5. In the Select Item box, select Add New. 

6. In the License Type field, enter the name of the license type. 

Retail Agent Profile 

The retail agent profile manages all contact, assignment, contracts and commissions information for retail 
agents once they have been added into Nexsure. 

To access the retail agent profile 

1. On the Primary menu, click SEARCH. 

2. Search for and select the retail agent by clicking the Details  icon. The retail agent profile will 
appear: 

 
Card File - The card file displays the agency contact and assignment information 

Contacts - Displays contact information as originally added. Contacts information includes: 

• Contact Name 

• Contact Role 

• Personal Numbers 

• Email 

• Contact Notes 
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To add a new contact, click [Add New]. To modify the existing contact, click the 
Details  icon. After making changes, click the Update link. 

Locations - Displays location information as originally added. Location information includes: 

• Location Type 

• Location Numbers 

• Physical Address 

• Mailing Address 

To add a new location, click [Add New]. To modify the existing contact, click the 
Details  icon. After making changes, click the Update link. 

Retail Agent Name - Displays the agency name and website. This tab also allows you to Activate or 
Inactivate a retail agent.  Selecting Inactivate will put a line through the retail agents name, serving as a 
reminder that the agent is not currently being worked with.  Selecting Activate will remove the line 
through the name. 

Assignment - Branch: Select the appropriate branch for this client department: Select a department 
within the specified branch for this client. (Departments are a sub-set of the Branch. IE: Personal or 
Commercial Lines). 

Unit: Select a unit pertaining to the department, if applicable. Units are not required. (Units are a 
sub-set of the Department. IE: Home, Auto or Other) 

Responsibility: Select the appropriate responsibility. The responsibilities appearing in the drop-
down box can be added to in Setup, Lookup Management. 

Name: Select the name of the person responsible for this client. The Names appearing in the drop-
down box are appointed from the employees title at the branch level. 

Primary: Check this box to set this assignment as the primary responsibility for the account.   

Note: A primary assignment cannot be deleted, it must either be revised or a new assignment can 
be added, designated as primary, then the old primary can be deleted. 

Contracts - See Retail Agent Contracts 

Commissions - See Retail Agent Commissions 

Retail Agent Setup 

Retail agents are outside producers that broker business through another agency because they do not 
have a market.   Retail agents are created from the search screen and used in the policy assignment, 
invoicing Bill To and accounting screens of Nexsure. 

To setup a retail agent 

1. You must search for a record before entering a new one.  On the Primary menu, click Search. 

2. From the Entity drop-down list, select Retail Agent, enter search criteria and click Search. 

3. If the retail agent you wish to add is not already in the system, click [Add New Record]. 

4. On the card file tab, fill in all location and contact information. 

5. Click Save. 
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Tax Authority Setup 

Tax Authorities are entities which policy generated taxes are paid.  Tax Authorities are created on the 
Search screen and are used in the Accounting screens of Nexsure. 

To setup a tax authority 

1. You must search for a record before entering a new one.  On the Primary menu, click SEARCH. 

2. From the Entity drop-down list, select Tax Authority, enter search criteria and click Search. 

3. If the tax authority you wish to add is not already in the system, click [Add New Record]. 

4. On the card file tab, fill in all location and contact information. 

5. Click Save. 

Adding a Vendor 

Vendors are outside entities to which payments are made for operating expenses such as rent, office 
supplies, etc.  Vendors are created on the search screen and used in the accounting screens of Nexsure. 

1. On the Primary menu, click SEARCH. 

2. Click the Entity drop-down box and select Vendor. 

3. Type the vendor name in the Vendor field and click Search.  The vendor name, entered here will 
prefill to the vendor card file tab. 

Note: The [Add New Record] link will not display unless an actual search has been run. 

4. If vendor is not in the system, click the [Add New Record] link. 

Vendor Info: 

• Complete the Vendors Name 

• Enter the Vendor’s Web site, if applicable. 

• Primary Account Address:  

• Select the Location Type from the drop-down box 

• Enter the Vendors Location Address 

• Enter the Vendors City  

Note: Clicking on the ellipsis button after the City will display all Cities and Zip Codes 
associated to the city entered.  Select the applicable City, State and Zip code from the drop-
down box and click Use Selection to prefill the State and Zip Code fields to the card file. 

• Enter the State 

• Enter the Zip Code - If the City and State are unknown, enter the Zip code.  Clicking on the 
ellipsis button after the Zip Code field will display the City and State associated to the Zip 
Code.  Click Use Selection to prefill the City and State fields to the card file. 
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• Enter the Location’s phone number.  (No formatting is needed). 

• Primary Contact: 

• Apply Contact: 

• Use Existing: Select this option to search all contacts in Nexsure. 
 

• Enter at least two characters in the Last Name fields. 

• Click Search 

• If the contact is found click on the name and click the Save Button. 

• If the contact is not found, select Add New. 

  

• Add New: Select the prefix from the drop-down box.  Items may be added to the drop-down 
box in Setup under Lookup Management. 
 

• Enter the First Name of the contact. 

• Enter the Middle Initial (MI) of the contact. 

• Enter the Last Name of the contact. 

• Select the Suffix from the drop-down box.  Items may be added to the drop-down 
box in Setup under Lookup Management. 

• Select the Title from the drop-down box.  Items may be added to the drop-down 
box in Setup under Lookup Management. 

• Select the Contact Role from the drop-down box.  Items may be added to the 
drop-down box in Setup under Lookup Management. 

• The E-Mail address for the contact is optional, however if the format is entered 
incorrectly an error will be returned to warn of the improper format.  The E-Mail 
address field must contain the @ and . signs. 

• Phone Numbers: 

• Select the Type of phone number from the drop-down box. 

• Enter the phone numbers, without formatting, for this contact.  Formatting will 
be applied after the screen has been saved. 

• Up to a six digit Extension may be entered. 

• A description may be entered for each number using alpha or numeric 
characters. 

 
Note: Items with a red * asterisk are required fields. 

5. Click Save. The Clear button will clear the screen of all information except the Vendor Name. 
Once the information is saved the vendor card file will be displayed. 
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6. Click the Details   icon on the contacts and locations tab to make updates or changes. 

 

7. Select the vendor name tab to enter the following information: 

Vendor Name - Make changes to the Vendor Name. 

WebSite - Make changes to the Vendor Web site. 

Federal Tax ID - Enter the Federal Tax ID for the vendor. 

Account Number - Enter your agency's account number with the vendor. 

Active - Selected by default. If your agency is not currently doing business with this vendor, clear 
the box to designate them as inactive. 

1099 - Select this box if the vendor is on 1099 status with your agency. This box must be selected 
to be included in the year end Vendor 1099 Disbursement Details  report. 

   

Related Topics 

Working with Vendors 

Disbursements 

Accounts Payable 
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Client Menu 
The Client menu is available for accessing the following area of Nexsure: 

  

• CLIENT PROFILE 

• MARKETING 

• POLICIES 

• SERVICING 

• ATTACHMENTS 

• TRANSACTIONS 

• T-LOG 

Profiling 

The Profiling screen can be used to pre-qualify an account if desired, or to capture information about the 
account you can quickly refer to at any time. 

1. Complete the profiling screen using the following information: 

• Client Type: Use the drop-down box to designate the client as a Personal or Commercial 
client. 

• Source: Use the drop-down box created in setup to designate where this client originated 
from. 

• Account Notes: Enter any appropriate notes. 

• Business Type: Use the drop-down box that contains items added by the agency in 
setup. 

• Years in business: Enter the number of years client has been in business. 

• No of Employees: Enter the number of client employees. 

• No of Locations: Enter the number of client locations. 

• No of Vehicles: Enter the number of client vehicles. 

• Estimated Annual Gross Sales: Enter the client’s estimated annual gross sales 
amount. 

• Estimated Commission: Enter the estimated commission amount to be derived from 
the client’s entire account. 

• Monthly Payroll: Enter the client’s monthly payroll amount. 

• No of states: Enter the number of states the client does business in. 

• Home Office State/Province: Select the client’s home office State / Province from the 
drop-down box. 

• On line business: Select the appropriate option. 

• TV/Radio Advertisement: Select the appropriate option. 
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2. Click on the Save link to keep data entered. 

  

Related Topics 

Opportunities 

Adding a Client Contact 

Every entity entered in Nexsure through search will have a contacts tab. The contacts tab will display all 
contacts that have been entered for the selected entity in a summary view.  An unlimited number of 
contacts may be added for each entity, but not every entity type is required to have a contact.  The first 
contact entered, when adding a new entity, will be designated as the primary contact and will be 
displayed in the contacts summary view with a checkmark in the Primary check box. A primary contact 
cannot be deleted, to change or delete a primary contact see Changing a Primary Contact. 

Note: Clicking on the Active links in the contact summary view will display information pertinent to that 
contact. 

Adding a contact 

1. On the Primary menu, Click SEARCH. 

2. Click the Entity drop-down box and select the appropriate entity. 

3. Click the Details  icon of the entity. 

4. Click the contacts tab. 

5. Click the [Add New] link. 

6. The contact detail tab will be displayed.  Before a contact is added, a search should always be 
done first.  A contact need only be added to the Nexsure database once.  Once the contact is 
added, it can be related to an unlimited number of entities, in any capacity. 

• Apply Contact: 

• Search Contact: 

• The Search Contact option button will be selected by default; this will allow a search of all 
Contacts in the Nexsure database. 

• Enter at least two characters in the Last Name field. 

7. Click Search.  If the contact is found, click the name and click Use Selection.  The contact 
information will be brought over and associated to this entity.  There are four fields in the contacts 
details unique to the contact’s relationship to the entity, they are listed below.  All other fields apply 
to the contact globally and if updated, it will update all records of this contact through out Nexsure. 

Four Unique Fields: 

• Title 

• Primary Contact 
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• Contact Role  

• Location 

8. If the contact is not found, select New Contact. 

Contact Information: 

• Select the Prefix from the drop-down box.  Items may be added to the drop-down box in 
Setup under Lookup Management. 

• Enter the First Name of the contact. 

• Enter the Middle Initial (MI) of the contact. 

• Enter the Last Name of the contact. 

• Select the Suffix from the drop-down box.  Items may be added to the drop-down box in 
Setup under Lookup Management. 

• Enter the Goes By name for the contact, if applicable. 

• Select the Title from the drop-down box.  Items may be added to the drop-down box in 
Setup under Lookup Management. 

• Select the Sex from the drop-down box. 

• Enter the Date of Birth (DOB) using the calendar icon or keying the date in using the 
correct formatting. 

• Enter the Social Security No. using the correct formatting, if applicable. 

• Select the Marital Status from the drop-down box.  Items may be added to the drop-down 
box in Setup under Lookup Management. 

Driver Information: 

• Select the State Licensed from the drop-down box. 

• Enter the License Number. 

• Enter the Date Licensed using the calendar icon or keying the date in using the correct 
formatting. 

• Select Yes or No to designate this contact as the primary contact for this entity. 

• Select the Contact Role from the drop-down box.  Items may be added to the drop-down 
box in Setup under Lookup Management. 

 
Note: The information displayed on the contacts tab may vary by entity. 

Personal Numbers: 

• Select the Type of phone number from the drop-down box.  Items may be added to the 
drop-down box in Setup under Lookup Management. 

• Enter the phone number, without formatting, for this contact.  Formatting will be applied 
after the screen has been saved. 

• Up to a six digit extension may be entered. 

• A description may be entered for each number using alpha or numeric characters. 
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• Enter the E-Mail address for the contact using the correct formatting.  The E-Mail address 
field must contain the @ and . symbols.  There are two E-mail address fields available to 
accommodate both a work and personal E-mail addresses. 

 
Note: E-Mail addresses should be obtained for all contacts. E-mail addresses are placed 
into a global Address Book, and made available on the delivery screen. 

Locations: 

• Select the Primary Account Location for this contact from the drop-down box. The 
locations available in the drop-down box will prefill from the locations tab of the entity. 

Contact Notes: 

• Enter any notes regarding this contact. 
 

Note: Keep in mind when entering contact notes that access may be given by the agency 
to allow contacts access to their Nexsure site. 

  

Related Topics 

Changing a Primary Contact 

Editing Client Contacts 

Contacts Security 

Changing a Primary Contact 

The first contact entered, when adding a new entity, will be designated as the primary contact and will be 
displayed in the contacts summary view with a checkmark in the Primary check box.   

Note: A primary contact cannot be deleted.  To change or delete a primary contact another contact will 
need to be assigned as primary. 

To change a primary contact 

1. On the Primary menu, click SEARCH. 

2. Click the Entity drop-down box and select the appropriate entity. 

3. Click the Details  icon of the entity. 

4. Click the contacts tab. If there is only one contact displayed, it will be designated as primary and a 
second contact will need to be added.  See Adding a Contact to add a second contact. 

5. Select Yes to designate the new contact as the primary contact for this entity.  If the person to be 
designated as the new primary contact is displayed, click on their Details   icon, select Yes to 
the Is this the Primary Contact for this Account? question and click the [Update] link. 

6. In the contacts tab summary view the newly appointed primary contact will be displayed with a 
checkmark in the Primary check box.  The old primary contact will now have a Remove   icon. 
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7. Click on the Remove   icon to delete the old primary contact, if applicable.  If the remove icon is 
not available, see the Nexsure point person within the agency for assistance. 

  

Related Topics 

Adding Client Contacts 

Editing Client Contacts 

Contacts Security 

Contacts Security 

Security may be given to allow access to the agent’s Nexsure site. There are two types of contacts 
available at this time that may be given security rights, employees of the agency and client contacts. The 
options selected for the contact on the security login information screen will be unique to that contact. In 
order for the options selected to apply they must be enabled on the security policy tab found in Setup > 
Security Administration. The contacts security will supersede the organization defaults that are setup in 
Setup > Security Administration. It is the agent’s ultimate responsibility to maintain their site’s security 
and to train outside entities, which have been granted access to their Nexsure site. 

To add security 

1. On the Primary menu, click SEARCH. 

2. Click the Entity drop-down box and select the appropriate entity. 

3. Click the Details  icon of the entity. 

4. Click the contacts tab. 

5. Click the Details  icon of the appropriate contact. 

6. Scroll to the bottom of the contact detail screen and click the here link to make this contact a 
user. The Security login information screen is displayed. 

• Enter a login name for the contact. Login names can only be used once, a good rule of 
thumb, when assigning login names, is to use the contacts email address omitting the ".com" 
at the end. 

• Enter a Password for the contact. The password should be unique and contain a combination 
of unique characters, such as $ or % signs and alpha and numeric characters. 

• Re-enter the Password in the Confirm Password field. This field requires the password be 
re-entered correctly. If incorrect, a warning window will display with this message: Specified 
passwords do not match. Click OK on the warning message and correct the password fields. 

• Select the time zone from the drop-down box and click the check box to automatically adjust 
the clock for daylight savings time for this contact. 

• Enter a Login expiration date, using the calendar icon or keying the date in using the correct 
formatting, if applicable. 

• Enter the time of day the login will expire. 
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• Click the Change of Password required check box to allow the contact to change the 
password assigned by the agency upon logging in to Nexsure for the first time. 

• To set a time restriction for accessing the agent’s Nexsure site for the contact enter a time in 
both the Access allowed from and Access allowed until fields. 

• Click the Notify admin upon login check box to have an email sent to the administrator in 
the agency when this contact logs into their Nexsure site.  The email is sent to the email 
address found on the Security policy tab in Setup > Security Administration. 

• Click the Allow login on Saturdays and Allow login on Sundays check boxes to allow the 
contact to login on these days. 

• Click the Login disabled check box to disable the login for the contact. 

 
• Click the [Save] link to save or the [Cancel] link to abort. 

7. Once the Login Information has been saved, the contact must be assigned to a User Rights 
Template.  User Rights Templates allow the agency to assign security to a group of people 
needing the same access to the agent’s Nexsure site.  This eliminates the need to setup security 
for an individual.  User rights are created in Setup > Security Administration > User Rights 
Templates tab. 
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8. Scroll to the bottom of the Login Information screen and click the [Add New] link.  The User 
Rights Information pop-up window will be displayed. 

  

• Select the Entity Type from the drop-down box. The drop-down box will display only the 
appropriate entity type defined by the area in Nexsure where the contact’s security is being 
setup.  (IE: Client, Employee, Retail Agent, Underwriter, Outside Finance Company or 
Additional Interest)  If a client contact, then the entity type available will be client. 

• Select the Entity Name from the drop-down box. The drop-down box will display only the 
appropriate entity names defined by the area in Nexsure where the contact’s security is being 
setup. 

• Select the Status from the drop-down box.  If Active is selected the contact login is enabled 
and an active key “  ” icon will be displayed on the contacts summary screen.  If Inactive is 
selected the contact login is disabled and an inactive key “  ” icon will be displayed on 
contacts summary screen.   

• Select the appropriate User Rights template for this contact from the drop-down box. User 
Rights are created in Setup > Security Administration > User Rights Templates. 

9. Click Add to add User Rights for this contact or cancel to abort. 

  

Related Topics 

Adding Client Contacts 

Editing Client Contacts 

Changing a Primary Contact 

User Rights Templates 

  

Editing Client Contacts 

Contact information may be changed or updated as needed.  There are four fields in the contacts details 
that are unique to the contact’s relationship to an entity and if update, will only affect this record.  The four 
unique fields are Title, Primary Contact, Contact Role and Location.  All other fields apply to the contact 
globally and if updated, it will update all records of this contact throughout Nexsure. 

To edit a client contact 

1. On the Primary menu, click SEARCH. 
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2. Click the Entity drop-down box, select and search for the appropriate entity. 

3. Click the Details  icon of the entity. 

4. Click the contacts tab. 

5. All contacts for this entity will display in a summary view. 

6. Click the Details  icon of the appropriate contact. 

7. Edit the information as needed. 

8. Click the [Update] link. 

  

Related Topics 

Adding Client Contacts 

Changing a Primary Contact 

Contacts Security 

Adding Locations 

1. On the Client Locations summary screen, click [Add New], the Locations Detail screen will 
appear. 

2. Complete the Locations Detail using the following information: 

• Location Type: Use the drop-down list to select from the location types entered in setup. 

• Locations Name: Enter an identifying location name if desired. 

• Primary Location for this account: The main address for this entity.  This is generally used 
for mailing invoices and correspondence. 

• Billing Location for this account: The default billing address where invoices are mailed. 

• Physical Address: The physical address for this location. 

• If the billing address is different from the physical address, make sure to indicate by 
addressing this question and completing the billing address section.   

• Mailing Address: The mailing address for this location if different from the physical address. 

• Location Numbers: Enter the phone numbers without formatting. Formatting will be applied 
after the Locations screen has been saved.  Use the drop-down list to identify the type of 
phone number.  Extension numbers may be entered up to six characters.  

• Cancel – The Cancel button will abort any modifications or adding a new location. 

• Save – The Save button will save new location information. 

• Delete – The Delete button will delete the Location. The primary location cannot be deleted 
but can be changed. The delete button will not be present if the location is set to primary.   
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• Update – The Update button will update any modifications to the location record.   

  

Adding additional phone numbers:  

1. Click the [Add New] link to the right of group heading after accessing the location record to 
edit. 

2. Use the drop-down box to select the identity of the phone number being added.   

3. Enter the phone numbers without formatting. Formatting will be applied after the screen has 
been saved.  

4. The extension numbers may be entered up to six numeric characters. 

5. Click on the Save button to save the phone number just added. 

6. Click on the Close button to abort the addition of the new number. 

7. The number of phone numbers that can be added to each location is only limited by the 
identity choices.  Click Add New to add a new phone number. 

8. Click on the Details  icon beside the number to edit. 

9. Click on the Delete  icon beside the number to delete. 

  

Related Topics 

Locations Summary 

Locations Summary 

The client locations tab displays all locations added for this entity.  You can add unlimited locations to an 
entity, but only one can be designated as the primary location.  You can designate the primary location by 
selecting the check box in the Primary column.  You can reassign primary contacts, but they cannot be 
deleted. 

• Click on the Address link to connect to mapquest.com for a map. 

• Click on the Details  icon to edit or delete the location. 

  

Related Topics 

Adding Locations 

Adding Named Insureds 

To add a named insured 
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1. On the named insureds summary screen, click [Add New]. 

2. Complete the Named Insureds Detail screen: 

 
• Named: Enter name of named insured. 

• Interest/Misc: This field may used to record interest, percentage of ownership, locations 
that pertain to particular named insured, etc. The information in this field will pre-fill to the 
new Named Insured Schedule “Interest/Misc.” field. 

• Organization Legal Entity Type: Use the drop-down box to designate the legal entity 
type (corporation, LLC, Non-profit etc.) of the named insured being added. 

• FEIN/SSN: Select the FEIN or Social Security Number option and enter the number in 
the field.  The number will be automatically formatted based on which option is selected. 

• Website: The web site address for the named insured is optional.   

• Is this a DBA Name: Select the appropriate option. 

• Is this the Primary Named Insured?: Selecting the Yes option will change a prior 
Primary Named Insured to the named insured being entered. 

 
• Long named insured: Enter complete named insured (if longer than ACORD 60 

character limit). 

• Description: Enter nature of business description. Information from this area will pre-fill 
to the ACORD 125 Nature of Business section. 

• Year Started: Enter the year business was started. 

• Gross Receipts: Enter the business gross receipts amount. In the adjacent drop-down 
box, select annually or monthly. 

• Number of Employees: Enter the number of employees. 

• NAICS/SIC: (Primary named insured only) Enter the NAICS/SIC codes. To add a new 
code 
 

a. At the NAICS/SIC field, click [Add New]. 
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b. In the Search by: drop-down list, select the search criteria: 

• NAICS Code 

• NAICS Description 

• SIC Code 

• SIC Description 

c. Click Search. 

d. Select the code you wish to add and click Save. 

3. Click Save or Cancel. 

Related Topics 

Named Insureds Summary 

Named Insureds Summary 

The named insureds tab displays all Named Insureds added for this entity. You can add unlimited 
named insureds for each entity, but only one can be designated as the primary named insured.  The 
primary assignment will be selected in the Primary column.  Primaries can be reassigned, but not 
deleted. This tab also allows you to activate or inactivate a named insured. 

 
• Import/Export - Click Import to import an Excel (.xls file) into the named insured summary. Click 

Export to save the named insured record as a .xls file. 

Note: When exporting a file, you must change the file extension to .xls before saving. 

• Click on the Details  icon to edit the named insured. 

• DBA - Indicates weather or not the named insured is "Doing Business As". (commercial account 
only) 

• URL - Displays the URL link to access the entity's website. 

• FEIN/SS# - Displays the FEIN or Social Security number as entered in the named insured details. 
(commercial account only) 

• Activate/Inactivate -   Selecting Inactivate will put a line through the named insured's name, 
serving as a reminder that the named insured is not currently being worked with.  Selecting 
Activate will remove the line through the name. 

  

Related Topics 

Adding Named Insureds 
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Adding Related Accounts 

Customers are cross-referenced by assigning an account relationship.  When assigning an account 
relationship, determine if the related account being added is Personal or Commercial.  You must enter a 
few characters of their name for the search.  Highlight the appropriate entity and identify the relationship 
type and if the relationship should be added to the related account.  If you relate a relationship to the 
other entity, the relationship is automatically added. 

  Q.  Why add account relationships? 

A1.  By adding account relationships, you can quickly see if a personal lines account is perhaps the 
owner of one of the branch’s commercial lines accounts. This could be important if the son on the 
personal auto policy had one too many tickets and the carrier wanted to cancel and the personal 
lines account manager does not know the commercial lines account exists and allows the 
cancellation to go through causing the large commercial account to be lost as well.  This may not 
have happened if there had been an account relationship association. 

A2.  An account in your branch is a franchise account and has many locations with different managers. 
 To keep each account separate with a different name and address each were set up as different 
clients.  However, the main office wants to receive all the invoices separately for each location.  By 
adding the account relationship to each entity, the invoice may be billed to the main office as 
requested by your client.   

To Add Related Accounts 

1. Select the client to add the related account to.   

2. Select the related accounts tab.   

3. Click [Add New].  The related accounts detail screen will appear.  

4. Search by: Select the appropriate search categories from the drop-down boxes.  Enter a minimum 
of two characters in the search window in order to have valid criteria for a search. No wild card 
searches to search all are available. The Search button will initiate the search and return all 
suitable matches.   

5. Highlight the appropriate entity to associate. The results will display in alphabetical order. If no 
results were found the message, No Results Found on Search is displayed instead.   

6. When commercial is selected, the following choices will be available. The agency will have the 
ability to add in setup.   

The Related Account is – this is the identification of the associated account that corresponds 
with the Relationship Type. Below are some examples: 

 Relationship Type Selected  The related Account is 

 Franchiser  Franchisee 

 Partner  Partner 

 PEO  Client Company 
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 Corporation  Subsidiary 

 Commercial  Personal 

 
• When personal is selected, the following choices will be available.  The agency will have the 

ability to add in setup. 
 

 

The Related Account is – this is the identification of the associated account that corresponds 
with the Relationship Type. 

 Relationship Type Selected  The related Account is 

 Commercial  Personal 

  

Related Topics 

Related Accounts Summary 

Related Accounts Summary 

1. The related accounts tab displays all related accounts added for this entity.  Unlimited related 
accounts may be added for each entity.  

• Click on the related account link to display the Related Accounts Client screen. 
• Click on the Details  to view the Related Account detail. 

Related Topics 

Adding Related Accounts 

Assignment Tab 

The Assignment is the person within the agency responsible for the client and/or client’s policy. An 
assignment is appointed when the client is first entered in Nexsure, this assignment will automatically be 
designated as primary.  There are two levels of assignments, client level assignment(s) and policy level 
assignment(s).   

Client Level Assignment 

This level pertains to the overall client account. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. Click the assignment tab. 

4. The assignment(s) will display in a summary view. 
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5. To add a new assignment, click the [add assignment] link. 
  

 
  

6. Select the following from the drop-down boxes: 

• Branch:  Select the appropriate branch for this client department: Select a department within 
the specified branch for this client. 
 
(Departments are a sub-set of the branch.  IE: Personal or Commercial Lines). 
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• Unit: Select a unit pertaining to the department, if applicable.  Units are not required. 
 
(Units are a sub-set of the department.  IE: Home, Auto or Other) 

• Responsibility: Select the appropriate responsibility.  The responsibilities appearing in the 
drop-down box can be added to in Setup > Lookup Management. 

• Name: Select the name of the person responsible for this client.  The names appearing in the 
drop-down box are appointed from the employees title at the branch level. 

• Primary: Check this box to set this assignment as the primary responsibility for the account.   

Note: A primary assignment cannot be deleted, it must either be revised (See step #8) or a 
new assignment can be added, designated as primary, then the  old primary can be deleted. 

• Update "Other Commissions" in policy info: Selecting this option will automatically update the 
Policy Info tab (Other Commissions) with the commission detail for the new assignment. 
Policy info can only be changed in the following stages: Marketing, Edits, Endorsements, 
Renewals and Audits.  This option can be selected when adding, changing or deleting an 
assignment. 
 

 
Note: The Name must be associated with the selected Branch to determine the existence of 
commissions.  The message "No Valid Commission Defaults Exist for Name Selected" will be 
displayed if the selected name is not associated with the branch.  

7. Click OK to save the changes. Click Cancel to abort the change. 

8. The primary assignment can be changed by clicking on the Details  icon of the primary 
assignment , make the necessary changes from the appropriate drop-down boxes, click OK to 
save the changes. Click Cancel to abort the change. 
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Policy Level Assignment 

This level pertains to a client's policy. 
  

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. 

4. Click the Details  icon of the appropriate policy. 

5. Click the assignment tab. 

6. The assignment(s) will display in a summary view. The assignment(s) at the policy level default in 
from the client level at the time the marketing policy is created. 

7. Assignments at the policy level can be added, revised or deleted, security permitting. 

8. Repeat steps 5-8 from the client level assignments to add, edit or delete assignments. 

  

Related Topics 

Global Reassignment 

Classified Detail 

Codes and values are used to segment prospects and clients for marketing campaigns. 

To add a new code and or value 

1. Locate a client via SEARCH. 

2. Click on the client's Details   icon.  

3. Select the classified tab. 

4. Click the Details  icon to edit an existing code or value, or click [Add New]. 

5. Select a Class Code and Designation. These items may be edited by the entity in setup. 

6. Click [Save]. 

Market Analysis Tab 

The market analysis tab displays a summary of all saved analyzed markets by default.  
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• Clicking the Details  icon will take you to the market analysis details screen.  

• Using the [Show] filters option allows for searching by specific status as well. 

 

Add an Application to a Suspect 

1. On the Primary menu, click SEARCH and search for the Suspect you wish to add the application 
for. 

2. Click the Details  icon for the suspect. 

3. Select MARKETING from the Client menu. You will be notified that no marketing policies exist.  

4. Since there is no history on a suspect record select Cancel to display the underwriting screen. 

Tip: Notice the color of the screen, the wheat color is always associated with the active policy 
stage of marketing. 

5. The top portion of the screen is called the policy header. Select the Billing and Issuing Carriers, if 
known, from the drop-down list. The billing company is who will pay or be paid and the issuing 
company is the company that issues the policy.  
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6. Enter the effective and expiration dates. Since the policy is currently being worked change the 
status to pending. 

7. Click Save Changes on the navigation toolbar under the policy header to keep the changes made 
to the policy header and display a second navigation toolbar.   

8. Click Add Application. 

9. The form standard defaults to ACORD, select a state as appropriate, then select the type of 
application and line of business from the drop-down boxes.  All appropriate applications are 
displayed in the available applications list.  The highlighted application description is displayed 
below the box for easy identification. 

10. The Nexsure application helper is used to copy from previously populated applications to save 
keystrokes, the box is checked by default. Since there are no policies to copy from, remove the 
check by clicking in the box.  

11. Click Next to add the application and any base forms. 

In-Forcing a Marketing Policy for New Business 

To in force a marketing policy for new business in Nexsure, begin by searching for the client or prospect.  

1. Click on the Details  icon next to the client or prospect name to display the card file.  

2. Select MARKETING from the Client menu.  

3. Click the Details  icon next to the marketing policy to display the underwriting screen.  

4. On the navigation toolbar select In Force and the In force pop-up window will be displayed.  

5. If no binder will be necessary, select only the in force option. If a status of bound is necessary but 
no binder is to be issued from your office, select the bound option. If a binder will be issued select 
both the bound option and the create binder check box. 

Selecting Cancel will abort the in force process and selecting Next will move the marketing policy to 
Policies. Current in force policies are easily identified by the dark blue background color.  

Navigate and Populate a Form 

After an application is added to marketing the suspect is identified in Nexsure as a Prospect. To navigate 
and populate the form first begin by searching for the Prospect. 

1. On the Primary menu, click SEARCH. Search for the Suspect you wish to add the application for. 

2. Click the Details  icon for the suspect. 

3. On the Client menu, click MARKETING and the marketing summary screen is displayed. 
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4. Click the Details  icon next to the marketing policy to display the underwriting screen. 

5. To complete the forms, use the navigation tab on the right side of the screen.  Select the 
application to complete by clicking on the plus in front of the form.   
 
For example: to populate the ACORD 125 click on the plus sign in front of Base Requirements 
then click on the plus in front of the ACORD 125.   

6. Click assign to display producer information in the assignment section of the application.  Some 
of the fields are already populated, therefore, only populate as necessary.  

Navigation and saving the form 

• Next - found on the navigation toolbar at the top and bottom of the screen saves, and navigates to 
the next screen.  

• Previous - in the navigation toolbar at the top and bottom of the screen saves, and navigates to 
the previous screen. 

• Save Changes - saves changes and remains on the same screen. 

• Select a link on navigation tab to save changes and go to the selected page of the application. 

• Select summary on a schedule section of the application saves the screen and returns to summary 
view. 

Rating Integration 

Nexsure facilitates integration with WinFSC, Agency Computer Systems (ACS2000) and The Hartford's 
ExpressWay rating software.  Marketing applications started in Nexsure can be exported for a quote, or a 
quote file can be imported into Nexsure as a new marketing line item.  

Note: Quotes obtained using ExpressWay cannot be imported (Bridged) back to Nexsure. Only WinFSC 
and ACS2000 are supported for bridging at this point. 

Additional Logins 

ExpressWay requires an additional login to be setup with a valid user name and password. See 
ExpressWay  for more details. 

Supported LOBs 

Click rating tool to view supported LOBs: 

ExpressWay 

• Homeowners 1560 ACORD 80 

• Personal Auto AL 840 ACORD 90 AL 

• Personal Auto AR 699 ACORD 90 AR 

• Personal Auto AZ 680 ACORD 90 AZ 

• Personal Auto CA 818 ACORD 90 CA 

• Personal Auto CO 722 ACORD 90 CO 
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• Personal Auto CT 716 ACORD 90 CT 

• Personal Auto FL 842 ACORD 90 FL 

• Personal Auto GA 1107 ACORD 90 GA 

• Personal Auto IA 792 ACORD 90 IA 

• Personal Auto ID 791 ACORD 90 ID 

• Personal Auto IL 952 ACORD 90 IL 

• Personal Auto IN 793 ACORD 90 IN 

• Personal Auto KS 850 ACORD 90 KS 

• Personal Auto KY 794 ACORD 90 KY 

• Personal Auto MD 851 ACORD 90 MD 

• Personal Auto MN 799 ACORD 90 MN 

• Personal Auto MO 804 ACORD 90 MO 

• Personal Auto MT 859 ACORD 90 MT 

• Personal Auto NC 719 ACORD 90 NC 

• Personal Auto NH 853 ACORD 90 NH 

• Personal Auto NM 807 ACORD 90 NM 

• Personal Auto NV 683 ACORD 90 NV 

• Personal Auto NY 708 ACORD 90 NY 

• Personal Auto OH 854 ACORD 90 OH 

• Personal Auto OK 704 ACORD 90 OK 

• Personal Auto OR 1132 ACORD 90 OR 

• Personal Auto PA 723 ACORD 90 PA 

• Personal Auto SC 813 ACORD 90 SC 

• Personal Auto TN 816 ACORD 90 TN 

• Personal Auto TX 860 ACORD 90 TX 

• Personal Auto UT 857 ACORD 90 UT 

• Personal Auto VA 721 ACORD 90 VA 

• Personal Auto WA 858 ACORD 90 WA 

• Personal Auto WI 830 ACORD 90 WIA 

 

WinFSC 

• Dwelling Fire 1191 ACORD 84 

• Homeowners 1560 ACORD 80 

• Mobile Home 886 ACORD 85 

• Motorcycle CA 818 ACORD 90 CA 
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• Personal Auto CA 818 ACORD 90 CA 

• Personal Condominium 1560 ACORD 80 

• Renters 1560 ACORD 80 

 

ACS 

• Homeowners 1560 ACORD 80 

• Personal Auto MI ACORD 90 

  

To export (Rate) a marketing application 

Marketing applications can be exported as a blank application, or after it is completed in Nexsure.  If the 
application is not complete when it is exported, the rating tool will prompt you to fill in the required data.  If 
the application is completed in Nexsure before it is exported, a quote will be provided once it opens in a 
rater (see Mapping Notes below). 

1. Select the client with the marketing application. 

2. On the Client menu, click MARKETING. 

3. Click the Details  icon for the marketing policy to rate. 

 

4. Select the line of business in the navigation panel, for example, the Personal Auto ACORD 90 CA. 
 The line of business must be selected for the Rate (export) link to become available. 

Note: If the line of business is not supported by the selected a rating tool, the Rate link will not 
become active. 

5. Click the Rate link. The rating tool selection screen appears: 
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6. Select a rater and click Next. 

Note: Clicking View Source will display the ACORD XML data being transferred to the rater. 

7. The rater will be launched with information from the application pre-filled. 

8. Once the quote has been provided, the application can be imported (Bridged) back to Nexsure. 

Important: Quotes obtained using ExpressWay cannot be imported (Bridged) back to Nexsure. 
Only WinFSC and ACS2000 are supported for bridging at this point. 

To import (Bridge) an application into Nexsure from FSC Rater 

When an application is exported to FSC Rater it is sent with a Nexsure-generated policy ID.  This ID 
number will route the same application back into Nexsure and overwrite the original marketing application 
that was exported for a quote (see Mapping Notes below).  To import (Bridge) applications as separate 
line items on the marketing screen (to show multiple quotes for example) see, Importing from the 
Interface Screen below. 

Note: Before an application can be imported from FSC Rater, the quote file must be exported from FSC 
Rater.  In FSC Rater, on the Tools menu, click Export.  The file can now be imported by Nexsure. 

1. Select the client with the original marketing application. 

2. On the Client menu, click Marketing. 
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3. Click the Details  icon for the marketing policy. 

4. Click the Bridge link.  The original marketing application will be overwritten with the quoted 
application from FSC Rater. 

Importing from the Interface Screen 

To import multiple quotes on the same application, quote files from FSC Rater must be imported from the 
Interface screen.  A new marketing line item will be added for each quote on the marketing screen for the 
specified client.  When applications are originated in FSC Rater, FSC Rater will first search the Nexsure 
database for the exact name of the client.  If a match is found it will be added as a new marketing line 
item.  If no match is found the new client will be automatically generated in Nexsure. 

1. On the Home menu, click INTERFACE. 

  
 
Click the [Bridge] link. If the client already exists in Nexsure, each quote will be added as a 
separate marketing line item to that client. If the client does not exist in Nexsure, the client will be 
automatically created based on the information in the quote file (see Mapping Notes below). 

ExpressWay Mapping Notes 

Nexsure to ExpressWay 

• Expressway requires that the Applicant Name, and Phone Number be provided to successfully 
start a quote. 

• Expressway can only be exported using the Rating option. You cannot Bridge an Expressway 
quote back into Nexsure.  

FSC Mapping Notes 

Nexsure to FSC 

• The employer, occupation and work address that populates in FSC will always come from driver #1 
in Nexsure. 

• The driver #1 name comes from Named Insured (so it may differ from driver # 1 name in 
Nexsure). 

• Default occupation in FSC is Employed ( even if "student" is input in Nexsure it still displays as 
Employed in FSC). 

• For rental reimbursement to be quoted, both the limit per day and max must be populated in 
Nexsure (if only the limit per day is entered, the rental will not be quoted). 
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• If driver license number of digits is invalid for the state licensed, the license state will not carry 
over to FSC (ex- California Driver License numbers have 7 digits.  If an 8 digit number is entered, 
the license state will not carry over as California for that driver). 

• Named insured - Because named insured in Nexsure is not separated into first, middle and last 
names, names brought over to FSC may need some adjusting (for instance, if two named insureds 
with an “&” separating them, the “&” may be brought in as middle name). 

• DP1 & DP3 - If the coverage type selected is Fire, Fire & EC or Fire, EC & VMM then FSC will 
rate policy as a DP1. If either broad or special coverage type are selected, FSC will launch DP3 
rating. 

FSC to Nexsure 

• If no payment plan selected, the default payment plan from FSC is Full Pay. 

• Client Name and Client Profile Named Insured will come from FSC First Name, Last Name but 
the application name will come from Legal Name (if any in FSC) 

• For Property LOBs, distance to fire hydrant is carried over to the application as the max distance 
for each group: 1000 ft or less from fire hydrant, (none of the three check boxes is selected), 5 
miles or less from station, (first check box selected) , 5 - 10 miles from station, (second check box 
selected) , 10 or more miles from station (third check box selected). 

• Input By in FSC Rater will determine the branch in Nexsure that the client will be added to. 

• First Name and Last Name in FSC Rater are matched in Nexsure with the named insured.  The 
names must match exactly in order for the quote to import to the existing client. 

• Nexsure also matches the mailing address line # 1 (Street Address).  If this field is left blank in 
FSC Rater, Nexsure will use the garaging or property address line 1. 

Note: If the quote originated in Nexsure, then the resulting quote will be attached to the client it 
came from in Nexsure (no matching of the name and address is needed). 

FSC Quote Import Exceptions 

• Producer Exception - When an FSC quote is imported, a search is performed to determine the 
branch/producer and who is assigned to the quote.  This search is performed using the "Input By:" 
information from FSC Rater.  If the Input By:(FSC Rater) name and the Producer (Nexsure) name 
match, the assignment will be generated using the first match found.   
 
If no match is found a Producer Exception is generated in Nexsure's interface screen.  To resolve 
the exception, add the employee under a branch in Nexsure, and accept the exception. 

• NAIC Code Exception - This exception can occur if Nexsure is unable to resolve the NAIC code 
from FSC Rater's proprietary carrier ID. 

• Carrier Exception - This exception occurs when the NAIC code for the quote being imported is not 
listed under the carriers in Nexsure.  To resolve this exception, add the carrier or carrier name with 
the appropriate NAIC code and accept the exception. 

ACS2000 Mapping Notes 

Some ACORD information is not captured or provided by ACS2000:  

Does not provide: Vehicle Registration State, Loss Years 

ACS Does Not Capture:   
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• Towing Coverage 

• Rental Coverage 

• Residence Owned 

• Applicant - Employer Name/Address 

• Homeowners Rating Credits 

• Building Code Effectiveness Grade Inspection 

• Hurricane Resistive Glass 

• Date Heating System Last Serviced 

• Circuit Breakers and Fuses 

• Knob & Tube or Aluminum Wiring 

• Plumbing System - Any Known Leaks 

• Condition of Roof 

• # of Amps 

• Sprinkler Info 

• # of Household Residents 

• # of Weeks Rented 

• Condition of Plumbing 

• Carrier Name 

  

Additional Notes 

1. When starting a quote from ACS2000 and bridging to Nexsure, the user will want to verify that the 
client name is exactly the same in both ACS2000 and Nexsure or a duplicate client could be 
created in Nexsure. If a quote is started in Nexsure, rated with the Nexsure-ACS2000 integration, 
and then bridged back to Nexsure, this will not be an issue.  

2. The ACS2000 "Transfer to Management System (Nexsure)" option is not yet enabled by ACS. 
Choose the option to "Export to a File (ACORD XML)" instead. See below:   

 
Related Topics 

Interface 
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IVANS Downloads 

Policy Underwriting 

Policies Summary 

 
  

Policies at Client level contains a list of the current policies along with the history, certificates, binders, 
verifications and summary of insurance tabs.  If no policies exist in Policy Summary when the 
Policies tab is selected you will be prompted to check for marketing history or click Cancel to add new 
marketing policy.  Complete the heading information and click  Save Changes.  If marketing policies 
exist, click Details   to edit the policy.  If a policy has expired the Details  icon will be red. 

• Click Details   to edit the policy.   Right clicking on the Details  icon will display the following 
navigation options:   

• Open - Displays the Underwriting screen to add a new marketing application as described in 
the Policy Underwriting topic. 

• Print - Displays a PDF of the entire policy for printing. 

• Summary of Insurance - The summary of insurance tab displays the policy info from the 
application at the policy level or all policies at the client level.  The summary of insurance tab 
is only active with In force policies.  

• Create policy edit - Displays the Servicing > Edits screen as explained in the Servicing > 
Edits topic. 

• Create endorsement - Displays the Servicing > Endorsements screen, as described in the 
Servicing > Endorsement topic. 

• Renew policy - Displays the policy underwriting screen. 

• Re-market policy - Displays the Servicing > re-marketing screen. 

• Create cancellation - Displays the Servicing > Cancellation screen.  

• Create claim - Displays the Servicing > Claims screen. 

• Create audit - Displays the Servicing > Audits screen as described in the Posting an Audit 
topic. 
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• Create binder - Displays the Servicing > Binders screen as described in the Servicing > 
Binders topic. 

• Click Delete  to delete the policy. 

  

Related Topics 

Underwriting 

Working with Forms 

Servicing Marketing 

Policy Account Management 

Assigning the policy to a different branch, producer and account manager is done on this screen. Click 
the "Account Management" tab from policy detail level to modify. If this screen is not modified, the 
assignments added at client level are the defaulted for each policy added. 

1. “Account Management” allows branch, producer and account manager assignments. 

2. Branch: The branches in the drop-down box are added to the organization in Setup. Select the 
appropriate branch for this entity. 

3. Primary Producer: The primary producers in the drop-down box are added as employees in 
organization Setup. Highlight the appropriate producer. The primary producer will display on the 
client screen. 

4. Account Manager: The account managers in the drop-down box are added as employees in 
organization Setup. Highlight the appropriate producer. The account manager will display on the 
client screen. 

5. Cancel: The Cancel button will abort modifications or additions. 

6. Update: The Update button will update modifications. 

Policy Code Definitions 

Policy codes can be found on the underwriting tab of a client’s policy. 
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• Stage: Nexsure determines the stage of a policy.  The stages of a policy are: 

• Marketing: This stage is displayed for marketing policies that are currently in the process of being 
worked on or submitted to a carrier.  See Servicing > Marketing. 

• Policy: This stage is displayed for in force policies. 

• Edit: This stage is displayed when a policy is in an edit stage.  An edit would be used to make an 
internal change to an in force policy that would not need to be sent to outside parties such as the 
carrier or the client.  See Servicing > Edits. 

• Endorsement: This stage is displayed when a policy is in an endorsement stage.  An 
endorsement would be used to make a change to an in force policy that would require a change 
request to be sent to the carrier.  See Servicing > Endorsements. 

• Audit: This stage is displayed when a policy is in an audit stage.  The carrier normally initiates the 
audit with the client and the audit is based on a prior time frame.  When the audit is completed, the 
carrier sends a copy to the agency for their records.  See Servicing > Audit. 

• Mode: Nexsure determines the mode during the servicing process.  The modes of a policy are: 

• New: This mode identifies the policy as a new piece of business written in the agency.   

• Renew: This mode identifies the policy as being renewed with the same carrier as the 
expired term. 

• Re-New-Co: This mode identifies the policy as being renewed with a different carrier then the 
expired term. 

• Rewrite: This mode identifies the policy as having been canceled and coverage is rewritten 
with either the existing carrier or a new carrier.  There is usually a lapse in coverage. 

• Canceled: This mode identifies a policy as being canceled. 

• Status: The user identifies the status during the servicing process.  The status is displayed in both 
the policy summary view and on the home menu links, if applicable.  This results in a quick 
overview of a client’s policy and lets the user know if there is any servicing being processed on a 
policy and the status of the item.  The statuses of a policy are: 
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Note: If a policy is being worked on and the Status is changed in the header, make sure to click 
the “Save Changes” link under the policy header to save the change. 

• 2nd Request: A copy of the item being processed has been submitted to the carrier and 
there has been no response.  The status would be changed to 2nd Request and the item re-
sent to the carrier. 

• 3rd Request: A copy of the item being processed has been submitted to the carrier twice 
and there has been no response.  The status would be changed to 3rd Request and the item 
re-sent to the carrier. 

• Declined by Carrier: The carrier declined to write the coverage being requested for the 
client. 

• Declined by Client: The client declined to write his coverage with the carrier. 

• Empty: This status is only displayed on a marketing policy for a new line of business. 

• No Response: There has been no response from the entity to which information was sent to. 

• Pending: The information is incomplete and the item is pending until further information can 
be gathered. 

• Pending Approval: The item being worked on is pending approval from the carrier. 

• Quoted: The user has received a quote from the carrier.  

• Submitted: The item being worked on has been submitted to the carrier for a quote or 
approval. 

• Pending Cancellation: A policy that is in the process of being canceled by the cancellation 
has not yet been finalized. 

• Reinstated: A canceled policy that was reinstated with no lapse in coverage. 

• Rewritten: A canceled policy that was rewritten with either a new carrier and/or new effective 
dates. 

Non-Renewals 

Non-renewal of policies is to identify when a policy will not be renewed in the agency. Flagging these 
types of policies lets everyone know the status of the policy and allows recording visually as well as 
documenting the policy with an action. 

Note: The action types must be created and associated with the action topic of non-renewed before 
using. 

To flag as a Non-Renewing 

1. Select the client. 

2. From the Client menu, click the POLICIES link. 

3. Select the non-renewing policy by clicking the Details  icon. 

4. In the policy header, select the Non-renewing check box. 
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Selecting this check box will open the Non-Renewal pop-up window. 

 
Note: The Status type cannot be changed. 

5. In the Reason drop-down list, select the reason of non-renewal. Reasons are created as actions 
(see to define reasons below). 

6. In the Notes box, enter any information about the non-renewal. The information entered in this box 
will become the 'memo' of the action. 

7. Click Save. The action will be added to the revised underwriting screen with the issuing carrier 
crossed out.  

 
Note: A policy flagged as Non-renewing uses the Stage and Status to determine how the policy 
may be serviced. Non-renewing does not change policy servicing. 

  

To Define Reasons 

1. On the Utility menu, click SETUP. The actions setup appears by default. Before adding a new 
Action Type, search to see if the action already exists and avoid duplicates. 
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2. Select the types tab and click [Add New]. 

 

3. Enter a reason in the Type field and click Save. 

4. Select the actions tab and click [Add New]. 

 

5. In the Topic drop-down, select Non-Renewal. 

6. In the Type drop-down, select the reason which was just created. 

7. Click Finish. 

  

Policy Info Tab 

The policy info tab is used to maintain the premiums, fees, taxes, agency commissions and people 
commissions throughout the life cycle of a policy. The information on this tab is locked down after a 
marketing policy is placed in force and can only be changed through the servicing screen. The 
information on this tab will default into the invoice. 

1. Click the Details  icon of the client. 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   171

2. On the Client menu, click MARKETING. 

3. Click the Details  icon of the appropriate marketing policy. 

4. Click the policy info tab. 

5. Using the links in the policy info tab, or the scroll bar, complete the following sections: 

Miscellaneous 
 

• Bill Method: Defaults to Direct Bill.  To change to agency bill click on the Edit link. 

• Annualize: Clearing this check box enables exclusion of annualized line items when 
invoicing. This option is helpful for short term policies or special event policies. This option is 
selected by default. Click the Edit link to change. 

• Internal Note: Add if needed. 

• Click OK to save changes. 

 

Invoice Bill To 
 

• The Invoice Bill To defaults to the client, to change the payee click on the Change Bill To 
link. 

• Choose entity. 

• Click next. 

• Select name, location & contact from the drop-down boxes. 

• Click next. 

• Click OK to confirm change. 

Premiums 
 

• Click the details icon to add the Level/Line of Business premium. 

• Estimated: The estimated amount of the term premium.  This field is input by the agent. 

• Annualized: The policy value based on the term of the policy including annualized mid-term 
audits and endorsement.  This field is updated by Nexsure.  

• Billed: The actual premium amount that has been billed in Nexsure.  This field is updated by 
Nexsure. 

• Input the amount of the Estimated premium. 

• Select the Commission type from the drop-down box. 

• If the premium is taxable select the Yes option button. 

• Click OK. 

Fees 
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• If a fee exists for this Line of Business, click the Add New Fee link. 

• Select the Level/LOB, Fee Code and Service Provider from the drop-down boxes, click OK. 

• Confirm or make the necessary changes to the Non-Premium Fee and Revenue fields: 

 
• Rate Type: Select Flat or % of Fee.  

• Rate: Enter the appropriate rate, Nexsure will calculate the commission based on the 
rate type chosen: 

• Flat: Flat dollar amount entered 

• % of Premium: Commission is calculated based on the premium entered. 

• % of Agency Commission: Commission is calculated on the amount of the 
Agency commission. 

• Estimated: Calculates based on Rate - cannot be edited. 

• Annualized: Annual premium. 

• Billed: Will populate when billing occurs - cannot be edited. 

• Entity Type: Select an Entity Type. 

• Entity: Select an Entity 

• GL Account: Select the GL account to bill the fee under. 

• Click OK. 

Taxes 
 

• If a tax exists for this line of business, click the Add New Tax link. (The taxable option 
button must be checked in the premium) 

• Select the Tax On, Level/LOB and Tax Code from the drop-down boxes, click the blue 
default link.  The tax will default in from invoicing setup. 

• Confirm or make the necessary changes to the tax. 

• Click OK. 
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Agency Commissions 
 
If commission defaults have been set up for the carrier, they should default in.  See Adding/Editing 
Carrier Commissions to setup defaults. 

 

To edit an existing commission: 

1. Click the Details  icon. 

2. Make the necessary changes to the rate type and rate, click OK 

3. Nexsure will calculate the % of premium based on the premium entered. 

To add a new commission: 

1. Click Add New Agency Commission: 
 

 

2. Commission On: Fee selected 

• Fee option will be available only if fee was flagged as branch commissionable.   

• Defaults to Policy/All LOBs once Fee is selected.   

3. Level/LOB: Select appropriate line of business.   

4. Select Fee: Fee selection permits the application of fee-specific commission rates.  Fees subject 
to commission do not need to have the same rate applied and can have a differentiating 
commission rate/rate type applied. 

5. Rate Type: Enter the Rate Type. 

6. Rate: Select Flat or % of Fee. 

7. Estimated: Calculates based on Rate 

8. Annualized: Annual premium 

9. Billed: Will populate when billing occurs - cannot be edited 

Other Commissions 
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If commission defaults have been set up for the employee, they should default in.  See Employee 
Commissions to setup defaults. 

 

To edit an existing other commission: 

1. Click the Details  icon 

2. Make the necessary changes to the employees, production role and production credit 
amount. 

3. The production role and production credit amount fields are used to designate the role and 
percent of business this employee brought into the agency on this policy. 

4. Select the Rate type from the drop-down box. 

5. Key in the appropriate rate, Nexsure will calculate the commission based on the rate type 
chosen: 

6. Flat: Flat dollar amount entered 

7. % of Premium: Commission is calculated based on the premium entered. 

8. % of Agency Commission: Commission is calculated on the amount of the agency 
commission. 

9. Click OK. 

To Add a New People Commission 

1. Click Add New Other Commission 

2. Employees: Select the employee from the employees box or use search people option. 

3. Commission On: Fee selected - Fee option will be available only if the fee was flagged as 
people commissionable.  Defaults to Policy/All LOBs once the fee is selected. 

4. Level/LOB: Select the appropriate line of business. 

5. Select Fee: Use this option to select fee-specific commission rates.  The selection of the 
fee, rate type and rate is specific to the fee. 

Note: Only fees which are subject to commission will be available. 

6. Production Role: Select the production role. The production role and production credit 
amount fields are used to designate the role and percent of business this employee brought 
into the agency on this policy. 

7. Production Credit Amount: Select the production credit amount. The production role and 
production credit amount fields are used to designate the role and percent of business this 
employee brought into the agency on this policy. 
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8. Rate Type: Select Flat or % of fee.  

9. Rate: Enter the appropriate rate, Nexsure will calculate the commission based on the rate 
type chosen: 

• Flat: Flat dollar amount entered 

• % of Premium: Commission is calculated based on the premium entered. 

• % of Agency Commission: Commission is calculated on the amount of the agency 
commission. 

10. Estimated: Calculates based on Rate - cannot be edited. 

11. Annualized: Annual premium. 

12. Billed: Will populate when billing occurs - cannot be edited. 

13. Click OK 

Adding an Attachment 

Adding an attachment allows the user to attach a picture, word document, etc., which has been saved to 
one of the agent’s drives, to a client or clients policy in Nexsure. After the item has been attached it may 
deleted off the agent’s drive, thereby saving space. Access the appropriate client or policy level 
attachment option. 

To Add an Attachment 

1. Click the [Add New] link. 

2. Select Add attachment. 

3. Click the Browse button. 

4. Browse to the where the file to be attached is stored and click Open.  The file path will be pulled 
over to the Add File field. 

5. Policy: 

• If the attachment is being done from the client level, the Policy field will display ‘none’.  A 
policy number may be selected from the drop-down box if desired. 

• If the attachment is being done from the policy level, the Policy field will display the 
appropriate policy number. 

6. Certificate: Select a certificate to be associated to the attachment from drop-down box, if 
applicable. 

7. Attachment Name – This can be something generic.  (i.e.,  Vehicle) 
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8. Attachment Description – This should be specific so Users will not have to open all attachments 
to find the correct one.  (i.e.,  2002 GMC Suburban Vin # 564773) 

9. Date – defaults to today.  The date can be changed. 

10. Click Next.  The attachment summary view is displayed: 
  

 

11. Click the attachments Details  icon to open the attachment for viewing. 

12. Click the Word  icon to update the attachment name or the document description. Click OK to 
save the change or Cancel to close the pop-up window. 

13. The [Show] filter may be used to refine a search. 

  

Related Topics 

About Attachments 

Using Document Templates 

Attaching Outlook Messages 

Delivery 

Attaching Outlook Messages 

Microsoft Outlook messages may be attached in Nexsure. 

To attach an Outlook message 

1. Access the appropriate client or policy level attachment option. 

2. Click [Add New]. 

3. Select Attach Outlook Message. 

4. Click Next. 

5. Nexsure will launch outlook or redirect to Outlook if it is open. 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   177

  

6. Click OK. 

7. Highlight the email message to be attached in Nexsure. 

8. On the Outlook File menu, click Save as Nexsure Attachment. 

 

 

9. Check the Allow access for box. 

10. Choose time (1 minute is adequate). 

  

11. Click Yes. 

12. The Email is attached as HTML file. 

13. Click the first Details   icon to open the email for viewing. 
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14. Click the X in the upper right corner to close. 

15. Click the second Details  icon to update the attachment name or the document description. 
Click OK to save the change or Cancel to close the pop-up window. 

  

Related Topics 

Attachments 

Creating Actions 

Setup - Actions 

Reducing Attachment Size 

Nexsure has a file size limitation of 6.0MB for attachments. This topic will outline some tips on how to 
reduce the file sizes of scanned images and pictures taken with digital cameras.   

Tips for reduced attachment sizes using:  

Scanners 

 
Tips to help reduce scanned file sizes: 

Reduce resolution 

Output resolution should not be more than 100 dpi (dots-per-inch) to help keep file sizes low.   

Tip: Use 75 dpi when scanning something that will be viewed on the screen (like on a web page or 
an attachment in Nexsure) 

• Image quality on a monitor does not dramatically improve with higher resolution 
scanning. 

• Attachments in Nexsure will normally be viewed on the screen. 

To change resolution when scanning, please consult the user’s manual. 

  

Avoid true color output type 

Typical scanner output types are:  

• True color (24-bit, millions of colors) 

• 256 colors (8-bit, 256 colors) 

• Grayscale (8-bit, 256 shades of gray) 

• Black/white (1-bit, black and white) 

It is recommended to change output type to black and white for attachments. The higher the color 
output, the larger the file size. 

To change the output type, please consult the user’s manual. 

  

Reduce scale (size) of image 

The scale (size) of an image can greatly reduce the file size of the scanned item 
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Generally, a scanned image can be scaled from the original by a percentage or by dimensions 

• Percentage 

• Scale image by 50% (reduce size of original by 50%) 

• Dimensions 

• If original image is 1600x1200 pixels, scale scanned item to smaller dimensions (for 
example 1024x768 pixels). 

• The horizontal and vertical dimensions may be specified individually, or there may be a 
predetermined size that is smaller than the original. 

To change the scale, please consult the user’s manual. 

Save in compressed formats 

Common scanner output file formats:  

• Bitmap 

• JPEG (recommended) 

• GIF 

• TIFF 

• WMF 

Common compressed formats: .jpeg, .gif, .tif compressed 

Saving an image in one of the compressed formats may greatly reduce file sizes.  Depending on the 
software, the amount of compression can be specified.  As the amount of compression is increased, the 
file size will decrease. 

Conversely, as the amount of compression is increased, there will be a reduction in quality of the scanned 
item.  As such, compressing a file too much will result in a blurred image. 

To change the output file format, please consult the user’s manual. 

  

Questions to ask the manufacturer 

Ask if the model of your scanner has the ability to do any of the following: 

• Reduce Resolution 

• Avoid True color output type 

• Reduce scale (size) of image 

• Save in compressed formats 

If none of the above is available, ask if there is a way to reduce the file sizes for scanned items. 

Digital Cameras 
 
Tips to help reduce files sizes of pictures taken by digital cameras:  

• Use medium to low resolution 

• Use the lowest (normal) image quality 
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General Image Resolutions  General Image Qualities 

1600x1200 pixels (Large)  Superfine (some cameras 
may not apply) 

1280x960  Fine 

1024x768 pixels (Medium)  Normal 

640x480 pixels (Small)    

Approximate Image File Sizes:  

Image Quality 

Resolution Super Fine Fine Normal 

1600x1200 
pixels 

957KB 611KB 302KB 

1024x768 
pixels 

450KB 294KB 155KB 

640x480 
pixels 

208KB 141KB 79KB 

  

Online manuals 

For a quick reference to the user’s manual for your digital camera, please identify the manufacturer 
of the digital camera below.  Then follow the instructions below the link to locate the manual for the 
specific model. 

Sony: http://www.ita.sel.sony.com/support/dvimag 

1. Images may not display automatically, so just click on Refresh (or Reload) button. 

2. Choose model of camera. 

3. Under documentation, click Manuals. 

Canon: http://www.powershot.com/powershot2/customer/support.html 

1. Select model of camera. 

2. Under Getting Started, click Product Instructions. 

Olympus: http://www.olympusamerica.com/cpg_section/cpg_download_manuals.asp 

1. Select Camera model from drop-down list.   

http://www.ita.sel.sony.com/support/dvimag
http://www.powershot.com/powershot2/customer/support.html
http://www.olympusamerica.com/cpg_section/cpg_download_manuals.asp
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2. Download appropriate Manual. 

Kodak: http://www.kodak.com/global/en/service/nav/index.jhtml 

1. In the Support by Products list, select Camera, then point to Digital Cameras and select 
the model.   

2. Click Manuals and Publications on the left side. 

3. Click Table of Contents. 

4. Click Topic. 

Fuji: http://www.fujifilm.co.uk 

1. At the top, click Service, Support and Downloads. 

2. Click Digital Cameras Manuals and Downloads. 

3. Click Manuals. 

4. Select model of camera. 

If the digital camera you have is not listed above or you cannot find the manual online, please 
contact the technical support for the manufacturer of your camera.   

  

Questions to ask the manufacturer 

Ask if the model of your digital camera has the ability to change image quality or resolution. 

If not, ask if there is a way to reduce file sizes for pictures taken with this camera. 

  

Related Topics 

Attachments 

Sending an Expired Policy to History 

Tip: It is recommended not to place the expiring policy into history until it has expired. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. Or from the HOME > EXPIRATIONS link, click the Details 
 icon next to the appropriate client. 

4. Click the Details   icon of the expired policy. Notice the Details  icon for the expired policy is 
red. 

http://www.kodak.com/global/en/service/nav/index.jhtml
http://www.fujifilm.co.uk/
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Clicking the Details  icon at any level where the policy expiration date is a date in the past (and 
the status is other than Expired) will prompt the Expired status pop-up window, which asks, Do 
you wish to change the status to Expired? The only time the policy should be changed to 
Expired is when the policy is not to be renewed.  

 

5. Click OK to change the status of the expired policy term to Expired. Click Cancel to keep the 
current status if the policy is to be renewed. 

6. Click OK to acknowledge the policy status change. 

7. Click the History link on the navigation toolbar located just under the policy header to send the 
expired policy term to history where a record of the expired policy will be retained. 

8. In the pop-up window, choose Non-Renewed or Lapsed from the Status drop-down list 
(depending on the circumstance) and enter a description as to why the policy is not being renewed 
in the Notes box. 

 

9. Click Save. The policy header will be displayed in gray; the expired term is now in history. The new 
policy term will now need to be placed In force.  

Moving expired policies to history keeps the In force policy list current and policy servicing for re-
marketing, editing, audits, claims and creating letters without templates are all available for policies 
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in history. The HOME > EXPIRATIONS screen is also kept up to date by removing the policy from 
the screen when policies are sent to history. 

Note: Expired policies may also be sent to history from the HOME > EXPIRATIONS screen by 
using the context tools. Right-click on the Details   icon and left click on Send To History. 

  

Related Topics 

In Forcing a Future Status Renewal 

Sending a Marketing Policy to History 

Processing Audits for Policies in History 

As audits are generally received several months after a policy has expired, expired policies should be in 
history. 

To add an audit to a policy in history 

1. Locate the appropriate client through SEARCH. 

2. Click the SERVICING link on the Client menu. 

3. In the Select column, select the Audit option. 

 

4. In the Description box, enter a description for the action annotation.  

5. In the Eff Date field, enter the expiration date of the policy being audited.  The date is used in the 
search screens during the policy selection process as well as the Coverage Term date on the 
policy header.  
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6. Click the [Next] link in the upper right side of the screen. 

7. By default, policies in history are omitted from search results. To locate the desired policy in 
history, click the [Show] link. 

8. In the History drop-down list, select Include History or History Only policies. 

 

9. Click the Search button to return the history policies. 

10. Select the policy being audited from the available policies and click the [Next] link in the upper 
right corner of the screen. 
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11. Update the policy details to add audited details including any endorsement information received 
that might affect the policy. Enter the details in actions > Annotation to document.  

Make sure when invoicing the audit or endorsement to invoice on the audited version of the policy, 
not the current in force policy.  

If the carrier sends an endorsement to include the audit results for the current policy, add an 
endorsement to the current policy and create an invoice on that version of the policy. 

Note: The endorsement for prior term audit should be completed through the Audit option in 
SERVICING – not ENDORSEMENTS.  

After the audit is complete (policy updated, audit invoiced, money received), post the audit. 
Monitoring open audits is done on the HOME > AUDITS screen. Once the audit is posted, it is 
removed from the HOME > AUDITS screen. 

Note: If any changes need to be made to a policy in history, edit the policy. If an endorsement is 
required for some reason other than audit, process an edit and do a memo type endorsement to 
submit to the carrier. Monitor either with an Action or leaving the edit open (monitoring the HOME 
> EDITS screen) until the Endorsement is received from the carrier. Remember that leaving an edit 
open on the policy locks the policy from further servicing. 

Binder Bill Invoicing 

Binder bill invoicing hits the general ledger but does not appear on the agents account current statement. 
Binder bills are available for agency billed policies only. 

To create a binder bill invoice 
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1. Click on the Details  icon of the client. 

2. On the Client menu, click POLICIES. 

3. Click the Details  icon on the appropriate policy. 

4. Select the transactions tab. 

5. Click Add New Invoice.  

6. Click Edit Invoice Header link. 

7. Choose Binder Bill as the invoice type. 

  

8. Click OK. 

9. In the quick navigation panel, click Invoice Posting.  

10. Click Post Now. 

Note: Invoice posting for binder bills creates entries to accounts receivable and binder bill payable 
only. No posting rules will be taken into consideration with binder bill invoices. 

  

To reverse the binder bill 

1. At the policy level, click the transactions tab.  If there are several invoices, go to the Select view 
drop-down box and choose Open Binder Bill. 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   187

2. Click the Details  icon of the posted binder invoice. 

3. On the binder invoice header, click Reverse Now. 

The reversal process displays three options: 

 
• Open payment for manual apply to invoices: Will open receive payment with the entire 

amount as residual.  

• Go to Receive Payment - note that it now has a residual amount. 

• Open and assign credits to invoices as applicable. 

• The original and reversal can be applied against each other. 

• Open payment and auto-apply: Will re-apply the receive payment to the replacement 
invoice. 

• Replacement invoice will have the credit. 

• The original and reversal invoice will need to be applied to each other. 

• Leave payments applied: No change to the receive payment, it will remain against the 
original binder bill. 

• No activity required. 

Note: If credits exist for binder bill invoices, the message returned will be the same except for the 
reference to the locked or closed period: 
 
Locked or closed period: "Entry is in locked or closed period" 
 
Open period: "Entry is in an open period" 

The binder bill reversal creates a replacement invoice. The invoice header shows the replacement 
invoice number and the original binder number.   

4. Make any necessary changes to the premium, fees, taxes etc. 

5. Click Post Invoice.  If the premium has been changed, the user will receive a prompt to generate a 
manual invoice, select Yes and click OK. 
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In the summary view there will be: 

• "+" in front of the replacement invoice with "posted" status only 

• "-" in front of the reversed binder bill invoice 

• (M) is the manual invoice 

 

Related Receive Payment Activity 

• Open payment for manual apply to invoices: 

• Go to Receive Payment, note that it now has a residual amount. 

• Open and assign credits to invoices as applicable. 

• The original and reversal can be applied against each other. 

• Open payment and auto-apply: 

• Replacement invoice will have the credit. 

• The original and reversal invoice will need to be applied to each other. 

• Leave payments applied: 

• No activity required. 
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Splitting an Installment 

Each installments invoice may be billed to more than one entity. 

  

To split an installment 

1. Click the Details  icon of the client. 

2. Click the POLICIES link on the Client menu. 

3. Click the Details  icon of the appropriate policy. 

4. Click the transactions tab. 

5. Click the Details  icon of the unposted installment invoice to split. 

6. Click edit invoice header. 

7. Change the number of billings to the number of entities splitting the installment. 

 

8. Click OK. 

9. Click on the compound billing schedule link in the quick navigation.  A new installment schedule 
will be generated, click OK. 
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10. This installments invoice is now split between the number of billings, with all installments being 
billed to the entity shown in the header. 

11. The entity for each installment can be changed: 

• Click the Bill To icon 

• Chose entity 

• Click next 

• Select name, location & contact from the drop-down boxes 

• Click next 

• Click OK  to confirm change 

• Close the installment schedule window by clicking the X in the upper right corner of the 
window. 

12. The invoice will post on print date (or tonight, if date is in the past). 

13. Each installments invoice will need to be split if the split applies to all. 

  

Related Topics 

Installment Billing 

Delivery Option for Installments 

Endorsements and Installment Billing 

  

Certificate Batch Printing 

Use certificate batch printing to print multiple (unlimited) certificates at once. 

To batch print certificates 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   191

1. On the Primary menu, click SEARCH. 

2. Select a client. 

3. On the Client Menu, click POLICIES. 

4. Select the certificates tab. 
  

 
  

5. Select the policies you wish to print separately or click select all to select all of the certificates. 
Clicking deselect all will uncheck all of the certificates.  

Note: Only certificates with holders are available for batch printing. 

6. Click the Print Selected link.  The default is 1 copy but up to 99 copies can be selected. 

7. Click OK to confirm the batch print job.  The certificates will be sent to the default printer. 

Note: When a certificate is printed it records it in the Printed column on the certificate summary 
screen. 

  

Related Topics 

Creating New Certificates 

Certificate Renewal 

Copying Certificates 

Client Access for Certificates 

  

Copying Certificates 

The copy certificates feature allows you to copy certificate coverages and or all holders attached to a 
particular certificate.  It can be copied to the current account or to a related account (up to 25 related 
accounts at one time). 

  

To copy a certificate 
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1. Select the client. 

2. On the Client menu, click POLICIES. 

3. Click the certificates tab. 

4. Click the Details  icon for the certificate you wish to copy. 
  

 
  

5. Click the Copy link. The copy record(s) dialog box appears: 

Note: If the certificate form has expired, Nexsure will notify you that a new form is available.  Click 
Accept to migrate the data to the new form.  Please verify that the new form is populated correctly. 

 
  

• Copy certificate coverages - Copies all coverages, but does not copy certificate holders. 

• Copy all holders attached to this certificate - Copies all holders, but does not copy 
coverages. 

• Copy to this account - The copy of the certificate will reside on the current client. 
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• Copy to related account - The copy of the certificate will reside on any related account you 
select.  See below: 
  

 

6. In this example Brown's Market is selected as a related account. The copied certificate will appear 
on the related accounts certificate tab. 
 
To view the copied certificate on the related account 

1. On the Primary menu, click Search 

2. Search for and select the related account. 

3. On the Client menu, click Policies. 

4. Click the certificates tab.  The copied certificate will appear: 

 
The Coverages from the copied certificate will be populated, with the following 
modifications: 

• No Coverage Summary - to add, click the Add New link. 

• Named Insured - Changed to the Related Account named insured. 

• Mailing Address - Will need to be added when coverages are added. 

Note: The copied certificate will appear with a new certificate number and the current date 
as the issued date.  The copied certificate will not be marked as issued. 

7. Click Copy.  After the copy is complete the Copy Records dialog box will remain open. 

Note: Though you can add unlimited copies, you can only copy 25 at a time. 
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8. If you are finished copying certificates, click Cancel. The copied certificate will appear on the 
certificates tab with a new certificate number and the current date as the issued date. The copied 
certificate will not be marked as issued. 

  

Related Topics 

Creating New Certificates 

Certificate Renewal 

Certificate Batch Printing 

Client Access for Certificates 

  

  

Summary of Insurance 

The summary of insurance tab displays the policy information from the application at the policy level or all 
policies at the client level.  The summary of insurance tab is only active with In force policies.  Policy info 
can be printed, exported to Microsoft Word or Excel. Using the nexMail option grants temporary access to 
clients allowing them to view and print their summary of insurance. 

 
  

To view the summary of insurance at the client level 

1. Select a client. 

2. From the Client menu, click Policies. 

3. Select the summary of insurance tab. 
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4. The Excel and Word links will open their respective applications and populate the spreadsheet or 
document with the policy summary. 

5. Click the Print link to send the summary to a printer. 

  

To view the summary of insurance at the policy level 

1. Select a client. 

2. From the Client menu, click Policies. 

3. Choose a policy by clicking the Details  icon. 

4. Select the summary of insurance tab. 

Tip: You can also access the summary of insurance tab by right clicking on the Details  icon 
and selecting Summary of Insurance. 

5. The Excel and Word links will open their respective applications and populate the spreadsheet or 
document with the policy summary. 

6. Click the Print link to send the summary to a printer. 

  

To deliver a summary of insurance file 

Export the summary of insurance to Word or Excel saving the file to the desktop or file folder. 

1. On the Client menu, click Delivery. 

2. In the Others category, click Add New. 

3. Attach the Word or Excel file. 

4. Enter the delivery information. 

5. Click Send. 

  

To grant temporary access to a summary of insurance 

Grant temporary access to any contact associated with a policy.  The contact will be sent an email with a 
link to view or print the summary of insurance. 

1. Select a client. 

2. From the Client menu, click Policies. 

3. Select the summary of insurance tab.  You can also view the summary of insurance from the 
policy level. 
 

• Select a client. 

• From the Client menu, click Policies. 

• Choose a policy by clicking the Details  icon. 

• Select the summary of insurance tab. 

Tip: You can also access the summary of insurance tab by right clicking on the Details  icon 
and selecting Summary of Insurance. 
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4. Click the NIC  icon. 

 
5. In the Select Contact drop-down box, choose the recipient of the temporary access.  You can 

grant multiple contacts access, but they must be sent one at a time. 

Note: If the client you wish to grant access to is not in this drop-down list, they must be added from 
the Client Profile / contacts tab.  Close the Create Temporary User dialog box, add the contact 
and then the client will appear in the drop-down list. 

6. Select the number of days the contact will have access. 

7. Enter a custom message, or accept the default: "Please review the summary of insurance." 

8. Click Send.  The dialog box will remain open to allow another contact to be selected.  If there are 
no other contacts to grant access to, click Close. 

9. An email with a link to the summary of insurance will be delivered to the contact. 

 
10. The contact must click the link in the email to be redirected to the summary of insurance 
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Note: The temporary access link can only be accessed one time. 

11. Once the user has accessed the summary of insurance and clicked the Logout link, an email will 
be returned to the Nexsure agent notifying them that the contact has reviewed the summary of 
insurance. 

About eServices 

Nexsure's eServices provides users real-time inquiry capabilities within a carrier’s web site.  This 
eliminates the need for the agency to log out of Nexsure or open another browser window to access the 
carrier’s site.  Users will have access to the very latest information directly from the carrier’s web site – 
the same information the Underwriters see.  Carrier information can include such things as: 

• Billing Inquiry 

• Invoice Copy 

• Policy Declaration 

• Claims Inquiry 

(This information varies by carrier.) 

Note: eServices are only available for in force business.  It is not available for opportunities or marketing 
policies. 

Each employee of the agency, who has login rights to a carrier’s site, must have their login information 
entered in Nexsure to access eServices.   

Note: In rare situations, where an employee may have more than one login to a carrier’s site, both should 
be entered in Nexsure.  If you have more than one additional login, you will be prompted to select which 
additional login to use when entering that carrier's site. 

  

Related Topics 

Setting up Additional Logins 

Accessing eServices 

Accessing eServices 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. 

4. Click the carrier’s name to launch eServices. 
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5. The eServices pop-up window is displayed. 

Note: The inquiry capabilities are dependent upon the individual carrier’s web site. 

 

6. Clicking on the carriers logo will take the user into the carriers site.  The policy number of the client 
is copied to the clipboard for easy access while browsing on the carrier’s web site. 

Note: When Nexsure eServices such as billing inquiry is first accessed each day, a copy of the 
result is stored within Nexsure for a period of 24 hours.  The next time that same option is 
requested during that day, that copy is displayed very quickly.  The Nexsure eServices refresh 
check box will instruct Nexsure to ignore what is stored in Nexsure and access the carrier's site for 
a fresh copy of that information. 

7. One application of the refresh option would be as follows.  If a call is received from a client and 
eServices needs to be accessed for them but a policy for another client is currently being accessed 
with the same carrier, the refresh option in Nexsure can be checked and the default policy number 
can be replaced with the caller's policy number. Then when one of the eServices options are 
accessed, the information returned will be for that caller's policy. 

  

Related Topics 

About eServices 

Setting up Additional Logins 

Delivery Option for Installment Invoicing 

To deliver an installment invoice 

1. From the Client menu, click the POLICIES link. 

2. Click the Details   icon for the appropriate policy. 
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3. Click the transactions tab. 

4. Click the Details  icon of the posted installment to be delivered. 

5. Under the invoice header, click Print. 

Note: The invoice must be posted in order to deliver. 

6. Select the Invoice Format from the drop-down list and select the invoice to print. 

7. Click OK. 

8. Click Deliver. The invoice must be in Adobe PDF format to deliver. Delivery can be sent via email 
or fax. 

• Fill out the Delivery screen and click Send. 

• Close the Delivery window. 

• Delivery details can be viewed from the delivery link on the client menu. 

  

Related Topics 

Installment Billing 

Splitting an Installment 

Endorsements and Installment Billing 

Endorsements and Installment Billing 

Endorsements are processed normal through servicing.  The Endorsement does not need to be posted to 
make premium adjustments to any remaining unposted installments. 

1. Click the Details  icon of the client. 

2. On the Client menu, click POLICIES. 

3. Click the Details  icon of the appropriate policy. 

4. Click the transactions tab. 

5. Click on the Master Invoice ID link of any installment. 
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6. Click on Modify Master link. 

7. In the Modify Master box, select split. Leave the other options unchecked and click OK. 

 

8. Scroll to the Premium link and click on the Details  icon. 

9. In the Amount due field put in the additional or return premium (a return premium will need a “-“ in 
front of the amount), generated by the endorsement. 
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10. Click OK. 

11. Click on the Installment Plan link. The amount of the additional or return premium will be divided 
over the number of the original installments. 

 

12. Click on the Create Invoices link. The amount of the additional or return premium will be divided 
over the remaining unposted installment invoices. 

13. Click the Transaction Summary link 

14. The remaining unposted installment invoices will post according to their respective dates. 
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Related Topics 

Installment Billing 

Splitting an Installment 

Delivery Option for Installments 

  

In Forcing a Future Status Renewal 

Tip: Do not place a future policy in force until the policy info tab is updated and all application edits are 
complete. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. All in force policies for the client appear.   

4. Click the Details  icon of the applicable line of business. Update the premium information on the 
policy info tab and make all edits to the application. 

5. Click the In Force link on the navigation toolbar located just under the policy header. 

6. If a binder is needed select the Bound option and check the box beside Click here to create a 
binder. (See Creating a Binder). 

 

7. Click Save to change the status to In Force. If a binder was selected, the status will be Bound, 
and the policy mode will remain as Renew or Re-New-Co. The policy now reflects an In Force 
status blocking any further modification without going through SERVICING. 
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Note: Once a policy has been invoiced the carrier cannot be modified during the current term 
unless the invoices are reversed. 

8. The expired policy should be sent to history.  (See Sending an Expired Policy to History). 

Installment Billing 

Installment billing is used when spreading a premium over a number of payments. 
  

To invoice using installment billing 

1. Select the client to be invoiced. 

2. On the Client menu, click the POLICIES link. 

3. Click the Details  icon for the appropriate policy. 

4. Click the transactions tab at the policy level. 

5. Click Add Master Invoice link. 

6. Click check boxes for premium, fees and/or taxes to default in from the policy info tab, click OK. 

7. Using the links in the quick navigation panel, or the scroll bar, complete the following screens: 

Edit Invoice Header 

 
a. Verify the Bill Method, Bill Type, Department and Unit. 

b. The Effective Date defaults to the Effective Date of the policy. 

c. Date Booked defaults to effective date of policy or invoice creation date based on whichever 
one is later. 

d. Enter the Down Payment Amount. 

e. Enter Down Payment Date Due. 

f. Chose the Payment Plan from the drop-down box. 

Note: The down payment is not included in the number of installments. 

Annual: Due date of 1st installment is based off date entered in 1st Installment Effective 
Date field.  Subsequent installments billed in one year increments up to the specified number 
of installments. 

Note: If client is paying in full, (no down payment), click [Add New Invoice] link and bill 
as full pay. 

Semi Annual: Due date of 1st installment is based off date entered in 1st Installment 
Effective Date field.  Subsequent installments are billed in 6 month increments up to the 
specified number of installments. 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   204

Quarterly: Due date of 1st installment is based off date entered in 1st Installment Effective 
Date field.  Subsequent installments are billed in 3-month increments up to the specified 
number of installments. 

Monthly: Due date of 1st installment is based off date entered in 1st Installment Effective 
Date field.  Subsequent installments are billed in 1-month increments up to the specified 
number of installments. 

Weekly: Due date of 1st installment is based off date entered in 1st Installment Effective 
Date field.  Subsequent installments are billed in 1-week increments up to the specified 
number of installments. 

Same Date: Due date of 1st installment is based off date entered in 1st Installment Effective 
Date field.  Subsequent installments are billed on the same date as the 1st Installment up to 
the specified number of installments. 

g. Enter the Number of Installments. 

h. Enter the 1st Installment Effective Date. (All subsequent installment default from this date). 

i. Enter the number of Days until Past Due. 

j. Enter the # of Print Days Before Effective Date. 

• This field is used to calculate the date when the installment will automatically post and 
makes the invoice available to print in batch. 

• EX: 1st installment effective date is 7/20/2004. 

• Print date field entered is the number 15. 

• Installment will post on 7/5/2004 and be available for batch printing on that date. 

• If zero used in this field each installments will post from the date in the effective date field 
in their scheduled month. 

• To suspend the posting of an invoice the user should leave this field blank to avoid 
Nexsure automatically posting the installment. 

Note: If the month is locked or closed, the invoice will post in the current month. 

k. Choose fee, tax & rounding options from the drop-down boxes. 

l. Input Unique Invoice message – this will print out on the invoice. 

m. Input Internal Note 

n. Click OK 

Change Bill To - This information is pulled from the policy but can be changed. Any named insured 
may be selected as the "Bill To" on invoices. 

To change bill to information 

1. In the quick navigation panel, select Bill To. 

2. Click Change Bill To. The Bill To pop-up appears with the client option selected with all 
named insureds displayed. 

Tip: If a long list of named insureds is displayed, enter a name in the search field and click 
Search. 
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3. Select the entity and named insured to bill. 

4. Click Next. 

 

5. Select the location and contact name from the drop-down lists and click Next. 

6. The new Bill To information is displayed, click OK to confirm the change. 

Policy Header - Displays the policy header information 

Base Forms - Displays base forms for the policy. 

LOB Forms - Displays all lines of business forms on the policy. 

Premiums - Changes can be made to the existing premium by clicking on the Details  
icon. A new premium can be added by clicking the add new premium link. 

Fees - Changes can be made to existing fees by clicking on the Details  icon. A new fee 
can be added by clicking the add new fee link. 

Taxes - Changes can be made to existing taxes by clicking on the Details  icon. A new 
tax can be added by clicking the add new tax link. 

Agency Commission - If a default commissions exist for the carrier it will automatically 
default in. 
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Changes can be made to Agency commissions by clicking on the Details  icon. 

A new agency commission can be added by clicking the add new agency commission link: 

 
• Commission On: Fee selected 

• Fee option will be available only if fee was flagged as branch commissionable (this 
has not changed) 

• Defaults to Policy/All LOBs once Fee is selected 

• Level/LOB: Select appropriate line of business 

• Select Fee: Fee selection permits the application of fee-specific commission rates.  Fees 
subject to commission do not need to have the same rate applied and can have a 
differentiating commission rate/rate type applied. 

Note: Only fees which are subject to commission will be available. 

• Rate Type/Rate: Enter rate information 

• Click OK 

Other Commissions - If a default commissions exist for the employee they will 
automatically default in. 

Changes can be made to employee commissions by clicking on the Details  icon. 

A new employee commission can be added by clicking the add new other 
commission link: 
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• Select the employee from the Employees box or use the Search People option. 

• Select the Commission On from the drop-down box. 

• Select Fee: Fee selection permits the application of fee-specific commission rates. 
 Fees subject to commission do not need to have the same rate applied and can have 
a differentiating commission rate/rate type applied. 

Note: Only fees which are subject to commission will be available. 

• Select the Production Role and Production Credit Amount from the drop-down boxes 

• The Production Role and Production Credit Amount fields are used to designate the 
role and percent of business this employee brought into the agency on this policy. 

• Select the Rate Type from the drop-down box 

• Key in the appropriate rate, Nexsure will calculate the commission based on the rate 
type chosen. 

• Click OK. 

8. Click the Installment plan link in the quick navigation.  A new installment schedule will be 
generated, click OK. 
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9. The installment schedule is based on the information in the invoice header. 

• The amount of an installment can be changed by clicking on the Details  icon. 
 Change the amount and click Update.  Click cancel to close the pop-up, click on 
Installment Plan in the quick navigation to revise the existing Installment schedule. 

• An installment may be billed to another entity.  See Change Bill To. 
 
This information is pulled from the policy but can be changed by clicking the Change 
Bill To link. 

a. Select the new Bill To entity. 

b. If Finance Company, Additional Interest or Retail Agent is selected, the 
appropriate entities will be displayed.  Enter at least two characters to narrow 
search results. 

c. Once you have selected an entity click Next.  Select the Name, Location and 
Contact from the drop-down boxes. 

d. Click Next. 

e. A pop-up box will confirm the change, click OK to complete. 

f. A Bill To Log will display the date and time changed, the prior bill to entity 
and the user who made the change. 

• The installment ID includes the installment number followed by its description letter or 
number. 

• The installment date, print date, past due date and description default from the 
information in the invoice header. 
 
 

a. Verify the Bill Method, Bill Type, Department and Unit. 

b. The Effective Date defaults to the effective date of the policy. 

c. Date book defaults to effective date of policy or invoice creation date based 
on whichever one is later. 

d. Enter the down payment amount. 
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e. Enter down payment due date. 

f. Chose the payment plan from the drop-down box. 

g. Enter the Number of Installments. 

h. Enter the 1st Installment Effective Date. 

i. All subsequent installment default from this date. 

j. Enter the number of Days until Past Due. 

k. Enter the number of Print Days Before the Effective Date 

• This field is used to calculate the date when the installment will 
automatically post and makes the invoice available to print in batch. 

• EX: 1st installment effective date is 7/20/2004 

• Print date field entered is the number 15 

• Installment will post on 7/5/2004 and be available for batch printing on 
that date 

• If zero used in this field each installments will post from the date in the 
effective date field in their scheduled month. 

• To suspend the posting of an invoice the user should leave this field 
blank to avoid Nexsure automatically posting the installment. 

Note: If the month is locked or closed, the invoice will post in the current 
month. 

l. Choose fee, tax & rounding options from the drop-down boxes. 

m. Input Unique Invoice message – this will print out on the invoice. 

n. Input Internal Note. 

o. Click OK. 

• The amount of each installment is based on the total premium, amount 
due of the down payment and number of installments. 

10. Click the Create Invoices link. 

11. Each installment will now have its own unique Invoice number.  The total number of invoices 
will be reflected in the header. 
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12. Click the Transaction Summary to close the master invoice. 

 

13. The Transaction Summary view displays each installment number with the master invoice 
number stacked below. The master number is a link, clicking on the link will launch the entire 
installment plan for review and modification. 

14. Unposted invoices can be removed, security permitting, but posted invoices must be 
reversed. 

Related Topics 

Splitting an Installment 

Delivery Option for Installments 

Endorsements and Installment Billing 

  

Servicing > Marketing  

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 
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3. On the Client menu, click SERVICING. 

 

4. Select the Marketing option and select either New line of business or Existing line of business 
and click [Next]. 

5. Select the policy to remarket.  If multiple policies are selected the policies will be grouped as if they 
are a package policy.  This feature allows applications to be bundled so they can all be sent to the 
carrier at one time.  

6. Click [Next] once policies have been selected. 

Tip: When a policy is selected the system automatically copies existing coverage information so 
the user will not need to re-key application information. 

7. The marketing underwriting screen is displayed for user completion. Modify the application as 
necessary as well as the carrier whom the policy is being submitted to. Go through the marketing 
process for each carrier that the business will be submitted to. This process is necessary to 
capture necessary statistical data and separate application information for each carrier.  

  

Related Topics 

Policy Underwriting 

Market Analysis 

Market analysis is used to compare alternative options/quotations to current in force coverage frequently 
done at renewal. This procedure is most commonly used within a commercial renewal setting for 
independent agents.  

To generate a marketing analysis: 

1. Locate the appropriate client using the SEARCH option on the Primary menu. 

2. Select SERVICING on the Client menu. 

3. Select the Market Analysis option. 
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4. Click the [Next] link in the upper right corner. 

5. The market analysis policy selection screen is displayed. 

 
6. Place a check mark  in the box to the left of the appropriate source policy by clicking on the box. 

Note: The first policy that is selected with a check mark is the source policy; this is the policy to 
which any other selected policy or policies will be compared against. 

7. Place a check mark  next to the policy or policies to be compared to the source.  

8. Click the [Next] link in the upper right corner. 

9. Click OK when prompted to create a new market analysis or Cancel to abort the operation. 
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The market analysis details screen will be displayed.  

Note: After a market analysis has been created, this screen is also accessible by selecting 
MARKETING from the Client menu, clicking the market analysis tab and then clicking the Details 

 icon. 

 

Market Analysis Toolbar 

 
Export 

Exports the file to Microsoft® Word or Excel®.  

Add Existing 

Goes to market analysis policy selection screen for selection of an additional policy or policies for 
comparison to the source policy. 

Finalize 

Use this option to select a policy that will be written. Any marketing policies used in the analysis that were 
not chosen will be sent to marketing history. Current and future policies will remain as they were. If a 
current policy is being renewed or rewritten with a different carrier, the user will need to manually push 
that policy to history when necessary. 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   214

The drop-down is used for entering the reason the policy was selected. The Notes section can be used 
for any additional information regarding the market chosen.  

The status of the analysis is changed to finalized. Once this been selected, the Add Existing option is no 
longer selectable. 

Save Changes 

Saves the analysis. 

Close 

Closes the market analysis window and displays the market analysis tab. 

  

Related Topics 

Market Analysis Tab 

Servicing > Binders 

Adding a binder from the servicing screen allows you to add a binder to an existing policy. 

To Add a Binder 

1. On the Client menu, click SERVICING. 

 

2. Select the Binders option and click [Next]. 

3. Select the policy that you wish to create a binder for and click [Next].  Then binder details screen 
appears. 

4. Click Save Changes to save the binder to the policy. 

  

Related Topics 

Creating a Binder 
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Extending a Binder 

Changing the Extension Default 

Delivering a Binder 

Putting a Bound Policy In Force 

Servicing > Edit  

Edit is used to edit an incorrect policy.  

 

1. Select the client.  

2. On the Client menu, click SERVICING. 

3. Select the Edit option in the Select column and click on [Next] to continue. 

4. Select the policy to edit by selecting the option next to the appropriate policy in the Select column 
and click [Next].  You cannot edit a policy that has pending activity and will not be given the 
option to select those policies. 

5. If policy editing is incomplete do not select to Post edit.  Policies that are in an Edit stage will 
display on the Policy Summary screen under the corresponding policy in a light shade of blue.   

6. To complete a policy with an Edit stage, click the Details  icon and make the necessary 
changes. When edits are complete, click Post Edit.   

7. You will be prompted to add a note pertaining to the edit that was made. This note will be attached 
to the policy when it is sent to history 

8. When the edit is posted on the underwriting screen, the policy prior to the edit is stored in history 
and removed from both the Policy Summary. The edited policy replaces the current in force 
policy. 
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Tip: Should you be interrupted or lose your place while editing a policy, select Compare Policy: 
[On]. This will display a comparison of data from the current in force policy to the current Edit and 
allow you to see what the differences are between the two. 

Servicing > Endorsement  

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click SERVICING. 
 

 

Tip: To check the list of policies prior to executing the endorsement, on the Client menu, click 
Policies to display a list of policies. The policy hot link may also be selected from the client card 
file, which is located under the stick-e-note. 

4. Select Endorse. 

5. Enter a Description of the endorsement and enter the effective date (defaults to current date). 

Note: The Description will pre-fill with “Process endorsement” – highlight and type the unique 
description that describes the endorsement being done. The effective date box to the right of the 
description will default to the current date, so make sure to enter the effective date of the 
endorsement if other than today’s date. The date entered here will populate in the policy header 
coverage date. 

6. Click [Next]. A list of current in force policies will be displayed. 

7. Select the policy to endorse and click [Next].  (If a policy displays a lock icon, the policy does not 
have a status that can be endorsed at this time. For example a Pending status on a policy may not 
be serviced until the pending item is posted, aborted or the status of the pending item has been 
changed to submitted, 2nd or 3rd request.) 
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8. On the policy underwriting screen the endorsement status defaults to Pending. The endorsement 
status will also display on the policies summary screen and the Home > Endorsement menu until 
the endorsement is posted or aborted. 

• An action is created using the description entered for the endorsement on the servicing 
screen. The action is used as a notation of the event, therefore, make sure the status is 
Closed. All endorsements should be tracked from the Home > Endorsement menu until the 
endorsement is either aborted or posted. If additional information is needed to complete the 
endorsement leave the status set to pending, make sure the action status is open and enter 
the appropriate number of days to follow-up on the action. Additional memos may be added 
to the action associated to the endorsement as needed. Keep in mind that the last memo 
entered is what will display on the policy summary page and will remain with the policy after 
the endorsement is posted. Therefore it is important to make sure the final description 
entered is what is needed to identify the policy or endorsement from policy summary. 

9. To enter the change, first note that the navigation tab is displayed on the right with links to the 
pending endorsement and the applications in the tree view. 

• Make the changes on application for the appropriate line of business form(s). 

• As changes are made to the application please note the following:  

• Adding a new item to a schedule will display an A from the schedule summary view to the 
right of the item; deleting an item (select the remove icon) will display a D on the right side 
of the item from the summary view and changing a scheduled item will display a C to the 
right side of the item.  

• It is important to make any applicant, location or billing changes to the ACORD 125 for 
commercial lines policies as the change request is mapped to the ACORD 125 for these 
details. 

• If you get side tracked and cannot remember where you left off use the Compare Policy: [On] 
[Off] link on the navigation toolbar in the application to compare this edited version of the 
application to the original application. Anything highlighted in red is an item that is different 
from the original application. 

To populate the change request: 

a. Click on the underwriting link at the top of the navigation tab to close tree view. 

b. Click the Populate icon to populate change request form.  

Note: If manual population is not desired, select the accept option to proceed and populate the 
change request with the changes entered on the application. 

c. Make sure to review the endorsement by clicking on the "+" next to the Pending Endorsement 
link on the navigation tab. 

10. Enter any necessary information to complete the endorsement making sure to save changes. 

Tip: To view the dates of the changes, click the "+" next to endorsement(s) on the navigation tab. 
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Aborting an Endorsement 

An endorsement may only be aborted (removed) if the status is still pending.  Once the status has been 
changed and saved by clicking on the Save Changes link in the navigation toolbar, the endorsement may 
not be aborted. Status cannot be changed back to pending. 

 

Endorsement Statuses  

A pending status means that the endorsement is incomplete and not ready to be submitted to the carrier. 
As long as the status is identified as pending any changes may be made to the endorsement. However, 
another endorsement cannot be added until it is either aborted or the status is changed. The other status 
options are as follows: 

• Submitted 

• 2nd Request 

• 3rd Request 

Submitted indicates that the endorsement is ready for submission to the carrier and has been sent to the 
carrier. 2nd and 3rd Request indicates the number of times that endorsement has been submitted to the 
carrier to be handled. Once the status has been changed from pending to submitted, 2nd or 3rd request 
the endorsement may not be changed nor can the status be changed to show pending again. As long as 
an endorsement does not have a status of pending new endorsements may be added. 

If the status was changed from pending and the Save Changes link was selected by mistake, the only 
recourse is to post the endorsement and enter a description indicating the mistake. It is recommended 
prior to posting, that the action memo be modified to indicate the mistake as well. The action remains on 
the Home > Endorsement menu to remind the user that the actual endorsement has not been received 
from the carrier. To identify that the endorsement has been received, post the endorsement. Posting the 
endorsement removes it from the Home > Endorsement menu. 

  

Related Topics 

Endorsements and Installment Billing 

  

Issuing a New Policy with the Mode of 'Renew' 

All Policies entered manually into Nexsure for the first time will have a mode of New.  If the client has had 
the coverage with the agency for a number of years, the mode should reflect Renew when the policy is 
issued.  The user will need to go through Servicing > Renew when issuing the policy.  This will allow 
reports to reflect correctly.  Enter the policy through marketing as normal (See the Marketing section of 
help for assistance).  When the marketing policy is ready to be issued: 

1. On the Primary menu, click SEARCH. 
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2. Click the Details   icon of the appropriate client. 

3. On the Client menu, click MARKETING. 

4. Click the Details  icon of the marketing policy. 

5. Click the In Force link in the navigation toolbar under the marketing header.  Click Save (do not 
create a binder).  This policy will have a mode of New. 

6. On the Client menu, click SERVICING. 

7. Select Renew and click [Next]. 

8. All in force policies for the client are displayed.  Select the check box for the newly In force policy 
and click [Next]. 

9. All marketing and in force policies for the client will be displayed.  Select the check box for the In 
force policy and click [Next]. 

10. The mode should now reflect Renew. 

Note:  The policy term and coverage term dates in the header will default to the next policy term. 
 Click the Calendar  icon for both dates and change the dates to the existing term.  Click the 
Save Changes link in the navigation toolbar under the policy header. 

11. Verify that the application data and the information on the policy info tab is correct then click the In 
force link in the navigation toolbar under the policy header. 

12. On the Client menu, click POLICIES. 

13. Delete the policy with the mode of New or send it to history with a description of why it was sent to 
history.  

Placing a Remarketed Policy in Force 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click SERVICING. 

4. Select Renewal and click [Next]. 

5. All in force policies for the client are displayed. Select the policy to be renewed and click [Next]. 

6. All marketing and in force policies for the client will be displayed. Select the policy being 
remarketed, along with any other lines of business that need to be included in the renewal and 
click [Next]. 
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7. The underwriting screen is displayed. The mode will display Renew and the status displays 
Future. Select the Issuing and Billing Carrier from the drop-down boxes, enter the policy number 
if available and review the policy term dates for accuracy.  

8. Click the Save Changes link in the navigation toolbar under the policy header.  

9. The mode will now display Re-New-Co and the status displays Future. This indicates that the 
policy is a renewal to the agency but is new to the carrier. The mode will remain as Re-New-Co 
throughout its policy term. Review the application and update the premium information on the 
policy info tab. 

10. Click the In force link on the navigation toolbar located just under the policy header. 

11. If a binder is needed select the Bound option and select the check box to create a binder. (See 
Creating a Binder). 

12. Click Save. The status of the policy now displays as In force. 

13. The expired policy, along with any un-issued remarketed policies, should be sent to history.  (See 
Sending an Expired Policy to History). 

Renewing with a New Carrier 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client.  Or from the Home menu > EXPIRATIONS link, 
click the Details  icon next to the appropriate client. 

3. On the Client menu, click SERVICING. 
 

 

4. Select Renewal and click [Next]. 

5. All in force policies for the client are displayed. Select the policy to be renewed and click [Next]. 
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6. All marketing and in force policies for the client will be displayed. Click the Select check box for 
policies needing to be included in the renewal from the current and/or marketing list and click Next. 

Splitting a package policy into monoline policies 

1. To create monoline policies select the policy to renew and then the line of business to create, click 
[Next], this creates the first monoline policy. 

2. Go back to Servicing > Renew until all the new monoline policies are created. 

Note: When a policy is selected the system automatically copies the existing applications so the 
user will not need to re-key application information. 

 

3. The underwriting screen is displayed.  Select the new Issuing and/or Billing Carrier; click the 
Save Changes link under the header.  The mode will now display Re-New-Co and the status 
displays future.  This indicates that the policy is a renewal to the agency but is new to the carrier. 
 The mode will remain as Re-New-Co throughout its policy term.  Review the application for 
accuracy and make any necessary modifications.  (See Working with Forms for assistance in 
navigating the forms). 

Note: When a policy status is future the application may be edited.  This allows the user to make 
any changes to the application as needed.  Endorsements processed in the expiring policy term 
are done through Servicing > Endorse.   

4. A policy with a future status may be modified, as necessary, until the policy is placed in force.  The 
policy info tab is not populated from the previous policy and must be entered before placing the 
policy in force. The user determines when to place the future policy in force.  (See  Changing 
Future Status to In-Force ). 
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5. The expiring policy is separate from the newly created future policy. The user determines when to 
send an expiring policy to history.  (See  Sending an Expired Policy to History ). 

Servicing > Renewal  

The SERVICING > Renew option is used when the policy is ready to be renewed.  

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon for the appropriate client.  Or, from the HOME > Expirations link, click 
the Details  icon next to the appropriate client. 

3. On the Client menu, click SERVICING. 

 

4. In the Select column, click Renew. 

5. In the Description box, enter a description for the action annotation. The description will display in 
the memo field of the action created. The effective date (Eff. Date: box) at the top of the servicing 
tab defaults to the current date and does not need to be changed when renewing the policy. The 
expiration date of the expiring policy will automatically be the effective date for the renewal. 

6. Click [Next]. All in force policies for the client appear.  

7. Select the policy to be renewed and click [Next]. All marketing and in force policies for the client ap
pear.  
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8. Click the Select  check box next to policies that need to be included in the renewal from the 
current and/or marketing list.  

The expiring version of the policy is highlighted in yellow and automatically selected. If the version 
of the policy is in marketing, make sure to click the [Show] link and choose to Include Marketing 
policies from the Policy Stage drop-down list.  

 
Note: Deselect any policies that should not be included in the renewal by clicking check boxes 
 in the Select column. 

9. Click the [Next] link in the upper right corner. The future policy is created. Notice that the status of 
the renewal has a status of Future. Any changes necessary for the renewal policy may be made 
as long as the status reflects a status of Future.  

10. After all changes have been made (including editing the premium amount on the policy info tab), 
click the In Force link on the navigation toolbar on the underwriting screen.  

11. Click Save. Notice that the Status is changed to In Force. An in force status requires modifications 
to be done through SERVICING. 

Note: Changing the carrier on the policy header and clicking the Save Changes link on the 
underwriting screen changes the Mode to Re-new-co (Renewal to the branch but new to the 
carrier). 

12. Return to the policy summary screen by clicking on the POLICIES link on the Client menu.  

  

Splitting a package policy into monoline policies 

1. To create monoline policies select the policy to renew and the line of business to create. 
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2. Click [Next] to create the first monoline policy. 

3. Go back to SERVICING > Renew until all the new monoline policies are created. 

Note: When a policy is selected, Nexsure automatically copies the existing applications so 
there is no need to re-key application information. 

 

4. The policy term will reflect the new term dates, the Mode is Renew and status shows Future. 

Note: When a policy status is Future the application may be edited. This allows changes to the 
application as needed. Endorsements processed in the expiring policy term are done through 
SERVICING > Endorse. 

5. The policy info tab is not populated from the previous policy and must be entered before placing 
the policy In Force.  See In Forcing a Future Status Renewal 

6. The expiring policy is separate from the newly created future policy.   See Sending an Expired 
Policy to History . 

It is important to send the renewed expired policy to history. Policies set to expired unintentionally 
can be changed to In Force by clicking the In Force link on the underwriting navigation toolbar.  

Note: A policy with an Expired status cannot be endorsed. 

 

Combining monoline policies into a package policy 

1. Click the SERVICING link at the Client level and select the Renewal option. 
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2. Enter a description for the action annotation to describe the renewal and click the [Next] link at 

the top right of the screen. 

3. If necessary, select the expiring policy using the [Show] link to filter through a lengthy list of 
policies. 

4. Select the policy in the Select column on the left. 

 
5. Click the [Next] link at the top right of the screen. The expiring version of the policy is highlighted 

in yellow and automatically selected.  

 
Be sure to choose only the applications that make up the renewal. If the version of the policy is in 
marketing, perform the following: 

6. Click the [Show] link and choose to Include Marketing policies from the Policy Stage: drop-
down list box and click the Search button to return the results. 
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7. Choose all policies to be included in the renewal by clicking the check boxes in the Select column. 

8. Click the [Next] link on the upper right corner. The future policy is created and displayed. 

 
  

Related Topics 

Renewing with a New Carrier 

Remarketing a Policy 

Placing a Remarketed Policy in Force 

Issuing a New Policy with the Mode of Renew 

In Forcing a Future Status Renewal 

Sending an Expired Policy to History 
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Servicing > Cancellation 

Cancellation is used to complete a Lost Policy Release form and to identify a policy that is pending 
cancellation. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click SERVICING. 
 

 

4. Select Cancellation. 

5. Select the method of cancellation:  

• Flat - The cancellation effective date is the effective date of the policy, without any 
premium charged.  

• Short-Rate -The cancellation effective date is mid-term; the earned premium changed is 
more than the pro-rata earned premium.  

• Pro-Rata - The cancellation effective date is mid-term; the earned premium is calculated 
only for the period coverage was provided.  . 

6. In the Description field, enter the description and effective date of the cancellation. 

7. Click [Next].  A list of current in force policies will be displayed. 

8. Select the policy to cancel and click [Next].  The cancellation header will appear in Red font and 
have a status of Pending.  

9. The effective date of the cancellation will appear in the header as the coverage term expiration 
date: 
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10. The cancellation form is available for completion in the navigation tab to the right of the screen. 
 Complete the form as described in the Marketing > Working with Forms topic. 

11. The cancellation action created will default to Closed and the due date will default to the effective 
date of the cancellation.  Complete the action as described in the Actions topic. 

12. On the client menu, click Policies.  This will display all in force policies for the client in summary 
view.  The pending cancellation will display with red font. 

 

13. On the Utility menu, click Home. 

14. On the Home menu, click Cancellations. 

15. The pending cancellation will appear on the cancellations link of the Home menu until the 
cancellation is either posted or aborted. The [Show] filter can be used to narrow down the list of 
clients who are in a Pending Cancellation status. 

Posting a Cancellation 

1. On the Home menu, click Cancellation. 

2. Click the 2nd Details  (white) icon of the appropriate client. 

3. Click the Post Cancellation link under the policy header. 
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4. Choose the status (reason for cancellation) from the drop-down box and enter any applicable 
notes.  The default options are Canceled by Agent, Canceled by Carrier, Canceled by Insured. 
 Agency-specific reasons (i.e. "Canceled for non-payment") can be added in Setup > Lookup 
Management. 

a. On the Utility menu, click Setup. 

b. In the Setup Console, click Lookup Management. 

c. From the Category drop-down list, select policies. 

d. From the Types box, select Cancellation Reasons. 

e. Enter a Reason. 

f. Enter a Description.  Whatever is entered in the Description field will appear in the 
Notes box when posting a cancellation with that specific reason. 

g. Click the Update link. 

Custom reasons may be deleted or updated until they have been put in use by being 
selected during a cancellation.  At that point a custom reason can not be deleted or edited. 

Note: The default system reasons can not be deleted or updated. 

5. Click the Save button.  The policy header will be displayed in a gray color; the canceled policy is 
sent to history. 

  

To access the policy in history 

1. On the Client menu, click policies and then on the history tab. The history summary tab is 
displayed.  

2. Click the Details  icon: 
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Tip: To view the cancellation date, in the navigation panel, click the "+" next to Cancellation(s).   

Reinstate 

Reinstate is used to restore the canceled policy back to its original state with no lapse in coverage. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. 

4. Click the history tab. 

5. Click the Details  icon of the appropriate policy in history to be reinstated. 

6. Click the Reinstate link under the policy header. 

 

7. A pop-up box will be displayed. Click OK to reinstate the policy. 

8. The policy header will turn blue and the status will show Reinstated. 

9. Click the In force link under the policy header to change the status from Reinstated to In force.  If a 
binder is needed select the Bound option and select the check box to create a binder.  Otherwise 
click Save. 

10. A record of the cancellation will remain on the policy until the renewal is processed. 
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Rewrite 

Rewrite is used when a revision needs to be made to a policy in cancellation status, say for example a 
lapse in coverage or a new carrier. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. 

4. Click the history tab. 

5. Click the Details  icon of the appropriate policy in history to be rewritten. 

6. Click the Rewrite link under the policy header. 

 

7. The policy will turn to a Wheat color and is placed into a marketing stage.  Complete the marketing 
process as described in the Marketing > Marketing Underwriting topic.   

Servicing > Claim 

The claim option is used to generate a claim form. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click SERVICING. 
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4. Select the Claims option; select the Line of Business from the drop-down box, enter the 
description i.e. "Our client rear-ended other party" and Date of loss of the claim. 

5. Click [Next].  Policies, including copies sent to history that fall within the date of loss, are 
displayed. 

6. Select the appropriate copy of the policy and click [Next]. 

7. The underwriting header will appear with a Red border around it.  The pending claim will display on 
both the Home menu > Claims link and the Client menu > Claims link.  It will also display on the 
Client menu > Policies link with a red border around the policy until it is either Posted or Aborted. 

8. The appropriate claim form for the line of business selected will be available for completion. 
 
ACORD 1 – Property Loss Notice   

This form is used for reporting commercial and personal lines property losses. 

ACORD 2 – Auto Claim  

This form is used for reporting commercial and personal lines auto losses. 

ACORD 3 – General Liability Notice of Occurrence - 

This form is used for reporting commercial and personal liability losses. 

ACORD 4 – Workers Comp First Report of Injury or Illness 

This form is designed as a first notice of a claim for injury or illness by an employee. 

  

Note: 9 through 17, below, describe using the populate button to populate an auto claim form. The 
populate workflow is similar on all claim forms. 

9. Click the Populate  button. 

10. Select the Agree option. 
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11. Click Accept. 

12. Click in both vehicles and drivers check boxes (if loss pertains to both) 

  

13. Click Next. 

14. Select vehicle involved in loss. 

 

15. Select Drivers from the drop-down box.  

16. Select the Driver involved in the loss. 
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17. Click Finish. 

Note: This pulls the vehicle and driver information from the application over to the claim form. 

18. Click " + " next to Pending claim form in the navigation tab 

19. Review the claim form for accuracy and populate the incomplete sections of the form as described 
in the Working with Forms section of help. 

Tip: Clicking "+" next to Claims will display the Date of Loss. 

20. Click the underwriting link to close tree view. 

21. Click the claims tab.  All claims for this policy will appear in a summary view. 

22. Click the Details  icon of the claim.  This is where claims information can be stored on an 
ongoing basis. 

Note: If making changes to the claims screen always remember to click the Save Changes link in 
the navigation toolbar under the claim header. 

23. Clicking the Details  icon of the claim form will open the claim form up on the underwriting tab to 
review and/or edit the information. 

24. The claim action created will default to Closed.  The action status can be changed to Open and 
the memo field can be used to track monies paid out.  Complete the action as described in the 
Actions topic.  

25. Complete the following fields: 
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• Adjuster Name & Phone 

• Date of Loss - Pulls from servicing screen. 

• Date Reported - Pulls from servicing screen. 

• Claim No 

• Estimated Amount 

• Reserved Amount 

• Total Paid Amount - This field will be automatically updated as payments are added. 

• Description - Pulls from the servicing screen. 

• Memo - Optional. 

26. Click the Save Changes link in the navigation toolbar under the claim header. 

Delivering a Claim 

Once a Claim has been created, it can be delivered via fax or email 

To deliver a claim 

1. Click the Delivery link on the Client menu.  If there are no records found click the here link to Add 
New. 

2. Select the method of the delivery, the email or fax tab. 

3. Enter the email or fax information on the left. 

4. On the right, in the Claims section, click [Add New]. 

5. Select the Claim to deliver and click Next. 

  

6. The claim will be attached, click Send. 
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Aborting a Claim 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click CLAIMS. 

4. Click the Details  icon of the appropriate claim. 

5. Click the Abort Claim link in Navigation toolbar under the claim header. 

Posting a Claim 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click CLAIMS. 

4. Click the Details  icon of the appropriate claim. 

5. Click the Post Claim link in Navigation toolbar under the claim header. 

Note: Once the claim is posted a reopen link is available on the navigation toolbar under the claim 
header. 

Posting an Audit 

To post an audit 

1. On the Primary menu, click SEARCH.  

2. Select a client. 

3. On the Client menu, click SERVICING. 

4. Select the Audit option and click [Next]. 

5. Select the policy to be audited and click [Next].   

Note: If you wish to audit multiple policies for the same client, a separate audit must be performed 
for each policy. 
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6. Make the desired changes to the policy and/or premium.  Click Save Changes. 

7. After the changes are made and saved, select Final or Disputed in the Status drop-down list.   

8. Click Post Audit.  Clicking Abort Audit will cancel the audit process.   

Tip: You can view all existing audits from the Home > Audits menu. Audits will also be displayed 
on the client history screen. 

Certificate Renewal 

The renewal process displays policies that have changed since the last issuance of certificates. 
 Temporary access can be granted to clients so they select which certificates they would like to have 
reissued.  

To Renew Certificates 

1. On the Client menu, click SERVICING. 

 

2. Select Certificates > Renew and click [Next] a list of policies that have changed will be 
displayed. 
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3. Select the policy(s) and click [Next]. 

Note: If the certificate form has expired, Nexsure will notify you that a new form is available. Click 
Accept to migrate the data to the new form.  Please verify that the new form is populated correctly. 

 
  

4. Select the Renew option and choose the delivery method, email, fax or both. To let the client 
select which certificates get renewed, see Granting Temporary Access to Clients below. 

Note: This process cannot be aborted after [Next] is selected. To review selected certificate(s), 
select "Back".  

5. Click [Next]. 

6. Renewal certificates are processed in the background and are displayed in blue text on the 
certificates tab.  A status of Active, shown in black text, indicates the successful creation of the 
certificate.  To confirm delivery, click the delivery tab.  

Related Topics 

Creating New Certificates 

Certificate Batch Printing 

Copying Certificates 

Client Access for Certificates 

   

Certificates Now (ConfirmNet) 

To receive a certificate through ConfirmNet, the following is required: 

• An additional login for access to ConfirmNet. 

• The client must have a primary location, and the location must have a primary phone. 

• The client must also have a primary SIC Code. 

• An In force policy with effective and expiration dates. 

Note: Currently, workers compensation, general liability and BOP (Business Owner 
Policy) are the only lines of business supported for integration. 
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To issue certificates of insurance 

1. Select the entity you wish to issue certificates to. 

2. On the Client menu, click SERVICING. 

3. Select Certificates Now and click [Next]. 

Client Access for Certificates 

Clients may have several certificate holders associated with a policy, but not wish to issue certificate 
renewals to each holder.  Nexsure users can grant temporary Nexsure access to clients so they can 
select which certificate holders will be issued a renewed certificate. 

1. On the Client menu, click SERVICING. 

2. Select Certificates > Renew and click [Next] a list of policies that have changed will be 
displayed. 

3. Select the policy(s) and click [Next]. 
 

 

4. Click the NIC  icon. 
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5. In the Select Contact drop-down box, choose the recipient of the temporary access.  You can 
grant multiple contacts access, but they must be sent one at a time. 

Note: If the client you wish to grant access to is not in this drop-down list, they must be added from 
the Client Profile > contacts tab. Close the Create Temporary User dialog box, add the contact 
and then the client will appear in the drop-down list. 

6. Select the number of days the contact will have access. 

7. Enter a custom message, or accept the default. 

8. Click Send. The dialog box will remain open to allow another contact to be selected.  If there are 
no other contacts to grant access to, click Close. 

9. An email with a link to the certificate(s) will be delivered to the contact. 

 

10. The contact must click the link in the email to be redirected to the certificate(s). 

Note: The temporary access link can only be accessed one time. 
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11. Once the user has accessed the certificate(s) and clicked the Logout link, an email will be 
returned to the Nexsure agent notifying them that the contact has reviewed the summary of 
insurance. 

  

Related Topics 

Creating New Certificates 

Certificate Batch Printing 

Certificate Renewal 

Copying Certificates 

  

Creating Certificates 

Nexsure offers the ability to create a certificate of insurance for one or multiple Holder/Additional 
Interest(s) in a single process. A separate certificate will be created for each Holder/Additional Interest 
added. You have the option to add a Holder/Additional Interest from an existing group of holders that 
have been used for this insured. Search Nexsure for a Holder/Additional Interest that may be already 
entered in Nexsure or create a new Holder/Additional Interest record.  

Note: The disclaimer is now available when furnishing a certificate of liability, ACORD 25, to 
holders. The disclaimer prints on the second page of the certificate.   Please contact Nexsure Support if 
your organization wants to add the disclaimer to all ACORD 25 forms.  

 
To create a certificate of insurance 

1. Select the entity you wish to create a certificate for. 

2. On the Client menu, click SERVICING.  

mailto:mailto:support.nexsure@xdti.com?subject=ACORD 25 Disclaimer
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3. In the Certificate(s) row, select New. 

4.  In the Description box, enter a description for the certificate. 

5. Click [Next]. 

 

6. Select the type of certificate to create and select the Insured Name from the drop-down list.  

7. Select an Authorized Representative Signature from the drop-down list.  This signature will 
appear on the certificate.  The authorized representative that you select must have a signature file 
appended to their employee details screen. 

Note: If you select the Existing Holder option, you must still click on the entities name to highlight 
it in the box before clicking [Next]. 

8. In the Description (optional) box, enter an option description. 

9. Click [Next]. 
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10. In the Coverage Summary area, click the [Add New] link to add a line of business. 

11. Select the appropriate line(s) of business for the certificate and click [Next]. 

12. Click the certificate holders tab to add certificate holder(s): 

 
Select one of the following options: 

Existing holder for this client - When selecting the existing holder, you must still select the 
entity name to highlight it in the box, then click Use Selection. 

Search org-level additional interests - Selecting the Search Holders option will open the 
additional interest search dialog box. 

 
You can search by name, address, phone number etc.  Select the Search By item from the 
drop-down list, enter at least two characters in the search field and click Search.   

Select the additional interest you were searching for and click Use Selection. 

Notice that when you clicked Use Selection in the search screen, it added the name to the 
certificate.  If you there are other additional interests in the box you wish to add to the 
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certificate, select each one and click Use Selection.  To select multiple additional interests, 
hold the ctrl key, select the name, and click Use Selection. 

 

Tip: Additional interests can be removed from the certificate by selecting the Remove  
icon for that particular name. 

  

Create new holder 
 

• Selecting the Create New Holder option will allow you to enter information on a new 
additional interest on the certificate holders tab.  Once you have added the 
additional interest name and contact information, you can also enter a Description of 
Operations/Special Instructions at the bottom of the screen by clicking Add New. 

• Once your information is complete, click Save. 

• Selecting the certificate tab will open the fields for the ACORD certificate form for the 
additional interest you just added. 

• To view any other certificate holders you have added, click back on the certificate 
holder tab. 

  

13. Once the certificate holders have been added, you can view and edit the details of a record by 
clicking the Details   icon.  Clicking the details icon will also give you access to the Description 
of Operations/Special Instructions section for a specific Holder/Additional Interest.  Remember, a 
separate certificate will be created for each holder listed.  Each certificate will display the selected 
Holder/Additional Interest Description of Operations/Special Instructions.  
 

To add Special Instructions 

• On the Certificate Holders tab, click the Details icon for the specified holder. 

• In the Description of Operations/Special Instructions area, click [Add New]. 

• Enter any special instructions into the text area.  Information entered into this area 
will appear after the standard description of operations text entered while creating a 
new certificate of insurance.  

• Click Save. 
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Tip: To edit any information in this area at a later time, click the Details  icon for the 
specified special instructions. 

 
Tip: Clicking the blue column headings will sort multiple certificates by the perspective 
heading. 

14. To populate the certificate form, select the certificate tab. 

 

15. Enter the certificate information using the navigation links on the right.  Click Save Changes, then 
click Next. 

Note: If the special conditions and certificate holders were already added from the certificate 
holders tab - do not enter them again in this area. 

16. Click Print, Issue or click Abort to cancel the certificate. 

Note: Once a certificate has been issued, it cannot be modified. 
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Related Topics 

Certificate Batch Printing 

Certificate Renewal 

Copying Certificates 

Client Access for Certificates 

  

  

Servicing > Verification 

The Verification screen is for generating verification of coverage forms, such as Auto ID cards. 

1. Click Search and select the client. 

2. On the Client menu, click SERVICING. 
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3. Select Verification and click [Next]. 

4. Select a policy to generate verification for. If there are multiple records on a policy, such as multiple 
vehicles on an auto policy, you can use the Select All Records or Deselect All Records options. 
Once you have selected the records for verification, click [Next]. 

 
5. Each vehicle on the policy will be displayed in the Verification Summary.  Select a Form in the 

drop-down list, the ACORD 50 is the default. 

6. Select the Insured. 

7. If you have selected a form or insured other than the default, click Save Changes. 

8. Click Issue for individual vehicles Issue All. 

9. Click Print to send the verifications to a printer or to PDF format. 

  

Attachments 

The attachment option allows the user to attach photographs, documents, email, etc to a client or to a 
client’s policy.  Documents can also be created using pre-designed templates. There are two levels of 
attachments that can be created, the client level and the policy level: 
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Client Level Attachments 

This attachment is created from the ATTACHMENT link in the Client menu. An attachment created here 
would contain general information pertaining to a client. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click ATTACHMENTS. 

4. Click the [Add New] link. 

Note: The ATTACHMENTS link on the Client menu will display all attachments for the client being 
accessed. 

Policy Level Attachments 

This attachment is created from the attachments tab at the policy level. An attachment created here 
would pertain to a client’s policy. 

1. On the Primary menu, click SEARCH. 

2. Click the Details  icon of the appropriate client. 

3. On the Client menu, click POLICIES. 

4. Click the Details  icon of the appropriate policy. 

5. Click the attachments tab. 

6. Click the [Add New] link. 

  

7. The Add New Attachment pop-up window is displayed. 

Note: From this point forward adding an attachment is the same for both client and policy levels. 
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There are five choices, only four are available at this time: 

• Add Attachment: Allows pictures, word documents, etc. to be attached that have been saved to 
one of the agent's drives. See Adding an Attachment. 

• Create Document with Template: Allows a document to be created using an existing template that 
was created in Setup.  See Create Document with Template (Before a template can be appended 
as an attachment, it must be created in Setup) 

• Create Document without Template: Allows the user to create a document without using an 
existing template.  Documents created here cannot be saved globally to be used on other clients or 
policies. See Create Document without Template. 

• Attach Outlook Messages: Allows users to attach an email message from outlook. See Attaching 
Outlook Messages. 

• Add External Attachment: Not available, this is a future enhancement. 

  

Related Topics 

Using Document Templates 

Agency Billing 

Agency billing generates a record for the agency showing the amount received from the client and the 
amount due to the carrier. 

To invoice using agency billing 

1. Select the client you wish to invoice. 

2. On the Client menu, click TRANSACTIONS. 

3. Click [Add New Invoice]. 

4. Select the Policy option.  In the View drop-down list, select Current or History. 

5. Select a policy number from the Policies field and click OK. 

6. Using the quick navigation panel, complete the following screens: 

Invoice Header 
 

• Bill Method: Select Agency (default).  

• Annualize: (Checked by default) Clearing this check box enables exclusion of annualized line 
items when invoicing. This option is helpful for short term policies or special event policies.  

• Bill Type: Select Regular Bill (hits all appropriate general ledger accounts), Binder Bill (hits 
accounts receivable, binder bill payables and appropriate income and expense accounts) or 
Manual Bill (is recorded in the system but does not affect any general ledger accounts). 

• Department: Select a Department. 
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• Unit: Select a unit. Units are a subset of departments that provide additional income and 
expense breakdown if needed. 

• Effective Date: Select the effective date of the transaction.  The default effective date is the 
date booked.  This date determines the period that the invoice will post in. 

• Full Pay: Select if billing in full. 

• Compound Billing: Select if the premium is being spread over multiple payments.  Selecting 
this option will add the following additional fields: 
 

• Down Payment Amount: 

• Down Payment Date Due: 

• Payment Plan: 

• Number of Compound Billings: 

• View Other CBs: Shows other billing dates a client may have.  This is to synch up 
billing dates. 

• 1st Compound Billing Eff. Date: 

• Fee Option:  

• Tax Option: 

• Rounding Option: 

• Amount Due: Defaults from premium entered on policy. 

• Date Due: 

• Days until Past Due: 

• # of Print Days Before Eff. Date: 

• Unique Invoice Message: 

• Internal Note: 

 

Bill To 

 
This information is pulled from the policy but can be changed. Any named insured may be selected 
as the Bill To on invoices. 

To change Bill To information 

1. In the quick navigation panel, select Bill To. 

2. Click Change Bill To. The Bill To pop-up appears with the Client option selected with all 
named insureds displayed. 

Tip: If a long list of named insureds is displayed, enter a name in the search field and click 
Search. 
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3. Select the entity and named insured to bill. 

4. Click Next. 

 

5. Select the location and contact name from the drop-down lists and click Next. 

6. The new Bill To information is displayed, click OK to confirm the change. 

Policy Header - Displays policy information 

Invoice premium - This screen allows you to make changes to a current policy premium by 
clicking the Details  icon.  You can also add a new premium. 

Invoice Non-Premium - Add any new non-premium items to the invoice.  These include fees 
and taxes. 

Invoice Commissions - Add any commissions to the invoice.  If default commissions exist 
for Carrier, People or Fees, they will be created automatically.  Defaulted commissions can 
be edited. 

7. Once the invoice has been created, click Invoice Details to verify the information in the new 
invoice.  If all information is correct, click Post Now. 

8. Invoice Posting - Displays general ledger posting entries for this invoice. 
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9. Receivable Tab - Displays client's receivables data including payments assigned for agency bill or 
carrier receivable data for direct bill. 

10. Payables Tab - Data for Carrier, People and Tax Authority payables including payments assigned. 

Note: Once a policy is invoiced, changes to the issuing/billing carrier cannot be made unless all 
invoices associated with the policy have been reversed. 

Transaction Summary 

The Transaction Summary screen displays all summary data for any of the following items: 

• Detail Assigned 

• Invoice Summary 

• Assigned Payments 

• Summary View 

• Unposted Invoices 

• Posted Invoices 

• Reversed Invoices 

• Unassigned Payments 

To view summary information on one of these items, select the view in the Select View drop-down list, 
and click search.  You can enter search criteria to narrow your search. 

Client Balance Summary 

The Client Balance Summary screen displays a client's agency bill current balance, aging at 30/60/90, as 
well as total, future, and grand totals. 

To access the Client Balance Summary 

1. Select a client. 

2. On the Client menu, click the transactions link. 

Note: The Client Balance Summary is only available at the client-level. 
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Note: The client balance summary screen updates will occur during night utilities. 

Review Date - Equals the exact date for login user’s time zone and refresh of view screen 

Last Update Date - Equals the date the last internal update for balance summary occurred 

Last Transaction Date - Equals the date the last transaction affecting any information displayed 
was entered. 

Status - Represents when Update occurred 

Client Information is Current - Last Transaction Date< or = Last Update Date 

Client Information is Not Current - Last Transaction Date > Last Update Date 

• Client balance would equal the total for accounts receivable report with last update criteria. 

Client Balance Calculations 

• Calculations will be a debit or credit totaled together depending upon the aging of the item 
based on date booked. 

• All transactions affecting the accounts receivable are included: 

• Invoices 

• List bill invoices 

• Installment invoices 

• Regular invoices 

• Reversals 

• Binder Bill Activity 

• Receive Payment 

• Only those items that the system offsets to accounts receivable 

• Reversal 

• Disbursement 
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• Only those items that the system offsets to accounts receivable 

• Reversal 

  

Only posted activity will be calculated: 

Current - Includes any transaction affecting the client account receivables as of today’s date and 
30 days prior to today’s date. 

Over 30 days - Includes any transaction affecting the client account receivables as of 31 days 
prior to today’s date through 60 days prior to today’s date. 

Over 60 days - Includes any transaction affecting the client account receivables as of 61 days 
prior to today’s date through 90 days prior to today’s date. 

Over 90 days - Includes any transaction affecting the client account receivables as of 91 days 
prior to today’s date. 

Total Due - Includes a cumulative total of all transactions prior to and including today’s date. 

Note: Total Due should always equal the total of Current, Over 30 days, Over 60 days, and Over 
90 days. 

Future - Includes any transaction affecting the client account receivables after today's date. 

Grand Total - Includes all items affecting the general ledger from the beginning to the end of time. 

Last Payment Date - The last posted entry for the account entered through receive payment 
based on date booked. 

Client Activity 

In the client activity below, unposted activity will be considered as any entry other than unposted 
reflecting posted invoices. 

 Total Unposted Invoices - represents the grand total of premium, fees, and taxes for any 
unposted invoice activity from the beginning to the end of time (excludes Manual and BOB 
invoices). 

Total Unassigned Payments - Total for residual posted receive payments (residual = not 
assigned to an item). 

Total Open Binder Bills - Total of all posted open binder bill invoices (excludes Manual and BOB 
invoices). 

Total Agency Bill Commissions - Total of all agency billed commissions from the beginning to 
the end of time based on posted invoices (excludes Manual and BOB invoices). 

Total Direct Bill Commissions - Total of all direct billed commissions from the beginning to the 
end of time based on posted invoices (excludes Manual and BOB invoices). 

Total Commissions - Total of the entire agency plus direct billed commissions from the beginning 
to the end of time based on posted invoices (excludes Manual and BOB invoices). 

Total Commission Expense - Total of all commissions shown as other in invoices from the 
beginning to the end of time based on posted invoices (excludes Manual and BOB invoices). 

Net Commission - Total of commissions less the total of commissions paid to others from the 
beginning to the end of time based on posted invoices (excludes Manual and BOB invoices). 
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Client Premium 

In the premium calculations below, policy info value totals will be used. 

Annualized Premiums - The grand total of annualized premiums on all in force policies 

Billed Premiums - The grand total of billed premiums on all in force policies  

List Billing 

List bill provides a means of splitting a premium over multiple entities and locations. A list bill is comprised 
of one master policy billed to multiple locations. The master policy provides insurance coverage for 
locations insured on a policy. Up to 300 combined locations and related accounts can be associated to 
the master account and of those, up to 15 may be selected into a single list bill plan for automatic 
inclusion in an invoice. The locations are attached to the master client via its related accounts tab.   

List billing is based on a percentage of the risk that each location will pay thus creating multiple 
receivables and multiple payables based on the entities involved in each individual billing. The carrier 
payables are based on an installment schedule generated over the specified number of locations, not 
time. 

List Bill Setup 

1. All Clients (the master client and the related accounts) are added to Nexsure following the normal 
procedures. See Adding Suspects, Prospects and Clients for assistance. 

2. Each client's location(s) should be added on their respective locations tab. See Adding Locations 
for assistance. 

3. All related accounts need to be associated to the master client via its related account’s tab. As a 
result of list billing the related accounts policy will reside with the master client. See Adding a 
Related Account for assistance. 

4. The master policy(ies) is added to Nexsure through marketing following the normal procedures. 
See Policy Underwriting for assistance.  

Note: The client containing the policy to be list billed is the master client for that policy and all 
related accounts.  The master policy provides insurance coverage for all locations.  When 
completing the ACORD application for the master client add the locations, coverage’s, limits, etc., 
for the related accounts as well.   

5. The premium information is entered on the policy info tab following the normal procedures. See 
Policy Info Tab for assistance. 

6. The marketing policy is In forced following the normal procedures. See In forcing a Marketing 
Policy for assistance.  

Related Topics 

Creating a List Bill Plan 

List Bill Plan Invoicing 
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Creating a List Bill Plan 

Setting up a list bill plan is done at the client level. On the Client menu, click transactions.  The list bill is 
only available on the master client; it is created as a template to be used for billing the master policy and 
related account locations. 

1. On the Primary menu, click Search. 

2. Click the Details  Icon of the appropriate master client. 

3. On the Client menu, click transactions.  

4. Click the list bill plans tab. 

5. Click the [Add New] link.  The Add New Bill Plan pop-up window is displayed. 

 
• Plan Name: Enter the plan name. 

• Plan Description: Enter the plan description 

• Active: Leaving this box checked it makes the list bill plan available for use, if unchecked, the 
plan is not available for use at invoicing and is marked inactive. 

• Click OK. 

6. All current locations of the master account and the related accounts are displayed.  As locations 
and related accounts are added or deleted, they will be shown here. 
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Note: For a related account with multiple locations, the related account will be displayed once with 
each location. 

7. Select the locations to be included in the list bill plan by clicking in the appropriate Select check 
boxes.  As locations are selected, the allocate factor and the ellipsis button are activated. 

8. In the Allocation Factor column, enter a value based on square footage, premium dollars, total 
insurance to value, etc. for each related account or location.  

Note: Select one type of factor and be consistent for each location. 

 
9. Click Allocate.  Each value will be divided by the total amount of related accounts (or locations) 

and calculate its percentage of the total in the Percent column.  The total of the Percent column 
will equal 100%. 

Seven related accounts or locations can be displayed per page.  Nexsure runs a per page total 
(This Page Total) as well as a collective total (All Pages Total).  The Allocation Factor box will 
display in red once that unit's total has been added to the page total field. 
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10. Click Save. 

 
11. If the allocation factors are changed, click the Allocate link to update the page total and 

percentages based on the new allocation factors. 

12. Clicking the Details icon of a location will display the specific location information for the 
selected line item.  If changes are made click OK to save or Cancel to close without saving. 

 
13. Clicking the ellipsis button to the right of a location displays the producer(s) (Account Managers 

are not displayed) commission record(s) at the bottom of the screen in a summary view for that line 
item.  The number displayed to the right of the ellipsis button is the total number of producer(s) for 
that line item.  The commission defaults in if it has been set up for the producer.  The location 
record is highlighted in gray to designate the record being worked.   
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See Employee Commissions section of help for assistance. 

Note: For the master account, producers will not prefill.  The producer(s) displayed are at the client 
level NOT the policy level. 

14. If the producer is displayed with the incorrect commission rate, click the details icon of the 
commission record, adjust the commission and click OK to save the change. 

15. If no producer(s) is displayed, click the [Add New] link to pull the producer in to create a 
commission record for that line item.  
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16. The Add People Commission pop-up is displayed.  The Employees box defaults to the employees 
that are assigned at the client level as producers. 

 
• Select the Employee from the Employees box or use Search People option. 

• Select the Commission On from the drop-down box. 

• Select Fee: Fee selection permits the application of fee-specific commission rates.  Fees 
subject to commission do not need to have the same rate applied and can have a 
differentiating commission rate/rate type applied. 

Note: Only fees which are subject to commission will be available. 

• Select the Production Role and Production credit amount from the drop-down boxes 

• The Production Role and Production credit amount fields are used to designate the role and 
percent of business this employee brought into the Agency on this policy. 

• Select the Rate Type from the drop-down box 

• Key in the appropriate rate, Nexsure will calculate the commission based on the rate type 
chosen. 

• Click OK. 

Note: An unlimited number of people commission records may be added for each location, 
as people commission records are added, the commission column tallies the number of 
commission records for each location. 

17. Click the Copy Plan button to copy the existing plan, if desired.  This removes the need to re-key 
an existing plan and reduces the chances of duplicate entries. 
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18. A confirmation window is displayed.  Click OK to confirm and return to the original list bill plan. 

19. Once the list bill plan template is created, or copied, click List Bill Summary to exit. 

20. All list bill plans created will appear in a summary view on the list bill plans tab.  Notice the copy 
displays with “copy of” before the original plan name and the Active check box is not checked.   

 
Note: You must edit the copy and check the activate box to activate the copy. 

21. Click the details icon of the copied plan.  The entire plan along with the Plan Name and Description 
can be edited as needed.  Click the Active check box to activate the new bill plan and click the 
Save link to save.  Click the List Bill Summary link to exit the plan. 
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Related Topics 

List Bill Plan Invoicing 

List Bill Overview and Setup 

List Bill Plan Invoicing 

Once a list bill plan has been created, it is used as a billing template.  The Invoice is created at the client 
level on the master client.   

1. On the Primary menu, click SEARCH. 

2. Click the Details  Icon of the appropriate master client. 

3. On the Client menu, click transactions.  The transaction summary tab is displayed. 

4. Click the [Add Master Invoice] link.  The Invoice Add Policy pop-up window is displayed.  
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5. Select the Policy option, select Current or History from drop-down box, highlight the policy 
number to be billed and select the List Bill Plan from the drop-down box.  Click OK. 

6. Select the appropriate check boxes for Premium, Fees and/or Taxes to default in from the policy 
info tab of the master client, click OK. 

 

7. Using the links in the quick navigation panel, or the scroll bar, complete the following screens: 

• Invoice Header 

• Verify the Bill Method, Bill Type, Invoice Type, Department and Unit. 

• The Effective Date defaults to the Effective Date of the policy. 

• Date book defaults to effective date of policy or invoice creation date based on whichever one 
is later. 

• Enter the number of Days until Past Due. 

• Enter the number of Print Days Before the Effective Date. 

• Click OK. 
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• Premiums - Changes can be made to the existing premium by clicking on the details icon.  A 
new premium can be added by clicking the [add new premium] link. 

• Fees - Changes can be made to existing fees by clicking on the details icon.  A new fee can 
be added by clicking the [add new fee] link. 

• Taxes - Changes can be made to existing taxes by clicking on the details icon.  A new tax 
can be added by clicking the [add new tax] link. 

• Agency Commission - If a default commissions exist for the Carrier it will automatically 
default in.  Changes can be made to Agency commissions by clicking on the details icon.  A 
new agency commission can be added by clicking the [add new agency commission] 
link. 

Note: The Other commissions will become available after the Invoices are created. 

8. Click the List Bill Detail link in the quick Navigation.  A new List Bill Schedule is generated.  The 
list bill schedule is based on the information in the list bill plan template. 

 

9. Click the Create invoices link.  A separate invoice is created for each location shown in the 
schedule and automatically posts. 
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10. Each location has its own unique invoice number.  The total number of invoices will be reflected in 
the header. 

Note: Each invoice ID numbers displays on the transaction summary tab at the client level where 
the location record is located. 

11. Click the Transaction Summary to close the master invoice.  The transaction summary view of 
the master client displays only the invoice(s) for the master client. 

 

12. Each invoice is displayed with the master invoice number stacked below.  The master number is a 
hot link, clicking on the link will launch the entire bill plan for review and modification. 

13. The select client drop-down box will display the accounts related to the master client.  Select one 
of clients in the drop-down box to access that related accounts transaction summary tab. 
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14. The transaction summary view of the related account selected will display the invoices for that 
client’s location.   

 

15. Click the Details  icon of one invoice; Invoice header will display the master client info along 
with the location that is being billed for this invoice. 

Note: If an agent makes changes to a policy level assignment it will affect list bill.  List bill 
assignment comes from the client level. 

Direct Billing 

Direct billing generates an invoice to be sent to the client and records the commissions due to the 
agency. 

To invoice using direct billing 

1. Select the client you wish to invoice. 

2. On the Client menu, click TRANSACTIONS. 

3. Click Add New Invoice. 

4. Select the Policy option. In the View drop-down list, select Current or History. 

5. Select a policy number from the Policies field and click OK. 
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6. Using the quick navigation panel, complete the following screens: 

Invoice Header 

 

• Bill Method: Select Direct.  

• Annualize: (Checked by default) Clearing this check box enables exclusion of annualized line 
items when invoicing. This option is helpful for short term policies or special event policies.  

• Department: Select a Department. 

• Unit: Select a unit.  Units are a subset of departments that provide additional income and 
expense breakdown if needed. 

• Effective Date: Select an effective date. 

• Full Pay: Select if billing in full. 

• Compound Billing: Select this option if the premium is being spread over multiple payments. 
 Selecting this option will add the following additional fields: 
 
 
• Down Payment Amount: 

• Down Payment Date Due: 

• Payment Plan: 

• Number of Compound Billings: 

• View Other CBs: Shows other billing dates a client may have.  This is to synch up billing 
dates. 

• 1st Compound Billing Eff. Date: 

  

• Fee Option: Gives you the option to add any applicable fees. 

• Tax Option: Select if the items are taxable. 

• Rounding Option: 

• Amount Due: 

• Date Due: 

• Days until Past Due: 

• # of Print Days Before Eff. Date: 

• Unique Invoice Message: 

• Internal Note: 

  

Bill To 

 
This information is pulled from the policy but can be changed. Any named insured may be selected 
as the Bill To on invoices. 

To change Bill To information 
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1. In the quick navigation panel, select Bill To. 

2. Click Change Bill To. The Bill To pop-up appears with the Client option selected with all 
named insureds displayed. 

Tip: If a long list of named insureds is displayed, enter a name in the search field and click 
Search. 

 

3. Select the entity and named insured to bill. 

4. Click Next. 

 

5. Select the location and contact name from the drop-down lists and click Next. 

6. The new Bill To information is displayed, click OK to confirm the change. 

Policy Header - Displays policy information 

Invoice premium -This screen allows you to make changes to a current policy premium by 
clicking the Details  icon.  You can also add a new premium. 

Invoice Non-Premium - Add any new non-premium items to the invoice. 



Nexsure User's Guide    Client Menu 

XDimensional Technologies, Inc.   269

Invoice Commissions - Add any commissions to the invoice.  If default commissions exist 
for carrier, people or fees, they will be created automatically.  Defaulted commissions can be 
edited. 

7. Once the invoice has been created, click Invoice Details to verify the information in the new 
invoice.  If all information is correct, click Post Now. 

8. Invoice Posting - Displays general ledger posting entries for this invoice. 

9. Receivable Tab - displays client's receivables data including payments assigned for agency bill or 
carrier receivable data for direct bill. 

10. Payables Tab - data for carrier, people and tax authority payables including payments assigned. 

Note: Once a policy is invoiced, changes to the issuing/billing carrier cannot be made unless all 
invoices associated with the policy have been reversed. 

Task Log 

The task log is on the Client menu (T-Log) and also in Setup > Security Administration.  The T-Log 
records client events (history of the client).  Items recorded are: 

• Task  

• Action  

• Policy #  

• Memo  

• User  

• Date/Time  

  

 When accessing the T-Log from the Client menu, all user actions associated with that client.  When 
accessing the T-Log from the Setup > Security Administration screen, all user actions associated with 
the current user are displayed. 

Clicking the Details   icon for an item in the T-Log will jump to that place in history.   

Note: Information that accessed by clicking the Details  icon, while it can be changed, cannot be 
saved and has no effect on the rest of the system.  It is intended for viewing purposes only. 
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Organization Setup Business Rules 
Setting up an organization has to occur in a specific order. The system will have two status flags set at 
organization - the first setting is “Organization Status = Active or Inactive”. If Active, then the organization 
can login. The second setting is “Organization Setup - Complete or Incomplete”. When switched to 
complete, the organization can begin entering transactions. 

Abbreviations: 

AR = Accounts Receivables 

BS = Balance Sheet 

COA = Chart of Accounts 

GL = General Ledger 

IS = Income Statement 

Organization Setup Order 

1. Designate accounting periods 

2. Set Fiscal Range with first Data Entry period set to enter beginning balances.   

3. First Data Entry period should be the period before normal transaction entry will begin as balances 
will be set to the prior period. 

4. Assign books 

5. Set posting rules 

6. Set Organization Setup to Complete (Locks organization posting rules.  Established accounting 
periods cannot be deleted.) 

7. Validate/Establish account groups 

8. Validate/Establish account types. 

9. Validate/Establish Chart of Accounts. 

10. Set Mandatory General Ledger Numbers. 

11. Complete Org Structure. 

• Region 
• Territory 

• Departments 

Validate posting rules (Posting to general ledger is set at organization.  Not a department 
variation.): 
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a. Agency Bill Accounting Method 

b. People Payment Accounting Method 

c. Direct Bill Accounting Method 

d. People Payment Accounting Method 

Note: If posting rules are changed for department, the applicable general ledger 
number must be added and designated as a mandatory general ledger number at 
organization. 

• Branch 

Validate Departments (Cannot change posting rules at department) 

Add Units if applicable. 

Note: As organization structures are added, based on books assignment and posting rules, 
chart of accounts will be added. 

12. Journal entry beginning balances. 

13. Enter insured beginning balances. 

14. Print beginning balance reports (Aged Receivables, Trial Balance, Balance Sheet, Income & 
Expense Report). 

15. At least lock, preferably close, beginning balance entry month. 

16. Begin transaction entry. 

Note: Organization, accounting, setup, assign books. Assign books represents the organizational 
level(s) that have balance sheet general ledger numbers and posting. Anything else, including 
departments and units, will have income and expense general ledger numbers. Reconciliation will 
occur at the lowest level of books assignment. 

  

Regions 

Region – Primary divisions of organization such as: Northern, Southern, Eastern Regions. Regions may 
be added to or modified by the entity depending on security. 

• Clicking on Regions in the tree view will display a summary view of all Regions on the right side of 
the screen.   

• To add a new region, click Add New.   

• To enter a location select the Use Existing option and select the location from the drop-down list. 
Or, add a new location by clicking the Add New option.   

• Complete detail information and click on the Save button to save. 

• To add employees, select the Employees tab and click Add New. 

  

Related Topics 
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Adding Region Contacts 

Region Employee Security 

Territories 

Branches 

Adding an Employee at Region Level 

If an employee is added at Org level, they will be available to be added at lower levels.  Employees, 
however, will not automatically be visible at lower levels.   

To add an organization level employee at the region level 

1. On the Primary menu, click ORGANIZATION. 

2. Click the regions tab. 

3. Select the region to add the employee to by clicking the Details  icon. 

4. Click the employees tab. 

5. Click Add New. 

6. Select the Search Contact option. 

7. Enter the employee's name and click Search. 

8. In the Contact Search Results box, select the employee and click Use Selection. 

Note: This same process can be used to add the same employee to any other level (Territory, 
Branch etc.) 

Region Employees Security 

To add security 

1. User Information is optional. Clicking "Click here to make this contact a user" will create the 
security tab beside the contact detail tab. Setup information provides information on adding and 
modifying security templates.  The security screen allows the users Login Information to be 
completed.  Once security has been assigned to a contact, this link can no longer be seen unless 
security is removed. 

2. To assign or edit the contacts security, select the security tab. Complete or edit the following 
fields: 

• Login ID: Enter an User login ID no more than 18 characters long using an alphanumeric 
value. 

• Password: Enter a user password no more than 18 characters long using an alphanumeric 
value. 



Nexsure User's Guide    Organization Menu 

XDimensional Technologies, Inc. 273

• Confirm Password: This field is required for the password to be reentered correctly. 

• Time Zone: In the drop-down list, select the user's local time zone. 

• Cancel: Click Cancel to abort the record. 

• Save: Click Save to create User Accounts 

• Update: Click Update to update modifications to the record. 

• User Accounts: The user account listing contains the following: 
• Details : The Details  icon will display in this column.  Clicking on the icon will 

display the User Rights Information which may be edited. 

• Entity Name: All entity name(s) the user has been assigned rights will display in 
this column.  

• Entity Type: The entity type is defined as the contacts type in Nexsure, such as 
Client, Employee, Retail Agent, Underwriter, outside finance company or 
additional interest. 

• Rights: Rights are assigned by clicking the Details  icon on the Details column 
to access the User Rights Information pop-up screen. The rights as identified in 
Setup under User Rights Templates will display in this column. 

• Status: Status is assigned on the User Rights Templates pop-up screen. 

• Date Created: Is the date security was saved.  

• Remove: Deletes the security record for the contact.  The security tab will no 
longer be displayed but the link to add security will again display at the bottom of 
the Contacts screen (“Click here to make this contact a user.”). 

3. Click on the Details  icon to display the User Rights Information pop-up screen.  Complete the 
following fields as appropriate for contact security: 

• Entity Type: Even though a drop-down list is shown, only the appropriate entity type as 
defined by the area in which the contact is being added in Nexsure will display; such as 
Client, Employee, Retail Agent, Underwriter, outside finance company or additional 
interest.  Example: If a client contact, then the entity type available would be Client. 

• Entity Name: Even though a drop-down box is shown, only the entity that rights are being 
assigned for will be available.   

• Status: Status will be a drop-down list and will contain two choices: Active and Inactive. If 
Inactive is selected the contact login is disabled and an “ ” icon will be displayed on 
Contacts summary screen.  If Active is selected the contact login is enabled and an “ ” 
icon will be displayed on the Contacts summary screen. (See Contacts Summary for 
placement details) 

• Rights: Select the appropriate User Rights template from a drop-down box that is 
populated in Setup under User Rights Templates.  

  

Related Topics 

About Regions 

Adding Region Contacts 

Territories 
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Branches 

Territories 

Territory – A Subdivision of Region such as California, Utah, etc.  Territories may be added to or 
modified by the entity depending on security. 

  

Related Topics 

Adding Territory Locations 

Territory Employee Security 

Branches 

Regions 

Territory Entity Associations 

  

Territory Entity Associations 

Associating additional interests with a territory will limit the search returns to that specific territory, 
providing a shorter list and reducing the time to find the correct entity. 

To Associate an Entity with a Territory 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab and select a territory by clicking the Details  icon. 

3. Click the entities associations tab. Any existing entity associations will be displayed. 

 

4. Click [Add New]. 
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5. Search for the entity, if it appears in the list, select it and click Use Selection. 

6. To view or edit the details of the association, click the Details  icon. 

 
  

Related Topics 

Adding Territory Locations 

  

Adding Territory Locations 

To add a territory location 

1. On the Primary menu, click ORGANIZATION. 

2. Click on the territories tab. 

3. Select the locations tab. 

4. Click Add New. 
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5. Use Existing is the default when adding new locations.  Scroll through the list of existing locations 
to make sure the location does not exist. If the location is present, click that location and then 
select the Save button.  This feature allows the entire organization location database to be utilized 
so that duplicate records may be avoided. 

• If the location does not exist select the Add New option and complete the following fields: 

Field Descriptions: 

• Complete the Location Detail using the following information: 

• Location Type: Select the location type from the drop-down list, which is populated by the 
agency in Lookup Management. 

• Location Name: Enter a unique name to identify the location. 

• Location Description: Enter a description of the location such as Billing, Underwriting, 
etc. 

• Mailing Address: The main address for this entity generally used for mailing invoices and 
correspondence. 

• Physical Address: The physical address for this location. 

• If the Billing address is different from the physical address, make sure to indicate by 
addressing this question and completing the billing address section. 

• Phone: Enter the phone numbers without formatting.  Formatting will be applied after the 
Locations screen has been saved. Use the drop-down box to identify the type of phone 
number. Extension numbers may be entered up to six characters. Phone number identities 
are as follows:  

• Back line 

• Building Security 

• Business Phone 

• Fax 

• Main Fax 

• Phone 

• Receptionist 

• Technical Support 

• Toll Free 

• Add additional phone number identities in Setup under Lookup Management. 

• Adding additional phone numbers: 

• Click on the Add New link to the right of group heading after accessing the 
location record to edit. 

• Use the drop-down box to select the identity of the phone number being 
added. 

• Enter the phone numbers without formatting. Formatting will be applied 
after the screen has been saved.  

• The extension numbers may be entered up to six numeric characters. 

• Click on the Save button to save the phone number just added. 
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• Click on the Close button to abort the addition of the new number. 

• The number of phone numbers that can be added to each location is only 
limited by the identity choices. Click on the Add New Link to add a new 
phone number. 

• Click on the Details  icon beside the number to edit. 

• Click on the Delete  icon beside the number to delete. 

• E-mail: The email address for the contact is optional, however if the format is entered 
incorrectly an error will be returned to warn of the improper format. The screen cannot be 
saved until the format is corrected. The field can contain up to 30 characters with 
alphanumeric data.  

• Cancel – The Cancel button will abort any modifications or adding a new location. 

• Save – The Save button will save new location information. 

• Delete – The Delete button will delete the location. The primary location cannot be deleted 
but can be changed. The delete button will not be present if the location is set to primary. 

• Update – The Update button will update any modifications to the location record.   

  

Related Topics 

About Territories 

Territory Employee Security 

Branches 

Regions 

Branches  

Branch - The third level of the organization are the branches in a specific territory, which translates to the 
agency name such as: West Coast Insurance Specialists.  Branches may be added to or modified by the 
entity depending on security.  

  

Related Topics 

Adding Branch Locations 

Branch Employee Security 

Territories 

Regions 

Branch Employees Security 

To add security 

1. User Information is optional.  Clicking "Click here to make this contact a user" will create the 
Security tab beside the contact detail tab.  Setup information provides information on adding and 
modifying security templates.  The security screen allows the users Login Information to be 
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completed. Once security has been assigned to a contact, this link can no longer be seen unless 
security is removed. 

2. To assign or edit the contacts security, click on the security tab.  Complete the following fields: 

• Login ID: Enter a login ID for the contact no more than 18 characters long using an 
alphanumeric value. 

• Password: Enter a password for the contact no more than 18 characters long using an 
alphanumeric value. 

• Confirm Password: This field is required for the password to be reentered correctly.  

• Time Zone: In the drop-down list, select the user's local time zone. 

• Cancel: Click Cancel to abort the record.   

• Save: Click Save to create User Accounts 

• Update: Click Update to update modifications to the record. 

• User Accounts: The user account listing contains the following: 

• Details: The Details  icon will display in this column. Clicking on the icon will 
display the User Rights Information which may be edited.   

• Entity Name: All entity name(s) the user has been assigned rights will display in this 
column.   

• Entity Type: The entity type is defined as the contacts type in Nexsure, such as 
Client, Employee, Retail Agent, Underwriter, outside finance company or 
additional interest.   

• Rights: Rights are assigned by clicking the Details  icon on the Details column to 
access the User Rights Information pop-up screen. The rights as identified in Setup 
under User Rights Templates will display in this column.   

• Status: Status is assigned on the User Rights Templates pop-up screen. 

• Date Created: Is the date security was saved.  

• Remove: Deletes the security record for the contact. The security tab will no longer 
be displayed but the link to add security will again display at the bottom of the 
Contacts screen (Click here to make this contact a user.) 

3. Click on the Details  icon to display the User Rights Information pop-up screen. Complete the 
following fields as appropriate for contact security: 

• Entity Type: Even though a drop-down box is shown, only the appropriate entity type as 
defined by the area in which the contact is being added in Nexsure will display; such as 
Client, Employee, Retail Agent, Underwriter, outside finance company or additional 
interest. Example: If a client contact, then the entity type available would be Client. 

• Entity Name: Even though a drop-down box is shown only, the entity that rights are being 
assigned for will be available.   

• Status: Status will be a drop-down list and will contain two choices: Active and Inactive. If 
Inactive is selected the contact login is disabled and an “ ” icon will be displayed on 
Contacts summary screen.  If Active is selected the contact login is enabled and an " ” 
icon will be displayed on the Contacts summary screen. (See Contacts Summary for 
placement details)   
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• Rights: Select the appropriate User Rights template from a drop-down box that is 
populated in Setup under User Rights Templates. 

  

Related Topics 

About Branches 

Adding Branch Locations 

Territories 

Regions 

  

IVANS Downloads 

To receive downloads from IVANS 

Before you can receive downloads from IVANS, you must associate your branch with your IVANS 
account information. 

1. On the Primary menu, click ORGANIZATION. 

2. Click the branches tab and select your branch by clicking the Details  icon. 

3. Click the ivans tab. If no record exists, you will be prompted to "click here" to add a record. 

 

4. Enter your IVANS account information and click Save. 

Authorizations Tab 

The authorization tab holds the electronic signatures/bar codes that are unique to New York insurance 
agencies.  The authorizations tab will store State, SID/DMV License Key and pass phrase. 
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Global Reassignment 

This option will allow an agency to re-assign, en-masse, current in-force policies, marketing policies, open 
actions, client card file and client assignments from an employee, who has left the agency, to another 
employee.  This will not affect policies in history or any closed actions.   

To perform global reassignment 

1. On the Primary menu, click ORGANIZATION. 

2. Click the branches tab. 

Note: If employee is assigned to multiple branches, they will need to be re-assigned at each 
branch level. 

3. Click the Details  icon of the appropriate branch. 

4. Click the employees tab. 

Note: If the employee has been terminated click on the [Show] filter, select Terminated 
Employees from the Employee Status drop-down box and click Search. 

 

5. Click the Details  icon of the employee who is to be re-assigned. 

6. Click the Re-Assign link on the toolbar. 
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7. The re-assign employee screen will be displayed. 
  

 

8. Highlight the name of the new employee to be assigned  

9. Click the [Re-Assign] link. 

10. Click OK to confirm the change. 

  

Related Topics 

Assignment 

Employee Commissions 

Employee Login Security 

Global Reassignment 

IMX Instant Messenger 

Departments 

Departments are sub-sets of a branch location. For example, a branch could be broken into two 
departments, commercial lines and personal lines.  

Before you can add a department to a branch, you must first create the branch at the organization level. 
 Once a department has been created, they can be added at the branch level. 

To Create a Department 
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1. On the Primary menu, click ORGANIZATION. 

2. Click the departments tab. 

3. Click [Add New]. 

4. In the Department field, enter a name for the department. 

5. In the Status field, selecting Active will make the department available to be used in a branch. 

6. Enter a description of the department (optional). 

7. Select the department posting rules.  Departments within a branch can have separate general 
ledger posting rules.   

8. To save the new department, click Update. 

To add a department 

1. On the Primary menu, click ORGANIZATION. 

2. Click the branches tab and select a branch to add a department to by clicking the Details  icon. 

3. Click the departments tab. 

4. Click [Add New]. A box with all available departments will be displayed. 

Note: You cannot create departments from the branch level.  If a department does not exist, it 
must be added at the organization level.   

5. Select a department and click Update. 

Adding Branch Locations 

To add a branch location 

1. On the Primary menu, click ORGANIZATION. 

2. On the locations tab, click Add New.  

3. Use Existing is the default when adding new locations. Scroll through the list of existing locations 
to make sure the location does not exist. If the location is present, click that location and then 
select the Save button. This feature allows the entire organization location database to be utilized 
so that duplicate records may be avoided.   

• If the location does not exist select Add New and complete the following fields: 

Field Descriptions: 

• Complete the Location Detail using the following information: 
• Location Type: Select the location type from the drop-down box, which is populated 

by the agency in Lookup Management. 
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• Location Name: Enter a unique name to identify the location. 

• Location Description: Enter a description of the location such as Billing, 
Underwriting, etc. 

• Mailing Address: The main address for this entity generally used for mailing 
invoices and correspondence. 

• Physical Address: The physical address for this location. 

• If the Billing address is different from the physical address, make sure to indicate by 
addressing this question and completing the billing address section.  

• Phone: Enter the phone numbers without formatting.  Formatting will be applied after 
the Locations screen has been saved. Use the drop-down box to identify the type of 
phone number. Extension numbers may be entered up to 6 characters.  Phone 
number identities are as follows: 

• Back Line 
• Building Security 

• Business Phone 

• Fax 

• Main Fax 

• Phone 

• Receptionist 

• Technical Support 

• Toll Free   

• Add additional phone number identities in Setup under Lookup Management. 

• Adding additional phone numbers: 

• Click on the Add New link to the right of group heading after accessing the 
location record to edit. 

• Use the drop-down box to select the identity of the phone number being 
added.   

• Enter the phone numbers without formatting. Formatting will be applied after 
the screen has been saved.  

• The extension numbers may be entered up to six numeric characters.   

• Click on the Save button to save the phone number just added. 

• Click on the Close button to abort the addition of the new number. 

• The number of phone numbers that can be added to each location is only 
limited by the identity choices. Click on the Add New link to add a new phone 
number. 

• Click on the Details  icon beside the number to edit. 

• Click on the Delete  icon beside the number to delete. 

• E-mail: The email address for the contact is optional, however if the format is 
entered incorrectly an error will be returned to warn of the improper format. 
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The screen cannot be saved until the format is corrected. The field can 
contain up to 30 characters with alphanumeric data.   

• Cancel – The Cancel button will abort any modifications or adding a new location.   

• Save – The Save button will save new location information. 

• Delete – The Delete button will delete the location. The primary location cannot be deleted 
but can be changed. The delete button will not be present if the location is set to primary.   

• Update – The Update button will update any modifications to the location record.   

  

Related Topics 

About Branches 

Branch Employee Security 

Territories 

Regions 

Adding Employees 

Employees should be added at the organization level.  This allows their names to be selected at any level 
(Region, Territory or Branch).  Access and security rights are assigned after the new employee has been 
added as a Nexsure user. 

Note: Employees can be added at lower organization levels such as Region, Territory or Branch. 
However, employees added at a specific level only have access to that level and the levels below it.  For 
example, an employee added at the region level has access to region, territory and branch functionality 
but does not have full organization level capability.  An employee added at the territory level has access 
to territory and branch functionality, but not to region or organization level functionality. Employees added 
at branch level only have access to branch level functionality.  The different levels of security, however 
can be edited in Security Administration > User Rights Templates. 

To add an employee  

1. On the Primary menu, click ORGANIZATION.    

2. Click the employees tab. 

3. Click Add New. 

 

4. By default the Search Contact option is selected.  To search, type the last name into the box and 
click Search.  Otherwise, select the New Contact option. 
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Tip: While not necessary, you should always perform a search to see if the name you are adding 
already exists in the system. 

5. Enter the employee detail information. 

 

6. When all of the information is entered, click the Save link to save the information. 

Note: Adding an employee in Nexsure does not automatically make that employee a Nexsure 
user, they must be added as a user and granted security user rights.  See Adding Employee 
Rights below. 

7. Click the Details  icon for the new employee you wish to make a user. Click the "Click here to 
make this contact a user" link appears at the bottom of the screen, the security tab appears. 
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• Login name: Assign the new user a Nexsure login name. 

• New password: Assign the new user a password.  You can give them the option to 
change the password you assigned upon their first login (see below). 

• Confirm new password: Retype the password you just entered to verify that you typed it 
correctly.  

• Time zone: Select the time zone for the user you are entering. 

• Automatically adjust clock for Daylight Savings Time: Select this option unless the 
user is in a state not effected by daylight savings time (ie. Indiana).  

• Login expiration date and time: You can enter a specific date and time to grant access 
to Nexsure.  This would be useful if you had a temporary employee that will only need 
access for a specified time frame.  If you enter a date and not a time, the system will 
default to 12:00 AM. 

• Change of password required: This allows the new user, once they have logged in the 
first time, to set their own personal password.  Upon login, they will be prompted to change 
their password. 

• Access allowed from/until: You can select the hours that this user can access Nexsure. 
 Leaving them blank allows 24 hour access. 

• Notify admin upon login:  

• Allow login on Saturday/Sunday: These options are selected by default.  To restrict 
access on these days, clear the check boxes. 

• Login disabled: Selecting this option restricts access for this user. 

8. Once the login security is setup click Save.  To add security rights for a user see Adding Employee 
Security below. 
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Adding Employee Rights 

When adding employee rights, it is important to limit the number of employees that have high level 
security access such as administrator.  A user with administrator rights will have access to all levels in the 
organization while a user with producer rights will only have access to CRM functionality. See User Rights 
Templates for more information on setting up custom templates. 

To add user security 

1. Once you have made an employee a Nexsure user, on the bottom of the security tab, click the link 
that reads Click here to add security. 

 

2. Select the user rights information: 

• Entity Type - Displays the level at which the employee was added (Organization, Region, 
Territory, Branch) 

• Entity Name - The name of the organization. 

• Status - Active/Inactive 

• User Rights - The level of security granted to the user (ex. Administrator = All access) 
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3. Click Add. 

Employee Identity 

To add a photo and signature file 

You can add a picture to your employee profile.  This is an optional feature.  Pictures can be in GIF or 
JPG format.  Signatures must be in JPG format. 

1. On the employees screen, click the identity tab. 

2. Click add photo. 

 

3. Click Browse to navigate to the gif file and click Upload. 

Note: Photos must be JPG format.  To avoid distortion, please upload the photo with a height of 
225 pixels and width of 150 pixels. 

4. Click Close. 

Creating a Signature File  

Signature files are for appending to certificates when creating Nexsure certificates.  Signature files MUST 
be created and attached to your employee details to create new certificates in Nexsure.  This option is 
not available if you are generating certificates via ConfirmNet.  Your signature file must be created in a 
graphics program such as MS Paint or Adobe Photoshop.  The signature file must be JPG format.  To 
avoid distortion, create the signature file with a height of 75 pixels and width of 300 pixels, for example: 
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 *Drop shadow used to show dimensions. 

  

To add a signature file 

1. On the employees screen, click the identity tab. 

2. Click add signature. 

3. Click Browse to navigate to the jpg file and click Upload. 

4. Click Close. 

  

Related Topics 

User Rights Templates 

Employee Commissions 

Employee Login Security 

Global Reassignment 

IMX Instant Messenger 

Setting up Additional Logins 

Additional logins are required to gain seamless access to systems outside of Nexsure such as rating 
systems or carrier Web sites. 

1. On the Primary menu, click ORGANIZATION. 

2. Click the employees tab. 

Note: It does not matter what level the additional login information is added to. 

3. Click the Details  icon of the appropriate employee. 

4. Click the additional logins tab. 

5. Click the Add New link. 
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6. Select the carrier from the Additional Login Type drop-down box. 

 

7. Complete the Login ID, Password, and Confirm Password fields.   

Note: Contact the carrier selected in the Additional Login Type drop-down box if the information 
is unknown. 

8. Department ID is a 3rd field used to collect any additional login information other than login id or 
password.  (IE: group id, etc.) 

9. Complete the Account Number and Description fields (these fields are optional). 

10. Click Save to save the Additional login information. Repeat steps 5 – 9 to add all additional logins 
for all carriers. 

  

Related Topics 
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About eServices 

Accessing eServices 

ExpressWay 

Nexsure Integrates with The Hartford's ExpressWay rater.  You must have a valid ExpressWay account to 
use this feature. In addition to a valid account, an additional login must be set up in Nexsure to use this 
functionality. 

  

Setting up an ExpressWay additional login 

1. On the Primary menu, click ORGANIZATION. 

2. Click the employees tab. 

Note: It does not matter what level the additional login information is added to. 

3. Click the Details  icon of the appropriate Employee. 

4. Click the additional logins tab. 

5. Click the Add New link. 

 

6. From the Additional Login Type drop-down box, select Hartford Expressway. 
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7. Complete the Login ID, Password, and Confirm Password fields.   

8. Department ID is a 3rd field used to collect any additional login information other than login id or 
password.  (IE: group id, etc.) 

9. Complete the Account Number and Description fields (these fields are optional). 

  

Employee Login Security 

In addition to the organization's security defaults, individual employees can have specific security settings 
that supersede the organization defaults.  To modify employee login security settings, you must have 
administrative rights. 

To set employee security 

1. On the Primary menu, click ORGANIZATION. 

2. Select the employees tab. 

3. Click the Details  icon for the employee you wish to modify the security settings for. 

4. Select the security tab.  

5. Select the login security settings and click Update. 

  

Related Topics 

Security Administration 
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Employee Commissions 

To setup people commission defaults 

People commission defaults can only be created in the employee file located at the branch level where 
the employee has been added. 

1. On the Primary menu, Click ORGANIZATION. 

2. Select the branches tab and click the details icon of the branch where the employee file resides. 

3. Select the employees tab.  

4. Click on the appropriate employee Details  icon.  

5. Select the commissions tab. 

6. Click on [Add New] or the Details  icon of an existing commission default to edit.   

 

7. In the Department field, select a department from the drop-down. 

8. In the Carriers field, select a carrier from the drop-down. 

9. In the Line of Business field, select a line of business in the drop-down.   

10. In the Sub-Code field, enter the required sub-code. 

11. Branch people defaults can be set using the check boxes located to the left of each default type 
and are used as follows: 
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• One department default for the branch. 

• One line of business default for each specific line of business within a branch. 

• One carrier default for each carrier within a branch. 

• Two people defaults for the employee within a branch: 

• One premium commission default. (% Agency, % Premium, Flat Rate) 

• One fee commission default. (% of Fee)  

Note: If a default exists and another default is selected it will overwrite the existing default and 
become the current default within the branch. 

12. Complete the information selecting the: 

• Rate Type 

• Min(minimum) and Max(maximum) rate if desired. 

• Eff (effective) Date if applicable. 

• Expiration Dates if applicable. 

• Quota amount.    

The status defaults to Active, but can be changed to Inactive if the commission default is no longer 
desired.   

  

Related Topics 

Adding Employees 

Employee Login Security 

Global Reassignment 

IMX Instant Messenger 

IMX Instant Messenger 

The Nexsure IMX instant messenger allows you to send and receive text messages instantly with anyone 
logged in to your Nexsure organization.   

To Send an Instant Message 

1. On the Utility menu, click ORGANIZATION. 

2. Select the employees tab. 

3. Select an online employee.  If the employee is online the word (Available) will appear next to their 
name.  Click on the employee's name.  The employee contact screen will appear: 
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4. Click the blinking IMX icon. The message box will open: 

 
  

5. Type a message in the lower box and click Send or press Enter. The message will be sent to the 
online employee. 

Tip: Use the B, I and U icons to format your text if needed.  You can also use the auto text 
messages in the drop-down list to reduce key strokes. 

Adding Region Contacts 

To add a region contact 

1. On the Primary menu, click ORGANIZATION. 

2. On the employees tab, click Add New, before adding a region contact, you must Search For 
Existing Contact Record.  This feature allows the current contact database to be utilized so that 
duplicate contact records may be avoided. 
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Search Contact 

• Select Search Contact to search existing contacts and to add as a contact to this entity. 

 
• Search For Existing Employee Record - Enter the last name, first name or email address 

of the employee as the search criteria. Enter a minimum of two characters in order to have 
valid criteria for a search.  No wild card searches to search all are available.  

• Click Search to display any potential matches. 
• The results will be displayed in alphabetical order by last name. If the contact has already 

been entered in the system, select their name and click Use Selection. 
 
• The selected contact detail is automatically populated into the current Contact Detail 

screen with exception of the following fields: 

• Is this the Primary Contact for this account? - There can only be one primary 
contact and cannot be deleted. The primary contact can be changed. 

• Contact Role - The role is used to identify the contacts role with the branch on 
behalf of the named insured (Billing, Claims, CPA, etc.).  Use the drop-down box 
that contains items that are added by the agency in Setup under Lookup 
Management.  

• Contact Notes - Enter any relevant notes to the contact (ex. "Leaves the office 
at 3PM.") 

 
• If no results are found, click No Match. The Search Results window will close, then select the 

New Contact option. 
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New Contact 

• If the New Contact option is selected, enter the information in the contact detail screen. 

 
Field Descriptions: 

• Prefix: Use the drop-down box that contains items added by the agency in 
Setup > Lookup Management. 

• First Name: Enter the first name of the primary contact for this entity. The 
primary contact is identified as the person you would call or correspond with 
most of the time. 

• Middle Initial: This field is one character long. Enter the middle initial of the 
primary contact. 

• Last Name: Enter the last name of the primary contact. 

• Suffix: Use the drop-down box that contains items added by the agency in 
Setup > Lookup Management. 

• Goes By: Enter the name the contact prefers to be addressed by. This field 
may be used in letters or emails to the entity. 

• Title: Use the drop-down box that contains items added by the agency in 
Setup > Lookup Management. The title is used to identify the contacts 
occupation. 

• Sex: Use the drop-down box containing Female and Male to identify gender. 

• Date of Birth (DOB): Enter the contacts date of birth in the following format: 

“##/##/####”. The  Calendar  icon may be used to access a pop-up 
calendar. Click on the appropriate day to populate the field. 

• Social Security Number: This field accepts numerical values only for the 
social security number. Accepted format: #########. Do not include dashes. 

• Marital Status: Use the drop-down box to select the appropriate marital 
status for the contact. 

• State Licensed: Use the drop-down to select the state licensed. 

• License Number: This field accepts alphanumeric characters for the license 
number. 

• Date Licensed: Enter the contacts date licensed in the following format: 

##/##/####. Use the Calendar  icon to access the pop-up calendar. Click 
on the appropriate day to populate the field. 

• Is this the Primary Contact for this account? There can only be one 
primary contact and cannot be deleted. The primary contact can be changed. 

• Contact Role: The role is used to identify the contacts role with the Branch 
on behalf of the named insured. Use the drop-down box that contains items 
that are added by the agency in Setup > Lookup Management.  

• Phone: Enter the phone numbers without formatting. Formatting will be 
applied after the client screen has been saved. Use the drop-down box to 
identify the type of phone number. Extension numbers may be entered up to 
six characters. Phone number identities are as follows: 
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• Home phone 

• Cell phone 

• International phone 

• Office phone 

• Pager 

• Personal Fax 

• To add additional phone numbers: 

• Click on the Add New link to the right of group heading 

• Use the drop-down box to select the identity of the phone number being 
added. 

• Enter the phone numbers without formatting. Formatting will be applied 
after the screen has been saved.  

• The extension numbers may be entered up to six numeric characters. 

• Click on the Save button to save the phone number just added. 

• Click on the Close button to abort the addition of the new number. 

• The number of personal phone numbers that can be added to each 
contact is only limited by the identity choices. Click on the Add New 
Link to add a new phone number. 

• Click on the Details  icon beside the number to edit. 

• Click on the Delete  icon beside the number to delete. 

• Email: The email address for the contact is optional, however if the format is 
entered incorrectly an error will be returned to warn of the improper format. 
The screen cannot be saved until the format is corrected. The field can 
contain up to 30 characters with alphanumeric data. There are two email 
addresses to accommodate both work and personal as necessary. 

• Contact notes: Can be used for any notation about this contact. The notes 
can only be viewed from the contact details screen. 

• Save – The Save button will save new contact information. 

• Cancel – The Cancel button will abort any modifications or adding a new 
contact. 

• Delete – The Delete button will delete the contact. The primary contact 
cannot be deleted but can be changed. The delete button will not be present 
if the contact is set to primary. 

• Update – The Update button will update any modifications to the contact 
record. 

• When the information is complete, click the Save link.  The screen returns to the employee tab. 

  

To add the new contact as a Nexsure user 

1. On the employee tab, select the contact by clicking on their Details  icon. 
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2. Click Click here to make this contact a user.  The security tab is enabled beside the 
Contact Detail tab.  See Setup for information on adding and modifying security templates.   

  

Related Topics 

About Regions 

Region Employee Security 

Territories 

Branches 

Accounting Summary 

The account summary gives a brief overview of your organization's operating account, operating 
payables, carrier payables and trust account balances.  The summary screen also displays alerts as to 
undeposited funds or if your premium exceeds the trust balance.  The information on the summary tab 
reflects booked information or balance sheet information for what ever organization is selected. 

The information on the summary screen is specific to how the summary screen is accessed.  For 
example, if you click organization on the Primary menu, and then select the accounting tab, the account 
summary will reflect the entire organization.  If you click organization on the primary menu, then select a 
territory or branch the account summary will display account summary information accordingly. 

 
  

Current Through - Displays the last day of the current period.  This column will display the cumulative 
total of all subordinate org levels (roll up) based on the account number defined in the mandatory 
accounts funds as of last updated.  Accounts include: 

• Operating Account 

• Operating Payable 

• Carrier Payable 

• Trust Account 

  

Previous Through - Displays the ending cumulative total on the last day of the period immediately 
proceeding the current period of all subordinate org levels (roll up) based on the account number defined 
in the mandatory accounts: 

• Operating Account 
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• Operating Payable 

• Carrier Payable 

• Trust Account 

Alerts 

Undeposited Funds - Calculated as of last updated. 

Current Through Premium Exceeds Trust Balance - Calculated by deducting the carrier payable 
balance from the trust account balance. 

 

Accounting Periods 

The accounting period is the time for which accounts are prepared. Accounting periods will be divided into 
12 monthly units for the next fiscal year.  If "Include Adjustment Period" is selected, a 13th period will be 
created beginning and ending on the last day of the fiscal year.  This period should be used for year-end 
adjustments.  You can set up the accounting periods as far into the future as needed. 

Use the search filter to search for specific accounting periods which have been entered. 

 
  

To add periods for the next fiscal year 

1. On the Primary menu, click Organization. 

2. Click the accounting tab. 

3. Click the setup tab and then click the accounting periods tab. 

4. Click [Add Period].   

  

Editing Account Periods 

Account period dates can only be edited at the organization level.  However, once an organization Setup 
is saved as complete account period dates cannot be changed.  Beginning and ending dates must be in 
chronological order and cannot overlap, with the exception of the adjustment period. 

Note: The adjustment period's beginning and ending dates will always be the last day of the last period. 

  

To edit a period 
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1. On the Primary menu, click Organization. 

2. Click the accounting tab. 

3. Click the setup tab and then click the accounting periods tab. 

4. Select the period you wish to edit and click the Details  icon. 

 
5. Edit the account period as needed and click [Update]. 

Locking and Closing Periods 

Locked 

When a period has been locked, it can no longer be posted to without appropriate security access. 
 Locked periods can also be unlocked at anytime (with appropriate security) to make adjustments to the 
period. 

To grant locked period posting access 

1. On the Utility menu, click Setup. 

2. In the Setup Console, click Security Administration. 

3. Select the user rights templates tab.  

4. In the Entity Types drop-down, select Client. In the User Template Types box, select Standard 
Client Rights. 

5. Click the Edit link. 

6. In the Security Wizard scroll down and select Transactions from the list. 

7. In the Rights area, select all Post Locked check boxes that will have access granted to. 

8. Click Save and Close. 

  

Closed 

When a period is closed it cannot be reopened.  Be sure that all adjustments to the period have been 
made prior to putting it in a closed status. 
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Periods must be closed in chronological order.  If you attempt to close a period out of order, you will be 
prompted to close any subordinate periods before closing the current period. 

Year-end Adjustments 

Year-end is when an organization's fiscal year comes to an end.  Typically, it is the last day of the last 
month of their fiscal year.  The system's year-end entries must “0” each level income and expense 
accounts.  This creates an offsetting entry to retained earnings by book level.  That increase or decrease 
to retained earnings will appear in the first month of the next fiscal year. 

At any given time of the current year, this process will always look at whatever the total income and 
expense balances are as of that moment to make entries.  The “Year end Adjustment” process should 
not be cumulative.  In other words, if I click “Year End Adjustment” on August 15 just to see retained 
earnings values for the next fiscal year, the system should not be creating a posted entry per se.  It 
should consider the year-to-date values every time and not hold any previous “Year End Adjustment” 
entries.  Retained earnings in the next fiscal year should simply reflect “0” totals from the previous year 
for income and expense with the appropriate retained earnings accounts updated by an offsetting 
amount. 

Other year end processing done by an organization generally involves working with an accountant to 
produce adjusting entries for the year.  This typically occurs several months after the end of the fiscal 
year.  Locking and unlocking the fiscal periods will facilitate moving forward with year end entries 
generated for the fiscal year without having to close the month. 

Once year-end entries are completed and the final postings validated, the last month of the fiscal year 
can be closed.  Final year end adjustments should be generated prior to closing the last month of the 
fiscal year as well as the adjustment period.  Nexsure handles each book level calculations separately. 
 Organization level year-end pertains to entries unique to org.  Trial balance summary by general ledger 
number enables easy view of total balance retained earnings. 

Sample of year-end balances with adjusting entries and beginning balances  

Year-End Procedure 

Before beginning the year-end procedure make sure to read this topic in its entirety.  

Year end is typically the last day of the last month of an organization’s fiscal year. A closing journal entry 
is created to zero out the accumulated balance for each income and expense account. This allows an 
organization to start accumulating new income and expense totals from the first day of each fiscal year. 
The difference created from the closing journal entry, which is income minus expenses, is posted to the 
Retained Earnings account. This difference is called Net Profit or Loss and the increase or decrease to 
retained earnings will be added to the beginning balance for the first period of the following year while all 
income and expense accounts will be zero.  

Step 1  

Several months prior to year end, evaluate and add the number of periods needed for future months. 
Accounting periods can be set up as far into the future as desired. However, it is important to set up 
enough fiscal years to cover the longest policy term, assuring that future installments will post into the 
correct period while avoiding posting errors. When a new fiscal year is added in Nexsure, the organization 
may choose to have either 12 or 13 accounting periods. The 13th period starts and ends on the last day 
of the last month of the fiscal year and is typically used only for year-end adjustments. If a 13th period 
was not created for the organization the year-end adjustments should be entered on the last day of the 
12th period. (For more details on Accounting Periods, see Tips and Facts Vol. 2 Issue 4)  
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Step 2 

Prior to creating the closing journal entry year-end adjustment, the last accounting period of the fiscal 
year must be open and unlocked. This applies regardless of whether the user’s security is set to allow 
posting to a locked period. All preceding accounting periods must be locked. Add any adjusting journal 
entries to the Income and Expense accounts within each territory making certain to enter the last day of 
the month of the fiscal year as the date booked for entries that should post to the 12th or 13th period. 

Note: Unwanted entries might occur while an accounting period is unlocked so it is advisable to unlock 
periods when no other users are logged into Nexsure. Locking and unlocking an accounting period at the 
Organization level also unlocks the same accounting period for all territories. However, locking or 
unlocking at the Territory level only affects that specific territory. 

Step 3  

The year-end adjustment—closing journal entry is first done for each territory (at the Book Level) and at 
the Organization level last. The territory year-end adjustment will zero out all income and expenses for 
the territory and each corresponding branch, department and unit. The difference will be posted to the 
Retained Earnings account for that territory. The year-end adjustment at the organization will zero out all 
income and expenses for the Organization level. The difference will be posted to the Retained Earnings 
account for the organization.  

Note: Creation of the year-end adjustment is done after the manual adjustments to the Income and 
Expense accounts are posted. 

Creating the Year-End Adjustment at the Territory level 

1. On the Primary menu, click the ORGANIZATION link. 

 

2. Click the territories tab and the Details   icon for the specific territory. 

 
3. Click the accounting tab. 

4. Click the setup tab on the second row of tabs which will default to the accounting periods tab on 
the third row of tabs. 
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5. Click the Year End Adjustments link to display the Year End Balances dialog box. 

 
The Year End Adjustments link may be run as many times as needed as long as the last 
period is open. 

6. Clicking the Post button creates a new year-end closing Journal Entry (J/E) number which 
replaces the previously generated year-end closing J/E. Once all periods are closed, this option is 
removed. 

 
7. Click the check  box next to the fiscal year to close. The Post button will be enabled. 

8. Click the Post button to display the Journal Entry ID number. 

This identifies the journal entry that was made to post profit or loss to the Retained Earnings 
account in the last period of the fiscal year. 

9. Click OK to confirm the Journal Entry ID number. 
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Important: Do NOT close the last period of the fiscal year prior to posting the year-end adjustment 
as this will permanently remove the option to post year-end adjustments. If attempted, a red text 
warning displays when accessing the last period of a fiscal year prior to posting the year-end 
adjustment. 

Step 4  

To view or print the detail of the journal entry 

1. Navigate to the Journal Entries report. 

2.  Enter the journal entry ID in the Entry ID box. 

 
Note: Journal Entries may also be viewed by accessing Accounting > Transactions > Journal 
Entries. 

Step 5 

At this point, all manual adjustments to income, expense accounts and the year-end adjustment within the 
territory have been completed. If not, complete those adjustments as well as any to the balance sheet 
accounts and repeat Step 3 and 4 before beginning Step 5. Close all periods for the year being closed but 
only after the journal entries are complete and all reports are verified. Accounting periods must first be 
closed sequentially at each territory level. Closing a period is permanent and ensures that no changes 
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can be made to that period and allows the year-end process to be completed. It is necessary for the prior 
year to be completely closed before creating year-end adjustments for the following fiscal year. If the prior 
year periods are not all closed there is a possibility that unwanted entries could be posted and a new 
year-end journal entry could be created with different figures.  

Note: If the accounting periods are not closed, accounting entries may be posted to these months by 
unlocking or with security access to post to a locked period. Only close accounting periods when all year-
end journal entries are complete.  

Step 6 

Repeat steps 1-5 for all territories then access the organization level and follow the same steps. Do not 
begin the year-end procedure at the organization level until all territory periods have been completed and 
closed. 

Year-End Recap 

Complete the year-end procedure for all territories first. Only after all territory accounting periods are 
completely closed should the organization level year-end closing be done. Use the same steps to do the 
year-end process for the organization level by accessing ORGANIZATION > ACCOUNTING > setup > 
accounting periods. 

1. Evaluate and add the number of periods needed for future months (Only added at the organization 
level as all territories are automatically propagated). 

2. Make sure all periods are locked except the last accounting period of the fiscal year. Add any 
manual adjusting entries to income accounts, expense accounts and balance sheet accounts as 
necessary, making certain to enter the date booked as the last day of the fiscal period for entries 
that should be posted to the 12th or 13th period. 

3. Click the Year End Adjustments link to create a new year-end closing entry. Rerun this 
process as many times as needed. (Year-end adjustments can be generated again and again until 
all periods are closed. A new year-end closing J/E number is created and is added in place of the 
previously generated year-end closing J/E.). The year-end adjustment posting is done after manual 
journal entries are made. 

4. Review the closing journal entry. 

5. At this point, all manual adjustments to income accounts, expense accounts and the year-end 
adjustment within the territory have been completed. If not, complete those adjustments as well as 
any to the balance sheet accounts and repeat Step 3 and 4 before beginning Step 5. After the 
financial statements are in order and finalized, close all periods including the last period in the 
fiscal year (All territories must be closed before attempting to close the organization level). When 
all the accounting periods are closed, no changes can be made to the fiscal year and the year-end 
adjustment cannot be recreated. It is necessary for the prior year to be completely closed (territory 
and organization levels) before creating year-end adjustments for the following fiscal year. If the 
prior year periods are not all closed there is a possibility that unwanted entries could be posted and 
a new year-end journal entry could be created with different figures. 

6. Repeat steps 1-5 for all territories. After all periods are closed for all territories, follow the same 
steps for the organization level. 

Important: Do not begin the year-end procedure at the organization level until all territory periods have 
been completed and closed. 
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Posting Rules 

Posting rules determine how your organization will post to the general ledger.   

To setup the posting rules 

1. On the Primary menu, click ORGANIZATION. 

2. Click the accounting tab. 

3. Click the setup tab. 

4. Click the posting rules tab. 

5. Select the desired options as follows: 

 

Global Invoice General Ledger Posting 

Post to the General Ledger - This option must be selected to enable direct bill posting to the general 
ledger. This option can be overridden on a per carrier basis (see below). 

Do Not Post to General Ledger - This option will eliminate any general ledger posting for invoicing 
globally or specific to direct bill, entries for people and carrier or tax authority reconciliation on an 
organizational level. This option would typically be used by an agency that would journal entry figures 
based on production reports.  

If this option is selected, all other activity is disabled including direct bill options. 

Invoices created will update production, account current, invoice transaction registers and any other 
reports that use invoice information exclusively. General ledger reports include: 

• Direct Bill Commission Receivable 

• Accounts Receivable 
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• Carrier Payable 

• People Payable 

As well as all financials and any other reports updated by information other than invoices. 

  

Agency Bill Accounting Method 

Accrual -  

Cash as Received -  

  

People Payment Accounting Method 

Pay on Invoiced 

Pay on fully paid / Accrue Expense 

Pay on partially paid / Accrue Expense 

 

Direct Bill Invoice General Ledger Posting 

Post to the General Ledger - Posts direct bill invoices to the general ledger. 

Do Not Post to General Ledger - Prevents direct bill invoices from posting to the general ledger. To 
override this option by carrier, select "Override by Carrier". 

Override by Carrier - Selecting this option will provide the ability to override the "Do Not Post to 
General Ledger" option on the Carrier Names screen for specific carriers. 

Note: If "Override by Carrier" is not selected after carriers have been set to alternative rules, those 
rules will revert to match the organization's posting rules. 
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Direct Bill Accounting Method 

Accrual 

Cash as Received 

 

People Payment Accounting Method 

Pay on Invoiced 

Pay on fully paid / Accrue Expense 

Pay on partially paid / Accrue Expense 

Account Groups 

To add a new account group 

1. On the Primary menu, click ORGANIZATION. 

2. On the organization screen, select the accounting tab. 

3. Click the setup tab, then select the account groups tab. 

4. Click [Add New], the Add Account Group screen will appear. 

 
• Select a Classification 

• Name the Account Group 

• Enter a Display Order number 

• Enter the Number Range 

• Enter a Description (optional) 

5. Click [Update].   

  

To edit an existing account group 

1. On the Primary menu, click ORGANIZATION. 
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2. On the organization screen, select the accounting tab. 

3. Click the setup tab, then select the account groups tab. 

Note: To search for an account group that is not displayed on the screen, use the Search Filter by 
clicking [Show] and entering search criteria. 

 

4. Select the account group you wish to edit and click the Details  icon. 

5. Make the necessary changes and click [Update]. 

Account Types 

Account types are subdivisions of account groups.  For example a branch may use account types to 
divide commercial and personal lines.   

  

To add a new account type 

1. On the Primary menu, click ORGANIZATION. 

2. On the organization screen, select the accounting tab. 

3. Click the setup tab. 

4. Select the account types tab. 

5. Click [Add New], the Account Type screen will appear. 
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• Select the Account Group to add the account type to. 

• Name the Account Type. 

• Select the Normal Balance, Debit or Credit. 

• Enter the Display Order. 

• Enter the Group Number range available. 

• Enter the Begin and End Type Number range. 

• Enter a description (optional). 

6. Click Apply. 

  

To edit an existing account type 

1. On the Primary menu, click Organization. 

2. On the organization screen, select the accounting tab. 

3. Click the setup tab, then select the account types tab. 

Note: To search for an account type that is not displayed on the screen, use the search filter by 
clicking [Show] and entering search criteria. 
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4. Select the account type you wish to edit and click the Details  icon. 

5. Make the necessary changes and click [Update].  

Invoicing Setup 

Fees 

 
   

To add new fees 

 
   

 
  

Taxes 
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To add new taxes 

 
  

 Receive Payment Defaults 

 

Receive Payments Default 

The receive payments defaults tab allows the agency to determine how they want payments to be 
applied.  The information on the received payments defaults tab can be changed at any time, if changes 
are made, click the Update link to save. 

1. On the Primary menu, click ORGANIZATION. 
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2. Click the accounting tab 

3. Click the invoicing setup tab. 

4. Click the receive payments defaults tab. 

• Third Party Payment - Future enhancement that, when checked, will indicate if the payment 
was received from a 3rd party (insurance carrier, additional interest, bank, etc.) 

• Select the Payment Type default from the drop-down box. 
 

• Cash 

• Check 

• Credit Card 

• EFT (Electronic Funds Transfer) 

• ACH (Automatic Check Handling) 

• Credit Card 

• Reference: The Reference field will default in to all received payments. 
• Description: The Description field will not default in to all received payment. 
• Assign payments: Selecting this check box will allow Nexsure to automatically allocate the 

payment to outstanding invoices. 
• Assign Payments Defaults 
• Default Assignments: 
• Invoice Balance/Oldest First 

When a payment is received and is an exact match to an outstanding invoice, Nexsure will apply it to that 
invoice first.  If an exact match is not found, Nexsure will apply the payment to the oldest open item first. 

Oldest Invoice/Invoice Balance - When a payment is received, Nexsure will apply it to the oldest open 
item first. 

Allow Manual Assignment Allocation: Selecting this check box will allow the user to override payments 
that have been automatically allocated by Nexsure. 

Allocate Assignment Defaults - Spread assignment evenly across premiums, fees and taxes.  Selecting 
this option allows the payment to be applied proportionally to the premiums, fees and taxes. 

Use the following rules: Selecting this option allows the agency to delegate the order of how a payment 
will be applied.  Only one selection can be made for Premiums, Fees and Taxes. 

Multiple selections can be made for the First, Second and Third options.  (IE: Agency can select to have 
the payment applied to Fees and Taxes first and the Premiums second). 

Invoice Defaults Tab 

To locate the invoice defaults tab: 

1. On the Primary menu, click ORGANIZATION. 

2. Click the accounting tab. 

3. Click the invoicing setup tab. 

4. Click the invoice defaults tab. 
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Permit Production Credit over 100%   

• If unchecked , neither policy info nor invoicing production credit can exceed 100%.  

• If checked , the policy info and invoicing production credit can exceed 100% but the user will be 
informed that the amount exceeds 100%. 

• If you change settings, be sure to use the [Update] link to save the change. 

  

Mandatory General Ledger Numbers 

Nexsure provides extensive flexibility and power in terms of transactions and automated work-flow. To 
properly record general ledger information internally, a series of mandatory general ledger numbers are 
required. Classification is assigned by the system.  As a specific general ledger number is selected, the 
Account Type and Group populates.   

Note: The general ledger number range indicated below is typical but is not required. The specific 
classification indicated is required.  If a mandatory general ledger number is required based on setup 
variation, the specific variation code will be indicated after classification. 

Income Posting Variations 

Agency Bill Accrual (Income hits general ledger at invoicing) 

Agency Bill Cash Basis (Income hits general ledger as payments are received and applied to insured 
invoice) 

Direct Bill Accrual (Income hits general ledger at invoicing) 

Direct Bill Cash Basis (Income hits general ledger as commission payments are reconciled as received 
from carrier) 

  

People Payable Posting Variations 

Pay People on invoiced 

• AB and DB payable and expense is created at invoicing. 

Pay People on fully paid 
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• AB people payable due and expense is created when insured pays agency in full and the payment 
is applied to the invoice. 

• Installments paid in full will create payable and expense as they are paid. 

• DB people payable and expense is created when agency reconciles receipt of commission 
statement and check where commission due agency is paid in full. 

• Installment commission paid in full will create payable due and expense as they are reconciled. 

Pay People on fully paid, accrue expense 

• AB people payable non-due and expense is created when invoice is posted. 

• People payable due is created when insured pays agency in full and the payment is applied to the 
invoice, clearing non-due payable. 

• DB people payable non-due and expense is created when invoice is posted. 

• People payable due is created when agency reconciles receipt of commission statement and 
check, paying the commission in full, clearing non-due payable. 

Pay People on partially paid 

• AB people payable due and expense is created proportionately based on the amount of payment 
when insured pays agency and the payment is applied to the invoice. 

• DB people payable due and expense is created proportionately based on the amount of payment 
reconciliation posted. 

Pay People on partially paid, accrue expense 

• AB people payable non-due and expense is created when invoice is posted. 

• People payable due is created proportionately based on the amount of payment when insured 
pays agency and the payment is applied to the invoice, clearing non-due payable. 

• DB people payable non-due and expense is created when invoice is posted. 

• People payable due is created proportionately based on the amount of payment reconciliation 
posted , clearing non-due payable. 

  

Invoice Mandatory General Ledger Numbers 

Note: Mandatory General Ledger Numbers cannot be deleted or flagged as inactive.  General ledger 
numbers with transactions cannot be deleted.   
 
Non-Mandatory General Ledger Numbers with transactions booked against them cannot be deleted.  
Once the balance is zero, they can be flagged as inactive. 

  

Agency Bill Accounts Receivable 

The following four accounts receivable general ledger numbers are used for agency bill invoice 
transactions that should be debited or credited with additional or return premium.  If desired, a separate 
general ledger number can be established for each Bill To or they can all be assigned the same general 
ledger number.  It is recommended that retail agent have a separate accounts receivable general ledger 
number. 

Description General Ledger Account Type Account Classification 
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Number Group 

1. Client 100000 range Receivables Current Asset Asset 

2. Additional Interest 100000 range Receivables Current Asset Asset 

3. Premium Finance 
Company 

100000 range Receivables Current Asset Asset 

4. Retail Agent 100000 range Receivables Current Asset Asset 

  

Direct Bill Accounts Receivable 

The following direct bill commissions receivable general ledger number is necessary for direct bill invoice 
transactions to record commission due the agency.  The offsetting entry will depend upon whether or not 
an agency records commission income on an accrual or as cash is received.  Accrual will offset 
immediately to the direct bill income account.  Cash as received will be held in a non-earned income 
account until reconciliation occurs, flagging that payment has been received and income should be 
recorded. 

Description  General Ledger 
Number 

Account Type Account 
Group 

Classification 

1. Commissions 
Receivable  

100000 range Revenue 
Receivables  

Current Asset Asset 

  

Unearned Income  

The following unearned income general ledger numbers are required only if an agency is cash basis as 
received for either agency bill or direct bill.  If setup is not cash basis, the system will disable the 
applicable section reference. 

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification Setup 
Variation 

1. Agency Bill 
Commission 
Unearned Income 

100000 to 
300000 
range 

    Asset/Liability/
Equity 

Cash 

2. Agency Fee Unearned 
Income 

100000 to 
300000 
range 

    Asset/Liability/
Equity 

Cash 

3. Vendor Fee 
Commission 
Unearned Income 

100000 to 
300000 
range 

    Asset/Liability/
Equity 

Cash 

4. Direct Bill Commission 
Unearned Income 

100000 to 
300000 
range 

    Asset/Liability/
Equity 

Cash 
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Invoice Payables 

The following payable general ledger numbers represent moneys that will be due based on invoice entry. 
 Non-due accounts will be disabled depending upon system setup.  Note items 5, 10 and 11 are used for 
cash basis income recognition for fee expenses and payables due to other vendors.  Carrier Payable is 
the account total used for the balances displayed in alerts.   

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification Setup 
Variation 

1. Carrier Payable 200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability   

2. Binder Bill Payable 200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability   

3. Tax Authority Payable 200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability   

4. Vendor Payable 200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability   

5. Vendor Payable Non-
due 

200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability Cash 

6. People Payable Due 200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability   

7. People Payable Non-
due 

200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability People 
Pay-Paid 
Accrue 
Expense 

8. Retail Agent Payable 
Due 

200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability   

9. Retail Agent Payable 
Non-due 

200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability People 
Pay-Paid 
Accrue 
Expense 
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Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification Setup 
Variation 

10. Agency Fee Expense 
Payable (Non-due) 

  

200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability Cash 

11. Vendor Fee Expense 
Payable (Non-due) 

200000 
range 

Insurance 
Payables 

Short 
Term 
Liability 

Liability Cash 

  

Income  

The following payable general ledger numbers represent moneys recorded as income based on the 
invoice entered.  Note that agency fee and vendor fee Income exists but alternative general ledger 
numbers may be assigned as an aspect of the fee setup process.  Service charge income may be 
implemented in a future release as the general ledger number for automatic service/late charge fees 
generated. 

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification 

1. Agency Bill Income 400000 
range 

Agency Bill 
Revenue 

Insurance 
Income 

Income 

2. Direct Bill Income 400000 
range 

Direct Bill 
Revenue 

Insurance 
Income 

Income 

3. Agency Fee Income 400000 
range 

Fee Revenue Fee Income Income 

4. Service Charge 
Income 

400000 
range 

Service 
Charge 
Revenue 

Other 
Income 

Income 

5. Vendor Fee 
Commission Income 

400000 
range 

Fee Revenue Fee Income Income/Under Ops 
Income 

  

Retail Agent Expense  

The following expense general ledger numbers represent moneys based on commissions paid to retail 
agents.  Classification can be either income or expense.  

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification 
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Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification 

1. Retail Agent Expense 
- Agency Bill 

400000 to 
900000 
range 

Commissions 
Paid 

Insurance 
Income 

Income/Expense 

2. Retail Agent Expense 
- Direct Bill 

400000 to 
900000 
range 

Invoice 
Commissions 

Sales 
Expense 

Income/Expense 

  

Expense 

The following people expense general ledger number represent moneys based on commissions paid to 
agency personnel entered in the system as employees , used as the offset to people payable due or non-
due.  Vendor fee expense reflects activity related to vendor fees. 

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification 

1. People Commission 
Expense 

500000 
range 

Invoice 
Commissions 

Sales Expense Expense 

2. Vendor Fee 
Expense 

500000 
range 

Other Sales 
Expense  

Sales Expense Expense/Under Ops 
Expense 

  

Bank Activity Mandatory General Ledger Numbers 

Accounts Payable Entry 

The following general ledger numbers represent general ledger numbers used in the accounts payable 
entry function.  Accounts payable entry automatically uses the operating payable general ledger number 
as the credit.  Use of reconciliation clearing account and subsequent selection of the accounts payable 
item in check issuance (disbursement entry) will make the item available as a disbursement in 
reconciliation.  Discounts taken may be implemented in a future release. 

Description General 
Ledger 
Number 

Account Type Account 
Group 

Classification 

1. Operating Payable 200000 
range 

Accounts Payable Short Term 
Liability 

Liability 

2. Reconciliation 
Clearing Account 

100000 
range 

Receivable Current 
Asset 

Asset/Liability/Equity 

3. Discounts Taken 400000 to 
999999 
range 

Discount/Interest 
Inc 

Other 
Income 

Income/Expense 
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Check Issuance 

Generating a disbursement may pull entries from the general ledger, accounts payable, invoicing, or 
reconciliation.  The primary definitive accounts would be a trust or operating account.  Additional bank 
accounts using alternative general ledger numbers are setup at organization or books level entities and 
selected when issuing disbursements.  These accounts balances are used in alerts on the accounting 
summary screen. 

  

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification 

1. Trust Account  100000 
range 

Cash 
Accounts 

Current Asset Asset 

2. Operating Account 100000 
range 

Cash 
Accounts 

Current Asset Asset 

  

Receive Payments 

Accounts receivable general ledger numbers will be set at invoicing mandatory general ledger numbers 
and are disabled.  Undeposited funds should always be cleared by deposit on a timely basis.  Using 
reconciliation clearing account will enable selection of payment in reconciliation. 

Description General 
Ledger 
Number 

Account 
Type 

Account 
Group 

Classification 

1. Client  Set at 
invoicing 

Receivables Current Asset Asset 

2. Additional Interest Set at 
invoicing 

Receivables Current Asset Asset 

3. Premium Finance 
Company 

Set at 
invoicing 

Receivables Current Asset Asset 

4. Retail Agent Set at 
invoicing 

Receivables Current Asset Asset 

5. Undeposited Funds 100000 
range 

Receivables Current Asset Asset 

6. Reconciliation 
Clearing Account 

Set at 
Accounts 
Payable 

Receivables Current Asset Asset/Liability/Equity 

  

Make Deposit 
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Making a deposit presents items based on selected ranges created through receive payments. 
 Alternative general ledger numbers may be used based on bank account selected for deposit.  These 
accounts balances are used in alerts on the accounting summary screen. 

Description General 
Ledger 
Number 

Account 
Type 

Account Group Classification 

1. Trust Account  Set at check 
issuance 

Cash 
Accounts 

Current Asset Asset 

2. Operating Account Set at check 
issuance 

Cash 
Accounts 

Current Asset Asset 

  

Reconciliation Mandatory General Ledger Numbers 

Adjustments 

Accounts available to balance reconciliation permit an offset to a designated commission differences 
account.  Use of reconciliation clearing account will enable selection at disbursement entry. 

Description General 
Ledger 
Number 

Account 
Type 

Account Group Classification 

1. Commission 
Differences 

400000 to 
999999 
range 

Invoice 
Commissio
ns 

Sales Expense Income / Expense 

2. Reconciliation 
Clearing Account 

Set at Bank 
Activity  

Receivable Current Asset Asset/Liability/Equity 

  

Journal Entry Mandatory General Ledger Numbers 

Journal Entry 

Year end processing will create net entries to zero income and expense with an offsetting entry to 
retained earnings. 

Description General 
Ledger 
Number 

Account 
Type 

Account Group Classification 

1. Retained Earnings 300000 
range 

Equity Equity Equity 

  

Intra-Office Mandatory General Ledger Numbers 
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Description General 
Ledger 
Number 

Account 
Type 

Account Group Classification 

1. Intra-Office 
Primary Offset 

110000-
110999 
range 

Receivable Current Assets Asset/Liability/Equity 

2. Intra-Office 
Secondary Offset 

220000-
229999 
range 

Non-
Insurance 
Payable 

Short Term 
Liability 

Asset/Liability/Equity 

  

Chart of Accounts 

The chart of accounts for use by all entities is created at organization. All entities and departments and 
units then have the applicable general ledger numbers based on the organization chart of accounts. 
Mandatory general ledger numbers are set at organization and are then used by all other entities.   

Organization Chart of Accounts Rules: 

• Organization has a full set of books – Balance sheet and income and expense chart of accounts. 

• All entities (organization, region, territory, and branch) have at least income and expense chart of 
accounts. 

• Departments and units at most have only income and expense chart of accounts – they never have 
books. 

If “Include Departments/Units Chart of Accounts” is unchecked in setup, then departments and 
units do not have chart of accounts. 

• Only region, territory and branch can optionally have books and, therefore, balance sheet chart of 
accounts. 

   

Related Topics 

Mandatory General Ledger Numbers 

 

Locking General Ledger Numbers 

General ledger access can be disabled based on an employee's user rights. Access to general ledger 
account posting can be restricted in all areas including: 

• Receive Payments 

• Journal Entry 

• Deposits 

• Disbursements 

• Invoices 
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• Reconciliations 

Administrators can grant users the ability to override locked general ledger accounts by modifying the 
user right's template using the Security Administration screen in the Setup Console. 

Note: This feature does not affect automatic system posting to any general ledger account that has the 
Disable Access box checked. 

To Disable General Ledger Access 

1. On the Primary menu, click ORGANIZATION. 

2. Select the accounting tab. 

3. Click the general ledger tab. 

4. Click the chart of accounts tab. 

5. Select the general ledger account by clicking the Details  icon. 
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6. Select the Disable Access check box and click OK. 

Note: In any area of Nexsure where a general ledger number can be selected by clicking an 
ellipsis  button, the disabled general ledger accounts will appear as grayed out: 
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Granting Disable Override 

To Modify the General Ledger Security Template: 

1. On the Utility menu, click SETUP. 

2. In the Setup Console, select Security Administration. 

3. Click the user rights template tab. 

4. Select the User Template Type to apply the changes to, i.e. Accountant. 

5. Click Edit. 

6. In the Core Components list on the right, select General Ledger. 
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7. Select or clear the Allow Override check box. 

8. Click Save. 

  

Related Topics 

Mandatory General Ledger Numbers 

Chart of Accounts 

Allocation Plan Setup 

Organizations with multiple branches, departments and possible units may have a policy of dividing 
expenses during the course of an accounting transaction based on the organizational structure. Creating 
a general ledger allocation plan provides a template for easily dividing expenses within the organization. 
Allocation plans can be created for accounts payable and journal entries. 

To Create an Allocation Plan 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Select the territory to add the plan to by clicking its Details  icon. 

4. Click the accounting tab.  

5. Select the general ledger tab.  

6. Select the gl allocation tab. Any previously created allocation plans will be displayed on this 
screen. 
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Note: The territory level is used in this example, but allocations can also be setup at the 
organization level. When created at the territory level, general ledger defaults will be based on that 
territory. Depending on user security to other territories, defaults may be overwritten. 

7. Click the [Add New] link. 

 
• Name: Enter a name for the allocation plan. Enter a name that can be easily recognized from 

a list of other possible allocation plans. 

• Allocation Type: Select Balance Sheet or Income & Expense. Balance Sheet will restrict 
selection of organizational entities to region and force a territory. Income and expense will 
permit all organizational entities as well as both income and expense accounts when 
allocation is used. 

• Description: Add a description of the plan (optional). 

• Active: This is selected by default. To create a plan to be used at a later time or to deactivate 
a current plan, clear this check box.   

8. Click OK. The GL Plan screen appears: 

 
• Intra-Office: Selected by default if the allocation uses multiple territories requiring intra-office 

transactions. 

• GL Allocation Summary: Click to return to the GL Allocation list screen. Any line items 
added will be saved, but allocation factors will not be saved unless Save or Allocate has 
been clicked. 
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• Copy Allocation: Creates a new allocation screen displaying "copy of" in front of the original 
plan description. 

• Allocate: Takes any allocation factor entered and creates appropriate percent values. 

• Save: Saves the allocation information without closing the screen. 

9. Click the [Add New] link. 

 
• Region: Defaults based on territory but can be changed depending upon security to other 

entities. 

• Territory: Available based on Region – defaulted based on entry level but can be changed 

• Branch: Available based on previous territory selection. 

• Department: Available if branch selected. 

• Unit: Available if applicable for department. 

• Allocation Factor: enter a percentage amount (numerical). 

10. Click OK. 

Note: After a line item has been added, Allocation Type cannot be edited. At this point, the 
income and expense has been designated as the selection which permits pulling all entities but will 
not be available for balance sheet accounts.  To switch the allocation type, you must delete all org 
line items. 
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The plan name and description as entered and can be edited by clicking the Details  icon. 

Note: In this example, the Intra-office check box is unchecked. Adding a different territory to the 
allocation will automatically place a check in the box. You cannot check or uncheck the check box. 
Deleting the different territory in an allocation group will uncheck the check box. 

Click [Add New] to continue adding desired groups 

• Note there can be a single line item = to 100%. 
• Click Save, Allocate or OK. Line items will be split per allocation factor percent to equal 

100%. 
• Clicking Cancel or GL Allocation Summary will return to the GL Allocation Summary 

list, saving changes as of the last “Save” or “Allocate”. 
• Clicking the Remove  icon deletes the item selected. 
• Note that if an allocation plan has been used, its use is held in the existing posted 

transaction. 

  

Intra-Office transaction capability 

With GL allocation permitting selection of multiple book levels (territories), subsequent use in 
accounts payable and journal entries permits intra-office transactions. 

Allocation is complete. 

Copying an Allocation Plan 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab, select territory by clicking the Details  icon. 

3. Click the accounting tab, then select the general ledger tab. 

4. Click the gl allocation tab and click the Details  icon on the desired plan to copy. 

5. Click Copy Allocation 

6. Click OK and system returns to the original GL Allocation Plan details. 
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7. Click GL Allocation Summary. 

 The Plan is an exact copy of original with the following exceptions: 

• Active Status is unchecked 
• Date Created is the date copy was created 

8. Click the Details  icon to edit as needed. Select the Active check box to activate the plan when 
complete. 

Trial Balance 

The trial balance sheet lists all general ledger numbers with a balance as of a given point in time.  You 
can generate a trial balance for specific periods by using the search filter, then print the report or export 
the file. 

To View a Trial Balance Sheet 

1. On the Primary menu, click ORGANIZATION. 

2. Click the accounting tab.  

3. Click the general ledger tab. 

4. Click the trial balance tab.  

5. To view a specific accounting period, click [Show] to display the Search filter. 

6. After the trial balance sheet has been generated, click [Print] to send it to a printer, or [Export] 
to save it to a file.   
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Balance Sheet 

You can generate a balance sheet for specific periods by using the search filter, then print the report or 
export the file.  The balance sheet will only be active with an entity which has books assigned.  

To View a Balance Sheet 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab and select a territory which has books assigned to it.   

3. Click the accounting tab. 

4. Select the general ledger tab.  

5. Click the balance sheet tab.   

6. To view a specific accounting period, click [Show] to display the Search filter. 

7. After the balance sheet has been generated, click [Print] to send it to a printer, or [Export] to 
save it to a file. 

 

Income Statement 

The Income Statement is a report which shows income and expenses for all entities.  You can use the 
search filter to choose a specific accounting period to generate the statement for.  Once the Income 
statement is generated, you have the option to print or export the file. 

To View an Income Statement 

1. On the Primary menu, click ORGANIZATION. 

2. Click the accounting tab.  

3. Click the general ledger tab. 
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4. Click the income statement tab. To view a specific accounting period, click [Show] to display the 
Search filter. 

5. After the statement has been generated, click [Print] to send it to a printer, or [Export] to save it 
to a file. 

 

Bank Accounts 

Bank accounts can be associated with any level of your organization that has books. Bank accounts are 
added as Financial Entities on the search screen. The bank account summary screen displays all bank 
accounts associated with the selected organization level. 

To add a new bank account 

1. On the Primary menu, click ORGANIZATION. 

2. Click the accounting tab. 

3. Click the bank accounts tab, then click [Add New]. 

4. Enter the bank account information. 
 

• Name: Click the ellipsis  button to search for and select a bank account that has been 
previously entered into the system.  Bank accounts are entered as a Financial Entity on the 
search screen. 

• Account Description: Enter a description for the account, such as, "Operating Account". 

• GL Account: Click the ellipsis  button to search for and select a general ledger account 
number that has been previously entered into the system.  General ledger numbers are 
assigned on the general ledger tab. 

• Account Number: Enter the account number for the bank you have selected. 
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• ABA Routing Number: Enter the ABA Routing Number (Optional) 

• Next Check #: Enter the number for the next check to be issued. 

• Primary Contact: This box will be automatically filled with the information supplied when 
the bank account was entered into the system. 

• Status: Active or Inactive. 

5. Click [Update]. 

To view bank account details  

1. Select the bank account you wish to view the details for and click the Details  icon. 

 

2. The bank account detail tab gives a description of the account as well as the account numbers 
and contact information.  If you change any information on this tab, you must click [Update] for 
the changes to take effect. 

Note: Multiple financial entities with the same name can be distinguished by selecting a different 
address from the Address drop-down box. 

 

3. The accounting transactions tab shows all transaction activity for the account, such as journal 
entries, deposits, disbursements etc.  To view details on each transaction click the Details  icon. 
  

Journal Entry 

A journal entry is an entry made directly to specific general ledger accounts.  Journal entries must 
balance before posting is allowed.  If a particular entry is made on a consistent basis, it can be created as 
a recurring entry.   
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To add a new journal entry 

1. On the Primary menu, click ORGANIZATION. 

2. Select the accounting tab. 

3. Select the transactions tab. 

4. Click the journal entry tab. 

5. Click [Add New], or click Add Recurring.   
 
Recurring journal entries must have been previously created as recurring to be available to add. If 
recurring journal entries have been created, they can be selected from the drop-down list. 

 

 
• Journal Entry ID: This number will be automatically assigned once the entry is made. 

• Posted: Check box will populate once entry is posted. 
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• Date Booked: Displays the date entry was booked. Enter the date manually or click the 
calendar icon to select a date. 

• Date Created: Displays the date entry was created. 

• Created By: User that created the entry. 

• Recurring: Select this option to save the journal entry so it may be easily selected next time 
it needs to be entered.  This eliminates the need to enter all of the journal entry information 
each time it is entered.  See Recurring Journal Entries.  

Note: If Recurring is selected, the Post option becomes unavailable as it will be determined 
when creating the recurrence schedule. 

• Set Properties: This option becomes active once Recurring is selected.  

• Frequency: Displays the journal entry schedule. 

• Start Date: Displays the journal entry starting point. 

• Expiration: Displays the recurrence expiration. 

• Auto Post: If checked, the journal entry will post automatically at 12:40 AM. If unchecked, 
the entry will be created based on rules and will be available to post, edit or delete. 

• Reference: (optional) Use this as a type of internal note. 

• Description: (optional) Add a description of the entry.  It will be displayed on the Journal Entry 
Summary screen.  The description will also populate the Description field in the general journal 
entry group below. 

6. Select an account number by clicking the ellipsis button. 

 

7. Use the drop-down lists or search fields to select the organization and general ledger account 
information and click OK. 
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8. Enter the amount of the Debit/Credit. 

9. Click Add Row to enter the corresponding general ledger account and Debit/Credit amount, or 
click Add Allocation to apply an allocation template. 

10. Click Save. You can then Print, Post or Abort the entry. Before you can post the entry, it must be 
in balance. 

  

Related Topics 

Recurring Journal Entries 

Using Allocations 

Recurring Journal Entries 

If a particular journal entry is made on a consistent basis, it can be created as a recurring entry. 
 Recurring entries can be created on any recurring schedule needed. Recurring entries can also be 
scheduled to automatically post. 

To create a recurring journal entry 

1. On the Primary menu, click ORGANIZATION. 

2. Select the accounting tab. 

3. Select the transactions tab.  

4. Click the journal entry tab. 

5. Click [Add New]. 

 
• Journal Entry ID: This number will be automatically assigned once the entry is made. 

• Posted: Check box will populate once entry is posted. 
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• Date Booked: Displays the date entry was booked. Enter the date manually or click the 
calendar icon to select a date. 

• Date Created: Displays the date entry was created. 

• Created By: User that created the entry. 

6. Select the Recurring option. 

7. Click Set Properties. 

Note: If not selected, previous recurring journal entries will apply and the entry will be available 
through [Add Recurring] on the journal entry screen. 

8. Select the recurring schedule: 

Daily 

 
Daily Recurrence Schedule 

• Every number of days will create journal 
entry on that number of days. 

• Every weekday will create journal entry 
Monday to Friday. 

Recurrence Range 

• Start date – defaults from Journal Entry 
screen and determines the first occurrence.

• Continuous – journal entry will be created 
until end is defined. 

• Continue for number of occurrences – 
journal entry will be created for set number 
of occurrences. 

• End by specific date – journal entry will be 
created until date is reached. 

• If end by date = the prescribed 
occurrence of a journal entry, the 
entry will be created.  For example, 
end by date = July 21, 2006  the 
journal entry will occur on July 21.  If 
end by date = July 23, 2006 then the 
last journal entry will also occur on 
July 21 since July 23 is not a 
weekday.  

Automatically Post  

Monthly 

 
Monthly Recurrence Schedule 

• Day ## of every # month(s) – specific date the 
number of months designated.  

• Example – Day 15 of every 1 month will 
create the journal entry on the 15th of 
each month beginning in August.  

• Example – Day 15 of every 3 months will 
create the journal entry on the 15th of 
every 3rd month.  In this example, with 
7/21/2005 as start date, the first entry 
will be August with subsequent entries 
occurring in November, February 2006, 
May 2006, August 2006 and so on.  

• To effect a different month, “Start” could 
be changed to later month to begin the 
series in that month. 

Recurrence Range  

• Start date – defaults from Journal Entry screen 
and determines the first occurrence. 

• Continuous – journal entry will be created until 
end is defined. 

• Continue for number  of occurrences – journal 
entry will be created for set number of 
occurrences. 

• End by specific date – journal entry will be 
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• If checked, journal entry will post during a 
night process automatically (12:40 AM). 

• If unchecked, journal entry will be created 
but will not post.  

  

  

created until date is reached.  

Automatically Post  

• If checked, journal entry will post during a night 
process automatically (12:40 AM). 

• If unchecked, journal entry will be created but 
will not post.  

 

 

 

Weekly 

 
Weekly Recurrence Schedule 

• Every # of week(s) on a specific day (or 
days) will create journal entry on that day 
every designated number of weeks. 

• Example – every 1 week on Tuesday 
will create the journal entry every 
Tuesday. 

• Example – every 2 weeks on 
Tuesday will create the journal entry 
every other Tuesday. 

Recurrence Range 

• Start date – defaults from Journal Entry 
screen and determines the first occurrence.

• Continuous – journal entry will be created 
until end is defined. 

• Continue for number  of occurrences – 
journal entry will be created for set number 
of occurrences. 

• Example – 24 occurrences will result 
in 24 weeks of Tuesday journal 
entry. 

• End by specific date – journal entry will be 
created until date is reached. 

Automatically Post  

• If checked, journal entry will post during a 
night process automatically(12:40 AM).  

• If unchecked, journal entry will be created 
but will not post.  

Yearly 

 
Yearly Recurrence Schedule 

• Only option is “Occurs” with the specific day 
designated.  

Recurrence Range 

• Start date – defaults from Journal Entry screen 
and determines the first occurrence. 

• Defaults from “Date Booked” but may be 
changed based on rules for using “Date 
Booked” in a journal entry.  

Today’s date is the default.  

Date may not be in a closed or locked period 

• Continuous – journal entry will be created until 
end is defined. 

• Continue for number of occurrences – journal 
entry will be created for set number of 
occurrences. 

• End by specific date – journal entry will be 
created until date is reached. 

Automatically Post  

• If checked, journal entry will post during a night 
process automatically (12:40 AM).  

• If unchecked, journal entry will be created but 
will not post.  
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9. Click OK. 

 
• Journal Entry Summary: Saves the entry and returns to journal entry transaction list view. 

 Recurring entries must be in balance, clicking Transaction Summary while not in balance will 
prompt a message notifying you to balance the journal entry. 

• Print: Prints journal entry line items. 

Note: Post is not available for a recurring entry. 

• Abort: Deletes the entry. 

• Save: Saves the entry, remaining in the journal entry screen. 

• Add Allocation: Displays available allocations for entry, see Using Allocations. 

• Add Row: Adds general ledger line items. 

 
Note: In the example above, items cannot be selected since they are recurring journal entries 
and are not posted. Only Journal Entries created from recurring journal entries that are 
unposted or single journal entries created and unposted can be selected for the Post Selected 
process. 

  

Related Topics 

Journal Entry 
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Allocation Plan Setup 

Using Allocations 

 

Disbursements 

To Create a Disbursement (Post/Print a Check) 

1. On the Primary menu, click ORGANIZATION. 

2. Select the book level tab and click the Details  icon of the desired entity. 

3. Click the accounting tab. 

4. Click the transactions tab, then select the disbursements tab. 

 

5. Select a bank account from the drop-down list. 

6. Click [Add New Disbursement].   

7. Select an entity type from the drop-down list. 

8. Enter at least two characters of the name for the entity you wish to disburse to and click Search. 

9. Select the entity in the search results and click OK. 

10. Complete the disbursement header information and click Save. 
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11. In the quick navigation panel, click Invoices.  All invoices for this client in the selected territory will 
be displayed. 

 

12. Select the invoice to disburse by marking the check box and click Pay All Selected. 

13. Click Post. You will be prompted to confirm the post, click OK.  The posted and printed from the 
Disbursement Summary screen. 
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Note: You must Post a disbursement before you can Print it. 

  

Related Topics 

Batch Printing 

Posting a Zero Disbursement 

A zero disbursement can be done to clear open items on a client’s account. 

Scenario: Client is invoiced for full payment of new business BOP policy. Full payment of BOP policy 
received on client’s account, (unapplied to invoice resulting) in a residual amount. 

Endorsement processed on BOP policy resulting in a return premium.  Client is invoiced for full payment 
of new business Auto policy.  Payment received on client’s account, (unapplied to invoice) resulting in a 
residual amount.  (Amount received was Auto premium minus return premium from BOP endorsement). 
 The disbursement process can be used to clear open items for the client in one transaction process. 

Client level Invoice Summary view: 

 
  

Client level Unassigned Payments view: 

 
  

Receive Payment tab summary view: 

Note: Amount received on clients account displays as a residual amount in receive payments tab 
summary view. 
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To process a zero disbursement  

1. On the Primary Menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Click the Details  icon of the appropriate territory. 

4. Click the accounting tab. 

5. Click the transactions tab. 

6. Click the disbursements tab. 

7. Select appropriate bank account from the drop-down list. 

8. Click [Add New Disbursement] link.   

 

9. Select Client as entity type from the drop-down list. 
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10. Enter at least two characters of the name of the client you wish to disburse to and click Search. 

11. Select the client in the search results and click OK. 

 

12. Complete disbursement header as appropriate and enter description. 

Note: To avoid a check number from being assigned, the disbursement method should be set to 
EFT.  
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13. Click on the Invoices link in quick navigation. 

14. Select all applicable invoices to pull into the disbursement.   

 
Scenario:  

• Invoice # 4171 full pay BOP policy.   

• Invoice # 4174 return premium - BOP endorsement. 

• Invoice # 4187 full pay Auto policy. 

15. Click Pay All Selected link under disbursement header. 

Note: Selected items are calculated into the disbursement when the Revised Balance column is 
zero and the Credit Assigned column shows an amount.  The Details   icon can be used to 
assign partial credit to an invoice. 
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16. Click on Payments Received link in quick navigation. 

17. Select applicable payments received on clients account to pull into the disbursement. 

18. Click the Save link under disbursement header to activate Pay All Selected link. 

 

19. Click Pay All Selected link under disbursement header. 

 
Note: Selected items are calculated into the disbursement when the Balance column is zero and 
the Return Amount column shows an amount.  The details icon can be used to apply a partial 
amount of a receipt into the overall disbursement. 

20. Click Save link under disbursement header. 

Note: Notice disbursement header is updated and reflects a $0.00 disbursement amount. 
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21. Click Post link 

22. Click OK to post zero disbursement.  Disbursement summary view shows zero amount posted. 

Receive Payments 

Use the receive payment tab to post received payments to the general ledger. They will then be available 
for deposit. 

To Receive a Payment 

1. On the Primary Menu, click ORGANIZATION. 

2. Select the territories tab.  

3. Select the appropriate Details  icon for the territory that will be receiving a payment. 

4. Select the accounting tab. 

5. Select the transactions tab  

6. Click the receive payments tab. 

7. Click [Add New]. 
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8. Select the Entity Type (the default is Client) and search for the entity name. 

9. Select the entity name and click OK. 

 
• Enter the Date Booked (current date is default). 

• If the payment is a 3rd Party Type, select the check box. 

• Select the Payment Type from the drop-down list. 

• Enter a Reference number. If payment is by check, enter the check number. 
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• Enter the Payment Amount. 

• Enter a Description (optional). 

10. Click Save. 

11. Select the Invoices link.  All invoices for the selected client in the selected territory will be 
displayed. 

Note: To search for specific invoices, click the [Show] link and use the drop-down lists to enter 
search criteria. 

 
  

12. Nexsure will automatically select the closest matching invoice based on payment and date.  Click 
Pay All Selected. 

13. Click Post.  Once received payments are posted, they will be available on the receipts screen of 
the deposit tab. 

  

Related Topics 

NSF > Receive Payment Reversal 

  

NSF / Receive Payment Reversal 

If a client’s receive payment has been returned to the agency after it was included in a deposit, you have 
to remove the money from the bank account and reverse the application of the receive payment to 
specific invoices. This process also allows for the creation of a charge back to the client for the returned 
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payment. Charging a fee back for NSF is available ONLY for clients. NSF flag functionality is available for 
the following entities but is for information purposes only and will not create a fee: 

• Employee 

• Retail Agent 

• Carrier 

• Additional Interest 

• Finance Company 

• Tax Authority 

• Vendor 

  

To Reverse a Received Payment 

1. Locate the original receive payment and click the Details  icon.  

2. Click Reverse. 

 

3. In the Reverse Payment pop-up, select NSF from the drop-down list. Enter a note in the Reversal 
Reason field (up to 20 characters). 

4. Click OK to complete process.  

Note: Both the reversing entry and the original entry will have Reversal Reason displayed. 

5. Click Payment Summary to view the reversal on the receive payments tab: 
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The following actions will occur after completing the reversal of a deposited receive payment: 

• Client’s transaction summary will reflect the reversal of all associated applications to 
invoices. 

• Client invoice receivables tab will reflect the reversal of all associated applications to 
invoices. 

• Client’s transaction summary will reflect the charge invoice created, if applicable. 

Note: To remove the amount from the bank account, you must add a negative Deposit 
picking up the reversed receipt by clicking the Receipt link on the deposit.  

 

Deposits 

To make a deposit 

1. On the Primary Menu, click ORGANIZATION. 

2. Click the accounting tab. 

3. Click the transactions tab. 

4. Select the deposits tab. 

5. Select the bank account you wish to deposit to from the drop-down list. 

 

6. Click [Add New Deposit]. 
 

 
  

Note: A deposit ID number will be assigned by Nexsure and will be displayed in the deposit 
header. The deposit header also displays other general information such as the date created, who 
created the deposit and bank account information including balances. 



Nexsure User's Guide    Organization Menu 

XDimensional Technologies, Inc. 353

7. Enter the Date Booked (current date is default). 

8. Select the Deposit Method, such as EFT (electronic file transfer). 

9. Enter the Anticipated Total dollar amount.   

10. Enter a description and internal note (optional) to help identify the deposit. 

11. In the quick navigation panel, click Receipt.  This will show a list of existing received payments. 

12. Select the payments you wish to deposit, or click Select All. 

13. Click Post to post the deposit to the general ledger, or click Abort to cancel the deposit. 

Accounts Payable 

To make an accounts payable entry 

1. On the Primary menu, click ORGANIZATION.   

2. Select the organization level where your bank accounts are located, for example - Territories. 

3. Select the accounting tab. 

4. Select the transactions tab.  

5. Click accounts payable. 

6. Click [Add New].  The Entity Search dialog appears. 
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7. Search for the Entity to pay. 

Note: If the entity has an alternate payment address, it can be selected from the Select Address 
drop-down list. 

8.  Click OK. 

 

9. Enter the Date Booked (current date is default). 
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10. Enter payable Date Due. 

11. Select Recurring to setup a recurring accounts payable. 
 
The recurring accounts payable option fully automates the accounts payable process. This topic 
covers the recurring option, for more information see Recurring Accounts Payable. 

12. Enter an internal Reference and Description for the payable transaction. The Description field is 
also important for generating a Vendor 1099 Disbursement Details report, see the note below. 

Note: For vendors with 1099 status to appear on the “Vendor 1099 Disbursement Details ” 
report, the following criteria must be met:  
 
Enter “1099” into the Description fields when creating an Accounts Payable transaction. This can 
be in addition to any other text in the description, ie. "Office Supplies - 1099" (see example) 
 
When Adding a Vendor, the 1099 box must be selected. 

13. In the Debit field, enter the amount owed, in the Credit field, enter the amount being paid. 

Note: If you are making more than one payment to the same vendor, click Add Row to add 
another line item. 

14. In the Credit field, enter the amount being paid.  The difference (if any) will be displayed below. 

15. Click Save to save the payable information, then click Post to return to the Accounts Payable 
Summary.   

16. Click Post to post the payable information to the general ledger.  The Posted check box will be 
selected.  Once a disbursement has been made, the Processed check box will be selected as 
well. 

Related Topics 

Accounts Payable Auto Processing 

Recurring Accounts Payable 

Using Allocations 

Accounts Payable Auto Processing 

This process allows you to create a disbursement by selecting multiple accounts payable items and 
posting them all at once, bypassing the need to create a new disbursement for each item.  All posted, 
unprocessed accounts payable entities can be selected for auto processing.   

Note: Accounts payable items that anticipate a refund and require a receive payment entry cannot be 
selected for auto processing. 

To auto-process AP items 

1. On the Primary menu, click ORGANIZATION.   

2. Select the accounting territory by clicking the Details  icon. 

3. Select the accounting tab. 
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4. Select the transactions tab.  

5. Click accounts payable. 

6. Click [Add New]. 

 

7. Search for the Entity to pay. 

Note: If the entity has an alternate payment address, it can be selected from the Select Address 
drop-down list. 

8. Click OK. 



Nexsure User's Guide    Organization Menu 

XDimensional Technologies, Inc. 357

 

9. Enter the Date Booked (current date is default). 

10. Enter payable Date Due. 

11. Enter an internal Reference and Description for the payable transaction (optional). 

12. Accounts payable should be the credit amount that will be paid.   Enter the amount owed in the 
Credit field.   The difference will be displayed below. 

Note: If you are making more than one payment to the same vendor, click Add Row to add 
another line item. 

13. The second line item will be the expense or offset detail related to the amount that is owed.  Enter 
that amount into the Debit field.  The difference, unless an additional row is needed, should be “0”. 

14. Click Save to save the payable information, then click Post to return to the Accounts Payable 
Summary.   

15. Click Auto Process Accounts Payable.  A list of the posted, unprocessed AP items will be 
displayed. 

Note: Items creating a debit to accounts payable (expecting receive payment) will not be available 
for auto processing. 
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16. Select a bank account from the drop-down list. 

17. Select AP items for auto processing by clicking in the Select box, or clicking the [Select All] link. 
  

18. Click [Process Accounts Payable].  All selected AP items will be auto processed and will now 
appear on the Disbursements tab. 

 

19. To print a check for an item in the disbursement list, click the Details  icon and click the Print 
link. 

   

Recurring Accounts Payable 

The recurring accounts payable option fully automates the accounts payable process. This topic covers 
the recurring option, for more information on AP functionality, see Accounts Payable. 
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To schedule recurring accounts payable 

1. Once you have created a new accounts payable item, select the Recurring option. 

2. Click Set Properties. 

3. Select the recurring schedule: 

Daily  

Daily Recurrence Schedule  

• Every number of days will create 
accounts payable on that number of 
days. i.e. 1 would create an entry every 
day, 8 would create an entry every 8 
days.  

• Every weekday will create accounts 
payable Monday to Friday.  

Recurrence Range  

• Start date – defaults from accounts 
payable screen and determines the first 

Monthly  

Monthly Recurrence Schedule  

• Day ## of every # month(s) – specific 
date the number of months designated. 

• Example – Day 15 of every 1 
month will create the journal entry 
on the 15th of each month 
beginning in August. 

• Example – Day 15 of every 3 
months will create the accounts 
payable on the 15th of every 3rd 
month.  In this example, with 
7/21/2005 as start date, the first 
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occurrence - Today's date plus one day. 

• Continuous – accounts payable will be 
created until end is defined. 

• Continue for number of occurrences – 
accounts payable will be created for set 
number of occurrences. 

• End by specific date – accounts payable 
will be created until date is reached. 

• If end by date = the prescribed 
occurrence of a journal entry, the 
entry will be created.  For 
example, end by date = July 21, 
2006  the accounts payable will 
occur on July 21.  If end by date = 
July 23, 2006 then the last 
accounts payable will also occur 
on July 21 since July 23 is not a 
weekday. 

Automatically Post  

• If checked, accounts payable will post 
during a night process automatically 
(12:40 AM). 

• If unchecked, journal entry will be created 
but will not post.  

  

accounts payable will be August 
with subsequent accounts 
payables occurring in November, 
February 2006, May 2006, August 
2006 and so on.  

• To effect a different month, “Start” 
could be changed to later month to 
begin the series in that month.  

Recurrence Range  

• Start date – defaults from accounts 
payable screen and determines the first 
occurrence. 

• Continuous – accounts payable will be 
created until end is defined. 

• Continue for number  of occurrences – 
accounts payable will be created for set 
number of occurrences.  

• End by specific date – accounts payable 
will be created until date is reached.  

Automatically Post  

• If checked, accounts payable will post 
during a night process automatically 
(12:40 AM). 

• If unchecked, accounts payable will be 
created but will not post.  

Weekly  

Weekly Recurrence Schedule  

• Every # of week(s) on a specific day (or 
days) will create accounts payable on 
that day every designated number of 
weeks.  

• Example – every 1 week on 
Tuesday will create the accounts 
payable every Tuesday. 

• Example – every 2 weeks on 
Tuesday will create the accounts 
payable every other Tuesday.  

Recurrence Range  

Yearly  

Yearly Recurrence Schedule  

• Only option is “Occurs” with the specific 
day designated.  

Recurrence Range  

• Start date – defaults from accounts 
payable screen and determines the first 
occurrence. 

• Defaults from “Date Booked” but 
may be changed based on rules 
for using “Date Booked” in a 
accounts payable.  

Today’s date is the default.  
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• Start date – defaults from accounts 
payable screen and determines the first 
occurrence. 

• Continuous – accounts payable will be 
created until end is defined. 

• Continue for number  of occurrences – 
accounts payable will be created for set 
number of occurrences. 

• Example – 24 occurrences will 
result in 24 weeks of Tuesday 
accounts payable. 

• End by specific date – accounts payable 
will be created until date is reached.  

Automatically Post  

• If checked, accounts payable will post 
during a night process 
automatically(12:40 AM). 

• If unchecked, accounts payable will be 
created but will not post.  

Date may not be in a closed or locked period

• Continuous – accounts payable will be 
created until end is defined. 

• Continue for number of occurrences – 
accounts payable will be created for set 
number of occurrences.  

• End by specific date – accounts payable 
will be created until date is reached.  

Automatically Post  

• If checked, accounts payable will post 
during a night process automatically 
(12:40 AM). 

• If unchecked, accounts payable will be 
created but will not post.  

  

  

4. Click OK. 

• Frequency - establishes schedule 

• Start Date - establishes the point that the entry will begin 

• Expiration - establishes expiration of recurring entity 

• Auto Post - if checked, reflects that the accounts payable will post automatically. 
Otherwise, the accounts payable will be created based on rules and will be available to 
post, edit or delete. 

• Transaction Summary - Saves the entry and returns to Journal Entry transaction list 
view.  Recurring entries must be in balance, clicking Transaction Summary while not in 
balance will prompt a message notifying you to balance the journal entry. 

•  Print - Prints accounts payable line items. 

Note: Post is not available for a recurring entry. 

• Abort - Deletes the entry. 

• Save - Saves the entry, remaining in the accounts payable screen. 

• Add Allocation - Displays available allocations for entry, see Using Allocations. 

• Add Row - Adds general ledger line items. 

  

Related Topics 

Accounts Payable 

Accounts Payable Auto Processing 
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Using Allocations 

Using Allocations 

Organizations with multiple branches, departments and possible units may have a policy of dividing 
expenses during the course of an accounting transaction based on the organizational structure. Creating 
a general ledger allocation plan provides a template for easily dividing expenses within the organization. 
Allocation plans can be created for accounts payable and journal entries. Before using an allocation 
template it must be created first, see Allocation Plan Setup. 

Accounts Payable Allocations 

To use allocations with accounts payable 

1. On the Primary menu, click ORGANIZATION.  

2. Select the Org level where your bank accounts are located, for example - Territories. 

3. Select the accounting tab. 

4. Select the transactions tab 

5. Click the accounts payable tab. 

6. Click [Add New]. The entity search dialog appears. 

7. Search for the entity to pay. 

Note: If the entity has an alternate payment address, it can be selected from the Select Address 
drop-down list. 

8. Click OK. 

 

9. Enter the accounts payable information as covered in the accounts payable topic. 

10. Click Add Allocation. An allocation plan must have been previously created to activate this link. 
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• GL Allocation Name - Select the allocation plan from the drop-down list. The entity where 

the transaction is created must be part of the allocation plan to be available.  

• Description - Defaults from allocation plan. 

• Type - Select debit or credit for fill in to accounts payable item. 

• Amount - Defaults from the first AP entry but can be changed. If the amount is changed, 
additional rows or allocation must be entered to balance. 

11. Click the GL Account Number ellipsis. 

 
• Classification - classification availability depends on the allocation plan's type. 

• A Balance Sheet Type will display: Classification Asset, Liability and Equity 

• An Income & Expense Type will display: Classification Income, Expense, Under 
Ops Income and Under Ops Expense 

• Group - selection is dependent upon the classification selected. 

• Type - selection is dependent upon the classification selected. 
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• Enter a partial name or GL account number and click Search. 

12. Select the general ledger number and click OK. 

13. Click OK to close the Add GL Allocation pop-up window. 

 
The allocation in this example divided items evenly across two organizational levels. Intra-territory 
angle creates additional entries to keep the books in balance. 

Processing the disbursement for the accounts payable item in this example will: 

• Credit bank $3,200.00 (Territory 001) 

• Debit accounts payable $3,200.00 (Territory 001) 

• No additional entries via disbursement (accounts payable processing) need to occur to 
Territory 002 

• Territory 002 may eventually repay territory 10, crediting the bank and debiting Intra-Office 
Secondary Offset. 

• Territory 001 receipts repayment, debiting undeposited funds and crediting Intra-Office 
Primary Offset. 

Journal Entry Allocations 

To use allocations with journal entries 

1. On the Primary menu, click ORGANIZATION. Select the organization level where your bank 
accounts are located, for example - Territories. 
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2. Select the accounting tab. 

3. Select the transactions tab. 

4. Click the journal entry tab. 

5. Click [Add New].   

 
Note: The first general journal entry line must be completed with a general ledger number and 
debit or credit value before Add Allocation can be used. 

6. Enter the journal entry information as covered in Journal Entry, and click Add Allocation. 

 
• GL Allocation Name - Select the allocation plan from the drop-down list. The entity where 

the transaction is created must be part of the allocation plan to be available.  

• Description - defaults from allocation plan. 

• Type - Select debit or credit for fill in to accounts payable item. 

• Amount - defaults from the first AP entry but can be changed. If the amount is changed, 
additional rows or allocation must be entered to balance. 
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• Classification - classification availability depends on the allocation plan's type. 

• A balance sheet type will display: Classification Asset, Liability and Equity 

• An income and expense type will display: Classification Income, Expense, 
Under Ops Income and Under Ops Expense 

• Group - selection is dependent upon the classification selected. 

• Type - selection is dependent upon the classification selected. 

• Enter a partial name or GL account number and click Search. 

7. Select the general ledger number and click OK. 

8. Click OK to close the Add GL Allocation pop-up window. 
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Note: Process for journal entry is different from accounts payable in that a determination must be 
made for the initial line item with subsequent offsets.  In this example, corporate accounting for the 
territory level has been credited the entire amount with the gl allocation providing subsequent 
allocation for the same general ledger number.  It could be the first line is bank interest or bank 
service charges with allocation created to distribute to other levels. 

Reconciliation 

Reconciliation posting clears existing income/receivable totals and/or payable totals.  Reconciliation items 
must be posted by invoicing with offsets to the reconciliation clearing account as recorded with 
disbursement issuance or cash payments received. 

 
To perform a reconciliation 

1. On the Primary menu, click ORGANIZATION. 

2. Select the territories tab and select the territory you wish to reconcile. 

3. Select the accounting tab. 

4. Select the transactions tab.  

5. Click the reconciliation. 
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6. Click [Add New Reconciliation]. 

 

7. Select an Entity Type from the drop-down list and search for the entity. 

Note: If you select Carrier, you are given the option to select any subordinate carriers associated 
with a parent carrier. Subordinate carriers will be followed by an (s).  Note also that if you search 
for a subordinate carrier, the primary carrier will also be displayed followed by a (p). 

8. Click OK. 

9. In the Description field, enter a description that identifies the reconciliation (such as March 05 
commissions). 

10. In the quick links list, click Transactions. By default, all agency billed posted invoices will be 
displayed. 

Note: Each invoice is posted showing the individual LOBs for that policy. There may be multiple 
invoices with the same invoice ID, these are not duplicates, but different line of businesses on a 
package policy. 

• If there are direct bill invoices that need to be included in the reconciliation, click [Show], in 
the bill method drop-down list, select Direct Bill or Both and click OK. 
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11. Select the invoices to include in the reconciliation by clicking in the check box. If you are making a 
partial payment on an invoice, click the Details  icon and enter the amount. 

12. Click Save. 

13. Click Pay All Selected.   

Important: If you have more than one page (or screen) of invoices, clicking Pay All Selected will 
only pay the invoices that are displayed on the current page.  If you selected invoices on other 
pages, navigate to each page and click Pay All Selected. 

14. Click OK. Verify that the proper amount appears in the Paid column. 

15. Click Post. 

  

Related Topics 

Direct Bill Carrier Statement Entry 

Revising Commission During Reconciliation 

Direct Bill Carrier Statement Entry 

This process allows you to create and post invoices quickly from a carriers direct bill commission 
statement, through reconciliation, without having to access individual clients.  No invoicing is done at the 
client’s policy level but the policy info tab does need to be completed with all applicable information. 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Click the Details   icon of the appropriate territory. 

4. Click the accounting tab. 

5. Click the transactions tab. 

6. Click the reconciliation tab.  

7. Click the [Add New Reconciliation] link. 

8. Select Carrier in the entity type drop-down box 

9. Search for the appropriate Carrier, select Subordinate Carriers if applicable, and click OK. 

10. The date booked field will apply to all items added. 

11. Enter a description. 
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12. In the quick navigation panel, click Transactions.  By default, all posted agency billed invoices will 
be displayed. 

Tip: Any existing invoices that need to be included in this reconciliation should be reconciled 
before entering the carrier statement. 

13. Click the [Add Carrier Statement Transactions] link. 

   

  

14. The search filter will open and default the Bill Method to Direct Bill.  The sort field and sort order 
can be used to match the search criteria to the carrier’s statement.  Click Search. 

 

15. A list of clients will be displayed.  The clients must have an in force policy and premium information 
entered on the policy info tab. 
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16. The information in the unposted invoice, pulled from the policy info tab, can be edited. 

• Click on the “item id” hotlink to launch an unposted invoice into edit mode. 

• The date booked will be the same for all entries and is designated at the reconciliation. 

• Make the necessary changes to premiums, fees, and taxes.  The agency and people 
commission should adjust automatically.  The invoice will display at both the client and policy 
level but can only be edited from the unposted reconciliation. 

• Click the reconciliation link under the invoice header to return to the reconciliation. 

• Repeat steps 16a-d for all unposted invoices where the amount does not match the carriers 
statement. 

17. Select the clients, appearing on the carrier statement, to create the Invoices for.  Click the Create 
Invoices link under the reconciliation header. 
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18. To post the invoices click the Post Invoices link under the reconciliation header. 

19. Click Pay All Selected.  To check your work against the carrier statement before posting, print 
remittance advice (see below). 

20. Click Post. 

Making a Payment 

1. In the quick navigation panel, click Receipts/Disbursements. 

2. Click [Add New Disbursement]. 

3. Select the disbursement. 

4. Click OK. 

5. Click Post. 

6. Click Print Check. 

Submitting Remittance Advice 

1. Once the reconciliation is completed and posted click the print link under the reconciliation header. 

2. Select Remittance Advice in the Print Selection drop-down box. 

3. Click OK. 

4. Click the print link in the adobe toolbar to print out the remittance advice to compare to the 
carrier’s statement. 
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5. Click the Delivery link under the reconciliation header to email or fax from Nexsure. 

  

Related Topics 

Direct Bill Carrier Statement Entry 

Revising Commission During Reconciliation 

Revising Commission During Reconciliation 

This process will allow the adjustment of commissions to be made during the reconciliation process 
without reversing or re-billing invoices.  Adjustments to commission can be made to both Direct and 
Agency billed invoices. 

To Revise a Commission 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Click the Details   icon of the appropriate territory. 

4. Click the accounting tab. 

5. Click the transactions tab. 

6. Click the reconciliation tab.  

7. Click the Add New Reconciliation link. 

8. Select carrier in the entity type drop-down box 

9. Search for the appropriate carrier, select subordinate carriers if applicable, and click OK to display 
the reconciliation header screen for the select carrier.  The Date Booked will default to today’s 
date. 

10. Enter Description. 

11. Click the Transactions link in quick navigation. 

12. Transactions screen defaults to posted agency bill invoices; click the search filter [Show] link and 
search by agency bill, direct bill or both to pull them into the reconciliation. (Use the other search 
criteria for a more refined search).  

13. Click the Item ID hotlink to launch the posted invoice into edit mode. 
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14. Click the Details   icon of the agency commission to enter the correct commission rate and click 
OK. 
  

 

15. If agency commission is based on a percent of the premium, it will automatically display a second 
line item with the difference and the amount due (credit or debit).  If people commission is based 
on a percent of the agency commission, it will adjust automatically.  The people commission can 
also be adjusted by clicking on the details icon.  This will also generate a second line item based 
on the difference. 
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16. Click the Post Adjustment link to post the commission changes made to the invoice. 

17. Click the Reconciliation (ID) link under the invoice header to return to the reconciliation. 

 

18. Repeat steps 14-18 for all invoices where the commission amount does not match the carrier 
statement. 

19. Continue the Reconciliation process. 
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20. Once the reconciliation is completed and posted, click the Print link under the reconciliation 
header. 

21. Select Remittance Advice in the Print Selection drop-down box. 

22. Click OK. 

23. Click the Print link in the Adobe toolbar to print out the remittance advice to compare to the 
carrier’s statement. 

24. Click the Delivery link under the reconciliation header to email or fax from Nexsure. 

  

Related Topics 

Reconciliation 

Direct Bill Carrier Statement Entry 

  

Invoices Tab 

The invoices tab allows access of posted, unposted and reversed invoices, including installments, for 
printing and research purposes. 

To access the invoices tab 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Click the Details  icon of the appropriate territory. 

4. Click the accounting tab. 

5. Click the transactions tab. 

6. Click the invoices tab. A maximum of 1000 records display. 
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7. Clicking the Details  icon will display the invoice for review. 

8.  To return to the invoices summary view, click the Transaction Summary link. 

9. Use the [Show] filter to display all posted invoices. 

  
  

10. Select invoices to print. 
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11. Click the Create Print Batch link to create new print batch (Invoices must be posted to batch 
printing). 
  

 

12. Edit batch name and description if needed. 

13. Select the check style, preview format and printer from the drop-down list. 

14. Select restricted box to limit access 
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15. Select print now to print invoice(s) immediately 

16. Click OK to add batch to print 

17. A window will appear with the batch print number. 
 
  

To add an invoice to an existing batch select the invoice to be added 

1. Click the Add to Existing Batch link. 

2.  In the pop-up window, select the batch to add the invoice to from the Last Batch Created window.  

 

3. Click OK. The Invoice has been added to the existing batch and will be available on the batch 
summary tab. 

  

Related Topics 

Batch Summary Tab 
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Batch Summary Tab 

Invoices and disbursements can be printed in batches from the Batch Summary tab. 

Invoices tab 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Click the Details  icon of the appropriate territory. 

4. Click the accounting tab. 

5. Click the batch summary tab.  Any batches that have been generated will appear. 

 

6. To view a batch, click the Details  icon of the selected batch.  A window will display all items in 
this batch. 
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7. Click the Refresh link to refresh the view. 

8. Click the Print Selected link to print individual items selected. 

9. Click the Edit link to edit the batch name, description, check, preview format and printer selected. 

10. Click the Close link to close the window. 

11. Click the Close link to return to the batch summary view. 

12. Use the Select All or Deselect All links to select batch items to print, or select each batch 
individually by clicking in the select box. 

13. Click the Print Selected link. 

14. Click OK. 

Batch Printing 

Batch printing allows you to select multiple disbursements and print a batch of checks for those 
disbursements. 

Important: To use the batch printing feature, you must have Adobe® Reader® or Professional version 6 
or higher.  Click here to get the latest version of Adobe® Reader®. 

To batch print checks 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

http://www.adobe.com/products/acrobat/readstep2.html
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3. Click the Details  icon of the appropriate territory. 

4. Click the accounting tab. 

5. Click the disbursements tab. 
  

 

6. Select the disbursements to add to the batch print job by clicking the Select check boxes. 

7. Click Create Print Batch. 

 
• Enter a name for the batch, Disbursement appears by default. 

• Enter a description for the batch, Disbursement created on 'current date' appears by default. 

• Select a style of check to print. 

• Select a program to preview the checks in (PDF, DOC, XLS). 

• Select a printer. 
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• Selecting Restricted will deny access to any other Nexsure user. 

• Select Print Now to immediately send the checks to the printer.  Leaving this option blank will 
send the print batch to the Batch Summary screen. 

8. Click OK. 

Note: Make sure that the proper check stock is loaded in the printer. 

  

 
  

9. Accept the Nexsure generated check numbers or enter check numbers manually and click OK. 
The checks will be sent to the selected printer. 

10. Once checks have been printed the print batch can be located on the Batch Summary screen: 
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Working with Vendors 

The vendor entity must be entered in search, see Adding a Vendor, to be able to associate it to a general 
ledger account at the territory level.  Associating the vendor to a general ledger account at the territory 
level will make it available for setting up account payable records and disbursements. 

1. On the Primary menu, click ORGANIZATION. 

2. Click the territories tab. 

3. Click the Details  icon of the appropriate territory. 

4. Click the vendors tab. 

5. Click the [Add New] link. 

 

6. Click the ellipsis  button next to the Name field. 

7. The Nexsure accounting screen will be displayed.  Enter at least three characters of the vendor 
name in the search field and click Search. 

8. Select the vendor name and click OK. 
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9. Enter a Description for the Vendor. 

10. Click the ellipsis  button next to the Default GL Account field 

11. The Nexsure accounting screen will be displayed. 

 
Note: The region and territory should be grayed out; this will confirm that the vendor is being 
added at the territory level.  If it is not grayed out, click Cancel and start at step 1. 

12. The Branch, Department and Unit, if applicable, may be selected from the drop-down boxes. 
 This information may be left blank. 

13. The Classification, Group and Type, may be selected from the drop-down boxes.  This 
information may be left blank. 

14. Enter at least two characters in the general ledger account name or number field and click the 
Search button. 

15. All general ledger accounts will be displayed.  Select the appropriate general ledger number and 
click OK. 

16. The general ledger number will be pulled over to the default GL account number for the vendor. 

Note: If this account is not accurate, click the Clear link to clear the field.  Click the ellipsis  
button to run a new search. 

17. Enter the account number for this vendor. 

18. Click the Primary Contact drop-down box to select a contact, if applicable. 

19. Click the Default Address drop-down box to select an address, if applicable. 
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20. Click the Update link. The vendor will appear in the vendor tab summary view. 

  

Related Topics 

Adding a Vendor 

Disbursements 

Accounts Payable 
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Reports Overview 
Nexsure offers a comprehensive list of over 40 reports covering all areas of Nexsure. Nexsure also offers 
Ad Hoc reporting (Ad Hoc reporting must be purchased separately, contact your Nexsure sales rep. for 
details).  Using the report criteria screens you can sort and select only the report criteria you need.  After 
the results are displayed they can be saved or printed as a MS Word, Excel or Adobe Acrobat PDF file. 

  

To access the Reports screen 

1. On the Primary menu, click Reports. 

2. On the Report menu, click Reports. 

 
  

3. Select a Report Type from the drop-down list. 

 
Report Types: 

• Accounting 

• Management 

• Clients/Contacts 
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• Organization  

• Marketing 

• Opportunities 

• Policies 

• Ad-Hoc 

4. If an accounting report is being generated, select a report category. 

 
Accounting Report Categories: 

• Accounts Payable 

• Accounts Receivable 

• General Ledger 

• Production 

• Profitability 

• Reconciliation 

• Entities 

5. Select a report from the Available Reports box. 

Note:  A description of each report will be displayed when it is selected. 

6. Click OK.  The report summary screen is displayed. 
  

 
 
  

7. All previous reports of that type and category will be displayed.  Existing reports can be modified by 
selecting the report and clicking the New Report Criteria link.  If this is the first time the report has 
been generated click New Report Criteria. 

8. Enter the organization Information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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9. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

10. Enter the remaining report criteria. 

11. In the Report Format Options drop-down list select how the report should be saved as (PDF, 
Word or Excel file). 

12. Click OK.  The report will appear on the report summary screen. 

Note: Some reports may take a few minutes to generate depending on the size of the report.  The 
Status will display a percentage of completion until the report is complete.  Click the Refresh link 
to update the progress. 

13. Once a report is complete, click the Print  icon. 
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14. Select the default printer. 

15. The Restricted option prevents other user's from viewing the report. 

16. Selecting Print Now will send the report to the printer immediately. 

Clients and Contacts Reports 

For help generating one of the following reports, click on the name of the report.   

Client Contact List 

 
A list of contacts for clients. 

To generate a Client Contact List report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Clients/Contacts. 

3. Locate Client Contact List and click Enter Report Criteria. 

4. Enter the Organization Information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  
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Client Mailing Labels 

 
Print client mailing labels.     

Note: Be sure to load your printer with label stock before printing.  Use Avery 5162 labels. 

To generate client mailing labels 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Clients/Contacts. 

3. Locate Client Mailing Labels and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

Tip:  Select the Avery drop-down list to select from a list of Avery label sheet numbers. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Client Listing 
 
List of clients. 

To generate a client listing report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Clients/Contacts. 
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3. Locate Client Listing and click Enter Report Criteria. 

4. Enter the Organization Information. 

Note: These fields can not be populated directly. You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

5. Click Submit Report Criteria.  The report viewer will open. 

6. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

  

More Report Types 

Accounting 

Management 

Organization 

Marketing 

Opportunities 

Policies 

  

Management Reports 

For help generating one of the following reports, click on the name of the report.  

Book of Business Report 
 
Displays the total value of an account by carrier or people.    
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To generate a book of business report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Management. 

3. Locate Book of Business and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select]. The Nexsure Organization Criteria dialog box will appear. Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add. This feature allows you to add as many regions, 
territories, etc. to the report as needed. Once information has been added to the Include box, it can 
be removed by selecting the item and clicking the Del button or Clear to remove all items. If the 
organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria. The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

New Business Report 
 
New business including lines of business, client type, policy number, policy mode and type, effective and 
expiration dates. 

To generate a new business report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Management. 

3. Locate New Business and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Lost Business Report 
 
Includes all policies canceled, lapsed or non-renewed for a selected date range.         

To generate a lost business report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Management. 

3. Locate Lost Business and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly. You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 
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6. Enter the remaining report criteria. 

4. Click Submit Report Criteria.  The report viewer will open. 

5. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Active Policies Report 
 
Lists active policies expired in the system.      

To generate a active policies expired report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Management. 

3. Locate Active Policies Expired and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly. You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Coverage Rounding 
 
A list of client and contact information for mailings and telemarketing. 

To generate an active policies expired report 

1. On the Primary menu, click Reports. 
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2. On the Reports menu, click Management. 

3. Locate Coverage Rounding and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. In the Policy Information fields, click the ellipsis buttons  to add up to two lines of business 
and select "And Or" from the drop-down list to complete the logic of the selection. 

 

7. In the Output Options drop-down list, select either Report or Excel. 

8. Click Submit Report Criteria.  The report viewer will open. 

9. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

  

More Report Types 

Accounting 

Clients/Contacts 

Organization 

Marketing 
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Opportunities 

Policies 

  

Marketing Reports 

For help generating one of the following reports, click on the name of the report.  

Marketing Results 
 
Use to determine source of new business written. (Note: Results are obtained from the 'Referred By' field 
on the profiling screen and a policy mode of 'New' for selected date range entered in criteria).      

To generate a marketing results report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Marketing. 

3. Locate Marketing Results and click Enter Report Criteria. 

4. Enter the Organization Information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  
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Marketing Policies 
 
Complete listing of all policies in the marketing stage for a selected date range.    

To generate a marketing policies report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Marketing. 

3. Locate Marketing Results and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

More Report Types 

Accounting 

Management 

Clients/Contacts 

Organization 

Opportunities 

Policies 
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Opportunities Reports 

For help generating one of the following reports, click on the name of the report. 

Opportunity Details 
 
Customizable report of opportunities showing complete detail including a total summary page.     

To generate an opportunity details report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Opportunities. 

3. Locate Opportunity Details and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Opportunity Summary 
 
Customizable report summarizing individual opportunities. 

To generate an opportunity summary report 

1. On the Primary menu, click REPORTS. 
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2. On the Reports menu, click Opportunities. 

3. Locate Opportunity Summary and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

More Report Types 

Accounting 

Management 

Clients/Contacts 

Organization 

Marketing 

Policies 

  

  

Organization Reports 

For help generating one of the following reports, click on the name of the report.  

Organization Hierarchy 
 
Shows the structure of all entities in the organization.   

To generate an organization hierarchy report 

1. On the Primary menu, click REPORTS. 
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2. On the Reports menu, click Organization. 

3. Locate Organization Hierarchy and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly. You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select]. The Nexsure Organization Criteria dialog box will appear. Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add. This feature allows you to add as many regions, 
territories, etc. to the report as needed. Once information has been added to the Include box, it can 
be removed by selecting the item and clicking the Del button or Clear to remove all items. If the 
organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria. The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Carrier Listing 
 
A complete listing of all carriers.  

To generate a carrier listing report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Organization. 

3. Locate Carrier Listing and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Employee Listing 
 
Listing of employees by organization, region, territory, and branch.     

To generate an employee listing report 

1. On the Primary menu, click REPORTS. 

2. On the Reports menu, click Organization. 

3. Locate Employee Listing and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

  

More Report Types 

Accounting 

Management 

Clients/Contacts 

Marketing 

Opportunities 

Policies 

  

  

Policies Reports 

For help generating one of the following reports, click on the name of the report.  

Actions 
 
A listing of actions due in a specified time period.   

To Generate an Actions Report 

1. On the Primary menu, click REPORTS. 

2. Click Reports to display the Reports pop-up window. 

3. From the Report Type drop-down menu, select Policies. 

4. Locate Actions and click Enter Report Criteria. 

5. Enter the organization information. 
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Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

6. Click [Select]. The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add. This feature allows you to add as many regions, 
territories, etc. to the report as needed. Once information has been added to the Include box, it can 
be removed by selecting the item and clicking the Del button or Clear to remove all items. If the 
organization information is correct, click OK. 

7. Enter the remaining report criteria. 

8. Click Submit Report Criteria. The report viewer will open. 

9. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Expirations 
 
A listing of policies with expiration dates in a specified date range along with associated actions. 

To generate a expirations report 

1. On the Primary menu, click REPORTS. 

2. Click Reports to display the Reports pop-up window. 

3. From the Report Type drop-down menu, select Policies. 

4. Click on Expirations and click OK. 

5. Click New Report Criteria. 

6. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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7. Click [Select]. The Nexsure Organization Criteria dialog box will appear. Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add. This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items. If 
the organization information is correct, click OK. 

8. Enter the remaining report criteria. 

9. Click Submit Report Criteria. The report viewer will open. 

10. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Claims 
 
To generate a claims report 

1. On the Primary menu, click REPORTS. 

2. Click Reports to display the Reports pop-up window. 

3. From the Report Type drop-down menu, select Policies. 

4. Locate Claims and click Enter Report Criteria. 

5. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select]. The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add. This feature allows you to add as many regions, 
territories, etc. to the report as needed. Once information has been added to the Include box, it can 
be removed by selecting the item and clicking the Del button or Clear to remove all items.  If the 
organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria. The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  
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More Report Types 

Accounting 

Management 

Clients/Contacts 

Organization 

Marketing 

Opportunities 

  

Accounting Reports 

Nexsure offers an extensive list of accounting reports.  For help generating one of the following reports, 
click on the name of the report.  
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Accounts Payable Reports 

Account Current 
 
A listing of Invoices billed for specified carriers in a given month. Displays both gross and net amounts. 

To generate an account current report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts payable tab, locate Account Current and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Vendor 1099 Disbursement 
 
Lists disbursements that require a 1099.    

To generate a vendor 1099 disbursement report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts payable tab, locate Vendor 1099 Disbursement and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Carrier Payables 
 
To generate a carrier payables report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts payable tab, locate Carrier Payables and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  
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People Payables 
 
To generate a people payables report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts payable tab, locate People Payables and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

4. Click Submit Report Criteria.  The report viewer will open. 

5. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Tax Authority Payables 
 
To generate a tax authority payables report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts payable tab, locate Tax Authority Payables and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
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wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Vendor Payables 
 
To generate a vendor payables report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts payable tab, locate Vendor Payables and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select]. The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria. The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  
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Accounts Receivable Reports 

Accounts Receivable Detail 
 
Summary of balances paid, unpaid, or due from a client.      

To generate an accounts receivable detail report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts receivable tab, locate Accounts Receivable Detail and click Enter Report 
Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Direct Bill Commission Receivables 
 
Commissions in a receivable status.  

To generate a direct bill commission receivables report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts receivable tab, locate Direct Bill Commission Receivables and click Enter 
Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 



Nexsure User's Guide    Reports Menu 

XDimensional Technologies, Inc.   412

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Aged Accounts Receivable 
 
Summary of balances paid, unpaid, or due from a client displayed in aging categories.   

To generate an aged account receivables report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. On the accounts receivable tab, locate Aged Account Receivables and click Enter Report 
Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  
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Reconciliation Report 

General Ledger Reports 

GL Account Details 
 
Displays beginning balances, ending balances, and any activity in between for general ledger accounts 
selected for a given date range. 

To generate a GL account details report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the general ledger tab, locate GL Account Details and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Balance Sheet 
 
Balance sheet for org levels.  

To generate a balance sheet report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the general tab, locate Balance Sheet and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats.  

Journal Entries 
 
A listing of Journal Entries posted in a given date range.     

To generate a journal entries report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the general ledger tab, locate Journal Entries and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 
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Trial Balance 
 
Trial balance for organization levels.    

To generate a trial balance report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the general ledger tab, locate Trial Balance and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

Income Statement 
 
Income statement for organization levels.  

To generate a income statement report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the general ledger tab, locate Income Statement and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

Budget Report 
 
General ledger budget report.    

To generate a budget report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the general ledger tab, locate Budget Report and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 
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More Report Types 

Management 

Clients/Contacts 

Organization 

Marketing 

Opportunities 

Policies 

  

Additional Accounting Reports 

Nexsure offers an extensive list of accounting reports.  For help generating one of the following reports, 
click on the name of the report.  
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Production Reports 

Production (Summary or Detail) 
 
A listing of invoices created in a given time period.       

To generate a production (summary or detail) report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the production tab, locate Production (Summary or Detail) and click Enter Report Criteria. 

4. Enter the Organization Information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

Production Analysis by Year 
 
Production figures for a given time-frame compared to the same time-frame of a previous year.    

To generate a production analysis by year report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the production tab, locate Production Analysis by Year and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

Production Analysis by Month 
 
A listing of invoices created in a given month.    

To generate a production analysis by month report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the production tab, locate Production Analysis by Month and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 
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Profitability Reports 

Profitability Each Assignment Unit 

 
Shows profit by unit.      

To generate a profitability each assignment unit report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the profitability tab and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

  

Reconciliation Reports 

Invoice Transaction Register 
 
List of invoices over a specified period of time.     

To generate an invoice transaction register report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the reconciliation tab, locate Invoice Transaction Register and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

Cash Disbursements 
 
A listing of cash disbursed in a given date range. 

To generate a cash disbursements report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the reconciliation tab, locate Cash Disbursements and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 
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Cash Receipts 
 
A listing of payments received in a given date range.   

To generate a cash receipts report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the reconciliation tab, locate Cash Receipts and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 

 
  

5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

  

Entities Reports 

Financial Entities 
 
List of Financial Entities.   

To generate a financial entities report 

1. On the Primary menu, click Reports. 

2. On the Reports menu, click Accounting. 

3. Click the entities tab and click Enter Report Criteria. 

4. Enter the organization information. 

Note: These fields can not be populated directly.  You must click the [Select] link to enter the 
organization information. 
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5. Click [Select].  The Nexsure Organization Criteria dialog box will appear.  Using the drop-down 
lists, select the desired organization information (region, territory, branch, department, unit) you 
wish to query for the report and click Add.  This feature allows you to add as many regions, 
territories, etc. to the report as needed.  Once information has been added to the Include box, it 
can be removed by selecting the item and clicking the Del button or Clear to remove all items.  If 
the organization information is correct, click OK. 

6. Enter the remaining report criteria. 

7. Click Submit Report Criteria.  The report viewer will open. 

8. Click the Print icon  to send the report to your printer or the Export icon  to save the file as 
one of the supported file formats. 

• Accounts Receivable Reconciliation Report - Detail and summary of accounts receivable 
reconciliation report including general ledger#, total client detail, balance per general ledger, 
difference. 

• Accounting Budget - Commission and Fees - Monthly actual vs. budget with YTD and prior 
year totals and variance to compare by unit. 

• Accounting Budget - Unit - Budget for unit by month for actual and budget amount including 
variance.  Budget includes commissions, fees, investments, revenues for monthly 
budget/actual totals.  

• Accounting Financial Statements - Compare to budget and In force business 

• Accounting Income Statement - Current year YTD and last year YTD and current month 
comparisons to same period in prior year. 

• Accounting GL-Balancing - Balance sheet 

• Accounting GL-Balancing - Invoice transactions carrier to general ledger payable  

• Accounting GL-Balancing  - Invoice transactions people to general ledger payable  

• Accounting GL-Balancing  - Invoice transactions tax authority to general ledger payable  

• Accounting - People payables non-due reconciliation  

• Management Book of Business - Enhanced sorting capabilities includes issuing co, billing co, 
producer, servicer, department.   
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More Report Types 

Management 

Clients/Contacts 

Organization 

Marketing 

Opportunities 

Policies 
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Accounting FAQs 
Any agency management system has specific work-flows designed to address normal processes. 
 Nexsure’s FAQ section will grow over time as procedures are requested by users. 

Beginning Balances 

How do I determine my beginning balance month? 

Typically, the month prior to the first live month on Nexsure will be the month for beginning balance entry. 

Accounting entries can begin with beginning balance entry can be held until balances are validated.  The 
beginning balance entry month should be locked to prevent inadvertent entry to the month and then 
unlocked for beginning balance entry. 

How do I establish my beginning balances? 

Copy Nexsure chart of accounts per territory (lowest book level) into an excel spreadsheet. 

Revise as directed by XDTI, including adding a debit and credit column to enter beginning balances per 
general ledger number. 

Note: Accounts receivable general ledger number will not be used; rather the mandatory general ledger 
number for “Client Beginning balances” will be used. 

Accounts receivable will have been set by adding the specific client beginning balance entries. 

Validate that total debits = credits per territory entry  

In the event balances are not clearly defined moving forward; i.e. carrier payables are not in balance, use 
a pseudo account rather than the mandatory general ledger number for beginning balances. 

Accounting entries can begin without beginning balance entry.  The beginning balance entry month 
should be locked to prevent inadvertent entry to the month and then unlocked for beginning balance entry 
after balances are validated. 

How do I handle old payables? 

When an agency converts to a new accounting system, there are generally balances brought forward 
from the previous system that will have to be paid over a 30 to 90 day period.  Depending upon how the 
beginning balances are entered, it should simply be a matter of applying amounts due from previous 
system invoices to a general ledger number with the balance applying to Nexsure invoiced items. 

Carrier Payables 

Statement – Apply to Old Balance 

In this scenario, a statement is received that consists exclusively of previously invoiced items.  Simply 
access disbursement, select carrier as the entity, select the correct carrier, select general ledger link, and 
use the general ledger link to offset the payment to the beginning balance general ledger number. 

Note: If items have been incorrectly invoiced, the reversing and correct invoice entry will have to be 
entered into Nexsure and the two items reconciled for payment. 

Statement – Combination Old Balance and Nexsure Invoices 

In another example, a statement is received where part of the items were invoiced on the previous 
system and the balance of items were invoiced on Nexsure.  This can be handled in a number of ways. 
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1. Reconcile the Nexsure invoiced items, selecting the adjustment link to include the previous system 
items and offsetting to the old balance general ledger number.  A virtual disbursement (or receipt) 
for the total will be created. 

• Issue the disbursement, selecting the reconciliation which should equal the statement. 

2. Reconcile the Nexsure invoiced items, creating a virtual disbursement or receipt for the invoiced 
items. 

• Issue the disbursement and use the general ledger link to offset the appropriate amount to 
the carrier beginning balance. 

• Select the Nexsure reconciliation to equal the total amount due the carrier. 

Issue the disbursement to carrier. 

Use the general ledger link to offset to the old carrier balance. 
Use the invoice link to select Nexsure invoiced items. 

Paying Carriers – Agency Bill 

Nexsure does not make a distinction between account current and company statement.  With the Select 
All feature, any carrier payable can be completed from the disbursement, selecting invoices to pay and 
reconcile as an aspect of disbursement issuance.  As an alternative, reconciliation can be completed first 
followed by the disbursement, selecting the reconciliation to include in the payment. 

Account Current 

Go to reconciliation. 

Select [Show] link in transactions and set the date range appropriately. 

Use [Select All] to choose all items. 

Save > Pay all Selected > Post Reconciliation. 

Go to disbursement, select carrier, and add the reconciliation from the reconciliation link. 

  

Company Statement 

Company statement might be handled by reconciling the statement first and then issuing the 
disbursement.  Alternatively, the reconciliation might be created and then the disbursement issued, 
selecting the reconciliation from the reconciliation link. 

Company Statement with Fees or Credits 

Reconcile and add fee or credit 

Go to reconciliation and select applicable invoices – pay all selected.  Note the virtual disbursement 
or receipt created. 

Select the adjustment link and Add Row creating an entry to offset to the appropriate general ledger 
number.  For example, if MVR credit has been given reducing the amount due the carrier, you will 
credit the general ledger number for MVR expense.  The result will be a reduction in the virtual 
disbursement or increase in the virtual receipt. 

Post the Reconciliation 

Go to Disbursement > carrier, and select the appropriate reconciliation. 

Pay carrier prior to issuing invoice. 

Go to disbursement. 
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Select general ledger link and offset to reconciliation clearing account. 

Invoice policy. 

Access reconciliation and select receipt/disbursement link. 

Add appropriate disbursement 

Select transaction link. 

Select appropriate invoice and pay all selected. 

Post reconciliation. 

Receive/Deposit Commission Check Prior to Reconciliation 

Go to receive payment. 

Select general ledger link and offset to reconciliation clearing account. 

Access reconciliation and select receipt/disbursement link. 

Add appropriate receipt. 

Select transaction link. 

Select appropriate invoice and pay all selected. 

Post reconciliation. 

Paying Carriers – Direct Bill 

There are a number of situations where an agency will pay a carrier for a direct bill policy on behalf of an 
insured.  Regardless of the terminology, it is important that the definition of direct bill is clear.  For 
Nexsure, direct bill is that policy where payment is presumed to occur between the customer and the 
carrier and the carrier subsequently sends the agency direct bill commission. 

Payment to Carrier – Direct Bill Payment Advance 

Any time an insured is going to pay or has paid an agency for a direct bill policy and the agency is 
going to transfer the funds to the carrier with one of their checks, payment advance will be used. 

Issue a disbursement, select carrier, select payment advance in the disbursement quick navigation 
links. 

Select appropriate customer to charge with the payment advance. 

Receive payment to record the customer payment – select invoice in the quick navigation links to 
apply against the payment advance previously entered. 

Ultimately deposit the funds. 

Payment to Carrier – Sweep Processing 

Carriers often “sweep” agency bank accounts for funds paid by clients.  The process to record the sweep 
(disbursement) from the agency account is the same as Payment Advance except instead of issuing a 
check, EFT (electronic funds transfer) or ACH (automatic check handling) can be used which creates an 
invoice to the insured. 

Receive payments is again used to apply the insured payment against the sweep record entered 
previously. 

Receive Payment Recorded before Payment to Carrier 

Clearing residual funds is more complex than simply applying a payment to an existing invoice but is not 
particularly difficult. 
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If receive payment is recorded, simply leave on account without applying to any invoice, general ledger, 
or other quick navigation Link.  You will note a residual amount remains. 

After generating the disbursement to carrier (whether check, EFT or ACH) as an advance payment, return 
to the original receive payment.  You can now select the invoice generated with the disbursement and 
assign the credit that remains with the residual receive payment. 

Premium Finance by Carrier 

Establish a carrier fee called Premium Finance. 

Allow Override. 

Not taxable. 

Do not allow override of general ledger number. 

Select no commission. 

Use Rate – 0.00. 

Associate to appropriate branch(es). 

Create PDR with appropriate premium, fees and taxes. 

Add invoice which copies PDR. 

From non-premium, add “Premium Finance” carrier fee. 

Enter credit using “-“ amount for carrier premium finance.  Net amount should be down payment less 
full commission. 

Premium Finance by Finance Company 

Nexsure does not currently handle Bill to premium finance that moves the balance from the insured’s 
account to a premium finance entity.  Handling depends upon the information that an agency needs to 
retain at the insured level. 

Invoice to Insured and Premium Finance Company. 

Invoice the correct premium to the insured as it will be paid to the carrier with commissions. 

Create two more invoices – selecting Manual as invoice type. 

One is for the amount of the down payment sent to the insured. 

The other will be for the amount due from the Premium Finance Company.  Be sure and change 
Bill to in the quick navigation link to the Premium Finance Company. 

  

Client payment forwarded to Finance Company. 

Show activity on insured account. 

Setup. 

Add (using Search) a Carrier with the Premium Finance Company name. 

 

Workflow 

It is easier to issue the disbursement first 

Select carrier (Premium Finance Company). 

Complete header. 

Go to payment advance. 



Nexsure User's Guide    Frequently Asked Questions 

XDimensional Technologies, Inc.   429

Add Payment advance. 

Click details > complete. 

Save and Post. 

Receive Payment, selecting Client from the entity drop-down. 

Enter the amount received from the client in the header. 

Description should indicate money will go to the Premium Finance Company which will then default 
into the general ledger information. 

Select Invoice – payment advance from 1 will be included. 

Apply to item. 

Save and post. 

Make Deposit (when all related receive payments are entered and ready to be deposited). 

Enter anticipated amount of the deposit based on the money that will make up the deposit. 

Select Payments in the quick navigation link on the right. 

To review at client level, go to client account, transactions and select payment summary or assigned 
payments from the View drop-down. 

Bank Account Reconciliation 

Currently, bank account reconciliation is a manual process.  It is important that each reconciliation 
session is saved to Excel and used as reference for subsequent reconciliations.  It is recommended the 
month and year (BR Jan-2003.xls) is used to name the spreadsheet.  BR can represent Bank 
Reconciliation to easily sort all reconciliations together.  A separate file for Bank Reconciliation could also 
be created. 

Update account balances from general ledger or account summary. 

Click on organization > appropriate entity (organization or territory) > bank accounts > select 
specific bank account details > note balance > highlight and Ctrl-C to copy. 

Click on accounting transactions. 

Click [Show] and select criteria of posted and uncleared items. 

Clear items based on bank statement. 

Click [Show] and search again, using criteria of posted and uncleared items. 

Export to Excel. 

Ctrl-V to paste balance into Excel at the top of the uncleared items column. 

Run an Excel formula at the bottom of the uncleared items column, adding outstanding disbursements 
or credit journal entries and subtracting outstanding deposits or debit journal entries. 

The result should equal the bank statement. If it does not equal, use standard balancing 
techniques such as: 

Divisible by 9 – transposed figure. 

Evenly divisible by 2 – was the amount entered as a credit and should be a debit or vice versa? 

Note: At accounting transaction list view, Ctrl-F can be used to find a specific amount. 
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Frequently Asked Questions 
Browse the FAQ below or jump directly to the section of interest  

Nexsure Administration 

Client Management 

Policy Management 

Policy Servicing 

Marketing Management 

Accounting 

Support 

  

  

Nexsure Administration 

  

Client Management 

Q:  Why doesn't my action show up on the Home > Actions summary? 

A:  The Actions that display on the Home > Actions summary screen are those that are due today or are 
past due.  If the due date of the action is in the future, it will not display until the due date. 

Q:  What is the client profiling screen used for? 

A:  When marketing new accounts for the organization, enter the information on the profiling screen to 
pre-qualify the account. This screen is not required. 

Q:  When adding security for client contacts what is the maximum number of characters that can be used 
for the Login ID and Password? 

A:  Both fields can contain up to 18 alphanumeric characters. 

Q:  What do the key icons stand for on the client’s contacts screen? 

A:  When security has been assigned to a contact and is Active, the column next to Details displays a  
icon. When security has been assigned but is Inactive a  icon is displayed. When no security is 
present this column remains blank. 

Q:  Is there a limit to the number of locations that can be added to a client record? 

A:  Unlimited locations may be added for each client. 

Q:  What does the Primary designation mean on the client locations and contacts screens? 

A:  The Primary designation is the default address or contact person for communication with the entity.   

Q:  Is there a limit to the number of named insureds that can be added to a client record? 

A:  Unlimited named insureds may be added for each client. 

Q:  Why add account relationships? 
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A:   By adding account relationships, you can quickly see if a personal lines account is perhaps the owner 
of one of the branch’s commercial lines accounts.  This could be important if the son on the personal 
auto policy had one too many tickets and the carrier wanted to cancel and the personal lines account 
manager does not know the commercial lines account exists and allows the cancellation to go 
through causing the large commercial account to be lost as well.  This may not have happened if 
there had been an account relationship association.  

Go back to the top 

  

Policy Management 

Q:  Can policies be assigned to a different branch, account manager and producer even though the  
client was assigned at client level to another entity in our organization? 

A:  Yes, even though the policy belongs to one branch, policies may belong to an entirely different 
branch, account manager or producer within your organization. 

Q:  Can documents and photos be attached from my local computer? 

A:  Yes, you may add attachments by clicking on the attachments tab either at client or policy level.   

Go back to the top 

  

Policy Servicing 

Q:  I'm unable to edit a policy because the system tells me that there's no policy to edit - why? 

A:  If there is already a pending edit, you are unable to do another edit until you either abort or post the 
edit that is already there.  Select the policies tab to see if there is a pending edit.    

Q:  I am receiving an error when I try to create a certificate - why? 

A:  Certificates require a signature file to be attached to the certificate.    

 
Signature files MUST be created and attached to your employee details to create new certificates in 
Nexsure.  This option is not available if you are generating certificates via ConfirmNet.  Your signature file 
must be created in a graphics program such as MS Paint or Adobe Photoshop.  The signature file must 
be GIF format.  To avoid distortion, create the signature file with a height of 75 pixels and width of 225 
pixels, for example: 

 
 *Drop shadow used to show dimensions. 

  

To add a signature file 

On the employees screen, click the identity tab. 

Click add signature. 

Click Browse to navigate to the jpg file and click Upload. 



Nexsure User's Guide    Frequently Asked Questions 

XDimensional Technologies, Inc.   432

Click Close. 

Q:  How are in force policies added to Nexsure? 

A:  If no marketing policies exist on the marketing tab a message window is displayed allowing history to 
be viewed if desired, click the Cancel button to add a new market. The policy header screen is 
displayed. Complete the heading information and click on the Save Changes link below the header. If 
marketing policies exist, click on the servicing tab, select the marketing option button and select the 
New Line of Business option button, the Next option will display the underwriting header. Make 
certain to complete the application prior to clicking the In force link since an In force policy may only 
be edited by accessing the edit feature on the servicing tab.   

Q:  Why can’t I change the policy period on the renewal? 

A:  The policy period needs to be changed before the renewal is put in force.  If the renewal has already 
been placed in force, an edit can be done on the policy to change the policy period. 

Q:  How can in force policies be modified that do not require an endorsement? 

A:  On the services tab select the Edit option in the Select column and click Next to continue. Select the 
policy to edit by selecting the option next to the appropriate policy in the Select column and click 
Next.  Click Post Edit when the edit is completed. 

Q:  How long can an un-posted edit or endorsement remain un-posted? 

A:  As long as necessary, however, be aware that policies cannot be edited, endorsed or renewed until 
the item is posted.   

Q:  On the servicing tab, what is the difference between edit and endorsement? 

A:  Edit allows the user to correct an error that has been made on the policy that does not require an 
official policy change by the company. 

Endorse allows the user to create a change request to send out to the company. 

Q:  What does  mean on an un-posted endorsement or edit? 

A:  This feature is found while editing data on a form.  Clicking On will display a comparison of data from 
the current in force policy to the current form that is being edited or endorsed.  This will allow the user 
to see what the differences are between the two.  

Go back to the top 

  

Marketing Management 

Q:  Must all policies be added as a marketing policy to have a valid in force policy in Nexsure? 

A:  Yes.   

Q:  When re-marketing an existing policy, do I need to re-enter all the information that is on the current in-
force policy? 

A:  No, the data on the selected policy to remarket is automatically copied to the marketing file with 
exception to some of the policy header information.  This gives you the opportunity to enter correct 
marketing information.   
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Q:  I need to send a different version of a policy currently in marketing to another company, how should 
this be done?   

A:  Follow the marketing process but select the policy already in marketing and then make the necessary 
changes to the form prior to submitting to the next carrier. 

Q:  After a policy has renewed, what should be done with the old marketing forms? 

A:  Once a policy has been successfully renewed and you no longer have a need for the marketing forms 
not used to renew the policy, click on the Remove  icon to remove the form. 

Go back to the top 

  

Accounting 

Q:  If the agency receives return premium from the carrier for a direct bill cancellation, how is this 
processed in Nexsure? 

A:  If the agency has never gone through this process before, they would first need to add an asset 
account and call it “DB Return Premium for Carrier” and propagate to all territories. Then follow the 
below steps: 

1. Invoice the Direct Bill Return Premium on the clients account as normal. 

2. Receive payment and select the GL link and Credit the “DB Return Premium for Carrier” for the 
premium, tax and fee if any. 

3. Do the deposit as normal. 

4. Reconcile the carrier statement as normal but select the adjustments link and Credit the “DB 
Return Premium for Carrier” for the commission amount.  

Note: there is nothing in reconciliation clearing to clear. 

5. Issue a check to the client selecting the payment at client level and the general ledger link and 
Debit the “DB Return Premium for Carrier” for the full amount due the client.  

Note: This clears the balance in the “DB Return Premium for Carrier” account. 

Q:  I applied money to the wrong client, can I move it to the proper client? 

A:  Yes. 

 
 
In this scenario the money was left on the client account and not assigned to an open item. 

 
1. Reverse the Cash Receipt for JH Construction. 
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2. Select Other and No to apply a charge to the client account. 

  

3. The reversal displays: 
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4. The money received was removed from the client account. 

  

5. Continuing in this scenario, the agency is forwarding money to the carrier so, add a 
disbursement and select carrier, search and select. Make sure to enter a good 
description in the header for the disbursement.  Select the Payment Advance link, search 
for the client, and enter the information for the advance and post. 

Note: If no payment advance is necessary, skip this step.  

 
  

6. Create a cash receipt to correct the client (Mr. Zimmerman) and allocate to payment 
advance. Enter the description that you are transferring the money from customer X to 
customer Y so it will display on the client transaction list. Click on the Invoices link and 
select the invoice to apply the cash receipt to display on the client transaction list. 

7. Click Pay All Selected. 

8. Click Post. 
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Customer Transaction View: 

 
9. Create a deposit and enter a description on the deposit header.  

Note: Enter a detailed description to include who and what the deposit is for as well as the 
deposit number this one is replacing.  

  

10. Make sure to include both the credit and debit for the clients. The amount will be zero 
which will have no affect on bank balance.  

11. Click Include All Selected. 

12. Then click Post to complete the deposit. 
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On the Deposit Summary view note that the amount is zero: 

 

 
Tip: This procedure can be taken one step further by adding an action to the client account 
that the money was transferred from and note the original cash receipt number, the new 
number and all the details of the transferring of funds. Example below: 
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